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DAMAGE IN TRANSPORTATION
All packages should be closely examined at time of delivery. If damage is apparent write “Damage In 
Shipment” on ALL copies of the freight or express bill BEFORE delivery is accepted or “signed for” by 
a GE representative or hospital receiving agent. Whether noted or concealed, damage MUST be 
reported to the carrier immediately upon discovery, or in any event, within 14 days after receipt, and the 
contents and containers held for inspection by the carrier. A transportation company will not pay a claim 
for damage if an inspection is not requested within this 14 day period.

CERTIFIED ELECTRICAL CONTRACTOR STATEMENT - FOR USA ONLY
All electrical Installations that are preliminary to positioning of the equipment at the site prepared for the 
equipment shall be performed by licensed electrical contractors. Other connections between pieces of 
electrical equipment, calibrations and testing shall be performed by qualified GE personnel. In 
performing all electrical work on these products, GE will use its own specially trained field engineers. 
All of GE’s electrical work on these products will comply with the requirements of the applicable 
electrical codes.

The purchaser of GE equipment shall only utilize qualified personnel (i.e., GE’s field engineers, 
personnel of third-party service companies with equivalent training, or licensed electricians) to perform 
electrical servicing on the equipment.

OMISSIONS & ERRORS
If there are any omissions, errors or suggestions for improving this documentation, please contact the 
GE Healthcare Global Documentation Group with specific information listing the system type, manual 
title, part number, revision number, page number and suggestion details. 

Mail the information to:
Service Documentation
9900 Innovation Drive (RP-2156)
Wauwatosa, WI   53226, USA.

GE employees should use PQM (Post Market Quality Management) to report service documentation 
issues. These issues will then be in the internal problem reporting tool and communicated to the writer.

SERVICE SAFETY CONSIDERATIONS 

For a complete review of all safety requirements, see the Chapter 1, Safety Considerations section of 
the latest version of LOGIQ P7/P8/P9/P10 Proprietary Service Manual, Direction 5599028.

DANGER DANGEROUS VOLTAGES, CAPABLE OF CAUSING DEATH, ARE PRESENT IN 
THIS EQUIPMENT. USE EXTREME CAUTION WHEN HANDLING, TESTING AND 
ADJUSTING.

WARNINGWARNING Use all Personal Protection Equipment (PPE) such as gloves, safety shoes, safety 
glasses, and kneeling pad, to reduce the risk of injury. 

WARNINGWARNING Beware of possible sharp edges of all mechanical parts. If sharp edges are 
encountered, the appropriate PPE (ex.cut resistant gloves) should be used to reduce 
the risk of injury.

NOTICE
!! NOTICE:

Several hand pictures do not have cut resistant gloves on in the service manuals but 
the purpose of the picture is to address the location of the parts and process steps. 
Therefore, field engineers should wear cut resistant gloves to reduce the risk of injury.



GE LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18  SERVICE MANUAL

 - xv

LEGAL NOTES

The contents of this publication may not be copied or duplicated in any form, in whole or in part, without 
prior written permission of GE.

GE may revise this publication from time to time without written notice.

TRADEMARKS
All products and their name brands are trademarks of their respective holders.

COPYRIGHTS
All Material Copyright© 2022 by General Electric Company Inc. All Rights Reserved
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Chapter 1
Introduction

Section 1-1
Overview

1-1-1 Purpose of Chapter 1
This chapter describes important issues related to safely servicing the LOGIQ P7/P8/P9/P10 ultrasound 
system. The service provider must read and understand all the information presented in this manual 
before installing or servicing a unit.

1-1-2 Purpose of Service Manual 

This Service Manual provides installation and service information for LOGIQ P7/P8/P9/P10 Ultrasound 
Scanning System and contains the following chapters:

1) Chapter 1 - Introduction: Contains a content summary and warnings.
2) Chapter 2 - Site Preparation: Contains pre-installation requirements.
3) Chapter 3 - Setup Instructions: Contains setup and installation procedures.
4) Chapter 4 - Functional Checks: Contains functional checks that are recommended as part of the 

installation, or as required during servicing and care and maintenance.
5) Chapter 5 - Components and Functions (Theory): Contains block diagrams and functional 

explanations of the electronics.
6) Chapter 6 - Service Adjustments: Contains instructions on how to make available adjustments.
7) Chapter 7 - Diagnostics/Troubleshooting: Provides procedures for running diagnostic or related 

routines.
8) Chapter 8 - Replacement Procedures: Provides disassembly procedures and reassembly 

procedures for all changeable Field Replaceable Units (FRU).
9) Chapter 9 - Renewal Parts: Contains a complete list of field replaceable parts.
10) Chapter 10 - Care & Maintenance: Provides care and maintenance procedures.

Table 1-1    Contents in Chapter 1

Section Description Page Number

1-1 Overview 1-1

1-2 Important Conventions 1-3

1-3 Safety Considerations 1-10

1-4 Electromagnetic Compatibility (EMC) 1-20

1-5 Customer Assistance 1-21

NOTICE
!! NOTICE:

This Service Manual is valid for LOGIQ P7/P8/P9/P10 ultrasound systems. 
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1-2 Section 1-1 - Overview

1-1-3 Typical Users of the Basic Service Manual
• GE Service Personnel (installation, maintenance, etc.)
• Hospital’s Service Personnel
• Contractors (Some parts of Chapter 2 - Pre-Installation)

1-1-4 Models Covered by this Manual 

NOTE: For LP9/P7 R3, the color of the system that is shown in this manual could look different from the real 
system. 

Table 1-2    LOGIQ P7/P8/P9/P10 - Model Designations

Part Number Description

5560941 LOGIQ P7 Standard

5560939 LOGIQ P7 Tall

5560938 LOGIQ P9

5641296 LOGIQ P7 with High Cabinet

5641037 LOGIQ P9 with Articulating Monitor Arm

5724885 LOGIQ P7 R2 with High Cabinet

5724886 LOGIQ P9 R2 with Articulating Monitor Arm

5759916 LOGIQ P7 R2.5

5759915 LOGIQ P9 R2.5

5794264 LOGIQ P9 R3

5795196 LOGIQ P7 R3

5842858 LOGIQ P8 R4

5842859 LOGIQ P9 R4

5842860 LOGIQ P10 R4

5858143 LOGIQ P10 R4 HD

5877532 LOGIQ P8 R4.5 

5877533 LOGIQ P9 R4.5

5877534 LOGIQ P10 R4.5

5877535 LOGIQ P10 R4.5 HD
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1-1-5 Purpose of Operator Manual(s)
The Operator Manual(s) should be fully read and understood before operating the LOGIQ P7/P8/P9/
P10 and also kept near the unit for quick reference.

Section 1-2
Important Conventions

1-2-1 Conventions Used in this Manual
Model Designations

This manual covers the LOGIQ P7/P8/P9/P10 ultrasound units listed on page 1-2.

Icons

Pictures, or icons, are used wherever they reinforce the printed message. The icons, labels and 
conventions used on the product and in the service information are described in this chapter.

Safety Precaution Messages

Various levels of safety precaution messages may be found on the equipment and in the service 
information. The different levels of concern are identified by a flag word that precedes the precautionary 
message. Known or potential hazards are labeled in one of following ways:

NOTE: Notes provide important information about an item or a procedure. 
Information contained in a NOTE can often save you time or effort.

DANGER
!! DANGER:

INDICATES THE PRESENCE OF A HAZARD THAT WILL CAUSE SEVERE 
PERSONAL INJURY OR DEATH IF THE INSTRUCTIONS ARE IGNORED.

WARNINGWARNING
!! WARNING:

INDICATES THE PRESENCE OF A HAZARD THAT CAN CAUSE SEVERE PERSONAL 
INJURY AND PROPERTY DAMAGE IF INSTRUCTIONS ARE IGNORED.

CAUTION
!! CAUTION: 

Indicates the presence of a hazard that will or can cause minor personal injury and property 
damage if instructions are ignored.

NOTICE
!! NOTICE:

Equipment Damage Possible
Notice is used when a hazard is present that can cause property damage but has absolutely no 
personal injury risk. 
Example: Disk drive will crash.
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1-2-2 Standard Hazard Icons
Important information will always be preceded by the exclamation point contained within 
a triangle, as seen throughout this chapter. In addition to text, several different graphical 
icons (symbols) may be used to make you aware of specific types of hazards that could 
cause harm. Even if a symbol isn’t used in this manual, it is included for your reference.

Other hazard icons make you aware of specific procedures that should be followed.

Table 1-3    Standard Hazard Icons

ELECTRICAL MECHANICAL RADIATION

LASER HEAT PINCH

Table 1-4    Standard Icons Indicating a Special Procedure be Used

AVOID STATIC ELECTRICITY TAG AND LOCK OUT WEAR EYE PROTECTION

 

WEAR HAND PROTECTION WEAR FOOT PROTECTION

LASER
LIGHT

Signed Date

TAG 
& 

LOCKOUT
EYE

PROTECTION

or
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1-2-3 Product Icons
The following table describes the purpose and location of safety labels and other important information 
provided on the equipment. 

Table 1-5    Product Icons 

LABEL/SYMBOL PURPOSE/MEANING LOCATION

Identification and Rating Plate
Manufacturer's name and address
Model and serial numbers
Electrical ratings

Rear side of the unit
on each probe

Device Listing/Certification Labels Laboratory logo or labels denoting conformance with industry 
safety standards such as UL or IEC. Rear side of the unit

Council Directive 93/42/EEC concerning medical devices: The 
CE mark affixed to the equipment testifies compliance to the 
directive.

Regulation (EU) 2017/745 concerning medical devices: The 
CE mark affixed to the equipment testifies compliance to the 
Regulation.

Rear side of the unit
on the plug of each probe

Type/Class Label Used to indicate the degree of safety or protection.

IP Code (IPX 1)
IP Code (IPX 7)

Indicates the degree of protection provided by the enclosure 
per IEC 60529.
IPX 1 - protected against dripping water
IPX 7 - protected against the effects of immersion

Footswitch
Probes

Equipment Type BF (man in the box, symbol IEC 60878-5333) 
indicates B Type equipment having even more electrical 
isolation than standard Type B equipment because it is 
intended for intimate patient contact.

Probe connectors 
Main label on rear of system

To identify a defibrillation-proof type CF (heart in box with 
“electrodes”, symbol IEC 60878-5336) applied part complying 
with IEC 60601-1.

Front side of the ECG-preamplifier

“CAUTION
This unit weighs...

Special care must be used to avoid..."

This precaution is intended to prevent injury that may result if 
one person attempt to move the unit considerable distances or 
on an incline due to the weight of the unit.

Used in the Service and User Manual 
which should be adjacent to equipment 
at all times for quick reference.

"DANGER -
Risk of explosion used in..."

The system is not designed for use with flammable anesthetic 
gases. Indicated in the Service Manual.

"CAUTION" The equilateral triangle is usually used in 
combination with other symbols to advise or warn the user. various

xxxx
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“ATTENTION - Consult accompanying documents " is 
intended to alert the user to refer to the operator manual or 
other instructions when complete information cannot be 
provided on the label.

Rear side of Power Supply

"CAUTION - Dangerous voltage" (the lightning flash with 
arrowhead in equilateral triangle) is used to indicate electric 
shock hazards.

various

"Mains OFF" Indicates the power off position of the mains 
power switch. rear of system at mains switch 

"OFF/Standby" Indicates the power off/standby position of the 
power switch.
CAUTION
This Power Switch DOES NOT ISOLATE Mains Supply

Adjacent to On-Off/Standby switch left 
below the Control panel.

"Mains ON" Indicates the power on position of the mains 
power switch. rear of system at mains switch 

"Protective Earth" Indicates the protective earth (grounding) 
terminal.

rear of system at mains switch 
(on primary power supply - RTN)

"Equipotentiality" Indicates the terminal to be used for 
connecting equipotential conductors when interconnecting 
(grounding) with other equipment.

rear of system at mains switch 
(on primary power supply - RTN)

Waste Electrical and Electronic Equipment (WEEE) Disposal.
This symbol indicates that waste electrical and electronic 
equipment must not be disposed as unsorted municipal waste 
and must be collected separately. Please contact an 
authorized representative of the manufacturer for information 
concerning the decommissioning of your equipment.

Rear side of the unit
on the plug of each probe

These symbols indicate that at least one of the six hazardous 
substances of the China RoHS Labeling Standard is above 
the RoHS limitation. 
The number inside the circle is referred to as the 
Environmental Friendly Use Period (EFUP). It indicates the 
number of years that the product, under normal use, will 
remain harmless to health of humans or the environment.
EFUP = 10 for Short Use Products
EFUP = 20 for Medium Use Products

Rear side of the unit
on the plug of each probe

Table 1-5    Product Icons (Continued)

LABEL/SYMBOL PURPOSE/MEANING LOCATION
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This product consists of devices that may contain mercury, 
which must be recycled or disposed of in accordance with 
local, state, or country laws.
(Within this system, the backlight lamps in the monitor and the 
Touch Panel display, contain mercury.) 

Rear side of the unit
not visible:
- below the cover on read side of Monitor
- on rear side of the Touch Panel

Loading prohibited at top cover of the system

Every system has a unique marking for identification, the 
Unique Device Identification (UDI) Label. The UDI label 
consists of a series of alpha-numeric characters and barcode, 
which uniquely identify the LOGIQ P7/P9 system as a medical 
device manufactured by General Electric. Scan or enter the 
UDI information into the patient health record as required by 
country-specific laws.

Rating Plate

Upgraded LOGIQ P9 systems, adjacent 
to the Rating Plate

Table 1-5    Product Icons (Continued)

LABEL/SYMBOL PURPOSE/MEANING LOCATION
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Every system has a unique marking for identification, the 
Unique Device Identification (UDI) Label. The UDI label 
consists of a series of alpha-numeric characters and barcode, 
which uniquely identify the LOGIQ P8/P9/P10 R4 system as a 
medical device manufactured by General Electric. Scan or 
enter the UDI information into the patient health record as 
required by country-specific laws.

Rating Plate

Upgraded LOGIQ P9 systems, adjacent 
to the Rating Plate

Table 1-5    Product Icons (Continued)

LABEL/SYMBOL PURPOSE/MEANING LOCATION
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Every system has a unique marking for identification, the 
Unique Device Identification (UDI) Label. The UDI label 
consists of a series of alpha-numeric characters and barcode, 
which uniquely identify the LOGIQ P8/P9/P10 R4.5 system as 
a medical device manufactured by General Electric. Scan or 
enter the UDI information into the patient health record as 
required by country-specific laws.

Rating Plate

Upgraded LOGIQ P8/P9/P10 systems, 
adjacent to the Rating Plate

Table 1-5    Product Icons (Continued)

LABEL/SYMBOL PURPOSE/MEANING LOCATION
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Section 1-3
Safety Considerations

1-3-1 Introduction
The following safety precautions must be observed during all phases of operation, service and repair of 
this equipment. Failure to comply with these precautions or with specific warnings elsewhere in this 
manual, violates safety standards of design, manufacture and intended use of the equipment.

1-3-2 Human Safety
Operating personnel must not remove the system covers, except for removing front cover to clean air 
filter. 
Servicing should be performed by authorized personnel only. Only personnel who have participated in 
a LOGIQ P7/P8/P9/P10 Training are authorized to service the equipment.

1-3-3 Mechanical Safety      

NOTE: Special care should be taken when transporting the unit in a vehicle:

• Eject any DVD/CD from the drive. 
• Place the probes in their carrying cases.
• DO NOT use the Control Panel as an anchor point.
• Secure the systems with straps in an upright position and lock the caster wheels (brake).
• Ensure that the LOGIQ P7/P8/P9/P10 system is firmly secured while inside the vehicle.
• Prevent vibration damage by driving cautiously. Avoid unpaved roads, excessive speeds, and 

erratic stops or starts.

CAUTION
!! CAUTION: 

The LOGIQ P7/P8/P9/P10 weighs 60 kg or more, depending on installed peripherals, (133 lbs 
or more) when ready for use. 
Care must be used when moving it or replacing its parts. Failure to follow the precautions 
listed could result in injury, uncontrolled motion and costly damage.
ALWAYS:
• Use the handle to move the system. • Be sure the pathway is clear. 
• Use slow, careful motions. • Do not let the system strike walls or door frames.
Two people are required when moving on inclines or lifting more than 16 kg (35 lbs).

WARNINGWARNING
!! WARNING:

USE EXTREME CAUTION WHEN ELEVATING THE UNIT, OR IF IT IS RAISED FOR A 
REPAIR OR MOVED ALONG ANY INCLINE. THE LOGIQ P7/P8/P9/P10 SYSTEM MAY 
BECOME UNSTABLE WHICH COULD CAUSE A TIP OVER.

WARNINGWARNING
!! WARNING:

ULTRASOUND PROBES ARE HIGHLY SENSITIVE MEDICAL INSTRUMENTS THAT 
CAN EASILY BE DAMAGED BY IMPROPER HANDLING. USE CARE WHEN 
HANDLING AND PROTECT FROM DAMAGE WHEN NOT IN USE. DO NOT USE A 
DAMAGED OR DEFECTIVE PROBE. FAILURE TO FOLLOW THESE PRECAUTIONS 
CAN RESULT IN SERIOUS INJURY AND EQUIPMENT DAMAGE.

WARNINGWARNING
!! WARNING:

NEVER USE A PROBE THAT HAS FALLEN TO THE FLOOR. 
EVEN IF IT LOOKS OK, IT MAY BE DAMAGED.

CAUTION
!! CAUTION: 

Always lower and center the Operator I/O Panel before moving the scanner.

CAUTION
!! CAUTION: 

Before you move or transport the system, make sure to lock the LCD monitor firmly and flip 
down the monitor to prevent damage to the system.
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1-3-4 Electrical Safety

1-3-4-1 Safe Practices
To minimize shock hazard, the equipment chassis must be connected to an electrical ground.
The system is equipped with a three-conductor AC power cable. This must be plugged into an approved 
electrical outlet with safety ground. If an extension cord is used with the system, make sure that the total 
current rating of the system does not exceed the extension cord rating. 

The power outlet used for this equipment should not be shared with other types of equipment.
Both the system power cable and the power connector meet international electrical standards.

This product is classified as Class I and INTERNALLY POWERED ME EQUIPMENT according to the 
IEC/EN 60601-1.

1-3-4-2 Probes
All the probes for the LOGIQ P7/P8/P9/P10 are designed and manufactured to provide trouble-free, 
reliable service. To ensure this, correct handling of probes is important and the following points should 
be noted:

• Do not drop a probe or strike it against a hard surface, as this may damage the transducer elements, 
acoustic lens, or housing.

• Inspect the probe prior to each use for damage or degradation to the Housing, Cable strain relief, 
Lens and Seal.

• Do not use a cracked or damaged probe. In this event, call your field service representative 
immediately to obtain a replacement.

• Avoid pulling, pinching or kinking the probe cable, since a damaged cable may compromise the 
electrical safety of the probe.

• To avoid the risk of a probe accidentally falling, do not allow the probe cables to become entangled, 
or to be caught in the machine’s wheels.

• Never immerse the probe connector or adapter into any liquid.

NOTE: For detailed information on handling probes, refer to the LOGIQ P7/P8/P9/P10 Basic User Manual and 
the care card supplied with the probe.
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1-3-5 Auxiliary Devices Safety 

The LOGIQ P7/P8/P9/P10 may be used with an isolation transformer to provide the required separation 
from mains for both, the system and the auxiliary devices. 
One AUX main outlet is located at the primary power supply. It is used for connecting the two-fold splitter 
whose outlets are led to the shelves intend for auxiliary devices (e.g., printers) and the AUX main outlet 
that is accessible on the back of the control console. 

The IEC 60601-1-1 standard provides a guideline for safely interconnecting medical devices in systems. 
“Equipment connected to the analog or digital interface must comply with the respective IEC/UL 
standards (e.g. IEC 60950 / UL 60950 for data processing equipment and IEC 60601-1 / ANSI/AAMI 
ES60601-1 for medical equipment).

Everybody who connects additional equipment to the signal input portion or signal output portion 
configures a medical system, and is therefore responsible that the system complies with the 
requirements of the system standard IEC 60601-1-1.

Special care has to be taken, if the device is connected to computer network (e.g., Ethernet), because 
other devices could be connected without any control. There could be a potential difference between 
the protective earth and any line of the computer network including the shield. 

In this case the only way to operate the system safely is to use an isolated signal link with minimum 
4mm creepage distance, 2.5mm air clearance of the isolation device. For computer networks there are 
media converters available which convert the electrical to optical signals. Please consider that this 
converter has to comply with IEC xxx standards* and is battery operated or connected to the isolation 
mains output of the LOGIQ P7/P8/P9/P10 ultrasound system.

* IEC xxx stands for standards such as:

• IEC 60601 for medical devices
• IEC 60950 for information technology equipment etc.    

WARNINGWARNING
!! WARNING:

Power Supplies for additional equipment MUST comply with IEC 60601-1.

WARNINGWARNING
!! WARNING:

DO NOT attempt to use different peripherals and accessories (brand and model; 
connected via USB ports) other than approved and provided by GE Healthcare! 
The ultrasound system is an extremely sensitive and complex medical system. 
Any unauthorized peripherals may cause system failure or damage!

NOTICE
!! NOTICE:

The system integrator (any person connecting the medical device to other devices) is responsible 
that the connections are safe.
If in doubt, consult the technical service department or your local representative.

CAUTION
!! CAUTION: 

The leakage current of the entire system including any / all auxiliary equipment must not exceed 
the limit values as per IEC 60601-1 / EN 60601-1 respectively other valid national or international 
standards. All equipment must comply with UL, CSA and IEC requirements.
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For hardware installation procedures see: Chapter 3 - Connection of Auxiliary Devices, on page 3-12.

CAUTION
!! CAUTION: 

Please observe that some printers may not be medical devices! If the Bluetooth Printer and/or 
Line Printers are no medical devices, they have to be located outside of the patient environment 
(according to IEC 60601-1 / ANSI/AAMI ES60601-1).

CAUTION
!! CAUTION: 

Auxiliary equipment must only be connected to the main console with the special main outlet 
provided for the electrical safety of the system.

CAUTION
!! CAUTION: 

Auxiliary equipment with direct main connection requires galvanic separation of the signal and/
or control leads.

WARNINGWARNING
!! WARNING:

After each installation, the leakage currents have to be measured according to
IEC 60601-1 respectively ANSI/AAMI ES60601-1.

NOTICE
!! NOTICE:

All peripherals mounted on the LOGIQ P7/P8/P9/P10 system chassis must be firmly secured in 
position.

2,5 m 1,5 m

1,5 m1,5 m
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1-3-6 Battery Safety 

NOTE: The LOGIQ P7/P8/P9/P10 ultrasound system is supplied with a lithium ion battery in the power 
supply module, as option.

The lithium ion technology used in the system’s battery is significantly less hazardous to the 
environment than the lithium metal technology used in some other batteries (such as watch batteries). 
Used batteries should not be placed with common household waste products. Contact local authorities 
for the location of a chemical waste collection program nearest you.

NOTE: Regulations vary for different countries. Dispose of a used battery in accordance with local 
regulations. 

• DO NOT short-circuit the battery by directly connecting the negative terminals with metal objects.
• DO NOT heat the battery or discard it in a fire.
• DO NOT expose the battery to temperatures over 50 C. Keep the battery away from fire and other 

heat sources.
• DO NOT charge the battery near a heat source, such as, a fire or heater.
• DO NOT leave the battery in direct sunlight.
• DO NOT pierce the battery with a sharp object, hit it, or step on it.
• DO NOT use a damaged battery.
• DO NOT apply solder to a battery.
• DO NOT connect the battery to an electrical power outlet.

• DO NOT immerse the battery in water or allow it to get wet.
• DO NOT place the battery into a microwave oven or pressurized container.
• If the battery leaks or emits an odor, remove it from all possible flammable sources.
• If the battery emits an odor or heat, is deformed or discolored, or in a way appears abnormal during 

use, recharging or storage, immediately remove it and stop using it.

NOTE: If you have any questions about the battery, consult your local GE representative.

• Storage of the battery pack:
Short-term (less than 1 month): between 0 C (32 °F) and 50 C(122 °F)

Long-term (more than 3 months): between 10 C (50 °F) and 35C (95 °F)

When charging the battery for the first time after long-term storage, recover the battery pack to 
original performance through repeating several cycles of full charging and discharging.

CAUTION USE ONLY BATTERIES APPROVED BY GE HEALTHCARE AS SUITABLE FOR USE WITH THE 
LOGIQ P7/P8/P9/P10 ULTRASOUND SYSTEM.

WARNINGWARNING THE LOGIQ P7/P8/P9/P10 BATTERY HAS A SAFETY DEVICE.
DO NOT ATTEMPT TO DIS-ASSEMBLE OR ALTER THE BATTERY!
ALWAYS OBSERVE THE FOLLOWING PRECAUTIONS:

CAUTION TO PREVENT THE BATTERY BURSTING, IGNITING, OR FUMES FROM THE BATTERY CAUSING 
EQUIPMENT DAMAGE, ALWAYS OBSERVE THE FOLLOWING PRECAUTIONS:
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1-3-7 Labels Locations
The LOGIQ P9/P7 ultrasound system comes equipped with product labels and icons.
These labels and icons represent pertinent information regarding the operation of the unit.

* Required for Asia.

1) LCD Caution Label
2) Gender Caution Label (Only for India, China, Korea)
3) Multi Caution Label
4) LOGIQ P9/P7 Rating Label (For China, Korea, Japan)
5) LOGIQ P9/P7 Rating Label
6) UL Label

Figure 1-1  Label Location (R1, R2 and R2.5)
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* Required for Asia.

1) LCD Caution Label
2) Gender Caution Label (Only for India, China, Korea)
3) Multi Caution Label
4) LOGIQ P9/P7 Rating Label (For China, Korea, Japan)
5) LOGIQ P9/P7 Rating Label

Figure 1-2  Label Location (R3)

*
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1) LCD Caution Label
2) Gender Caution Label (Only for India, China, Korea)
3) Multi Caution Label
4) LOGIQ P8/P9/P10 Rating Label (For China, Korea, Japan)
5) LOGIQ P8/P9/P10 Rating Label

Figure 1-3  Label Location (R4)
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1) LCD Caution Label
2) Gender Caution Label (Only for India, China, Korea)
3) Multi Caution Label
4) LOGIQ P8/P9/P10 Rating Label (For China, Korea, Japan)
5) LOGIQ P8/P9/P10 Rating Label

Figure 1-4  Label Location (R4.5)
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1-3-8 Dangerous Procedure Warnings
Warnings, such as the examples below, precede potentially dangerous procedures throughout this 
manual. Instructions contained in the warnings must be followed.  

1-3-9 Lockout/Tagout Requirements (For USA Only)
Follow OSHA Lockout/Tagout requirements to protect service personnel from injuries caused by 
unexpected energizing or start-up of equipment during service, repair, or maintenance.

1-3-10 Returning/Shipping System, Probes and Repair Parts
When returning or shipping the LOGIQ P7/P8/P9/P10 system in the original packaging:

• system must be lowered to its minimum height with monitor flapped down (see Figure on page 3-7)
• the Control Console has to be centered and locked in “unextended” position.
Equipment being returned must be clean and free of blood and other infectious substances.

GEHC policy states that body fluids must be properly removed from any part or equipment prior to 
shipment. GEHC employees, as well as customers, are responsible for ensuring that parts/equipment 
have been properly decontaminated prior to shipment. Under no circumstance should a part or 
equipment with visible body fluids be taken or shipped from a clinic or site (for example, body coils or 
and ultrasound probe).

The purpose of the regulation is to protect employees in the transportation industry, as well as the 
people who will receive or open this package.

DANGER
!! DANGER:

DANGEROUS VOLTAGES, CAPABLE OF CAUSING DEATH, ARE PRESENT 
IN THIS EQUIPMENT. 
USE EXTREME CAUTION WHEN HANDLING, TESTING AND ADJUSTING.

WARNINGWARNING
!! WARNING:

EXPLOSION WARNING
DO NOT OPERATE THE EQUIPMENT IN AN EXPLOSIVE ATMOSPHERE. 
OPERATION OF ANY ELECTRICAL EQUIPMENT IN SUCH AN ENVIRONMENT 
CONSTITUTES A DEFINITE SAFETY HAZARD.

WARNINGWARNING
!! WARNING:

DO NOT SUBSTITUTE PARTS OR MODIFY EQUIPMENT
BECAUSE OF THE DANGER OF INTRODUCING ADDITIONAL HAZARDS, DO NOT 
INSTALL SUBSTITUTE PARTS OR PERFORM ANY UNAUTHORIZED MODIFICATION 
OF THE EQUIPMENT.

NOTICE
!! NOTICE:

Energy Control and Power Lockout for LOGIQ P7/P8/P9/P10.
When servicing parts of the system where there is exposure to voltage greater than 30 Volts:
Unplug the system.
Maintain control of the system power plug.
There are no test points to verify isolation, you must wait for at least 20 seconds for capacitors to 
discharge.
Beware that the Power Supply, Front End Processor and Back End Processor may be energized even 
if the power is turned off when the cord is still plugged into the AC Outlet.UT

Signed Date

TAG 
& 

LOCKOUT
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1-3-10 Returning/Shipping System, Probes and Repair Parts (cont?)

NOTE: The US Department of Transportation (DOT) has ruled that “items what were saturated and/or dripping 
with human blood that are now caked with dried blood; or which were used or intended for use in patient 
care” are “regulated medical waste” for transportation purpose and must be transported as a hazardous 
material.

Section 1-4
Electromagnetic Compatibility (EMC)

1-4-1 What is EMC?
Electromagnetic compatibility describes a level of performance of a device within its electromagnetic 
environment. This environment consists of the device itself and its surroundings including other 
equipment, power sources and persons with which the device must interface. Inadequate compatibility 
results when a susceptible device fails to perform as intended due interference from its environment or 
when the device produces unacceptable levels of emission to its environment. This interference is often 
referred to as radio–frequency or electromagnetic interference (RFI/EMI) and can be radiated through 
space or conducted over interconnecting power of signal cables. In addition to electromagnetic energy, 
EMC also includes possible effects from electrical fields, magnetic fields, electrostatic discharge and 
disturbances in the electrical power supply.

For applicable standards please refer to Chapter 2 in the Basic User Manual of the LOGIQ P7/P8/P9/
P10 ultrasound system.

1-4-2 Compliance
The LOGIQ P7/P8/P9/P10 unit conforms to all applicable conducted and radiated emission limits and 
to immunity from electrostatic discharge, radiated and conducted RF fields, magnetic fields and power 
line transient requirements as mentioned in IEC 60601-1-2.

NOTE: For CE Compliance, it is critical that all covers, screws, shielding, gaskets, mesh, clamps, are in 
good condition, installed tightly without skew or stress. Proper installation following all 
comments noted in this service manual is required in order to achieve full EMC performance.

1-4-3 Electrostatic Discharge (ESD) Prevention  

WARNINGWARNING
!! WARNING:

DO NOT touch any boards with integrated circuits prior to taking the necessary ESD 
precautions: 
1.) When installing boards, ESD may cause damage to a board. 

ALWAYS connect yourself, via an arm-wrist strap, to the advised ESD connection
point located on the rear of the system (to the right of the power connector).

2.) Follow general guidelines for handling of electrostatic sensitive equipment.

WARNINGWARNING
!! WARNING:

Risk of electrical shock: System must be turned off. 
Avoid all contact with electrical contacts, conductors and components. 
Always use non-conductive handles designed for the removal and replacement of ESD 
sensitive parts. All parts that have the potential for storing energy must be discharged 
or isolated before making contact.
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Section 1-5
Customer Assistance

1-5-1 Contact Information
If this equipment does not work as indicated in this service manual or in the Basic User Manual, or if 
you require additional assistance, please contact the local distributor or appropriate support resource, 
as listed below.

NOTE: Prepare vital system information (see: Section 7-2 on page 7-2) before you call:

• System Type
• System Serial number (also visible on label on back of the system)
• Application Software version
• Backup version
• additional information about installed software

1-5-2 System Manufacturer 

Table 1-6    Phone Numbers for Customer Assistance

Location Phone Number

USA
GE Healthcare
Ultrasound Service Engineering
9900 Innovation Drive (RP-2123)
Wauwatosa, WI 53226, USA

Service On-site
Service: Parts

Applications support

1-800–437–1171
1-800-558-2040

1-800-682-5327 or 1-262-524-5698

Canada 1-800-668-0732

Latin America
Service
Applications support

1-800-321-7937
1-262-524-5698

Europe
GE Ultraschall Deutschland GmbH
Beethovenstraße 239
Postfach 11 05 60, D-42655 Solingen
Germany

OLC - EMEA (Europe, Middle East & Africa)
Phone: +49 (0) 212 2802 - 652 (-OLC)

+33 1 3083 1300 (English/German all segments incl. training)
Fax: +49 (0) 212 2802 - 431

Online Services Ultrasound Asia
Australia
China
India
Japan
Korea
Singapore

Phone: +(61) 1-800-647-855
+(86) 800-810-8188
+(91) 1-800-11-4567
+(81) 42-648-2924
+(82) 2-6201-3585
+(95) 6277-3444

Table 1-7    System Manufacturer

Manufacturer FAX Number

GE Ultrasound Korea, Ltd.
9, Sunhwan-ro 214beon-gil, Jungwon-gu, 
Seongnam-si, Gyeonggi-do,
Korea

+82 (0) 31-740-6436
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Chapter 2
Site Preparation

Section 2-1
Overview

2-1-1 Purpose of Chapter 2
This chapter provides the information required to plan and prepare for the installation of a LOGIQ P7/
P8/P9/P10 ultrasound unit. Included are descriptions of the facility and electrical needs to be met by the 
purchaser.

Table 2-1    Contents in Chapter 2

Section Description Page Number

2-1 Overview 2-1

2-2 General Console Requirements 2-2

2-3 Facility Needs 2-7
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Section 2-2
General Console Requirements

2-2-1 Environmental Requirements  

2-2-1-1 Cooling
The cooling requirement for the LOGIQ P7/P8/P9/P10 is 680 BTU/hr. This figure does not include 
cooling needed for lights, people, or other equipment in the room. 

NOTE: Each person in the room places an additional 300 BTU/hr. demand on the cooling system.

2-2-1-2 Lighting
Bright light is needed for system installation, updates and repairs. However, operator and patient 
comfort may be optimized if the room light is subdued and indirect. Therefore a combination lighting 
system (dim/bright) is recommended. Keep in mind that lighting controls and dimmers can be a source 
of EMI which could degrade image quality. These controls should be selected to minimize possible 
interference.

2-2-2 Electrical Requirements

NOTE: GE Healthcare requires a dedicated power and ground for the proper operation of its Ultrasound 
equipment. This dedicated power shall originate at the last distribution panel before the system. 

The dedicated line shall consist of one phase, a neutral (not shared with any other circuit), and a full 
size Ground wire from the distribution panel to the Ultrasound outlet.

NOTE: Please note that image artifacts can occur, if at any time within the facility, the Ground from the main 
facility's incoming power source to the Ultrasound unit is only a conduit.

Table 2-2    System Environmental Requirements

Operational 
(with probe)

Storage
 (LOGIQ P7/P8/P9/P10)

Transport
 (LOGIQ P7/P8/P9/P10)

Temperature

10 - 35 oC (50 - 95 oF)
with 2D probe

18- 30 oC (64.4 - 86oF)
with 4D probe

-10 - 50 oC
(14 - 122 oF)

-10 - 50 oC
(14 - 122 oF)

Humidity 10 - 80% 
(non-condensing)

10 - 90% 
(non-condensing)

10 - 90%
(non-condensing)

Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa

CAUTION
!! CAUTION: 

If the system has been in storage or has been transported, please see the acclimation requirements 
before powering ON and/or using the system (see: Section 3-2-2 "Installation Warnings" on page 3-3).



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022) SERVICE MANUAL

Chapter 2 - Site Preparation 2-3

2-2-2-1 LOGIQ P7/P8/P9/P10 Power Requirements

Power Consumption nominal 500 VA including all on-board peripherals.

2-2-2-2 Inrush Current
Inrush current is not a factor to consider due to the inrush current limiting properties of the power 
supplies.

2-2-2-3 Site Circuit Breaker
It is recommended that the branch circuit breaker for the machine be readily accessible.

2-2-2-4 Site Power Outlets
A dedicated AC power outlet must be within reach of the unit without extension cords. Other adequate 
outlets for the external peripherals, medical and test equipment needed to support this unit must also 
be present within 1 m (3.2 ft.) of the unit. Electrical installation must meet all current local, state, and 
national electrical codes.

2-2-2-5 Main Power Plug
The LOGIQ P7/P8/P9/P10 ultrasound system is supplied with a main power plug, as standard. In the 
event that the unit arrives without a power plug, or with the wrong plug, contact your GE dealer. When 
necessary, the installation engineer will supply the appropriate power plug to meet the applicable local 
regulations.

Table 2-3    Electrical Specifications for LOGIQ P7/P8/P9/P10

Voltage Tolerances Current Frequency

100 - 120 VAC ±10% 5.0 ... 4.1 A 50, 60 Hz (±2%)

220 - 240 VAC ±10% 2.2 ... 2.0 A 50, 60 Hz (±2%)

CAUTION
!! CAUTION: 

POWER OUTAGE MAY OCCUR. 
The LOGIQ P7/P8/P9/P10 requires a dedicated single branch circuit. To avoid circuit overload 
and possible loss of critical care equipment, make sure you DO NOT have any other equipment 
operating on the same circuit.
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2-2-3 EMI Limitations
Ultrasound systems are susceptible to Electromagnetic Interference (EMI) from radio frequencies, 
magnetic fields, and transients in the air or wiring. Ultrasound machines also generate EMI. 
The LOGIQ P7/P8/P9/P10 complies with limits as stated on the EMC label. However, there is no 
guarantee that interference will not occur in a particular installation.

Electrical and electronic equipment may produce EMI unintentionally as the result of a defect. 
Sources of EMI include the following: 

• medical lasers
• scanners
• cauterizing guns
• computers
• monitors
• fans
• gel warmers
• microwave oven
• light dimmers 
• portable phones
• broadcast stations and mobile broadcasting machines

NOTICE
!! NOTICE:

Possible EMI sources should be identified before the unit is installed.

Table 2-4    EMI Prevention/Abatement

EMI Rule Details

Be aware of RF sources.
Keep the unit at least 5 meters (16.4 feet) away from other EMI sources. Special shielding may be 
required to eliminate interference problems caused by high frequency, high powered radio or video 
broadcast signals.

Ground the unit. Poor grounding is the most likely reason a unit will have noisy images. 
Check grounding of the power cord and power outlet.

Replace and/or reassemble 
all screws, RF gaskets, 
covers and cores.

After you finish repairing or updating the system, replace all covers and tighten all screws.
Any cable with an external connection requires a magnet wrap at each end.
Install the shield over the front of card cage. Loose or missing covers or RF gaskets allow radio 
frequencies to interfere with the ultrasound signals.

Replace broken RF gaskets. If more than 20% or a pair of the fingers on an RF gasket are broken, replace the gasket. 
Do not turn ON the unit until any loose metallic part is removed and replaced, if required.

Do not place labels where 
RF gaskets touch metal.

Never place a label where RF gaskets meet the unit. Otherwise, the gap created will permit RF 
leakage. In case a label has been found in such a location, move the label to a different, 
appropriate location.

Use GE- specified 
harnesses and peripherals.

The interconnect cables are grounded and require ferrite beads and other shielding. 
Cable length, material, and routing are all important; do not make any changes that do not meet 
all specifications.

Take care with cellular 
phones. Cellular phones may transmit a 5 V/m signal that causes image artifacts. 

Properly dress peripheral 
cables.

Do not allow cables to lie across the top of the card cage or hang out of the peripheral bays.
Loop the excess length for peripheral cables inside the peripheral bays.
Attach the monitor cables to the frame.
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2-2-4 Probe Environmental Requirements

2-2-5 Time and Manpower Requirements
Site preparation takes time. Begin Pre-installation checks as soon as possible. If possible, allow six 
weeks before delivery, for enough time to make necessary changes.

Table 2-5    2D/4D Probe Environmental Requirements 

Operational

Temperature

10 o - 35 oC
for 2D probe

18o - 30oC
for 4D probe

Humidity
10 - 80% (non-condensing) for 2D probe

30 - 80% (non-condensing) for 4D probe

Pressure 700 - 1060hPa

NOTICE
!! NOTICE:

SYSTEMS AND ELECTRONIC PROBES ARE DESIGNED FOR STORAGE TEMPERATURES OF
0 TO + 55 degrees C. WHEN EXPOSED TO LARGE TEMPERATURE VARIATIONS, THE 
PRODUCT SHOULD BE KEPT IN ROOM TEMPERATURE FOR 10 HOURS BEFORE USE.

CAUTION
!! CAUTION: 

Have two people available to deliver and unpack the LOGIQ P7/P8/P9/P10 Ultrasound System.
Attempts to move the unit considerable distances (or on an incline) by one person alone, could 
result in personal injury and/or damage to the system.
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2-2-6 System Specifications

2-2-6-1 Physical Dimensions of LOGIQ P7/P8/P9/P10
The physical dimensions and weight (without Peripherals) of the LOGIQ P7/P8/P9/P10 unit are 
summarized in Table 2-6.

NOTE: Physical dimensions (especially height and depth) depend on control console and monitor positioning. 
For more details refer to Chapter 5 - OPIO Positioning, on page 5-25. 

2-2-6-2 Acoustic Noise Output
max. 50 dB(A) 

2-2-6-3 Electrical Specifications
Please refer to Section 2-2-2-1 "LOGIQ P7/P8/P9/P10 Power Requirements" on page 2-3.

Table 2-6    Physical Dimensions and Weight (without Peripherals) (R1 to R3)

Height Width Depth Weight

1570 mm (max)
1375 mm (min) *

530 mm (console)
430 mm (Operator Panel)

740 mm 60 kg

* with low cabinet option

Table 2-7    Physical Dimensions and Weight (R4 and R4.5)

Height Width Depth Weight

P8/P9/P10:
1595 mm (max)
1345 mm (min)

P10 HD:
1640 mm (max)
1390 mm (min)

545 mm (23.8 inch monitor)
545 mm (23.8 inch HD monitor)

430 mm (Operator Panel)

740 mm P8/P9/P10: 67kg
P10 HD: 69kg
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Section 2-3
Facility Needs

2-3-1 Purchaser Responsibilities
The work and materials needed to prepare the site is the responsibility of the purchaser. Delay, 
confusion, and waste of manpower can be avoided by completing pre installation work before delivery.

Use the Pre-installation checklist (provided in Table 2-8) to verify that all needed steps have been taken. 

Purchaser responsibility includes:

• Procuring the materials required.
• Completing the preparations before delivery of the ultrasound system.
• Paying the costs for any alterations and modifications not specifically provided in the sales contract.

NOTE: All electrical installations that are preliminary to the positioning of the equipment at the site prepared for 
the equipment must be performed by licensed electrical contractors. Other connections between pieces 
of electrical equipment, calibrations, and testing must also be performed by qualified personnel. 
The products involved (and the accompanying electrical installations) are highly sophisticated and 
special engineering competence is required. All electrical work on these products must comply with the 
requirements of applicable electrical codes. The purchaser of GE equipment must only utilize qualified 
personnel to perform electrical servicing on the equipment. 

The desire to use a non–listed or customer provided product or to place an approved product further 
from the system than the interface kit allows presents challenges to the installation team. To avoid 
delays during installation, such variances should be made known to the individuals or group performing 
the installation at the earliest possible date (preferably prior to the purchase).

The ultrasound suite must be clean prior to delivery of the machine. Carpet is not recommended 
because it collects dust and creates static. Potential sources of EMI (electromagnetic interference) 
should also be investigated before delivery. Dirt, static, and EMI can negatively impact system reliability.

Table 2-8    LOGIQ P7/P8/P9/P10 Pre-Installation Check List

Action Yes No

Schedule at least 3 hours for installation of the system.

Notify installation team of the existence of any variances from the basic installation.

Make sure system and probes have been subject to acclimation period.

Environmental cooling is sufficient.

Lighting is adjustable to adapt to varying operational conditions of the scanner.

Electrical facilities meet system requirements.

EMI precautions have been taken and all possible sources of interference have been removed.

Mandatory site requirements have been met.

If a network is used, IP address has been set for the system and a dedicated network outlet is available.
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2-3-2 Mandatory Site Requirements
The following are mandatory site requirements. Additional (optional) recommendations, as well as a 
recommended ultrasound room layout, are provided in Section 2-3-3 "Site Recommendations" .

• A dedicated single branch power outlet of adequate amperage (see Table 2-3 on page 2-3) that 
meets all local and national codes and is located less than 2.5 m (8.2 ft) from the unit’s proposed 
location. Refer to: Section 2-2-2 "Electrical Requirements" on page 2-2.

• A door opening of at least 76 cm (2.5 ft) in width.
• The proposed location for the unit is at least 0.2 m (0.67 ft) from the walls, to enable cooling.
• Clean and protected space for storage of probes (either in their case or on a rack).
• Material to safely clean probes (performed using a plastic container, never metal).
• Power outlet and place for any external peripheral are within 2 m (6.5 ft.) of each other with 

peripheral within 1 m of the unit to connect cables.

NOTE: The LOGIQ P7/P8/P9/P10 has one outlet for on board peripherals.

In case of network option:

• An active network outlet in the vicinity of the ultrasound unit.
• A network cable of appropriate length (regular Pin-to-Pin network cable).
• An IT administrator who will assist in configuring the unit to work with your local network. 

A fixed IP address is required. Refer to the form provided in Figure 3-59 on page 3-81 for network 
details that are required.

NOTE: All relevant preliminary network port installations at the prepared site must be performed by authorized 
contractors. The purchaser of GE equipment must utilize only qualified personnel to perform servicing 
of the equipment.

2-3-3 Site Recommendations
The following are (optional) site recommendations. Mandatory site requirements are provided in the 
Mandatory Site Requirements section, above.

• Door opening of 90 cm (3 ft) in width.
• Accessible circuit breaker for a dedicated power outlet.
• Sink with hot and cold running water.
• Receptacle for bio–hazardous waste, for example, used probe sheaths.
• Emergency oxygen supply.
• Storage area for linens and equipment.
• Nearby waiting room, lavatory, and dressing room.
• Dual level lighting (bright and dim).
• Lockable cabinet for software and manuals.
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2-3-3-1 Recommended Ultrasound Room Layout

Figure 2-1 below shows a floor plan illustrating the recommended layout of the Ultrasound Room and 
depicting the minimal room layout requirements.

Figure 2-1  Recommended Floor Plan 4.3m x 5.2m (14ft x 17ft)

35.5 IN. 
(92 CM)

Dedicated Power Outlets

Hospital Network

Cabinet for
Software and Manuals
(optional)

LOGIQ P7/P8/P9/P10
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2-3-4 Networking Setup Requirements

2-3-4-1 Stand-alone Unit (without Network Connection)
None

2-3-4-2 Unit Connected to Hospital’s Network
Supported networks:

• Ethernet network connection
• Up to 900 Mbps WLAN (optional)

2-3-4-3 Purpose of the DICOM Network Function
DICOM (Digital Imaging and Communications in Medicine) services provide the operator with clinically 
useful features for moving images and patient information over a hospital network. 
Examples of DICOM services include the transfer of images to workstations for viewing or transferring 
images to remote printers. As an added benefit, transferring images in this manner frees up the on-
board monitor and peripherals, enabling viewing to be done while scanning continues. 
With DICOM, images can be archived, stored, and retrieved faster, easier, and at a lower cost.

2-3-4-4 DICOM Option Pre-installation Requirements
To configure the LOGIQ P7/P8/P9/P10 ultrasound unit to work with other network connections, the 
network administrator must provide some necessary information.

Use the Agent Configuration (R3, R4 and R4.5) on page 3-75 to record required information that must 
include:

Installation see: Section 3-13 "Configuring Connectivity" on page 3-65.

• LOGIQ P7/P8/P9/P10
Details:

DICOM network details for the LOGIQ P7/P8/P9/P10 unit, 
including the host name, local port, IP address, AE title and net 
mask.

• Routing Information: IP addresses for default gateway and other routers in use at site.

• DICOM Application Information: Details of DICOM devices in use at the site, including the DICOM 
host name, AE title, DICOM port number and IP addresses.
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Chapter 3
Setup Instructions

Section 3-1
Overview

3-1-1 The Purpose of Chapter 3
This chapter contains information needed to setup the LOGIQ P7/P8/P9/P10 Ultrasound System. 
Included are procedures to receive, unpack and configure the equipment. 
A worksheet is provided (see: page 3-75 to page 3-81) to help ensure that all the required information 
is available, prior to setup the system.

Table 3-1    Contents in Chapter 3

Section Description Page Number

3-1 Overview 3-1

3-2 Set Up Reminders 3-2

3-3 Receiving and Unpacking the Equipment 3-6

3-4 Packing materials - recycling information 3-9

3-5 Preparing for Set Up 3-10

3-6 Connection of Auxiliary Devices 3-12

3-7 Completing the Set Up 3-21

3-8 Printer Installation 3-35

3-9 System Configuration 3-47

3-10 Available Probes 3-53

3-11 Software/Option Configuration 3-60

3-12 Connectivity Setup 3-61

3-13 Configuring Connectivity 3-65

3-14 Connectivity Setup Worksheet 3-80

3-15 Paperwork 3-82
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Section 3-2
Set Up Reminders

3-2-1 Average Installation Time
Once the site has been prepared, the average installation time required is shown in Table 3-2 below.

Table 3-2    Average Installation Time

Description Average Installation Time Comments
Unpacking the scanner 0.5 hours

Installing the scanner / options / printers 0.5 to 1.5 hours depends on required configuration

DICOM Option (connectivity) 0.5 - 1.5 hours depends on configuration amount
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3-2-2 Installation Warnings
1) Since the LOGIQ P7/P8/P9/P10 weighs approximately 90 kg (200 lbs.) without peripherals, two 

people are required to unpack it. 
2) There are no operator serviceable components. To prevent shock, do not remove any covers or 

panels. Should problems or malfunctions occur, unplug the power cord. 
Only qualified service personnel should carry out servicing and troubleshooting.

3-2-2-1 Moving/Lifting the System

3-2-2-2 System Acclimation Time
After being transported, the LOGIQ P7/P8/P9/P10 system may be very cold or hot. 
It requires one hour for each 2.5C increment if it's temperature is below 10C or above 40C. 

3-2-2-3 OPIO Position
If weight is placed on the OPIO (User Interface) in it’s extended position the console could tip over.

Figure 3-1  moving or lifting the system

CAUTION
!! CAUTION: 

Equipment damage possibility. Turning the system on without acclimation after arriving at site 
may cause the system to be damaged.

Table 3-3    Acclimation Time

°C 60 55 50 45 40 35 30 25 20 15 10 5 0 -5 -10 -15 -20 -25 -30 -35 -40

°F 140 131 122 113 104 96 86 77 68 59 50 41 32 23 14 5 -4 -13 -22 -31 -40

hrs 10 8 6 4 2 0 0 0 0 0 0 2 4 6 8 10 12 14 16 18 20

WARNINGWARNING
!! WARNING:

The system should NOT be moved with the OPIO (User Interface) extended. Move the 
OPIO to it’s centered and locked position.

WARNINGWARNING
!! WARNING:

Monitor mounting mechanism may break if not properly supported (e.g., with packing 
foam) during transportation.

When moving or lifting the system, grasp it only at the rear 
handle.

WARNINGWARNING

Do NOT pull or lift the system with the front handle
of the user interface (operator panel).
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3-2-2-4 Brake Pedal Operation

3-2-3 Safety Reminders

WARNINGWARNING
!! WARNING:

REMEMBER: If the front wheel brakes are engaged for transportation, release brake 
pedals (brakes on front wheels under the foot rest) to disengage the lock. 

DANGER
!! DANGER:

WHEN USING ANY TEST INSTRUMENT THAT IS CAPABLE OF OPENING THE 
AC GROUND LINE (I.E., METER’S GROUND SWITCH IS OPEN), DO NOT 
TOUCH THE UNIT!

CAUTION
!! CAUTION: 

Two people should unpack the unit because of its weight. 
Two people are required whenever a part weighing 16kg (35 lb.) or more must be lifted.

CAUTION
!! CAUTION: 

If the unit is very cold or hot, do NOT turn on its power until it has had sufficient time to 
acclimate to its operating environment. 

CAUTION
!! CAUTION: 

To prevent electrical shock, connect the unit to a properly grounded power outlet. 
DO NOT use a three to two prong adapter. This defeats safety grounding.

CAUTION
!! CAUTION: 

DO NOT wear the ESD wrist strap when you work on live circuits and more than 30 V peak is 
present.

CAUTION
!! CAUTION: 

DO NOT use a 20 Amp to 15 Amp adapter on the 120 Vac unit’s power cord.
This unit requires a dedicated 16 A circuit.

CAUTION
!! CAUTION: 

DO NOT operate this unit unless all board covers and frame panels are securely in place, to 
ensure optimal system performance and cooling. 
(When covers are removed, EMI may be present).

CAUTION
!! CAUTION: 

OPERATOR MANUAL(S) 
The User Manual(s) should be fully read and understood before operating the LOGIQ P7/P8/
P9/P10. Keep manuals near the unit for reference.

CAUTION
!! CAUTION: 

ACOUSTIC OUTPUT HAZARD
Although the ultrasound energy transmitted from the LOGIQ P7/P8/P9/P10 LOGIQ P9/P7 
ultrasound system system is within FDA limitations, avoid unnecessary exposure. 
Ultrasound energy can produce heat and mechanical damage.

Figure 3-2   Environmental Labels (R1-R4)
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Figure 3-3  Environmental Labels (R4.5)
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Section 3-3
Receiving and Unpacking the Equipment 

The LOGIQ P7/P8/P9/P10 ultrasound system, together with peripherals, probes and accessories are 
shipped from the factory in a single durable shipping crate which is mounted on a raised wooden 
platform base. 

* Weight is approximate and will vary depending upon the supplied peripherals

Before unpacking the unit:

• Inspect the crate for visible damage.
• Inspect the Drop and Tilt Indicator for evidence of accidental shock or tilting during transit (damage 

incident, see: Figure 3-4 below).   

CAUTION
!! CAUTION: 

Please read this section carefully before unpacking the LOGIQ P7/P8/P9/P10 LOGIQ P9/P7 
ultrasound system and its (optional) peripherals.

CAUTION
!! CAUTION: 

Transport only with forklift or stacker truck.
During transport pay attention to the point of gravity (“tilt and drop” indicator)!
Have two people available to unpack the LOGIQ P7/P8/P9/P10. 
Attempts to move the unit considerable distances (or on an incline) by one person alone, could 
result in personal injury, and/or damage to the system.

Table 3-4    Shipping Carton - Dimensions and Weight

Description Height Width Depth Weight*
LOGIQ P7/P8/P9/P10

incl. peripherals and accessories 1550 mm / 61 inch 706 mm / 27.7 inch 904 mm / 35.6 inch 120 kg / 267 lbs

Figure 3-4  Drop and Tilt Indicator

NOTICE
!! NOTICE:

The device must only be transported in the original packaging!
Each shipping crate is composed of wooden base, cardboard box, re-usable plastic caps and cushions 
inside. It is recommended to keep and store the shipping crate and all other packing materials (including 
the support foams, anti-static plastic cover, etc.), in case the unit has to be moved to a different location. 
Unpack the devices such a way that packaging can be reused. 
For warranty purposes, storage of the above is required for one year from date of purchase.

NOTICE
!! NOTICE:

If the shipping crate is damaged, please inform the GE sales representative immediately. 

Indicator turns Red
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Figure 3-5  envelope at front panel of the crate

Table 3-5    Unpacking Procedure

Step Task

1. Remove the top cover, then remove the out sleeve.

2. Remove the option box on front of the system.

Check whether delivery is complete 
(according to packing list) and check visual damage!

The envelope with delivery address, packing list and 
invoice is located on the front panel of the crate. 

top cover
out sleeve

Option box on front of the system
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3. Remove the monitor pads from the monitor and remove the 4 pads of the box bottom assy.

4. Carefully remove foam packing material and plastic bag from the ultrasound unit and monitor.

Caution: Two people are needed in the next step due to the weight of the equipment.
5. Unlock the casters and place the 4 caster's direction like the picture below and then using the incline plane 

of the box bottom assy, slowly move the system from the box.

Note: Packing crate and material should be stored for future use.

Table 3-5    Unpacking Procedure

Step Task

monitor pad
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Section 3-4
Packing materials - recycling information

The packing materials for LOGIQ P7/P8/P9/P10 are recyclable:

• The Transportation Box is made of cardboard.
• The inner reinforcements are made of Ethafoam (Polyethylene foam).
• The plastic foil is made of LDPE (Low Density Polyethylene).
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Section 3-5
Preparing for Set Up

3-5-1 Verify Customer Order
1) After unpacking the equipment, it is important to verify that all items ordered by the customer have 

been received. Compare all items listed on the packing slip (delivery note) with those received.

2) Visually inspect the system components using the following checklist.
 

NOTE: Report any items that are missing, back-ordered, or damaged, to your GE sales representative. The 
contact address is shown in Contact Information on page 1-21.

NOTICE
!! NOTICE:

It is recommended to keep and store the shipping carton and all other packing materials (including the 
support foams, anti-static plastic cover, etc.), in case the unit has to be moved to a different location. 
Unpack the devices such a way that packaging can be reused.
For warranty purposes, storage of the above is required for one year from date of purchase.

Table 3-6    Damage Inspection Checklist - LOGIQ P7/P8/P9/P10 System

Step Item Recommended Procedure

1 Main label Enter Serial Number: __________________________ (printed on main label, see: Figure 1-1 on page 1-15)

2 Console Verify that the system is switched OFF and unplugged. Clean the console and control panel.

3 Control Console Physically inspect the control console for missing or damaged items. 
After switching on the system, verify the proper illumination of all the control panel buttons.

4 Probes
Check all probes for wear and tear on the lens, cable, and connector. Look for bent or damaged pins on the 
connector and in the connector socket on the unit. Verify that the EMI fingers around the probe connector 
socket housing are intact. Check the probe locking mechanism and probe switch.

5 LCD Display Clean the LCD display by gently wiping with a dry, soft, lint-free non-abrasive folded cloth. Inspect the monitor 
for scratches and raster burn.

6 Fans Verify that the system’s cooling fans and peripheral fans are operating.

7 Rear Panel Check the rear panel connectors for bent pins, loose connections and loose or missing hardware. Screw all 
the cable connectors tightly to the connector sockets on the panel. Verify that the labeling is in good condition.

8 Covers Check that all screws are tightly secured in place, that there are no dents or scratches and that no internal 
parts are exposed.

9 Peripherals Check and clean the peripherals in accordance with the manufacturer’s directions.
To prevent EMI or system overheating, dress the peripheral cables inside the peripheral cover.

10 Power Cord Check the power cord for cuts, loose hardware, tire marks, exposed insulation, or any deterioration. 
Verify continuity. Replace the power cord, as required.
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3-5-2 EMI Protection
This unit has been designed to minimize the effects of Electo-Magnetic Interference (EMI). Many of the 
covers, shields, and screws are provided primarily to protect the system from image artifacts caused by 
this interference. For this reason, it is imperative that all covers and hardware are installed and secured 
before the unit is put into operation.

Ensure that the system is protected from electromagnetic interference (EMI), as follows:

• Operate the system at least 15 feet away from equipment that emits strong electromagnetic 
radiation.

• Operate the system in an area enclosed by walls, floors and ceilings comprised of wood, plaster or 
concrete, which help prevent EMI.

• Shield the system when operating it in the vicinity of radio broadcast equipment, if necessary.
• Do not operate mobile phones or other EMI emitting devices in the ultrasound room.
• Verify that all EMI rules listed in the following table are followed:
The LOGIQ P7/P8/P9/P10 ultrasound unit is approved for use in hospitals, clinics and other 
environmentally qualified facilities, in terms of the prevention of radio wave interference. Operation of 
the ultrasound unit in an inappropriate environment can cause electronic interference to radios and 
television sets situated near the medical equipment. 
For further details and EMI Prevention/Abatement refer to Section 2-2-3 "EMI Limitations" on page 2-4.
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Section 3-6
Connection of Auxiliary Devices

NOTE: Normally auxiliary devices and peripherals come pre-installed with the system.

Table 3-7 below outlines hardware installation procedures described in the sub-sections.

   

NOTE: For more detailed Safety Considerations when connecting auxiliary devices to the LOGIQ P7/P8/P9/
P10 system, please review: Chapter 1 - Auxiliary Devices Safety, on page 1-12.

Table 3-7    Connection Procedures

Sub-section Description Page Number

3-6-1 Connecting the Black & White Printer 3-13

3-6-2 Connecting the Secondary “Patient” LCD Monitor 3-16

3-6-3 Connecting the Footswitch 3-18

3-6-4 Connecting the USB Flash Memory Stick 3-19

3-6-5 Connecting the external USB Hard disk (Handydrive) 3-19

3-6-6 General Remarks and Hints when using external USB-Devices 3-20

WARNINGWARNING
!! WARNING:

After each installation, the leakage currents have to be measured according to 
IEC 60601-1 respectively ANSI/AAMI ES60601-1.

CAUTION
!! CAUTION: 

Please observe that some printers may not be medical devices! If the Bluetooth Printer and/or 
Line Printers are not medical devices, they have to be located outside of the patient 
environment (according to IEC 60601-1 / ANSI/AAMI ES60601-1).

2,5 m 1,5 m

1,5 m1,5 m
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3-6-1 Connecting the Black & White Printer

1) Power OFF/Shutdown the system as described in: Section 3-7-3 on page 3-27.
2) Connect the Black & White printer according to correct connection scheme as described in 

Figure 3-6 on page 3-14.

NOTE: There are three USB ports (stack) on rear panel.  The BW printer may be connected to any of the 3x 
USB stack connector.

3) When all the cables are connected, press the Power ON switch on the Black & White printer.
4) Power ON/Boot up the LOGIQ P7/P8/P9/P10 system as described in Section 3-7-2 on page 3-22. 

All software drivers are pre-installed for the designated Black & White printer only.
5) Verify the correct settings in the printer “Properties”, see: Section 3-8-5 "Adjustment of Printer 

Settings" on page 3-40.

WARNINGWARNING
!! WARNING:

After each installation, the leakage currents have to be measured according to 
IEC 60601-1 respectively ANSI/AAMI ES60601-1.
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3-6-1-1 Connection Scheme: B&W Printer (R1 to R3)
 

Figure 3-6  B&W Printer connection (R1 to R3)
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3-6-1-2 Connection Scheme: B&W Printer (R4 and R4.5)

Figure 3-7  Connection Scheme: B&W Printer (R4 and R4.5)
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3-6-2 Connecting the Secondary “Patient” LCD Monitor
   

1) Power OFF/Shutdown the system as described in: Section 3-7-3 on page 3-27.
2) Connect the Secondary Monitor according to connection scheme (see: Figure 3-8 on page 3-17).

CAUTION
!! CAUTION: 

Secondary LCD “Patient” Monitor MUST NEVER be connected to the LOGIQ P9/P7 ultrasound 
systems mains supply directly!
Always connect it to the supplied Isolation Transformer!
The Secondary Monitor is the only item to be connected to the Transformer.

NOTICE
!! NOTICE:

Secondary Monitor is NOT intended for diagnostic use. 
It is an additional device used to allow the patient to watch the proceedings.
Take your time to think about the best position of the monitor in your facilities. 
Patients should be able to view the monitor easily and without having to bend or turn around.

NOTICE
!! NOTICE:

Connection to Secondary Monitor is via HDMI cable, but HDMI connector output does NOT carry audio 
signal (R1/R2/R2.5/R3/R4) except for R4.5
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Figure 3-8  Connection Scheme - Secondary LCD Monitor

HDMI to DVI / HDMI to HDMI cable
connected to the
rear side of the
2nd Monitor

Secondary Monitor

appropriate
Transformer

A Secondary “Patient” Monitor MUST NEVER 
be connected to the LOGIQ P9/P7 ultrasound systems mains 

supply directly!
Always connect it to an appropriate Isolation Transformer

CAUTION
!! CAUTION: 

Composite (BNC) Cable
S-Video Cable
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3-6-3 Connecting the Footswitch
The footswitch should be directly connected to any accessible USB-port on the LOGIQ P7/P8/P9/P10 
(e.g., on rear of the system).

NOTE: Connection of the Footswitch is always the same 
(no differences between PC-Motherboard version of the system).

Figure 3-9  Connection Scheme - Footswitch
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3-6-4 Connecting the USB Flash Memory Stick 

The USB Flash Memory Stick may be connected to an accessible USB port of the LOGIQ P7/P8/P9/
P10 system. Refer to Section 3-9-2 "External I/O Connectors" .

An external USB Flash Memory Stick can be connected once the system is powered ON, or after 
shutdown. The LOGIQ P7/P8/P9/P10, Windows detects the device and automatically installs a driver. 
During this process several dialogs may pop up, starting with the „Found New Hardware” dialog.

NOTE: Memory drives or sticks may be sensitive to EMC interference.
This may affect system performance and/or image quality.

3-6-5 Connecting the external USB Hard disk (Handydrive) 

The external “Handydrive” HDD may be connected to an accessible USB port of the LOGIQ P7/P8/P9/
P10 system.  Refer to Section 3-9-2 "External I/O Connectors" .

An external USB Hard Disk Drive can be connected once the system is powered ON, or after shutdown. 
The LOGIQ P7/P8/P9/P10, Windows detects the device and automatically installs a driver. During this 
process several dialogs may pop up, starting with the „Found New Hardware“ dialog.

NOTE: Memory drives, sticks or HDD drives may be sensitive to EMC interference.
This may affect system performance and/or image quality.

NOTICE
!! NOTICE:

Before connecting an USB device, please read General Remarks and Hints when using external USB-
Devices on page 3-20.

NOTICE
!! NOTICE:

Before disconnecting an external USB-device (e.g., USB Stick), the system has to be informed about 
the removal of the device! For this purpose press the EJECT button on the keyboard.
For further details refer to: Section 3-6-6-2 "External USB-Devices - Disconnection" on page 3-20.

NOTICE
!! NOTICE:

Before connecting an USB device, please read General Remarks and Hints when using external USB-
Devices on page 3-20.

NOTICE
!! NOTICE:

Before disconnecting an external USB-device (e.g., USB Hard disk), the system has to be informed 
about the removal of the device! For this purpose press the EJECT button on the keyboard.
For further details refer to: Section 3-6-6-2 "External USB-Devices - Disconnection" on page 3-20.
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3-6-6 General Remarks and Hints when using external USB-Devices 

3-6-6-1 External USB-Devices - Connection
When an external USB-storage device (such as a USB-memory stick or an external hard disk) is 
connected to the LOGIQ P7/P8/P9/P10, Windows detects the device and automatically installs a driver. 
During this process, several dialogs may pop up, starting with the “Found New Hardware“ dialog.

The device is then accessible using the drive letter the system assigned to it.

3-6-6-2 External USB-Devices - Disconnection  

To stop the external device, press F3 EJECT button.

WARNINGWARNING
!! WARNING:

Do not connect or disconnect any external USB-devices to or from the system while 
scanning a patient! The appearing dialogs could distract you from the scan!

NOTICE
!! NOTICE:

When connecting external USB devices, be sure to execute Safety Directions found in the 
LOGIQ P7/P8/P9/P10 Basic User Manual.

CAUTION
!! CAUTION: 

Unplugging or ejecting USB devices without first stopping them can often cause the system to 
crash and possibly result in loss of valuable data.
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Section 3-7
Completing the Set Up

3-7-1 Connecting the Unit to a Power Source
The connection of the LOGIQ P7/P8/P9/P10 ultrasound unit to a power source should be performed by 
a qualified person who has completed basic LOGIQ P7/P8/P9/P10 System User Training. Use only the 
power cords, cables and plugs provided by or designated by GE to connect the unit to the power source.   

CAUTION
!! CAUTION: 

Prior to connect the LOGIQ P7/P8/P9/P10 unit to a power source, verify compliance with all 
electrical and safety requirements. Check the power cord to verify that it is intact and of 
hospital-grade. Products equipped with a power source (wall outlet) plug should be connected 
to the fixed power socket that has a protective grounding conductor. Never use an adapter or 
converter to connect with a power source plug (for example, a three-prong to two-prong 
converter).

WARNINGWARNING
!! WARNING:

The unit’s power must be supplied from a separate, properly rated outlet to avoid risk 
of fire. Refer to Section 2-2-2-1 "LOGIQ P7/P8/P9/P10 Power Requirements" on page 2-
3 for rating information. The power cord should not, under any circumstances, be 
altered to a configuration rated less than that specified for the current.

CAUTION
!! CAUTION: 

Whenever disconnecting the LOGIQ P7/P8/P9/P10 system from the electrical outlet, always 
observe the safety precautions. First unplug the main power cable from the wall outlet socket, 
then from the unit itself. Remove by pulling on the cable connector - DO NOT pull on the cable. 

CAUTION
!! CAUTION: 

The LOGIQ P7/P8/P9/P10 requires all covers!
Operate this system only when all board covers and frame panels are securely in place.
The covers are required for safe operation, good system performance and cooling purposes.
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3-7-2 Power On / Boot Up

3-7-2-1 Scanner Power On

1) Ensure that the wall outlet is of appropriate type, and that the Circuit Breaker is turned off.
2) Uncoil the power cable, allowing sufficient slack so that the unit can be moved slightly.
3) Verify that the power cable is without any visible scratches or any sign of damage.
4) Verify that the on-site mains voltage is within the limits indicated on the rating label on the right side 

of the rear panel.
5) Connect the Main Power Cable to the back of the system. 
6) Connect the Main Power Cable to a hospital grade power outlet with the proper rated voltage. 

Never use an adapter that would defeat the safety ground. 
7) Switch ON the Circuit at the rear of the system. 

Figure 3-10  Circuit and main power cable at rear of system

Circuit Breaker

Main Power
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3-7-2-2 Back End Processor Boot Up

8) Hold down the On/Off button (see: Figure 3-11) on the control panel for ~3 seconds. 

NOTE: The mains outlet of the system for peripheral auxiliary equipment are commonly switched with the 
ON/OFF button. The power switch of any attached printer(s) needs to be in ON position before starting 
the system. However, be aware some auxiliary equipment may switch itself to standby mode 
(e.g., Color video printer) and must therefore be switched on separately.

When the ON/OFF button on the control panel is pressed, the System (including the Back-end 
Processor) starts and the operating system is loaded which then leads the application software to 
activate the scanner.

The system automatically performs an initialization sequence which includes the following:

- Loading the operating system.
- Running a quick diagnostic check of the system.
- Detecting connected probes

As soon as the software has been loaded, the system enters 2D-Mode with the probe connected to port 
nearest to a user.

NOTE: Total time used for start-up is about 2 minutes.

9) Adjust Height and position of control console.

NOTICE
!! NOTICE:

When AC power is applied to the scanner, the ON/OFF button on the control panel illuminates blue, 
indicating that the System (including the Back-end Processor) is in Standby mode.

Figure 3-11  On/Off Button on Control Panel

 (R3) (R4)
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3-7-2-3 During a normal boot, you may observe

A) Power is distributed to Peripherals, Operator Panel (control panel), Monitor, Front-End and 
Back-End Processor.

B) The Back-End Processor and rest of the scanner starts with the sequence listed in following steps:
1) “Boot Screen” is displayed.
2) Back-End Processor is turned ON and starts to load the software.
3) The Start Screen (LOGIQ?) is displayed on the monitor.
4) Start-up progress bars indicating software loading procedures, are displayed on the monitor, 

as shown in Figure 3-12 below.Start-up progress bars indicating software loading procedures, 

Figure 3-12  GE Healthcare wallpaper with progress bar (R1.x.x)

Figure 3-13  GE Healthcare wallpaper with progress bar (R2.x.x and later)
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5) Startup GE

Figure 3-14  GE Healthcare wallpaper with progress bar (R3.x.x and later)

f

Figure 3-15  GE Healthcare wallpaper with progress bar (R4.x.x and later)
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NOTE: Startup GE Healthcare wallpaper with progress bar may differ depending on product type and release.

6) The software initiates and sets up the Front-End electronics and the rest of the scanner 
(incl. the clicking sound of the relays on the PIL board).

7) The Keyboard backlight is lit.
8) As soon as the software has been loaded, the 2D screen is displayed on the monitor.
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3-7-3 Power Off / Shutdown 
When you power off the unit, the system performs an automatic shutdown sequence

Figure 3-16   System Exit Window (R2 and R2.5)

Figure 3-17   System Exit Window (R3, R4 and R4.5)
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The SYSTEM - EXIT menu, used when power off the unit, gives you these choices:

• Logoff
Use this button to log off the current user. The system remains ON and ready for a new user to log 
on. If the Logoff button is dimmed, it indicates that no user is logged on to the unit at the moment.

• Shutdown
Use this button to shut down the system. The entire system will shut down. It is recommended to 
perform a full shutdown at least once a week.

If the Shutdown button is dimmed, press the power button or Alt F10 to shut down the unit.

• Cancel
Use this button to exit from the System-Exit menu and return to the previous operation.

• Exit (Only available when logged in as GE Service with Service Dongle)
Select this button when you want to exit to the Windows Desktop.

• Sleep (R2 and R2.5 Only)
Use Sleep Mode when you do a portable exam in order to reduce the time to start up the system. 
When you use Sleep Mode, it takes ~90 seconds to start up the system versus 2-3 minutes.

• Change Password
Use this button to change User Password.

NOTICE
!! NOTICE:

After turning off a system, wait at least 10 seconds before turning it on again. 
The system may not be able to boot if power is recycled too quickly.
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3-7-3-1 Scanner Shutdown

1) If not already in read mode, freeze the image.
2) Press the ON/OFF button (see: Figure 3-11) on the control panel. Following dialog appears. 

Figure 3-18  System - Exit (R2 and R2.5)

Figure 3-19  System - Exit (R3)
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Figure 3-20  System - Exit (R4 and R4.5)
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3) Select the SHUTDOWN button. The system performs an automatic full shutdown sequence.
4) Switch OFF the Circuit at the rear of the system.

NOTE: The mains outlet of the system for peripheral auxiliary equipment are commonly switched with the 
ON/OFF button. So the auxiliary equipment need not to be switched ON/OFF separately.

WARNINGWARNING
!! WARNING:

Disconnection of the Main Power Cable is necessary! 
For Example: When repairing the system.
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5) After complete power down, disconnect the main power cable from the system or unplug it from the 
AC wall outlet socket.

6) Press on the brakes to block the front caster wheels.
7) Disconnect probes. (Turn the probe locking handle counterclockwise and then pull the connector 

straight out of the probe port.)

Figure 3-21  Circuit and main power at rear of system

CAUTION
!! CAUTION: 

DO NOT disconnect a probe while running (Live Scan “Write” mode)! 
A software error may occur. In this case switch the unit OFF (perform a reset).

Circuit Breaker

Main Power
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3-7-4 Transducer Connection

3-7-4-1 Connecting the Probe   

Probes can be connected at any time, regardless of whether the console is powered on or off. To ensure 
that the ports are not active, place the system in the image freeze condition.

Figure 3-22  Probe port

To connect a probe:

1) Place the probe's carrying case on a stable surface and open the case.
2) Carefully remove the probe and unwrap the probe cord.
3) Put the probe in the probe holder.

4) Hold the probe connector vertically with the cable pointing upward.
5) Turn the connector locking handle to the left.
6) Align the connector with the probe port and carefully push into place.
7) Turn the connector locking handle to the right to secure the probe connector.

CAUTION
!! CAUTION: 

Inspect the probe before and after each use for damage or degradation to the housing, strain 
relief, lens, seal, cable and connector. DO NOT use a transducer which appears damaged until 
functional and safe performance is verified. A thorough inspection should be conducted during 
the cleaning process.

CAUTION
!! CAUTION: 

Remove any dust or foam rests from the probe pins.

CAUTION
!! CAUTION: 

Fault conditions can result in electric shock hazard. Do not touch the surface of probe 
connectors which are exposed when the probe is removed. DO NOT touch the patient when 
connecting or disconnecting a probe.

CAUTION
!! CAUTION: 

DO NOT allow the probe head to hang free. Impact to the probe head could result in irreparable 
damage. Use the integrated cable management hook to wrap the cord.

a. Active probe port
b. Pencil probe port

R3  R4 and R4.5
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8) Carefully position the probe cord so it is free to move and is not resting on the floor.

3-7-4-2 Connecting the CW Pencil Probe
Insert the probe connector into the probe port all the way seated in. Carefully position the probe cord so 
it is free to move and is not resting on the floor.

3-7-4-3 Cable Handling 
Take the following precautions with probe cables:

• Keep free from wheels
• Do not bend the cable acutely
• Avoid crossing cables between probes.

3-7-4-4 Activating the Probe
To activate the probe, select the appropriate probe from the probe indicators on the touch panel.

The probe's default settings for the mode and selected exam are used automatically.

3-7-4-5 Deactivating the Probe
When deactivating the probe, the probe is automatically placed in standby mode.

To deactivate a probe:

1) Ensure the LOGIQ™ P7/P8/P9/P10 is in freeze mode. If necessary, press the Freeze key.
2) Gently wipe the excess gel from the face of the probe.
3) Ensure that the probe is placed gently in the probe holder.

3-7-4-6 Disconnecting the Probe
Probes can be disconnected at any time. However, the probe should not be active when disconnecting 
the probe.

1) Ensure the probe is deactivated. Deactivate by selecting another probe or pressing Freeze.
2) Move the probe locking handle to the left.

3) Pull the probe connector straight out of the probe port carefully.

4) Ensure the cable is free.
5) Be sure that the probe head is clean before placing the probe in its storage box.

CAUTION
!! CAUTION: 

Make sure that the probe and application names displayed on the screen correspond to the 
actual probe and application selection.

CAUTION
!! CAUTION: 

DO NOT allow the probe head to hang free. Impact to the probe head could result in irreparable 
damage. Use the integrated cable management hook to wrap the cord.
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Section 3-8
Printer Installation

NOTE: For Connection schemes refer to Section 3-6 "Connection of Auxiliary Devices" on page 3-12.

For further installation instructions see:

• Section 3-8-1 "Installing Digital Black & White Printer Sony UP-D898" on page 3-35
• Section 3-8-2 "Digital Color Printer Sony UP-D25MD" on page 3-36
• Section 3-8-5 "Adjustment of Printer Settings" on page 3-40

3-8-1 Installing Digital Black & White Printer Sony UP-D898
1) Power off/Shutdown the system as described in: Section 3-7-3 on page 3-27.
2) Physically connect the printer cables as described on Section 3-6-1 on page 3-13. 

NOTICE
!! NOTICE:

After boot up of the system, verify the correct settings in the printer “Properties”,
see: Section 3-8-4 "Adding Printer to the system" for assigning the Printer to the remote keys P1, P2, 
P3, P4, P5 and/or P6, and
see: Section 3-8-5 "Adjustment of Printer Settings" .
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3-8-2 Digital Color Printer Sony UP-D25MD 
1) Power off/Shutdown the system as described in: Section 3-7-3 on page 3-27.
2) Connect USB cable into the available USB port on the rear of the system. There are three available 

USB ports on rear of the system. : Section 3-9-2 "External I/O Connectors" 

Figure 3-23   External I/O Connectors - on Rear of System

NOTICE
!! NOTICE:

After boot up of the system, verify the correct settings in the printer “Properties”,
see: Section 3-8-4 "Adding Printer to the system"  for assigning the Printer to the remote keys P1, P2,
P3, P4, P5 and/or P6, and see: Section 3-8-5 "Adjustment of Printer Settings" 

USB Port on the rear of system
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3-8-3 Installing the Bluetooth Deskjet Printer (R2 and R2.5)
1) Power off/Shutdown the system as described in: Section 3-7-3 on page 3-27.

2) Physically connect the Bluetooth dongle as described on Section 3-8-3-1 on page 3-37.

3-8-3-1 Connecting the Bluetooth Dongle into the System

1) Connect Bluetooth Dongle into the available USB port. There are three available USB ports on the 
system. : Section 3-9-2 "External I/O Connectors" .

Figure 3-24   External I/O Connectors - on Rear of System

USB 2.0 port: Two hub ports for service and user.

Figure 3-25   External I/O Connector

NOTICE
!! NOTICE:

After boot up of the system, verify the correct connection of Bluetooth device driver on the maintenance 
mode, see: Section 3-8-3-2 "Verifying Bluetooth device driver"  and, see: Section 3-8-3-3 "Prepare the 
Printer and connect the Bluetooth Printer Adapter"  for Bluetooth pairing between the system and 
printer.

USB-2.0 Port
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3-8-3-2 Verifying Bluetooth device driver

1) Turn on the system.
2) Enter maintenance mode by using service dongle.
3) Go to Device Manager by pressing shortcut on the taskbar
4) Check that there is “Bluetooth Radios” category.

Figure 3-26   Bluetooth Radios

5) Check that there are no any “Unknown Device” messages. If there are unknown devices, check 
again after reboot the system.
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3-8-3-3 Prepare the Printer and connect the Bluetooth Printer Adapter

3-8-3-3-1 HP Officejet 100

1) Connect the power cord to a wall outlet socket.
2) Turn on the printer.
3) Install ink tanks in the correct order.
4) Load paper in the auto sheet feeder.
5) Turn on Bluetooth radio.

Figure 3-27   Connection of Bluetooth Printer Adapter (HP Officejet 100)

3-8-3-3-2 Bluetooth Pairing

1) Press [CTRL + ESC] to open windows start menu.
2) Select “Devices and Printers.”
3) Press “Add a printer” button on the top menu.
4) Select “Add a network, wireless or Bluetooth printer.”
5) Searching for available printers.
6) Select a printer.

Figure 3-28   Selecting a Printer

7) Press “Next” button to install device driver, and then device driver software installed successfully.
8) Press “Next” button after confirming the printer name.
9) Check “Do not share this printer” option, and press “Next” button.
10) Press “Printer a test page” button to check if the printer is working properly.
11) Press “Finish” button.
12) The printer is listed in the “Device and Faxes” category.
13) Bluetooth pairing is completed.
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3-8-4 Adding Printer to the system
1) Select Utility -> Connectivity -> Service.
2) Add the Standard Print.
3) Highlight Standard Print in the Service list.
4) Select the printer from the Printer pull-down Properties menu. For the UP-D898 printer, select 

“Portrait” as orientation.
5) Type the printer name in the Name field. This name is used on the Button screen. After you select 

the printer from the Printer pull-down Properties menu again, it turns white.
6) Press Save.
7) Select Button.
8) Select the appropriate print key (Print1, Print2...) from the Physical Print Buttons section.
9) Select the printer from the MyComputer column and press >> to move it to the Printflow View 

column.
10) Press Save.

3-8-5 Adjustment of Printer Settings
1) Press Utility ->System ->Peripherals. Select the printer to adjust (UP-D25MD or UP-D898) from the 

pull-down menu under Standard Printer Properties. Click Properties.
2) Select Properties from Printer pull-down menu.
3) Click Printing Preferences at the bottom of Properties Window.

To adjust the UP-D898 printer see: Section 3-8-5-1 "UP-D898 - Printer Settings" .

To adjust the UP-D25MD Printer see: Section 3-8-5-2 "UP-D25MD - Printer Settings" .

WARNINGWARNING
!! WARNING:

After each printer installation, the leakage currents have to be measured 
acc. IEC 60601-1 resp. ANSI/AAMI ES60601-1.
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3-8-5-1 UP-D898 - Printer Settings

1) Call up the ‘Printer Preferences’; operation see: Section 3-8-5 "Adjustment of Printer Settings" .
2) Select the MAIN page (see: Figure 3-29 below) and select: 

- Paper: 1920x1280
- Orientation: Landscape
- Interpolation Method: Bilinear 

3) Select the DENSITY ADJUST page (see: Figure 3-29 above) and select: 
- Dark = 0; Light = 0

4) For saving the adjusted printer settings click APPLY and then OK.
Finally close the ‘Printers’ -window with the close button and exit System Setup with SAVE&EXIT.

Figure 3-29  Layout + Density Adjust page
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3-8-5-2 UP-D25MD - Printer Settings

1) Call up the ‘Printer Preferences’; operation see: Section 3-8-5 "Adjustment of Printer Settings" .

2) Select the PAPER page and select: 
- Recommended Paper: UPC-24LA (large) / UPC-24SA (small)

NOTE: Paper UPC-21L and UPC-21S are also acceptable paper to use.

- Orientation: Landscape (recommended when using large paper size)
- High Speed (check mark on) 

3) Select the GRAPHICS page. From the “Color Adjust” pop-up menu select:

a) Color Balance: Cyan = 0; Magenta = 0; Yellow = 0

NOTICE
!! NOTICE:

Settings for Paper Size MUST match with the used Paper (large/small) and also the right color ink 
cartridge has to be used. Otherwise you will get an error message at printing.

Figure 3-30  Paper page
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b) Color Correction: set Printer Hardware Color Correction1

c) Lightness: Sharpness = 7; Dark = 0; Gamma = 14; Light = 0
d) Lightness: Gamma Curve = Curve 1

4) For saving the adjusted printer settings click APPLY and then OK.
Finally close the ‘Printers’-window with the close button and exit System Setup with SAVE&EXIT.

Figure 3-31  Graphics page (Color Balance + Color Correction)

Figure 3-32  Graphics age (Lightness + Gamma Select)
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3-8-6 Installing Network Printer (R3, R4 and R4.5)
1) Confirm that your HP Network Printer is listed on HP Universal Print Driver (UPD) supported 

printers from https://support.hp.com/us-en/document/ish_4952109-2831856-16.
2) Note IPv4 Address of your HP Network Printer (i.e 192.168.1.3).

3) Open ‘Properties’ and ‘Printing Preferences…’ of ‘HP Universal Printing PCL6’.
4) Enter IP Address of your HP Network Printer.

Figure 3-33  

Figure 3-34  
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5) Select your HP Network Printer and Click ‘OK’.

Figure 3-35  
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3-8-7 Setting Printer to Print Reports

3-8-7-1 Setting up the Printer to Print Reports
To set up the Off-Line Printer to print reports, 

1) Press Utility -> System -> Peripherals. 
2) Select the printer from Default Printer pull-down menu. 

3) Press Save. 
4) Press Print on the Report screen to print the report. 

Figure 3-36  Report Printer Setup (R1.x.x - R2.x.x)

Figure 3-37  Report Printer Setup (R3.x.x - R4.5.x)
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Section 3-9
System Configuration

3-9-1 System/General Preset Menu
The System/General screen allows you to specify hospital name and system date and time.

Figure 3-38  System/General Preset Menu (R1.x.x)

Figure 3-39  System/General Preset Menu (R2.x.x)
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Figure 3-40  System/General Preset Menu (R3, R4 and R4.5)

Table 3-8    Location

Preset Parameter Description

Hospital Type the institution’s name.

Department Type the institution's department name.

Preset Region  (restart needed) Select region (None, Americas, Asia, Europe or Japan).

Language (restart needed) Select the appropriate language from the drop-down list.
Note: If you select Japanese (JPN), only the warning and status messages are displayed 
in Japanese. You can not type in Japanese. 

Units Select metric or US units of measurement.

Regional Options Select to set up the keyboard. 

Table 3-9    Date and Time

Preset Parameter Description

Time Format Select the time format: 12 Hr. AM/PM or 24 Hr.

Date Format Select the date format: dd/mm/yyyy, mm/dd/yyyy, or yyyy/mm/dd.

Default Century Select the default century for the system to use.

Date/Time Select to display the Date/Time Properties window, to specify the system date, time, time 
zone, and to auto adjust for daylight savings time. 
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Table 3-10    General User Interface

Preset Parameter Description

Color Level (restart needed) Select System Color according to the condition of the room.

Table 3-11    Title Bar

Preset Parameter Description

Hide Patient Data When set to Always, patient information is removed from the scanning screen Title bar and 
when storing images; or you can set this to remove patient information only when storing 
the image (On Store); or Never. 
Note: Upon recall of images with measurements, Dual image, the DICOM image is 
recalled. In this case, there is no patient data burned into the DICOM image. If you DO NOT 
want this to occur, set this to Never. 

Font Size (restart needed) Select to display patient information in the title bar using a small, medium, or large font size. 
You need to reboot the system for this change to take effect. 

Table 3-12    Trackball

Preset Parameter Description

Speed Set how fast you want the Trackball to move while performing actions such as tracing the 
anatomy. 0=Slow; 20=Very Fast 

Acceleration Set how fast you want to trackball to move across the display. 0, 1, and 2 with 0 being the 
slowest acceleration. 

Table 3-13    Key Usage

Preset Parameter Description

Run Fast Key speed Select the maximum value of the key interval when running Fast Key.

Swap Print1/Freeze Key 
(restart needed)

Swap the control between Print 1 and Freeze key.

Enable Virtual Keyboard If checked, the Virtual Keyboard appears automaticaly when cursor is prompted in Patient 
screen.

Auto Hide Delay Time for Virtual 
Keyboard(sec)

Select the delay time to Virtual Keyboard auto-hide.

Auto Hide Delay Time for Digital 
TGC(sec)

Select the delay time to Digital TGC auto-hide.

Table 3-14    Utility

Preset Parameter Description

Prompt for Save on Exit If selected, the system prompts you to save data when you select exit without saving.

Utility Font Size Select the font size you want to use to view the Utility menus: Small, Medium, or Large. 
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Table 3-15    Scan Assistant

Preset Parameter Description

Auto Selection Off, Category, or Description.
•  Off. The Scan Assistant selection on the Patient screen is completely manual. It will say 

“None” when starting a new patient and you can make a selection manually if desired. 
•  Category. Scan Assistant uses the combination of exam category (Abd, OB, etc.) and the 

currently-selected user to automatically select a Scan Assistant program. It chooses the 
same program that was used the last time this combination of exam category and user. 
The user can manually override this auto selection.

•  Description. Scan Assistant uses the combination of the exam description (often auto fills 
in if the patient was selected from the worklist) and the currently selected user to 
automatically select a Scan Assistant program. It will choose the same program that was 
used the last time this combination of exam description and user was selected. The user 
can manually override this auto selection. If the exam description is blank then it will do 
the auto selection based on Category as described in the previous paragraph.

Always Use Doppler Cursor Use the Doppler Cursor when you activate Scan Assistant. 

Table 3-16    Monitor (R1.x.x)

Preset Parameter Description

Dark Pre-defined monitor settings for Dark Room

Semi Dark Pre-defined monitor settings for Semi-Dark Room

Light Pre-defined monitor settings for Light Room

OSD Control The monitor can also be adjusted in brightness and contrast. For detailed adjustment press 
the [ OSD controls] buttons on the screen. The OSD menu will appear on the screen. 
Brightness, Contrast, Backlight and Sharpness can be adjusted in General tab. Monitor 
colors can be adjusted in RGB tab.

Table 3-17    Power Assistant (R2.x.x)

Preset Parameter Description

 Allow offline scanning (restarted 
needed) 

Allow users to scan without AC power if battery option is installed. User need to reboot the 
system to activate offline scanning.

Battery Low Warning with Sound Make beep sound when the installed battery is running out.

Table 3-18    Smart Start

Preset Parameter Description

Use Smart Start Check to enable Smart Start

Edit mappings Smart Start mapping editor
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3-9-2 External I/O Connectors

Figure 3-41  External I/O Connectors - on Rear of System

Table 3-19    External I/O Connector - Description

Item Connector Name Table Number Description

1 USB
Table 5-2
Table 5-4 USB port. Refer to Section 5-2-4 for details.

2 Composite Table 5-6 Composite(BNC) Connector for external Monitor. TV-out signal.
Resolution :PAL(720x576), NTSC(720x480)

3 HDMI Table 5-5 Connector for external Monitor. No audio output (R1/R2/R2.5/R3/R4).
Resolution: FHD(1920x1080)

4 NETWORK Table 5-4 DICOM input/output, twisted pair RJ-45 10/100/1000 megabit/s

5 S-Video Table 5-6 S-Video Connector for external Monitor. TV-out signal.
Resolution: PAL(720x576), NTSC(720x480)

Figure 3-42  External I/O Connector

[R1, R2, R2.5, R3]

[R4 and R4.5]
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Table 3-20    External lI/O Connector - Description (R1/R2/R2.5)

Item Connector Name Table Number Description

6 USB Table 5-2 Connected to IO Box via USB HUB. Refer to Section 5-2-4 for details.

7 USB Table 5-2 Connected to MCB via USB HUB. Refer to Section 5-2-4 for details.

Table 3-21    External I/O Connector - Description (R3)

Item Connector Name Table Number Description

6 USB Table 5-3 Connected to MCB via USB HUB. Refer to Section 5-2-4 for details.

7 USB Table 5-2 Connected to Touch panel via USB HUB. Refer to Section 5-2-4 for details.

Table 3-22    External I/O Connector - Description (R4 and R4.5)

Item Connector Name Table Number Description

6 USB Table 5-3 Connected to MCB via USB HUB. Refer to Section 5-2-4 for details.
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Section 3-10
Available Probes

3-10-1 Supported probes
The LOGIQ P7/P8/P9/P10 supports the following types of probes: 

• Sector Phased Array
• Linear Array
• Convex Array
• Micro convex Array
• Matrix Array
• Split Array
• Volume Probes (4D)

- Convex Array
- Micro Convex Array

NOTE: Not all probes described in this document may be available or cleared for sale in all markets. 

3-10-1-1 Probe Naming Conventions

3-10-1-2 Probe Description

Table 3-24    Probe Description

Table 3-23    Probe Naming Convention

Type Application Frequency Connector Type

C=Convex
L=Linear
M=Matrix
S=Sector
R=Real time 4D

AB=Abdominal
IC=Intracavitary
NA=Neonatal
SP=Small Parts

“1-5” RS
D=DLP

Part Name Illustration Application Feature
Part 

Number
Probe 
Type Qty FRU

C1-5-RS Abdomen (incl.
Pleural), Vascular
(No transcranial),
OB/GYN, Urology

B, CHI, CF, PDI, M, PW, B-Flow, B-
Flow
Color, Contrast, Elastography,
Shearwave Elastography, 
CrossXBeam,
LOGIQView, ATO/ASO, CTO,
SRI-HD, Advanced 3D, Biopsy, B 
Steer+

5499608 Convex 1 1 

9L-RS Abdomen (incl.
Pleural), Small
Parts, Vascular (No
transcranial),
Pediatric, 
Neonatal,
OB, Breast,
Musculoskeletal

B, CHI, CF, PDI, M, PW, B-Flow, B-
Flow
Color, Elastography, Virtual 
Convex,
CrossXBeam, LOGIQView, ATO/
ASO,
CTO, SRI-HD, Advanced 3D,
Biopsy, B Steer+

5499511 Linear 1 1 
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4C-RS Abdomen, OB/
GYN,
Urology, Vascular
(No transcranial)

B, CHI, CF, PDI, M, PW, B-Flow, B-
Flow
Color, CrossXBeam, LOGIQView, 
ATO/ASO, CTO, SRI-HD, 
Advanced 3D,
Biopsy, Elastography, Shearwave 
Elastography, B Steer+, Contrast

5488477 Convex 1 1 

ML6-15-RS Abdomen (incl.
Pleural), Small
Parts, Vascular (No
transcranial),
Pediatric, 
Neonatal,
Musculoskeletal,
Breast

B, CHI, CF, PDI, M, PW, B-Flow, B-
Flow
Color, Elastography, Virtual Convex,
CrossXBeam, LOGIQView, ATO/
ASO,
CTO, SRI-HD, Advanced 3D,
Biopsy, B Steer+

5499610 Linear
(Matrix)

1 1

E8C-RS OB/GYN, Urology,
Transvaginal,
Transrectal

B, CHI, CF, PDI, M, 
PW,CrossXBeam,
LOGIQView, ATO/ASO, CTO,
SRI-HD, Advanced 3D, Biopsy

5499516 Convex 1 1

L3-12-RS Abdomen (incl.
Pleural), Vascular
(No transcranial),
Small Parts,
Pediatric, 
Neonatal,
OB, Breast,
Musculoskeletal

B, CHI, CF, PDI, M, PW, B-Flow, B-
Flow
Color, Elastography, Virtual Convex,
CrossXBeam, LOGIQView, ATO/
ASO,
CTO, SRI-HD, Advanced 3D,
Biopsy, B Steer+, Shear Wave
Elastography

5785912 Linear 1 1

L8-18i-RS Small Parts,
Vascular (No
transcranial),
Neonatal, 
Pediatrics,
Intraoperative
(Not for China)
Musculoskeletal

B, CHI, CF, PDI, M, PW, B-Flow, B-
Flow
Color, Virtual Convex, 
CrossXBeam,
LOGIQView, ATO/ASO, CTO, SRI-
HD, Advanced 3D

5499609 Linear 1 1 

P8D Cardiac, 
Vascular(No 
transcranial)

CW, ASO

5504447

Pencil 
Probe 
(CW 
Split 
Crystal)

1 1

Part Name Illustration Application Feature
Part 

Number
Probe 
Type Qty FRU
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RAB2-6-RS Abdomen, OB/
GYN,
Urology

B, CHI, CF, PDI, M, PW, 
CrossXBeam,
LOGIQView, ATO/ASO,CTO,
SRI-HD, 3D/4D real-time imaging,
Biopsy, Advanced 3D, B Steer+

KTZ303982

Volume
(Real 
Time 4D, 
Convex)

1 1 

12L-RS Abdomen (incl.
Pleural), Small
Parts, Vascular (No
transcranial),
Pediatric, 
Neonatal,
Musculoskeletal,
Breast

B, CHI, CF, PDI, M, PW, B-Flow, B-
Flow
Color, Elastography, Shearwave 
Elastography, Virtual Convex,
CrossXBeam, LOGIQView, ATO/
ASO,
CTO, SRI-HD, Advanced 3D,
Biopsy, B Steer+

5499501 Linear 1 1

3Sc-RS Cardiac, Abdomen
(incl. Pleural),
Transcranial

B, CHI, CF, M, MCF, Anatomical M, 
PW,
CW, TVI, TVD, Virtual Convex,
LOGIQView, ATO/ASO, CTO,
Stress Echo, SRI-HD, Advanced 
3D,
Biopsy, Contrast

5433833 Sector 1 1

8C-RS Pediatrics, 
Neonatal

B, CHI, CF, PDI, M, PW, B-Flow, B-
Flow
Color, CrossXBeam, LOGIQView, 
ATO/
ASO, CTO, SRI-HD, Advanced 3D,
B Steer+

5499508 Convex 1 1 

L6-12-RS Abdomen (incl.
Pleural), Vascular
(No transcranial),
Small Parts,
Pediatric, Neonatal

B, CHI, CF, PDI, M, PW, B-Flow, B-
Flow
Color, Elastography, Virtual Convex,
CrossXBeam, LOGIQView, ATO/
ASO,
CTO, SRI-HD, Advanced3D,
Biopsy, B Steer+

5454332 Linear 1 1 

6S-RS Abdomen (incl.
Pleural), Cardiac,
Pediatrics, 
Neonatal,
OB

B, CHI, CF, PDI, M, MCF, 
Anatomical M,
PW, CW, TVI, TVD, Virtual Convex,
LOGIQView, ATO/ASO, CTO,
SRI-HD, Advanced3D 5499316 Sector 1 1 

L4-12t-RS Abdomen (incl.
Pleural), Small
Parts, Vascular (No
transcranial),
Pediatric, 
Neonatal,
Musculoskeletal

B, CHI, CF, PDI, M, PW, B-Flow, B-
Flow
Color, Elastography, Virtual 
Convex,
CrossXBeam, LOGIQView, ATO/
ASO, 
CTO, SRI-HD, Advanced 3D,
Biopsy, B Steer+

5435010 Linear 1 1

Part Name Illustration Application Feature
Part 

Number
Probe 
Type Qty FRU
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L10-22-RS Small Parts,
Musculoskeletal,
Neonatal

B, CHI, CF, PDI, M, PW, B-Flow, B-
Flow
Color, Virtual Convex,CrossXBeam,
LOGIQView, ATO/ASO, CTO, SRI-
HD, Advanced 3D 5459953 Linear 1 1

L12n-RS Small Parts, 
Vascular(No 
transcranial), 
Pediatric, 
Neonatal, 
Musculoskeletal

B, CHI, GT, CF, PDI, M, PW, B-
Flow, B-Flow Color, Elastography, 
Virtual Convex, CrossXBeam, 
LOGIQView, ATO/ASO, CTO, SRI-
HD, Advanced 3D, Biopsy, B Steer+

5505771 Linear 1 1

12S-RS Abdomen (incl.
Pleural), 
Pediatrics,
Neonatal

B, CHI, CF, PDI, M, MCF, 
Anatomical M,
PW, CW, TVI, TVD, Virtual Convex,
LOGIQView, ATO/ASO, CTO,
SRI-HD, Advanced3D 5499321 Sector 1 1

E8CS-RS OB/GYN
(Transvaginal),
Urology
(Transrectal)

B, CHI, CF, PDI, M, PW, B-Flow, B-
Flow
Color, CrossXBeam,LOGIQView, 
ATO/
ASO, CTO, SRI-HD, Advanced 3D, 
Elastography,
Biopsy

5670375 Convex 1 1

BE9CS-RS Urology
(Transrectal)

B, CHI, CF, PDI, B-Flow, B-Flow 
Color,
M, PW, CrossXBeam, LOGIQView, 
ATO/
ASO, CTO, SRI-HD, Advanced 3D, 
Elastography, Contrast, Biopsy

5589323 Convex 1 1

IC9-RS OB/GYN, Urology,
(Transvaginal,
Transrectal)

B, CHI, CF, PDI, M, PW, B-Flow, B-
Flow
Color, CrossXBeam,LOGIQView, 
ATO/
ASO, CTO, SRI-HD, Advanced 3D, 
Elastography,
Shearwave Elastography,
Biopsy, Contrast, Max Angle

5722023 Convex 1 1

RIC5-9A-RS OB/GYN
(Transvaginal),
Urology
(Transrectal)

B, CHI, CF, PDI, M, PW, 
CrossXBeam,
LOGIQView, ATO/ASO,  CTO, SRI-
HD,
Advanced3D, 3D/4D, Biopsy. Max 
Angle

KTZ304128

Volume 
(Real 
Time 4D, 
Convex)

1 1

Part Name Illustration Application Feature
Part 

Number
Probe 
Type Qty FRU
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P6D Cardiac, 
Vascular(No 
transcranial)

CW, ASO

5729437

Pencil 
Probe 
(CW 
Split 
Crystal)

1 1

P2D Cardiac, 
Vascular(No 
transcranial)

CW, ASO

TE100024 Pencil 
Probe

1 1

L3-9i-RS Small Parts,
Vascular,
Musculoskeletal,
Neonatal,
Intraoperatives 
(Not
for China)

B, CHI, CF, PDI, M, PW, B-Flow, B-
Flow
Color, Virtual Convex,CrossXBeam,
LOGIQView, ATO/ASO, CTO,  SRI-
HD, Advanced 3D 5721640 Linear 1 1

6Tc-RS Cardiac
(Transesophageal)

B, CHI, CF, PDI, M, MCF, 
Anatomical M,
PW, B-Flow, B-Flow Color, CW, TVI, 
TVD, Virtual Convex,
LOGIQView, ATO/ASO, CTO, SRI-
HD, Advanced 3D
Note: 6Tc-RS probe requires 
special
handling. Refer to the TEE Probe 
User
Manual enclosed with 6Tc-RS 
probe.

5729431 TEE 1 1

C1-6-D Abdomen (incl.
Pleural), OB,
Gynecology,
Vascular (No
transcranial),
Urology

B, CHI, CF, PDI, M, PW,
B-Flow, B-Flow Color, Contrast,
CrossXBeam, LOGIQView, ATO/
ASO, CTO,
SRI-HD, Advanced3D, 
Elastography,
Shearwave Elastography, Biopsy, B 
Steer+, UGAP

5499606
Convex 1 1

C2-7-D Abdomen (incl.
Pleural)

B, CHI, CF, PDI, M, PW,
B-Flow, B-Flow Color, Contrast,
CrossXBeam, LOGIQView, ATO/
ASO, CTO, 
SRI-HD, Advanced3D, Biopsy, B 
Steer+

5505700
Convex 1 1

C3-10-D Abdomen (incl.
Pleural), Neonatal,
Pediatric, Vascular
(No transcranial)

B, CHI, CF, PDI, M, PW,
B-Flow, B-Flow Color, 
CrossXBeam,
LOGIQView, ATO/ASO, CTO, SRI-
HD,
Advanced 3D, B Steer+

5493012
Convex 1 1

Part Name Illustration Application Feature
Part 

Number
Probe 
Type Qty FRU
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10C-D Neonatal, 
Pediatric,
Vascular, (No
transcranial)

B, CHI, CF, PDI, M, PW,
B-Flow, B-Flow Color, 
CrossXBeam,
LOGIQView, ATO/ASO, CTO, SRI-
HD,
Advanced3D, Elastography,
Shearwave Elastography, B Steer+

5476030
Convex 1 1

M5Sc-RS Cardiac,
Transcranial,
Abdomen (incl.
Pleural)

B, CHI, CF, PDI, M, MCF, 
Anatomical M,
PW, CW, TVI, TVD, Contrast, 
Virtual Convex, LOGIQView, ATO/
ASO, CTO, Stress Echo, SRI-HD, 
Advanced 3D, Biopsy

5718483 Sector 1 1

E7C8L-RS (-
C: Convex 
Transducer 
& -L: Linear 
Transducer)

Urology 
(Transrectal)

B, CHI, CF, PDI, M, PW, B-Flow, 
B-Flow Color, CrossXBeam, 
LOGIQView, ATO/ASO, CTO, 
SRI-HD, Advanced 3D, Contrast, 
B Steer+(only E7C8L-L),Max 
Angle(only E7C8L-C), Biopsy, 
Virtual Convex (only E7C8L-L)

5817485 Bi-plane 1 1

Probes

LP9 
R1
(RS 

type)

LP7 
R1
(RS 

type)

LP9 
R2
(RS 

type)

LP7 
R2
(RS 

type)

LP9 
R2.5
(RS 

type)

LP7 
R2.5
(RS 

type)

LP9
R3
(RS 

type)

LP7 
R3
(RS 

type)

LP8 
R4 

(RS/
DLP 
type)

LP9 
R4 

(RS/
DLP 
type)

LP10 
R4 

(RS/
DLP 
type)

LP8 
R4.5 
(RS/
DLP 
type)

LP9 
R4.5 
(RS/
DLP 
type)

LP10 
R4.5 
(RS/
DLP 
type)

Matrix

ML6-15-RS X X X X X X X X X X

4D

RIC5-9A-RS X X X X X X X X X X X X
RAB2-6-RS X X X X X X X X X X X X X X

Convex

4C-RS X X X X
E8CS-RS X X X X X X X X X X X X

E8C-RS X X X X X X X X X X X X X X

8C-RS X X X X X X X X X X X X X X

BE9CS-RS X X X X X X X X X X X X X X

C1-5-RS X X X X X X X X X X
IC9-RS X X X X X X X X
C1-6-D X X X X
C2-7-D X X X X X X

Part Name Illustration Application Feature
Part 

Number
Probe 
Type Qty FRU
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NOTE: “X” means the probe supports the system. 

C3-10-D X X
10C-D X X X X X X

Sector
3Sc-RS X X X X X X X X X X X X X X

6S-RS X X X X X X X X X X X X X X
12S-RS X X X X X X X X X X X X
M5Sc-RS X X

Linear

L6-12-RS X X X X X X X X X X X X X X

9L-RS X X X X X X X X X X X X X
12L-RS X X X X X X X X X X

L8-18i-RS X X X X X X X X X X

L3-9i-RS X X X X X X X

L4-12t-RS X X X X X X X X X X X X
L10-22-RS X X X X X X X

L3-12-RS X X X X X X X X

Pencil

P8D X X X X X X X X X X X X X X

P6D X X X X X X X X X X

P2D X X X X X X X X

Haystack

L12n-RS X X X X

TEE

6Tc-RS X X X X X

Bi-plane

E7C8L-RS (-C: 
Convex 
Transducer & -L: 
Linear 
Transducer)

X X X

Probes

LP9 
R1
(RS 

type)

LP7 
R1
(RS 

type)

LP9 
R2
(RS 

type)

LP7 
R2
(RS 

type)

LP9 
R2.5
(RS 

type)

LP7 
R2.5
(RS 

type)

LP9
R3
(RS 

type)

LP7 
R3
(RS 

type)

LP8 
R4 

(RS/
DLP 
type)

LP9 
R4 

(RS/
DLP 
type)

LP10 
R4 

(RS/
DLP 
type)

LP8 
R4.5 
(RS/
DLP 
type)

LP9 
R4.5 
(RS/
DLP 
type)

LP10 
R4.5 
(RS/
DLP 
type)
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Section 3-11
Software/Option Configuration

For description refer to:

• Section 3-9-1 "System/General Preset Menu" on page 3-47 

NOTICE
!! NOTICE:

More detailed information pertaining System Setup and Measure Setup adjustments is found in the 
LOGIQ P7/P8/P9/P10 Basic User Manual, which is available in different languages.
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Section 3-12
Connectivity Setup

The LOGIQ™ P7/P8/P9/P10 ultrasound system can be connected to various connectivity devices. 
The following sections describe how to connect the system to a remote archive/work station or a DICOM 
service, using a TCP/IP connection.

3-12-1 Connectivity Introduction
This section describes communication and connection options between the LOGIQ P7/P8/P9/P10 
ultrasound unit and other devices in the hospital information system. 

The following scenarios are covered:

• stand-alone LOGIQ P7/P8/P9/P10 scanner; see: Section 3-12-1-3 on page 3-63. 
• LOGIQ P7/P8/P9/P10 and one or several PC workstations within a “Sneaker Net” environment. 

(“Sneaker Net” means that you use a DVD/CD to move data because no network is available); see: 
Section 3-12-1-4 on page 3-63.

• LOGIQ P7/P8/P9/P10 and DICOM server in a network; see: Section 3-12-1-5 on page 3-63.

3-12-1-1 The Dataflow Concept
Communication between the LOGIQ P7/P8/P9/P10 ultrasound unit and other information providers on 
the network takes the form of data flows. Each dataflow defines the transfer of patient information from 
either an input source to the unit, or from the unit to an output source (see examples in Figure 3-43 on 
page 3-62). 

Patient information can include demographic data and images, as well as reports and Measurement 
and Analysis (M&A) data. 

A dataflow is a set of pre-configured services. Selecting a dataflow will automatically customize the 
ultrasound unit to work according to the services associated with this dataflow. 

By utilizing data flows, the user can configure the LOGIQ P7/P8/P9/P10 ultrasound unit to optimally 
meet the needs of the facility, while keeping the user interface unchanged. Once the dataflow is 
selected, the actual location of the database is entirely transparent.
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3-12-1-2 Dataflow Examples

Figure 3-43   Examples of Dataflows

The local database is used for patient archiving. 
Images are stored to internal hard drive. 

The local database is used for patient archiving.
Afterwards images are stored to a DVD/CD or 
external USB device, etc.

Search in the DICOM Modality Worklist, 
the patient found is copied into local database. 
The patient information and the examination 
results are stored to the local database. 
Images are stored to a DICOM server and to an 
image network volume on the local hard drive.
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3-12-1-3 Stand-alone LOGIQ P7/P8/P9/P10
If digital images or 3D/4D data sets (if available) are stored, they should be saved in the Archive (Image 
Management System software).

For Image Management functionality refer to the Basic User Manual of the LOGIQ P7/P8/P9/P10.

Physical Connection:

No network connection needed.

3-12-1-4 LOGIQ? + PC within a “Sneaker Net”
A PC is used for review and work on studies acquired on one or more LOGIQ P7/P8/P9/P10 scanners 
without being connected in a network.

The images are first stored on the LOGIQ P7/P8/P9/P10 scanner’s hard drive (Archive) and then 
exported from the scanner’s hard drive to a sneaker device (e.g., DVD/CD), and finally imported from 
the sneaker device to the PC’s internal hard drive.

For Image Management functionality refer to the Basic User Manual of the LOGIQ P7/P8/P9/P10.

Physical Connection:

No network connection needed.

3-12-1-5 Connection between LOGIQ? and DICOM Server
In this configuration, the LOGIQ P7/P8/P9/P10 is configured to work with a DICOM server in a network 
environment. Usually, this will be the hospital network. Images are first saved on the local image buffer 
on the scanner. At the end of the examination, the images are sent to the DICOM server via a DICOM 
spooler. This scenario requires that the scanner is configured to be connected to the DICOM server.

Physical Connection:

You will need one network cable.

1) Connect one end of the cable to the Ethernet connector on the LOGIQ P7/P8/P9/P10.
2) Connect the other end of the cable to the wall outlet.

NOTE: If a Peer-to-Peer Network is connected to the hospital’s network, you may connect the LOGIQ 
P7/P8/P9/P10 to the Peer-to-Peer Network.

For more details refer to Section 3-13 "Configuring Connectivity" on page 3-65.

NOTICE
!! NOTICE:

To avoid loss of essential data, it is highly recommended to export/backup patient data as well as 
measurements at least once a month.

NOTICE
!! NOTICE:

To avoid loss of essential data, it is highly recommended to export/backup patient data as well as 
measurements at least once a month.
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3-12-2 Wired Ethernet from LOGIQ P7/P8/P9/P10 to a Workstation

3-12-2-1 Direct Cable Connection from the LOGIQ P7/P8/P9/P10 to a Workstation via a Crossover Cable.
You will only need a Crossover Cable for network use to connect the two units this way.

1) Connect one end of the crossed network cable to the network connector on the LOGIQ P7/P8/P9/
P10.

2) Connect the other end to the network connector to the Workstation, see the Workstation Service 
Manual.

3-12-2-2 Connection via a Peer-to-Peer Network
You will need a network switch and one network cable for each unit connected to the switch.

3-12-2-3 Connection via Hospital Network

3-12-2-4 You will need one network cable to connect the LOGIQ P7/P8/P9/P10 to a wall outlet on the hospital’s 
network. 

3-12-3 Connection using Wireless Option
Refer to:

- Chapter 5 for theory.
- LOGIQ P7/P8/P9/P10 Basic User Manual: Chapter 16 Configuring Connectivity.

NOTE: In R4.x.x, CISCO EAP authentication methods for wireless connectivity are not available. If the hospital 
wireless network supports PEAP authentication, use the Microsoft PEAP authentication methods for 
wireless connectivity.
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Section 3-13
Configuring Connectivity

3-13-1 Overview
You use Connectivity functionality to set up the connection and communication protocols for the 
ultrasound system. This page gives an overview of each of the Connectivity functions. Each function is 
described in detail in the following pages. 

3-13-2 Structured Reporting
DICOM Structured Reporting provides the results of a procedure as structured data elements (well-
defined fields) as opposed to unstructured data (large amounts of text undifferentiated by individual 
fields). This greatly improves query capability. DICOM Structured Reporting creates coded clinical data 
that can be used for clinical research, outcomes analysis, and disease management.

DICOM Structured Reporting is a standardized format for medical results. LOGIQ P7/P8/P9/P10 
supports the following templates:

• OB-GYN REPORT TEMPLATES
• VASCULAR ULTRASOUND REPORT TEMPLATES
• The system supports selectable vessels with their locations for B-Mode measurements.
• For Vascular studies (Bypass Graft, UEV Map, LEV Map, LEA/UEA, and Carotid), additional 

measurement locations were added. For instance, for a Bypass Graft, there are now 
measurements at Inflow, Anast, Thigh, Knee, Calf, Ankle, Graft, RunOff, Pre-Sent, Stent, Post-
Stent, and Outflow locations.

• ECHOCARDIOGRAPHY PROCEDURE REPORT TEMPLATES
These templates do not support all M&A results for the LOGIQ P7/P8/P9/P10.

3-13-2-1 Supported parameters
The DICOM supported parameters are listed in the DICOM Conformance Statement at the following 
web site under DICOM - Ultrasound:

http://www3.gehealthcare.com/en/Products/Interoperability/DICOM
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3-13-3 Connectivity Functions
To set up your institution's connectivity, you must login with administrator privileges. 

1) TCPIP: allows you to configure the Internet Protocol.
2) Device. allows you to set up devices. 
3) Service: allows you to configure a service (for example, DICOM services such as printers, worklist, 

and other services such as video print and standard print) from the list of supported services. This 
means that the user can configure a device with the DICOM service(s) that particular device 
supports.

4) Dataflow: allows you to adjust the settings of the selected dataflow and associated services. 
Selecting a dataflow customizes the ultrasound system to work according to the services 
associated with the selected dataflow. 

5) Button: allows you to assign a pre-configured output service (or a set of output services) to the Print 
keys on the control panel. 

6) Removable Media: enables formatting (DICOM, database, or blank formatting) and DICOM 
verification of removable media.

7) Miscellaneous: allows you to set up the patient exam menu options, print and store options, and 
the order of the columns in the examination list on the Patient menu. 

Configure these screens from left to right, starting with the Tcpip tab first. 

NOTE: The ultrasound system is pre-configured for many services, with default settings selected. You can 
change these services and settings as needed.

CAUTION
!! CAUTION: 

You must restart the LOGIQ P7/P8/P9/P10 (shutdown) after making any changes to connectivity 
settings in the Utility menus. This includes any changes on the TCPIP or dataflow setup 
screens.
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3-13-4 TCPIP
This configuration category enables users with administrative rights to set the TCPIP for the system and 
connected remote archive.

1) Type the name of the Ultrasound system in the Computer Name field. 
2) Identify the ultrasound system to the rest of the network by one of the following:

- DO NOT enable DHCP in the Wired Network Configuration Section..
- In the Wired Connection Section, Type the IP-Address (acquire unique static IP address from 

hospital network administrator), Subnet Mask, and Default Gateway (if applicable). 

NOTE: Do not set up the system with DHCP. The IP address MUST BE static for the diagnostic and DICOM to 
function correctly.

3) Select Save settings. 
4) Re-boot the ultrasound system. 

NOTE: TCPIP settings do not get restored when restoring backups. This is per system design. 
The LOGIQ P7/P8/P9/P10 IP address MUST BE unique.

Figure 3-44   Connectivity TCPIP Preset Menu (R1, R2, R2.5)
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Figure 3-45   Connectivity TCPIP Preset Menu (R3, R4 and R4.5)

Table 3-25    Computer Name

Preset Parameter Description

Computer Name Type the unique name for the Ultrasound system (no spaces in name).

Table 3-26    Wired Network Configuration

Preset Parameter Description

Enable DHCP
Select this box to enable dynamic IP Address selection.
NOTE: The system shall disable IP-Address, Subnet Mask, and Default Gateway when the user 
chooses to use DHCP.

IP-Address Type the IP Address of the Ultrasound system. NOTE: IP stands for Internet Protocol. Every 
device on the network has a unique IP address. 

Subnet Mask Type the subnet mask address. NOTE: The Subnet Mask is an IP address filter that eliminates 
communication/messages from network devices of no interest to your system. 

Default Gateway Type the default gateway address.

Network Speed Select the network speed (Auto Detect, 10Mbps/Half/Full Duplex, or 100 Mbps/Half/Full Duplex/
1000Mbps/Auto-negotiate)

IPv6 (R3.0 or above) Select this box if your network system support and you want to use IPv6

IPv6 Address (R3.0 or above) Type IPv6 Address of the Ultrasound system

IPv6 Prefix Length (R3.0 or 
above) Type IPv6 Prefix Length
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NOTE: Reboot the system to activate any changes saved from this page.

Default IPv6 Gateway (R3.0 or 
above) Type IPv6 Gateway address

Prmary DNS Server (R3.0 or 
above) Type Primary DNS Server address

Secondary DNS Server (R3.0 
or above) Type Secondary DNS Server address

Table 3-27    Wired Connection

Preset Parameter Description

IP-Address Displays currently configured IP address

Subnet Mask Displays currently configured subnet mask address

Default Gateway Displays currently configured default gateway address

MAC Address Unique network card address of the system.

Speed (Mbps) The performance of a network connection.

Connected (min The connection time with network.

Status Current network status.

IPv6 Address (R3.0 or 
above) Displays currently configured IPv6 address

IPv6 Prefix Length (R3.0 or 
above) Displays currently configured IPv6 Prefix Length

Default IPv6 Gateway (R3.0 
or above) Displays currently configured Gateway address

Primary DNS Server (R3.0 
or above) Displays currently configured Primary DNS Server address

Secondary DNS Server 
(R3.0 or above) Displays currently configured Secondary DNS Server address

Table 3-26    Wired Network Configuration

Preset Parameter Description



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

3-70 Section 3-13 - Configuring Connectivity

3-13-5 Device
To add a new device, 

1) Press Add. 
2) Type the device name in the Name field. 
3) Type the device's IP address in the IP Address field. 

Figure 3-46   Connectivity Device Preset Menu (R1, R2, R2.5)

Figure 3-47   Connectivity Device Preset Menu (R3)
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To ping a device, 

1) Select the device. 
2) Press Ping. If the smiley face smiles, then the connection has been confirmed. If the smiley face 

frowns, then the connection has not been made. Check the device name and IP address. 

Table 3-28    Device

Preset Parameter Description

Add/Remove Press Add to add a new device; press Remove to delete a device. 

Ping Press Ping to confirm that a device is connected. 

Properties: Name Type the name of the device. 

Properties: IP Address Type the device's IP address. 

Properties: AE Title AE Title of the LOGIQ P7/P8/P9/P10. NOTE: Only available for MyComputer.

Properties: Port Number IP Port Number Used for DICOM, set by default to 104. NOTE: Only available for MyComputer.

Properties: MAC Address Unique network card address. NOTE: Only available for MyComputer.



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

3-72 Section 3-13 - Configuring Connectivity

3-13-6 Service
For each Device that you added to the system, you need to set up the service(s) that device supports 
(you must be an administrator to update these screens). 

Figure 3-48   Connectivity Services Preset Menu, My Computer (R1, R2, R2.5)

Figure 3-49   Connectivity Services Preset Menu, My Computer(R3, R4 and R4.5)

Figure 3-50   Connectivity Services Preset Menu, New Device (R1, R2 andR2.5)
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Figure 3-51   Connectivity Services Preset Menu, New Device (R3, R4 and R4.5)

The Services screen has the following sections of information:

1) Destination Device - lists information about destination devices. You can select from a list of 
currently existing devices.

2) Service Type to Add - lists information about services for the destination device. You can add 
services, select from a list of currently existing services, and remove services.

3) Service Parameters - lists parameters for the service currently selected in the Services section. The 
name and parameters in this section change, depending on what service is currently selected. In 
the above figure, this section shows DICOM Print parameters.

3-13-6-1 Adding a service to a destination device

1) Select the service from the pull-down menu. Press Add. 
2) Specify the properties for this service. Press Save. 
3) Verify the service. 

3-13-6-2 Removing a service

1) Select the service. Press Remove. 
2) Press Save. 

3-13-6-3 Changing parameters for a service
There are certain parameters that may need to be set up for each service: 

Table 3-29    Service Parameters: Common Service Parameters

Preset Parameter Description

Name Free text: give a descriptive name to the device.

AE Title The Application Entity Title for the service.

Port Number The port number of the service.

Maximum Retries Max # - the maximum number of times to try establishing a connection to the service.

Retry Interval (sec) Specify how often (in seconds) the system should try to establish a connection to the service. 
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Many service parameters are specific to each type of service. The parameters are described on the 
following pages:

• DICOM Image Storage
• DICOM Performed Procedure
• DICOM Print
• DICOM Query/Retrieve
• DICOM Storage Commitment
• DICOM Worklist
• Standard Print
• Video Capture
• Save As
• Network storage
• USB Quick Save

Timeout The amount of time after which the system will stop trying to establish a connection to the 
service.

Table 3-29    Service Parameters: Common Service Parameters

Preset Parameter Description
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Section 3-14
Agent Configuration (R3, R4 and R4.5)

3-14-1 Agent Configuration (R3, R4 and R4.5)
Overview

System may be configured to connect to the back office server (FFA Site), which enables GE Service 
Personnel to connect to the system to monitor health of the system, perform diagnostics, exchange 
files, or view console desktop.

3-14-1-1 Agent Configuration

1) Select [Utility] from touch panel
2) Select [Service] to open Common Service Desktop
3) Select [Agent Configuration] menu

Figure 3-52  Agent Configuration (R3)
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Use Agent Configuration to:

• Edit and configure the following:
- Enterprise server, Select “Production” for install base. Select “Staging”for test purpose

- Enterprise host name in the agent

- Enterprise port number in the agent

- Proxy server, Proxy port in the agent, Consult institutions’ IT personnel for Proxy settings

- CRM number in the agent. The default CRM Number is same as the serial number prefixed with 
"LP9P7". (R3)

- CRM number in the agent. The default CRM number is same as the capital serial number. (R4 and 
R4.5)

- For software download URL, address where software will be downloaded from to the LOGIQ 
P8P9P10.(R4 and R4.5)

-Display name in the agent

• Enter the user name and password for the proxy
• Reset the edited unsaved value
• Update contact details

For more information, see: "Agent Configuration (R3, R4 and R4.5)" on page 3-75

Figure 3-53  Agent Configuration (R4 and R4.5)

NOTICE
!! NOTICE:

If you want to activate Request for Service (RFS), you need the verified CRM Number. The Serial 
Number must be registered with only one CRM Number.
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3-14-1-2 Verifying Back Office Connection - CSD

1) Login to FFA Site from Remote PC using Chrome web browser
As of 2018, FFA Site address is https://ffa.am.health.ge.com

2) In System ID field, type the CRM Number of the machine and select [Get Started]

3) At CONNECT mode, Select [Connect] of the “Service Desktop” on Remote Console

4) After selecting [Connect] button, operator may need to wait long time to launch the remote service 
desktop

5) Verify Service Desktop appears on remote PC

Figure 3-54  FFA Site

Figure 3-55  Remote Console
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3-14-1-3 Verifying Back Office Connection – VOC

1) On Console, invoke “Disruptive Mode” and “VCO” by left click “GE ICON” and select “Connect 
Clinical Lifeline

2) Login to FFA Site from Remote PC using Chrome web browser
As of 2018, FFA Site address is https://ffa.am.health.ge.com

3) In System ID field, type the CRM Number of the machine and select [Get Started]

Figure 3-56  Connecting Clinical Lifeline

Figure 3-57  FFA Site
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4) At CONNECT mode, Select [Connect] of the “Virtual Console” on Remote Console

5) After selecting [Connect] button, operator may need to wait long time to launch the remote service 
desktop

6) Verify console desktop can be viewed from Remote PC

Figure 3-58  Remote Console
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Section 3-15
Connectivity Setup Worksheet

Site System Information

Services (Destination Devices)

TCP/IP Settings

Device Type Manufacturer Name IP Address Port AE Title
1
2
3
4
5
6
7
8
9

10
11
12

Dept:

LOGIQ P7/
P8/P9/P10 Type:

Floor:

Room:

REV:

Comments:

CONTACT INFORMATION
Name Title Phone E-Mail Address

Site:

System IP Settings

IP Address:

Subnet Mask:

Default Gateway:
Server Name:

Remote DB User Name:

Name - AE Title:

Remote Archive Setup

IP Address:

Subnet Mask:

Default Gateway:

Name - AE Title:
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Figure 3-59   Worksheet for DICOM Network Information

LOGIQ P7/P8/
P9/P10
Host Name

AE Title

Local Port IP Address

Net Mask

.. .

.. .

ROUTING INFORMATION

ROUTER2
ROUTER3

ROUTER1

.. .

.. .

.. .

.. .

.. .

.. .

.. .

Destination 
IP Addresses

GATEWAY IP Addresses

Default

DICOM APPLICATION INFORMATION
NAME

Store 2

Store 3D_1

Store 1

MAKE/REVISION IP ADDRESSES PORTAE TITLE

Print

Worklist

Store 3D_2

Storage 
Commit

MPPS

Structured 
Reporting

.. .

.. .

.. .

.. .

.. .

.. .

.. .

.. .

.. .
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Section 3-16
Paperwork

NOTE: During and after installation, the documentation (i.e. User Manual, Installation Manual,...) for the 
peripheral units must be kept as part of the original system documentation. This will ensure that all 
relevant safety and user information is available during the operation and service of the complete 
system.

3-16-1 Product Locator Installation

NOTE: The Product Locator Installation Card shown may not be same as the provided Product Locator card.

3-16-2 User Manual(s)
Check that the correct User Manual(s) for the system and software revision, is included with the 
installation. Specific language versions of the User Manual may also be available. 
Check with your GE Sales Representative for availability.

Figure 3-60  Product Locator Installation Card
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Chapter 4
Functional Checks

Section 4-1
Overview 

4-1-1 Purpose of Chapter 4
This chapter provides procedures for quickly checking major functions of the LOGIQ P7/P8/P9/P10 
scanner diagnostics by using the built-in service software, and power supply adjustments.

Table 4-1    Contents in Chapter 4

Section Description Page Number

4-1 Overview 4-1

4-1-1 Purpose of Chapter 4 4-1

4-2 Required Equipment 4-2

4-3 General Procedure 4-3

4-3-1 System Exterior Visual Check 4-4

4-3-2 Mechanical Parts Functional Check 4-9

4-3-3 Power On/Off 4-17

4-3-4 System Information 4-23

4-3-5 System Integration Checks 4-27

4-3-7 Peripheral Checks 4-32

4-3-8 Mode Transition Checks 4-33

4-3-9 OPIO Interface Check (R1, R2, R2.5 only) 4-46

4-3-10 OPIO Interface Check (R3, R4 and R4.5) 4-49

4-3-11 Touch Panel Calibration (R3, R4 and R4.5) 4-53

4-4 Board Diagnostics 4-58

NOTICE
!! NOTICE:

Most of the information pertaining to this Functional Checks chapter is found in the LOGIQ P7/P8/P9/
P10 Basic User Manual;
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Section 4-2
Required Equipment

• An empty (blank) CD-R, DVD-R, and/or external USB devices (stick or hard disk drive for data 
storage/backup. A DVD+RW disc for DVR recording

• At least one transducer. See Chapter 9 - Probes, on page 9-52 for an overview.
(normally you should check all the transducers used on the system)
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Section 4-3
General Procedure 

CAUTION
!! CAUTION: 

SYSTEM REQUIRES ALL COVERS
Operate this unit only when all board covers and frame panels are securely in place. 
The covers are required for safe operation, good system performance and cooling purposes.

NOTICE
!! NOTICE:

Lockout/Tagout Requirements (For USA only)
Follow OSHA Lockout/Tagout requirements by ensuring you are in total control of the Power Cable 
on the system.

Signed Date

TAG 
& 

LOCKOUT
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4-3-1 System Exterior Visual Check

4-3-1-1 Physical Abnormalities 

1) Check for no loose or cracked parts on above locations.

Figure 4-1  System Exterior (R1 to R3)

1. LCD MONITOR 10. BW printer 18. OPIO tray (option)

2. USB Port 11. Drawer 19. Rear Handle (option)

3. Touch Panel 12. Foot rest 20. ECG connector (option)

4. Probe Holder 13. CW pencil probe port (option) 21. Articulating arm (option)

5. Control Panel Swivel button 14. SIDE tray (option) 22. External I/O panel

6. Control Panel Up_down button 15. Probe ports - 3 active probe ports
4 active probe ports (option)

7. A/N keyboard (option)

8. Multi Purpose Holder (option) 16. Paper tray (option)

9. DVD Drive 17. Audio speaker

23
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4-3-1-2 Physical Abnormalities (R4 and R4.5) 

Figure 4-2  System Exterior (R4 and R4.5)

1. LCD MONITOR 10. BW printer (option) 19. Rear Handle

2. USB port 11. Drawer (option) 20. ECG connector (option)

3. Touch panel 12. Foot rest 21. Articulating arm

4. Probe Holder 13. CW pencil probe port (option) 22. External I/O panel

5. Control Panel Swivel button 14. Side tray 23. Battery (option)

6. Control Panel Up_down button 15. Probe ports (3 RS ports, 1DLP 
port)

7. A/N Keyboard (option) 16. Paper tray (option)

8. Multi Purpose Holder (option) 17. Audio speaker

9. DVD Drive (option) 18. OPIO tray (option)
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4-3-1-3 Appearance Inspection

* Required for Asia.

1) Check presence of LCD Caution Label.
2) Check presence of Gender Caution Label.l

NOTE: Some countries may not have "gender determination" label.

3) Check presence of Multi Caution Label.
4) Check presence of Rating Plate.

NOTE: Rating Plate design slightly differ depending on Console destination. At minimum simply check Console 
number, manufacturing date and serial Number.

5) Check presence of UL Label

Figure 4-3  Label Location (R1, R2, and R2.5)

1. LCD CAUTION LABEL

2. GENDER CAUTION LABEL (ONLY FOR INDIA, CHINA, KOREA)

3. MULTI CAUTION LABEL

4. LOGIQ P9/P7 RATING LABEL (FOR CHINA, FOR KOREA, FOR 
JAPAN)

5. LOGIQ P9/P7 RATING LABEL

6. UL LABEL

*
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4-3-1-4 Appearance Inspection (R3)

* Required for Asia.

1) Check presence of LCD Caution Label.
2) Check presence of Gender Caution Label.

NOTE: Some countries may not have "gender determination" label.

3) Check presence of Multi Caution Label.
4) Check presence of Rating Plate.

NOTE: Rating Plate design slightly differ depending on Console destination. At minimum simply check Console 
number, manufacturing date and serial Number.

5) Check presence of UL Label. (But R3 system have UL symbol in LOGIQ P9/P7 RATING LABEL) 

Figure 4-4  Label Location (R3)

1. LCD CAUTION LABEL

2. GENDER CAUTION LABEL (ONLY FOR INDIA, CHINA, KOREA)

3. MULTI CAUTION LABEL

4. LOGIQ P9/P7 RATING LABEL (FOR CHINA, FOR KOREA, FOR 
JAPAN)

5. LOGIQ P9/P7 RATING LABEL

*
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4-3-1-5 Appearance Inspection (R4 and R4.5)

* Required for Asia.

1) Check presence of LCD Caution Label.
2) Check presence of Gender Caution Label.

NOTE: Some countries may not have "gender determination" label.

3) Check presence of Multi Caution Label.
4) Check presence of Rating Plate.

NOTE: Rating Plate design slightly differ depending on Console destination. At minimum simply check Console 
number, manufacturing date and serial Number.

5) Check presence of UL Label. (But R4 system have UL symbol in LOGIQ P8/P9/P10 RATING 
LABEL) 

Figure 4-5  Label Location (R4 and R4.5)

1. LCD CAUTION LABEL

2. GENDER CAUTION LABEL (ONLY FOR INDIA, CHINA, KOREA)

3. MULTI CAUTION LABEL

4. LOGIQ P8/P9/P10 RATING LABEL 
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4-3-2 Mechanical Parts Functional Check

Figure 4-6   System Mechanical Checkpoint

CAUTION
!! CAUTION: 

Pay attention to moving parts and pinch point when performing mechanical parts functional 
check.

Location

1 Main LCD

2 OPIO Swivel Lock

3 OPIO UP_DOWN Lock

4 Total Lock Caster 

5 Swivel-Lock Caster

6 LCD Arm

[R1, R2, R2.5 and R3]  [R4 and R4.5]
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4-3-2-1 Main LCD

1) Tilt LCD Monitor forward
2) Verify can be tilted.

Figure 4-7   Main LCD (R1, R2, R2.5 and R3)

Figure 4-8   Main LCD (R4 and R4.5)



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 4 - Functional Checks 4-11

4-3-2-2 LCD ARM

1) Loosen LCD Arm LOCK.

Figure 4-9   LCD ARM Lock (R1, R2, R2.5 and R3)

Figure 4-10   LCD ARM Lock (R4 and R4.5)

2) Verify LCD Monitor can move up/down (vertically) and left/right (horizontally).
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NOTE: LCD Monitor can move approximately 150mm vertically and 250mm horizontally.

Figure 4-11   LCD Movement (R1, R2, R2.5 and R3)

Figure 4-12   LCD Movement (R4 and R4.5)

• a, b : LOGIQ P7/P9 with Flexible Arm
• c : LOGIQ P7/P9 with Fixed Arm

3) Engage LCD Arm LOCK.
4) Align LCD Arm along center line of the system.
5) Verify LCD Panel is locked to position and LCD ARM does not move.

a b c
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4-3-2-3 OPIO Swivel Lock

Figure 4-13   OPIO Swivel (R1, R2, R2.5 and R3)
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Figure 4-14   OPIO Swivel (R4 and R4.5)

1) Push the swivel button and hold it.
2) Rotate OPIO (while holding button).
3) Verify OPIO is free to rotate.

NOTE: OPIO can rotate approximately 30 degrees to each side.

4) Let go of Swivel Lock button (disengage).

5) Verify OPIO does not rotate.

NOTICE
!! NOTICE:

Do NOT attempt to apply excessive rotating force to OPIO. OPIO Swivel brake is designed to hold 
OPIO in desired position during normal use, and not meant to completely fix the OPIO position.
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4-3-2-4 Swivel/Brake Lock Caster

NOTE: This procedure applies to RIGHT REAR Caster only.

Figure 4-15   Right Rear Caster

1) Press ‘a’.
2) Rotate wheel until it locks (only one lock position in 360deg turn).
3) Verify Swivel Lock engages.
4) Press ‘b’ downward.
5) Verify Brake is applied to the wheel. (i.e. Wheel does not rotate)
6) Press ‘b’ upward.
7) Verify Brake is released.
8) Press ‘c’. 
9) Verify Swivel is released.

CAUTION
!! CAUTION: 

System weighs approximately 60kg.  Pay attention for system stability when working with the 
casters
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4-3-2-5 Swivel/Brake Lock Caster

NOTE: This procedure applies to casters other than RIGHT REAR Caster.

Figure 4-16   Total Lock Casters

1) Press ‘a’. 
2) Rotate wheel until it locks (several locations where caster engages).
3) Verify Swivel Lock engages and Brake is ON.
4) Press ‘b’.
5) Verify wheel is free to move.

CAUTION
!! CAUTION: 

System weighs approximately 90kg.  Pay attention for system stability when working with the 
casters.
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4-3-3 Power On/Off

4-3-3-1 Scanner Power On

1) Connect the Main Power Cable to the back of the system.
2) If not already done, screw on the pull-out protection of the mains power cable with the 2 screws.
3) Connect the Main Power Cable to a hospital grade power outlet with the proper rated voltage. Never 

use an adapter that would defeat the safety ground.
4) Switch ON the Circuit Breaker at the rear of the system.

Figure 4-17   Circuit Breaker, pull-out protection and main power cable at rear of system.

NOTICE
!! NOTICE:

After turning off a system, wait at least 10 seconds before turning it on again. 
The system may not be able to boot if power is recycled too quickly.

NOTICE
!! NOTICE:

When AC power is applied to the scanner, the On/Off button on the control panel illuminates BLUE 
indicating that the system (including back-end processor) is in Standby Mode.

Circuit Breaker

Pull Out Protection
(Metal Bracket)

Mains Power Cable
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5) Hold down the On/Off button on the control panel for ~3 seconds.

NOTE: The power for on-board peripheral auxiliary equipments are commonly switched with the ON/OFF 
button. The power switch of any attached printer(s) needs to be in ON position before starting the 
system. However, be aware some auxiliary equipment may switch itself to standby mode (e.g., Color 
video printer) and must therefore be switched on separately.

Figure 4-18   On/Off Button on Control Panel and indicator color

OFF (STAND-BY) (R3, R4, R4.5) OFF (Stand-by)

ONON (R3, R4, R4.5)

[R4 and R4.5 Control Panel]

[R1, R2, R2.5 and R3 Control Panel]
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6) Verify On/Off button color changes to GREEN.
7) Verify on-board peripherals power is also turned ON.

As soon as the software is loaded, the system enters 2D-Mode with the probe and application that were 
used before the system was shut down. Total time used for start-up is about 2 minutes.

NOTE: The power for on-board peripheral auxiliary equipments are commonly switched with the ON/OFF 
button. So the auxiliary equipment need not to be switched ON/OFF separately.
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4-3-3-2 Complete power down
 

1) If not already in read mode, freeze the image.
2) When you shutdown the system, enter the scan screen and lightly press the Power On/Off switch 

once. The System-Exit window is displayed.

NOTICE
!! NOTICE:

After turning off a system, wait at least 10 seconds before turning it on again. The system may not be 
able to boot if power is recycled too quickly.

Figure 4-19  Power OFF User Interface (R2 and R2.5)
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3) Select the SHUTDOWN button. The system performs an automatic full shutdown sequence.
4) Switch OFF the Circuit Breaker at the rear of the system.

NOTE: The mains outlet of the system for peripheral auxiliary equipment are commonly switched with the ON/
OFF button. So the auxiliary equipment need not to be switched ON/OFF separately.

5) After complete power down, unscrew the 2 screws and remove the pull-out protection to disconnect 
the main power cable from the system or unplug it from the AC wall outlet socket.

6) Press on the brakes to block the front caster wheels.
7) Disconnect probes. 

Figure 4-20  Power OFF User Interface (R3, R4 and R4.5)

WARNINGWARNING
!! WARNING:

Disconnection of the Main Power Cable is necessary!
For Example: When repairing the system.

NOTICE
!! NOTICE:

Be sure to follow probe handling instruction and caution outlined in Basic User Manual.
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4-3-3-3 Power Off / Shutdown Check

1) When you shut down the system, enter the scan screen and lightly press the Power On/Off switch 
once. The System-Exit window is displayed.

2) The SYSTEM - EXIT menu, used when power off the unit, gives you these choices:
• Logoff

Use this button to log off the current user. The system remains ON and ready for a new user to log 
on. If the Logoff button is dimmed, it indicates that no user is logged on to the unit at the moment.

• Shutdown
Use this button to shut down the system. The entire system will shut down. It is recommended to 
perform a full shutdown at least once a week.

If the Shutdown button is dimmed, press the power button or Alt F10 to shut down the unit.

• Cancel
Use this button to exit from the System-Exit menu and return to the previous operation.

• Exit (Only available when logged in as GE Service with Service Dongle)
Select this button when you want to exit to the Windows Desktop.
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4-3-4 System Information

4-3-4-1 Software Version

1) From the touch panel, select Utility -> System -> About.
2) Note “Software Version” in Software Group.
3) Note "Software Revision" in Software Group.
4) Note “Image Part Number” in System Image.

Figure 4-21   Software version (R2 and R2.5)

Figure 4-22   Software version (R3)
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Figure 4-23   Software version (R4 and R4.5)
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4-3-4-2 Service Platform Confirmation (R1, R2, R2.5 only)

1) From the touch panel, select Utility -> Service.
2) On Service Browser, select GE Service, and enter the password.
3) Note “SvcPform” version.

Figure 4-24   Software Platform version
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4-3-4-3 USB Port Test

Required Equipment : Service Dongle

External Port Test

1) Plug service dongle to the following locations. Refer to Section 3-9-2 for locations.
- Front USB Port in OPIO
- USB Port in LCD Monitor
- Rear USB Access Port

2) Verify service dongle LED.
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4-3-5 System Integration Checks

4-3-5-1 OPIO Test

Figure 4-25   OPIO (R1, R2, R2.5 and R3)

Figure 4-26   OPIO (R4 and R4.5)

1) Power ON the system.
2) Check backlight on AN Keyboard, B Buttons, Freeze Key.
3) Select UTILITY in touch panel.
4) Turn encorder knobs as shown in Figure 4-25.
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5) Verify backlight luminance (intensity) changes when knobs are turned.

Figure 4-27   Utility

Figure 4-28   

6) Connect any probe. (if not connected)
7) Go to Live CF Mode. (Mode Rotary Line Area in touch panel, Press “CF” Mode button, unfreezes.) 
8) Turn “GAIN” encoder around CF Mode button and verify ROI gain change.
9) Operate TGC sliders(Select TGC in touch panel) and verify B image gain change.
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10) Press “COMMENT” key. 
11) Select ‘KBD’ in touch panel and Type in arbitrary strings. Verify keyboard is functional
12) Type in arbitrary strings from A/N Keyboard(If installed). Verify keyboard is functional.

4-3-5-2 DVD Drive Test

1) Insert Blank CD-R or DVD-R Media into Optical Drive.
2) Select UTILITY -> SYSTEM -> Backup Restore.
3) Select “CD/DVD” in “MEDIA” list.
4) Select “User Define Configuration checkbox” in Backup and Press “Backup”.
5) Start backup into Media by pressing “OK” Button.
6) Verify “Finished OK” message appears.

4-3-5-3 LAN Port Test

1) Plug the Ethernet Cable to connect local area network.
2) Verify that Local area network connection is recognized.
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4-3-6 System Integration Checks (R4 and R4.5 only)

4-3-6-1 OPIO Test

1) Power ON the system.
2) Check backlight on AN Keyboard, B Buttons, Freeze key.
3) Select UTILITY in touch panel.

Figure 4-29  OPIO

Figure 4-30  Utility
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4) Connect any probe. (if not connected)
5) Go to Live CF Mode. (Press “CF” Mode button, unfreezes.)
6) Turn “GAIN” encoder around CF Mode button and verify ROI gain change.
7) Operate TGC sliders (Select TGC in touch panel) and verify B image gain change.
8) Press “COMMENT” key.
9) Select ‘KBD’ in touch panel and Type in arbitrary strings. Verify keyboard is functional.
10) Type in arbitrary strings from A/N Keyboard (if installed). Verify keyboard is functional.

4-3-6-2 DVD Drive Test

1) Insert Blank CD-R or DVD-R Media into Optical Drive.
2) Select UTILITY -> SYSTEM -> Backup Restore.
3) Select “CD/DVD” in “MEDIA” list.
4) Select “User Define Configuration checkbox” in Backup and Press “Backup”.
5) Start backup into Media by pressing “OK” Button.
6) Verify “Finished OK” message appears.

4-3-6-3 LAN Port Test

1) Plug the Ethernet Cable to connect local area network.
2) Verify that Local area network connection is recognized.

Figure 4-31  
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4-3-7 Peripheral Checks

4-3-7-1 DVR Test (if equipped)
Required: Blank [DVD+RW] media.

1) Make sure the tab menu of “Video” is found on the right-most touch panel tab. If not found, go to 
“Utility” -> “Application” -> “Setting” and check “Show video Tab”.

2) Insert DVD+RW. Go to DVR Touch Panel menu. 
3) Press “REC-Standby” to go stand-by.
4) Start Recording. Perform image scanning including Doppler sound.
5) Stop Recording. 
6) Exit from stand-by. 
7) Play.
8) Verify that Recorded image and sound can be played back.

NOTE: LOGIQ P7/P8/P9/P10 support USBHDD file capture. and this menu can select in “Utility” “System” 
“Peripherals” tab. The recorded data can play on your target PC. The support video format mpeg-2 and 
h.264 and it depend on codec on your PC of operation system. If you cannot play in window media 
player, you should be download video codec or recommend use VLC media player (http://
www.videolan.org/).

4-3-7-2 Black and White Printer Test

1) Print an image by pressing P button associated with BW Printer. (P key should be configured 
correctly.)

2) Verify that image can be printed.
3) Verify that printed image has no distortion as compared the image on screen.

4-3-7-3 Color Printer Test

1) Print an image by pressing P button associated with Color Printer. (P key should be configured 
correctly.)

2) Verify that image can be printed.
3) Verify that printed image has no distortion as compared the image on screen.

4-3-7-4 CD/DVD Read/WriteTest

1) Insert Blank CD/DVD Media into Optical Drive.
2) Go to Utility -> System -> Backup Restore. Select “CD/DVD” in “Media” list.
3) Select “User Define Configuration checkbox” in Backup and Press “Backup”.
4) Start backup into Media by pressing “OK” Button.
5) Verify that “Finished OK” message appears.

4-3-7-5 ECG Test

1) Connect a any probe. Select cardiac application like “Adult”. And start scan.
2) Verify that ECG timeline gets displayed on image area.
3) Enter CSD.
4) Select DIAGNOSTICS - Service Diag - ECG Test.
5) Verify diagnostics exhibit “PASS”.
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4-3-7-6 Gel Warmer Test

1) Insert Gel Bottle into Gel Warmer.
2) Power ON the warmer.
3) Verify Gel gets warm.

NOTE: Depending on environment, Gel requres 30 minute or more to warm up.

4-3-7-7 Single CWD

1) Connect P8D probe. Select vascular application like “Carotid”. And start scan.
2) Verify that CW timeline image appears.

4-3-8 Mode Transition Checks

4-3-8-1 General Information

1) [R1.X.X] Select UTILITY -> SYSTEM -> User Configurable Key.
[R2.X.X and R3.X.X] Select UTILITY -> APPLICATION -> Settings.

2) [R1.X.X] Select "M" in 2 list of "Mode Rotary Line Key".
[R2.X.X and R3.X.X] Select ""M"" in 2 list of ""User Configurable Mode Rotary".

3) [R1.X.X] Select "PW" in 3 list of "Mode Rotary Line Key".
[R2.X.X and R3.X.X] Select ""PW"" in 3 list of ""User Configurable Mode Rotary".

4) [R1.X.X] Select "CF" in 5 list of "Mode Rotary Line Key".
[R2.X.X and R3.X.X] Select ""CF"" in 5 list of ""User Configurable Mode Rotary".

5) Press “Save”.
6) Select UTILITY -> SYSTEM -> User Configurable Key.
7) Select “B-Flow” in 4 list of “User Defined Hard Key”.
8) Select "Reset" in 3 list of "User Defined Touch Button".
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9) Press "Save" and restart the system into Question window by pressing "OK" Button.

Figure 4-32   User Configurable Key Page (R1.x.x)

Figure 4-33   User Configurable Key Page (R2.x.x)
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Figure 4-34   User Configurable Key Page (R2.x.x)

Figure 4-35  User Configurable Key page (R3.x.x)
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Figure 4-37   Hard key and Touch Panel for User interaction (R2.x.x or R3.x.x)

Figure 4-36  User Configurable Key Page (R4.x.x or later)
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4-3-8-2 B-Mode

1) Press B Mode button.
2) Verify that system scan with the activated probe.
3) Verify probe name is displayed on upper right hand corner of main monitor (scan screen).

Figure 4-38  Hard key and Touch Panel for User interaction (R4.x.x or later)
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4-3-8-3 Color Flow-Mode

1) Press CF Mode button. (Active CF Mode button on "User Configurable Mode Rotary".(R1-R3 only))
2) Increase CF Gain until noise floor shows up.
3) Verify no vertical “streaks” of color that significantly contrasts the surrounding color.

Figure 4-39   Color Flow-Mode
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4-3-8-4 Pulse Doppler Mode

Figure 4-40   (R2.x.x or R3.x.x)

1) From Utility -> Imaging -> General, verify check on “Simultaneous”.
2) Press B Mode button.
3) Press PW Mode button. (Active PW Mode button on "User Configurable Mode Rotary".(R1-R3 

only))
4) Verify that system scan B/PW duplex with the activated probe.
5) Revert to original setting in Utility -> Imaging -> General “Simultaneous”.

Figure 4-41  (R4.x.x or later)
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Figure 4-42   Pulse Doppler Mode

4-3-8-5 B/CF/PW Mode

1) Press B Mode button.
2) Press PW Mode Button.
3) Press CF Mode Button.
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4) Verify that system scan with B/CFM/PWD Modes.

Figure 4-43   B/CF/PW Mode



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 4 - Functional Checks 4-42

4-3-8-6 M-Mode

1) Press B Mode Button.
2) Press M Mode Button. (If not R4.X.X, active M Mode button on "User Configurable Mode 

Rotary".(R1-R3 only))
3) Verify that system scan B/M with the activated probe.

Figure 4-44   M-Mode

4-3-8-7 B-Flow Mode

NOTE: Make sure to select probe which supports B-flow

1) From the touch panel, select Utility -> Imaging -> General.
2) Change BF/BFC Button to “BF”
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Figure 4-45   BF Setting (R2.x.x or R3.x.x)

3) Press B-Flow Button. (If not R4.X.X, active M Mode button on "User Defined Hard Key".(R1-R3 
only))

Figure 4-46  BF Setting (R4.x.x or later)
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4) Verify BF Mode.

Figure 4-47   B-Flow Mode

5) From the touch panel, select “COLOR”
6) Verify B-Flow Color is shown.

Figure 4-48   B-Flow Color Mode

4-3-8-8 CW Mode (Optional)

NOTE: Make sure to select probe which supports CWD

1) Press B Mode button.
2) Press CW Mode button.
3) Verify that system CW scan with the activated probe.
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4-3-8-9 WLAN (Optional)

NOTE: This test is only applied if the WLAN option has been installed

1) Connect a service dongle to USB port and press a power button on console panel.
2) Select Exit and enter the user name and password. Choose Maintenance > Exit to Windows. The 

Windows desktop will appear.
3) Click the Device Manager icon on the status bar. A Device Manager window will open.

4) Open a sub node of Network adapters.
5) Verify that NETGEAR WNDA4100 N900 Wireless Dual Band USB Adapter is listed.

4-3-8-10 4D Mode (Optional)

NOTE: This test is only applied if the 4D options (both hardware and software) have been installed.

1) Prepare a 4D probe that the version of software has supported.
2) Make sure that the probe is connected properly.
3) Select the probe on the touch panel.
4) Press 3D/4D key.
5) [R1.X.X or R2.X.X or R4.X.X]Press Static 3D / [R3.X.X] Press 3D tab
6) Press Start Set key.
7) Verify that Static 3D image is acquired.

4-3-8-11 Power Assistant (Optional)

NOTE: This test is only applied if the Battery option has been installed

1) Make sure that the Power Assistant option is installed.
2) Verify that Battery icon is displayed in status bar and the color is green or yellow, not orange
3) Make sure battery icon in status bar is green. If it is yellow, wait for the battery is charged and turned 

to green.
4) Unplug the AC power cable.
5) Verify that the system is not turned off.
6) Verify that the main display gets dark and the touch panel turn off.
7) Plug the AC power cable .
8) Verify that Brightness of main display and touch panel be gets normal.
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4-3-9 OPIO Interface Check (R1, R2, R2.5 only)

NOTE: In above example, key “Alt” is pressed.

NOTE: Alternatively, OP Panel Interface test may be executed from Common Service Desktop.

However, performance / response of the diagnostics may be degraded when executed with scanner 
software still active.

It is located under Diagnostics -> OP Panel Interface in the Diagnostics page.

Before OP Panel Interface test execute from Common Service Desktop, you have to enable the 
Disruptive Mode in Diagnostics -> Common diagnostics -> Utilities -> Disruptive Mode

To perform OPIO Interface Check using Diagnostics

1) Enter Common Service Desktop
2) Select Diagnostics -> Common diagnostics -> Utilities -> Disruptive Mode

Figure 4-49  Diagnostic Mode page screen
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3) Click the "YES" on Diagnostic Mode page

4) Select Diagnostics -> OP Panel Interface

Figure 4-50  Diagnostic Mode page screen after enable the Disruptive mode

Figure 4-51  OP Panel Interface page screen
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5) Click the "Start" on OP Panel Interface page

6) Select "Op-Panel Open"
7) Verify OP Panel button operation is reflected on diag window.
8) Check the “Display Touch Panel Layout” and Press the four Points in Touch Panel. 

The four Points is (80, 80), (720, 80), (80, 520) and (720, 520) points.
9) Verify that 4 touch points have the almost same position between appeared log points and touch 

points. The possible error range of touch points is plus or minus 20 points. If this step is failed, 
Please execute section 4-3-11

NOTE: If four touch points are out of possible error range, repeat these 8-9 steps three times.

Figure 4-52  OP Panel Interface page screen
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4-3-10 OPIO Interface Check (R3, R4 and R4.5)

NOTE: Alternatively, OP Panel Interface test may be executed from Common Service Desktop.

However, performance / response of the diagnostics may be degraded when executed with scanner 
software still active.

It is located under Diags -> Run Diags -> Service Menu -> OpPanel -> OpPanel Test in the Diagnostics 
page.

Before OP Panel Interface test execute from Common Service Desktop, you have to enable the 
Disruptive Mode in Utilities -> Disruptive Mode Utility

To perform OPIO Interface Check using Diagnostics

1) Enter Common Service Desktop
2) Select Utilities -> Disruptive Mode Utility

Figure 4-53  Disruptive Mode Utility (R3)

Figure 4-54  Disruptive Mode Utility (R4 and R4.5)
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3) Click the "Enable" on Diagnostic Mode Utility page

4) Select Diags -> Run Diags -> Service Menu -> OpPanel -> OpPanel Test

Figure 4-55  Diagnostic Mode page screen after enable the Disruptive mode (R3)

Figure 4-56  Diagnostic Mode page screen after enable the Disruptive mode (R4 and R4.5)

Figure 4-57  OP Panel Interface page screen (R3)
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5) On “Maintenance Access” dialog,

1.) enter the password (R3 only)
2.) click [Maintenance] button. On “System halted” dialog, click [Maintenance] button. (R4 and 

R4.5)

Figure 4-58  OP Panel Interface page screen (R4 and R4.5)

Figure 4-59  OP Panel Interface page screen (R3)
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6) Select "Op-Panel Open"
7) Verify OP Panel button operation is reflected on diag window.
8) Check the “Display Touch Panel Layout” and Press the four Points in Touch Panel. 

The four Points is (80, 80), (720, 80), (80, 520) and (720, 520) points.
9) Verify that 4 touch points have the almost same position between appeared log points and touch 

points. The possible error range of touch points is plus or minus 20 points. If this step is failed, 
Please execute section 4-3-11

NOTE: If four touch points are out of possible error range, repeat these 8-9 steps three times.

NOTE: For LCD Video Test, press the ‘PASS’ button as the touch panel displays according to the following 
screens:

Figure 4-60  OP Panel Interface page screen (R4 and R4.5)
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4-3-11 Touch Panel Calibration (R3, R4 and R4.5)
1) Power ON the scanner, and wait until the main screen comes up.
2) Insert the service dong to the front USB port.
3) Press Power button on the operator panel once.
4) Click [Exit] button on the SYSTEM EXIT dialog.
5) On “Maintenance Access” dialog,

1.) enter the password (R3 only)
2.) click [Maintenance] button. On “System halted” dialog, Click [Maintenance] button. (R4/R4.5 

only)
6) Click [Exit to Windows] on Maintenance dialog. The system will exit to the Windows desktop.
7) Click [Start] button, select “Control Panel”, and then select “Tablet PC settings”. Tablet PC settings 

dialog appears.
8) Select the “3. Displaylink” in Display tab -> Display options -> Display
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9) Press the Reset button in Display tab -> Display options -> Details

10) Press the OK when pop-up the window.

11) Press “Calibrate...” in Display tab -> Display options -> Details

Figure 4-61  Tablet PC Settings dialog

Figure 4-62  Digitizer Calibration Tool
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12) Calibrated carefully 16 calibration points in touch panel.

NOTE: Figure 4-35 is intended to be shown upside-down.

13) Press the Yes when pop-up the window.

14) Functional Check in section 4-3-9

Figure 4-63  Calibration Layout

Figure 4-64  Digitizer Calibration Tool
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4-3-12 Monitor sound setting (R4.5)
1) Power On the scanner and wait until the main screen comes up.
2) Insert the service dongle to the front USB port
3) Press Power button on the operator panel once.
4) Click [Exit] button on the SYSTEM EXIT dialog.
5) On “Maintenance Access” dialog, Click [Maintenance] button. 
6) On “System halted”, Click [Maintenance] button.
7) Click [Exit to Windows] on Maintenance dialog. The system will exit to the Windows desktop.
8) Click [Start] Button, Select “Control Panel” and then select “Sound”. Sound setting dialog appears.
9) Verify two “FW23****” devices are included in the “Playback”. The last four alphabets can be 

changed.
10) Verify “FW23****(NA)” is disabled with the down arrow.
11) Verify “FW23****” is enabled.

Figure 4-65  Playback tab
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12) Select Stereo Mix on “Recording” menu.

13) Verify “Listen to this device” is checked and “Playback through this device” is “FW23****”.

Figure 4-66  Recording tab

Figure 4-67  Listen tab
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Section 4-4
Board Diagnostics

Category Item MCB MDC MPI MIO Battery 
Module ECG DC4D Other

MCB

MCB Swept Demodulator Test X

MCB Front End Interface Test X

MCB Analog Test X

MCB Memory Access Test X

MCB Front End Interface FPGA Test X

DSP Master Clock Check X

MCB Temperature Test X

CPU Temperature Test X

MCB Voltage Test X

FPGA Version Test X

HV_STOP Test X X

MDC
MDC Temperature Test X

MDC Voltage Test X

Battery
Battery Status Test X

Battery Charge/ Discharge Test X

System 
Rack Temperature Test X X X

Rack Voltage Test X X X

Memory Callisto Internal Memory Test X

Digital Receive

AFE IF Test X

Complex Mixer Test X

CE Decoder Test X

Analog Receive

Noise Floor Test X

BF Analog Rx Gain Test (High Gain) X

BF Analog Rx Gain Test (Med Gain) X

BF Analog Rx Gain Test (Low Gain) X

aCW Pedof X

aCW Beamforming X

aCW IQ Symmetry X

ECG ECG Module Test X

DC4D

DC4D Presence Test X

DC4D Version Test X

Static 3D Test X

4D Test X
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COMEXP

Essential Test COMEXP

HD Test Long HDD

HD Test Short HDD

Memory COMEXP

Network Interface
COMEXP/

EthernetPort

Network Interface Reliability Test X
COMEXP/

EthernetPort

RTC Clock X COMEXP

Video cards COMEXP

AVI Playback COMEXP

CDR ODD

CDRW ODD

DVD-R ODD

DVD-R Double Layer ODD

DVD-RW ODD

DVD+R ODD

DVD+R Double Layer ODD

DVD+RW ODD

DVD RAM ODD

DVD Readonly ODD

Keybaord
COMEXP/

AN Keyboard

Microphone

Monitor COMEXP

Mouse
COMEXP/ 

OPIO 
Trackball

Sound COMEXP

USB Ports
COMEXP/ 
MIO/ USB 

Ports
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Chapter 5
Components and Functions (Theory)

Section 5-1
Overview

5-1-1 Purpose of Chapter 5
This chapter explains LOGIQ P7/P8/P9/P10’s system concepts, component arrangement, and 
subsystem function. It also describes the Power Distribution scheme and probes.

Table 5-1 Contents in Chapter 5

Section Description Page Number

5-1 Overview 5-1

5-2 General Information 5-2

5-3 Power ON/DOWN Sequence 5-16

5-4 Software Options 5-17

5-5 Hardware Options 5-21

5-6 Regional and Peripheral Options 5-23

5-7 Mechanical Descriptions 5-24

5-8 Exiting to Windows Desktop 5-28

5-9 Service Platform 5-31

5-10 Common Service Desktop (CSD) (R1, R2, R2.5 only) 5-33

5-11 Common Service Desktop (R3, R4 and R4.5) 5-43
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Section 5-2
General Information

LOGIQ P7/P8/P9/P10 is a digital beamforming curved-, linear- and phased array ultrasound imaging 
system. The system supports various operating mode such as 

• B-Mode, M-Mode, Color Flow (CFM)
• Power Doppler Imaging (PDI), PW Doppler, CW Doppler
• Volume Mode (3D)
Refer to Basic User Manual for full range of operating mode.

5-2-1 System Exterior

Figure 5-1   System Exterior (R1, R2, R2.5 and R3)

21.5" Monitor

Touch Screen
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Figure 5-2   System Exterior (R4 and R4.5)
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5-2-2 Operator Panel

5-2-2-1 Basic Block Diagram R1 to R4.5

Figure 5-3  Basic block diagram of LOGIQ P7/P8/P9/P10 R1 to R4
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Figure 5-4   Operator Panel and Probe connector (R1, R2, R2.5 and R3)
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Figure 5-5   Operator Panel and Probe connector (R4 and R4.5)
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5-2-3 System Options

Figure 5-6   System Options
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Figure 5-7   System Options (R4 and R4.5)
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5-2-4 System Ports

Figure 5-8   System Ports (R1, R2, R2.5 and R3)

System is equipped with 4 USB ports in front. These are customer use and Service port connected to 
USB controller via USB Hub.

The Rear panel contains following ports.

• 3 USB ports for peripherals such as printers and footswitch
• HDMI for monitor output (without sound)
• S-Video & Composite for monitor output
• RJ45 for LAN connection
• AC Inlet for power

USB Ports Rear Panel
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Figure 5-9   System Ports (R4 and R4.5)

System is equipped with 2 USB ports in front. These are customer used and service port connected to 
USB controller via USB Hub.

The Rear panel contains following ports.

• 3 USB ports for peripherals such as printers and footswitch
• HDMI for monitor output (R4 : without sound, R4.5 : with sound if the external monitor supports 

HDMI audio)
• S-Video & Composite for monitor output
• RJ45 for LAN connection
• AC Inlet for power



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 5 - Components and Functions (Theory) 5-11

5-2-4-1 Front USB
Customer use and Service port connected to USB controller via USB Hub.

NOTE: Front USBs are non-isolated port and not fit to connect external powered USB Devices.

Table 5-2    USB Connectors(on OPIO for R1 to R2.5)

Table 5-3    USB Connectors(on OPIO for R3)

Table 5-4    USB Connectors (on LCD monitor)

5-2-4-2 Rear USB and LAN
2 USB ports and a LAN port are integrated in a connector

Pin No Output Signal Description

1 VCC USB Power Supply

2 - Data USB Data (-)

3 + Data USB Data (+)

4 GND USB Power Ground

Pin No Output Signal Description

1 VCC USB Power Supply

2 - Data USB Data (-)

3 + Data USB Data (+)

4 GND USB Power Ground

5 USB_SSRX- Receive signal differential pairs for the 
Super speed USB data6 USB_SSRX+

7 GND USB signal Ground

8 USB_SSTX- Transmit signal differential pairs for the 
Super speed USB data9 USB_SSTX+

Pin No Output Signal Description

1 VCC USB Power Supply

2 - Data USB Data (-)

3 + Data USB Data (+)

4 GND USB Power Ground

5 USB_SSRX- Receive signal differential pairs for the 
Super speed USB data, Not supported6 USB_SSRX+

7 GND USB signal Ground

8 USB_SSTX- Transmit signal differential pairs for the 
Super speed USB data, Not supported9 USB_SSTX+
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LAN : 1000Base-T, 100Base-T, 10Base-T

USB : USB 2.0, 480Mbps, 5V 500mA.

NOTE: Rear USBs are non-isolated port and not fit to connect external powered USB Devices.

NOTE: Maximum allowable current through USB port is 500mA.  Devices connected to port should not 
consume more than rated limit.

Table 5-5    USB and LAN integrated Connector

Pin No Output Signal Description

A1 VCC USB Power supply

A2 Data - USB Data (-)

A3 Data + USB Data (+)

A4 GND Ground

B1 VCC USB Power supply

B2 Data - USB Data (-)

B3 Data + USB Data (+)

B4 GND Ground

1 VCC Ethernet reference voltage

2 MD0+ Ethernet MDI data 0 (+)

3 MD0- Ethernet MDI data 0 (-)

4 MD1+ Ethernet MDI data 1 (+)

5 MD1- Ethernet MDI data 1 (-)

6 MD2+ Ethernet MDI data 2 (+)

7 MD2- Ethernet MDI data 2 (-)

8 MD3+ Ethernet MDI data 3 (+)

9 MD3- Ethernet MDI data 3 (-)

10 GND Ground
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5-2-4-3 HDMI

NOTE: HDMI for external monitor

Table 5-6    Pin Out

Pin number Signal name

1 TMDS Data 2+

2 TMDS Data 2 Shield

3 TMDS Data 2-

4 TMDS Data 1+

5 TMDS Data 1 Shield

6 TMDS Data 1-

7 TMDS Data 0+

8 TMDS Data 0 Shield

9 TMDS Data 0-

10 TMDS CLK+

11 TMDS CLK Shield

12 TMDS CLK-

13 NC

14 NC

15 NC

16 NC

17 GND

18 +5V

19 NC

19 1
18 2
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5-2-4-4 S-Video / Composite
There are S-video / Composite port for external display

<S-Video 4Pin Mini-DIN Female>

Table 5-7    S-Video 4Pin Mini-DIN Female

<Composite Connector>

<Composite Output Port Signal Assignment>

Pin number Signal name

1 GND / Ground (Y)

2 GND / Ground (C)

3 Y / Intensity (Luminance)-

4 C / Color (Chrominance)

Pin number Signal name

1 1 plus screen
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5-2-4-5 AC Inlet

Figure 5-10   AC Inlet

100-120V/220-240V AC 
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Section 5-3
Power ON/DOWN Sequence

5-3-1 Power On Sequence
1) Circuit breaker ON
2) AC/DC in IOBOX generates standby 5V
3) Standby 5V is supplied to OPIO, COM Express and each board 
4) OPIO generates Button signal 
5) COM Express receives the Button signal and generates Power Switch On signal
6) ACDC generates P12V after receiving Power Switch On signal from COM Express.
7) AC/DC route P12V to each board 

- AC Power is supplied to BW Printer, after generating P12V 
- MIO generates P5V and routes to each board

8) MDC generates LV, HV, SHV to MCB and MPI.

5-3-2 Power Down Sequence
1) Press shutdown on application.
2) COM Express generates power down signal.
3) ACDC 12V down.

NOTICE Power-ON using Battery is NOT allowed.
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Section 5-4
Software Options

5-4-1 Options
Following options are offered for LOGIQ P7/P8/P9/P10.

Table 5-8    Software Options

Software Options Description

Auto IMT automatically measures the thickness of the Intima Media on the far and near vessel walls. 
Near Wall IMT is the distance between the trailing edges of the adventitia and intima; the 
Far Wall IMT is the distance between the leading edges of the adventitia and intima.

B-Flow intended to provide a more intuitive representation of non-quantitative hemodynamics in 
vascular structures. All B-Mode measurements are available with B-Flow active: depth, 
distance along a straight line, % stenosis, volume, trace, circumference, and enclosed area.

Coded Contrast Imaging LOGIQ P9 only (R1 or R2 or R2.5): Provides contrast imaging capability

CW Doppler Allows examination of blood flow data all along the Doppler Mode cursor rather than from 
any specific depth. Gather samples along the entire Doppler beam for rapid scanning of the 
heart. Range gated CW allows information to be gathered at higher velocities.

DICOM To enable DICOM connection to network device

Elastography Elastography shows the spatial distribution of tissue elasticity properties in a region of 
interest by estimating the strain before and after tissue distortion caused by external or 
internal forces. The strain estimation is filtered and scaled to provide a smooth presentation 
when displayed.

Elasto QA Provides QAnalysis function in Elastography

Flow QA Provides QAnalysis function in Flow

LOGIQView provides the ability to construct and view a static 2D image which is wider than the field of 
view of a given transducer. This feature allows viewing and measurements of anatomy that 
is larger than what would fit in a single image. Examples include scanning of vascular 
structures and connective tissues in the arms and legs.

Report Writer Provides output to external printers

Scan Assistant provides an automated exam script that moves you through an exam step-by-step. This 
allows you to focus on performing the exam rather than on controlling the system and can 
help you to increase consistency while reducing keystrokes.

Stress Echo provides an integrated stress echo package, with the ability to perform image acquisition, 
review, image optimization, and wall segment scoring and reporting for a complete, efficient 
stress echo examination.

TVI (Tissue Velocity Imaging) calculates and color-codes the velocities in tissue. The tissue velocity information is 
acquired by sampling of tissue Doppler velocity values at discrete points

B Steer+ The user can enhance detectability of biopsy in the tissue without slanting whole B mode 
image.

VOCALII You use VOCAL(Virtual Organ Computer-aided Analysis) to visualize and calculate the 
volume of anatomical structures, such as a tumor lesion, cysts, and the prostate.

VCI Static VCI (Volume Contrast Enhanced Ultrasound) allows you to sweep smaller slices of data 
with a higher volume rate.

TUI Tomographic Ultrasound Imaging (TUI) is a visualization mode which presents data as 
parallel slices (planes) through the dataset.

4D 4D provides continuous, high volume acquisition of 3D images. 4D adds the dimension of 
“movement” to a 3D image by providing continuous, real-time displays.
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Auto EF Automated Ejection Fraction (AutoEF) is a semi-automatic measurement tool used for 
measurement of the global EF (Ejection fraction).

Measure Assist Breast Allows automatic contour and measurement of breast lesions.

Measure Assist OB Allows automatic contour and measurement of BPD, HC, FL and AC.

Breast Productivity Allows automatic contour and measurement of breast lesions.

Thyroid Productivity Worksheet summary includes measurements and locations for nodule, parathyroid and 
lymph node.

Compare Assistant Allows side-by-side comparison of previous ultrasound and other modality exams during 
live scanning.

DVR Software Digital Video Recorder provides cine recording function to DVD or USB storage 
media.

AFI Automated Function Imaging (AFI) is a semi-automatic measurement tool used for 
measurement of the regional functions of the left ventricle.
The AFI tool is used as an optional decision support tool. The AFI tool is derived from 2D 
speckle tracking algorithm, which tracks and calculates the myocardial tissue deformation 
based on feature tracking on 2D grey scale loops.

Omniview Displays non-orthogonal view along any drawn plane. Sub-menu on Sectional Visualization 
of 3D/4D mode.

STIC Spatio-temporal image correlation (STIC) is a new approach for clinical assessment of the 
fetal heart.
STIC offers an easy to use technique to acquire data from the fetal heart and to aid in 
visualization with both two dimensional and three-dimensional (3D) cine sequences.

Advanced3D Designed for rendering B Mode and Color Flow Mode images, e.g., vessel trees.

LP7 MSK Korea 
(R2 or R2.5 or R3)

Support the ML6-15 probe on LP7. (Korea only)

GT (R2.5 or R3) Displays the needle's position in real-time graphics that are overlaid on the image of the 
scan plane. The trajectory can then be monitored as it progresses toward the target.

Shear Wave Elastography A type of Elastography using force generated from a high intensity ultrasound pulse to 
generate a laterally travelling shear wave that is then observed and tracked using 
ultrasound. The velocity of the shear wave is used to generate an elasticity image.

HRes Contrast Upgrade (R2 or 
later)

LOGIQ P9 only (R2 or R2.5): Provides additional high resolution contrast imaging modes.

Tablet Tools LOGIQApps are available for Android devices via Bluetooth: Remote Control App and 
Photo/Barcode Reader App. Bluetooth dongle can be inserted to any of the USB ports in 
the system. 

HDLive HDlive is an extraordinary rendering method generating amazingly realistic images of the 
human fetus from sonographic data. Through the use of an advanced illumination model, 
HDlive supports shadows, a virtual light source and advanced skin rendering techniques.

SW DBV Basic (R3 or later) Software Digital Video Recorder provides cine recording function to DVD or USB storage
media.
It's DVD Title production is not supported.

Sono NT/IT (R4 or later) Sonography-based Nuchal/Intracranial Translucency (SonoNT/IT) is a semi-automated tool 
to help provide quantifiable NT/IT measurements. With SonoNT/IT, clinicians can achieve 
the reproducible results that are crucial for diagnostic confidence. With its intuitively 
designed user interface, SonoNT/IT is easy to use and can integrate easily into user 
workflow.

Table 5-8    Software Options

Software Options Description
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NOTE: In case the user scans any other barcodes in the manual below apart from “USB Serial” then the 
barcode reader might be unable to scan the QR Code on the Pinpoint Needle or Patient or worklist. In 
this case, please re-scan the “USB Serial” barcode.

UGAP (R4 or later) UGAP( Ultrasound-Guided Attenuation Parameter) calculates attenuation coefficient for the 
quantification of liver steatosis.

SonoAVC (R4 or later) A method for volume calculation available on 3D/4D mode. The volumes are generated by 
segmentation, computed manually or automatically.

KOIOS (R4 or later) Breast Assistant, Powered by Koios DS is a Breast Lesion Analysis Option. Koios is 
configured similar to a DICOM Service. The user can accept/reject analysis results.

KOIOS Thyroid (R4 or later) Thyroid Assistant, Powered by Koios DS is a Thyroid Nodule Analysis Option. Koios is 
configured similar to a DICOM Service. The user can accept/reject analysis results.

Figure 5-11  USB Serial

Table 5-8    Software Options

Software Options Description
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5-4-2 Smart Devices Applications (LOGIQ Apps)
The Smart Devices Applications are available for Android via Bluetooth:

• Remote Control App

• Camera App

To link to the device:

1.) Insert Bluetooth dongle into USB slot

2.) Connect the device to the LP7/9 via dongle. 

3.) Scan for devices. 

4.) Connect to the device. 

Remote Control App

Via the Remote Control App, you will be able to adjust the following controls:

• Depth

• PW Gain

• CF Gain 

• B-Mode Gain 

• Left/Right

• Measure 

• Comment 

• Clear 

• Trackball 

• Freeze 

• Store 

• Color Flow Scale 

• Cursor 

Camera App

You can use the camera to capture images that will go to the patient’s exam.
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Section 5-5
Hardware Options

5-5-1 Options
Following options are offered for LOGIQ P7/P8/P9/P10.

Table 5-9    Hardware Options 

Hardware Options Description

ECG Option

LP7/P8/P9/P10 ECG Module without ECG cables Provides interface to ECG cable

ECG Cable - AHA For US (AHA) color codes

ECG cables - IEC Right Hand = Red, Left Hand = Yellow, Left Foot=Green

Peripheral Device Cabinet

High Cabinet for LOGIQ Provides additional 2 on-board devices

Low Cabinet for LOGIQ Provides lowest OPIO position

Drawer (for High Cabinet) Installed on Color printer position

Peripheral Devices & Misc

Card Reader Mounting Kit LP7/P8/P9/P10 CR Mounting Kit

LP9 and LP7 Articulating Monitor Arm LP9 and LP7 Articulating Monitor Arm

LP7/P8/P9/P10 Pencil Probe CW HW Kit LP9 and LP7  Pencil CW HW Kit

LP9 and LP7 Side Tray Maru Side Tray

LP7/P8/P9/P10 4D Kit LP9 and LP7 4D Kit

USB 3 Pedal Foot Switch USB 3 Pedal Foot Switch

LP7/P8/P9/P10 Paper tray LP7/P8/P9/P10 Paper tray

LP7/P8/P9/P10 Rear handle LP7/P8/P9/P10 Rear handle

LP7/P8/P9/P10 OPIO tray LP7/P8/P9/P10 OPIO tray

LP7/P8/P9/P10 Battery Kit LP7/P8/P9/P10 Battery Kit

LP7/P8/P9/P10 Battery Pack (=power assiat) Solo Battery

LP9 and LP7 4 RS Connector MPI LP9 and LP7 4 RS Connector MPI

LP7/P8/P9/P10 Wireless LAN LP7/P8/P9/P10 Wireless LAN

LP7/P8/P9/P10 Gel Warmer LP7/P8/P9/P10 Gel Warmer

LP7/P8/P9/P10 Universal Video Converter LP7/P8/P9/P10 Universal Video Converter

Isolation Transformer Isolation Transformer for external patient monitor AC input

MCWD CW Piggy board for CW option

EMI filter (AC filter) EMI filter (AC filter)

Optional Probe Holders

LP7/P8/P9/P10 Endocavity vertical probe holder LP7/P8/P9/P10 Vert Endo Prb Holder

LP7/P8/P9/P10 Probe holder adapter for small probe LP7/P8/P9/P10 Small Probe Holder
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LP7/P8/P9/P10 Probe Cable Hanger - Front LP7/P8/P9/P10 Front Probe Cable Hanger

LP7/P8/P9/P10 Probe Cable Hanger - Rear LP7/P8/P9/P10 Rear Probe Cable Hanger

Table 5-9    Hardware Options (Continued)

Hardware Options Description
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Section 5-6
Regional and Peripheral Options

5-6-1 Regional Options
Following options are offered for LOGIQ P7/P8/P9/P10.

5-6-2 Peripheral Options
Following options are offered for LOGIQ P7/P8/P9/P10.

Table 5-10    Regional Option

Optional Power Cables

Destination Set - UK

Destination Set - South Africa

Destination Set - Argentina

Destination Set - Israel

Destination Set - Switzerland

Destination Set - Denmark

Destination Set - US

Destination Set - Japan

Destination Set - Australia/New Zealand  

Destination Set - China

Destination Set - India

Destination Set - Italy

Destination Set - Brazil

Power Cord Fix Bracket 220V

Power Cord Fix Bracket 110V

Optional Language Keyboards

LOGIQ P7/P8/P9/P10 Greek Keyboard

LOGIQ P7/P8/P9/P10 Norwegian/Danish Keyboard

LOGIQ P7/P8/P9/P10 Russian Keyboard

LOGIQ P7/P8/P9/P10 Swedish Keyboard

LOGIQ P7/P8/P9/P10 French Keyboard

Table 5-11    Peripheral Option

Printers Description

LOGIQ P7/P8/P9/P10 Sony UP-D898 Digital B/W Printer Kit B/W Printer Kit

LOGIQ P7/P8/P9/P10 Sony UP-D25MD Digital Color A6 Printer Kit Digital Color A6 Printer Kit

LOGIQ P7/P8/P9/P10 Color Inkjet Printer (Off-board) Inkjet Printer
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Section 5-7
Mechanical Descriptions

5-7-1 Physical Dimensions

5-7-1-1 Dimensions and Weight - R1, R2, R2.5 and R3
• Height: 1,375mm (Minimum), 1,570mm (Max.)
• Width: 530mm (Monitor), 430mm (Operator Panel)
• Depth: 740mm
• Weight: 60kg (133 lbs)

5-7-1-2 Dimensions and Weight - R4 and R4.5
• Height: 1,345mm (Minimum), 1,595mm (Maximum)
• Width: 545mm (Monitor), 430mm (Operator Panel)
• Depth: 740mm
• Weight: 67kg (148 lb) 

5-7-1-3 Dimensions and Weight - R4 and R4.5 HD
• Height: 1,390mm (Minimum), 1640mm (Maximum)
• Width: 545mm (HD Monitor)
• Depth: 740mm
• Weight: 69kg (152 lb)

5-7-2 LCD Monitor
The LOGIQ P7/P8/P9/P10 has a free adjustable LCD monitor in relation to the user interface.

• position up/down: +/- 7.5 cm
• position left/right: +/- 18cm
• rotation up/down: +90°/-15°
• rotation left/right: +/- 90°
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5-7-3 OPIO Positioning
The control console can be rotated, translated and adjusted in height.

Figure 5-12  Adjustable Control Console (R1, R2, R2.5 and R3)

Highest

810mm
Lowest
910mm
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Figure 5-13  Adjustable Control Console (R4 and R4.5)
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5-7-4 Air Flow Distribution

NOTE: Clean the Air Filter periodically.

Through the filter grid on the front of the system, air flow into the LOGIQ P7/P8/P9/P10 scanner. By 
means of the 2 FAN, air is blown through the nest-box, and the warm air exits the scanner through holes 
in the left side panel and rear of the system.

Figure 5-14   Air Inlet/Outlet at LOGIQ P7/P8/P9/P10

(Rear)

Main Air inlet
(Side)

Main Air inlet
(Filter grid)

(Filter gird)

Main Air Outlet
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Section 5-8
Exiting to Windows Desktop

LOGIQ P7/P8/P9/P10 backend software operates on embedded version of Windows 7® operating 
system (R2 and R2.5) or ersion of Windows 10 Enterprise® operating system (R3, R4 and R4.5). To 
access some of the functions, service personnel occasionally require to enter Windows desktop to 
access files, folders or applications.

5-8-1 Exiting to Windows Desktop
Tools Required: Service Dongle

1) Wait for system to boot.
2) Connect Service Dongle to any of the USB ports available.
3) Tap power button once. 
4) If Service Dongle is correctly recognized by the system, U/I popup window provides selection 

“EXIT”.

Figure 5-15   SYSTEM - EXIT (R2 and R2.5)

Figure 5-16   SYSTEM - EXIT (R3, R4 and R4.5)
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5) On “Maintenance Access” window, type in service password (user name not required).

NOTE: Service Password is rotating password that changes on 6 months period.  Only the GE service 
personnel or GE authorized dealers have access to maintenance password.

NOTE: Maintenance Password is function of date/time.  Therefore, if BIOS settings differ from actual date/time, 
then the maintenance password may not be recognized. 

6) When entering Windows Desktop, press “Ctrl” and “Esc” at the same time to make windows menu 
bar to appear.

Figure 5-17   Windows Desktop (R2 and R2.5)

Figure 5-18   Windows Desktop (R3)
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Figure 5-19   Windows Desktop (R4 and R4.5)
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Section 5-9
Service Platform

5-9-1 Introduction
The Service Platform will increase service productivity and reduce training and service costs.

5-9-2 Access / Security
The Service Platform has different access and security user levels.
Each user is only granted access to the tools that are authorized for their use.

• Local Access: via Utility - SERVICE button

5-9-2-1 Local Access

1) If not already in read mode, FREEZE the image.
2) Press the UTILITIES key on the control panel and touch SERVICE to invoke setup desktop.
3) As soon as the GEHC Service Home Page appears, select “Operator” from the pull-down menu, 

enter the password uls and then click [Okay] (R1, R2, R2.5 only)

The Common Service Desktop (CSD) is started and the [Home] page - containing basic System 
Information - appears. The navigation bar at the top of the screen allows to select different tools.

For more detailed information and description refer to Section Section 5-10 on page 5-33 (R1, R2, R2.5 
only) or Section Section 5-11 on page 5-43 (R3 only).

Figure 5-20  Service Login (R1, R2, R2.5 only)

enter password: uls

select: Operator
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5-9-2-2 How the Customer enables/disables Disruptive Mode and VCO

1) If not already in read mode, FREEZE the image.
2) Move the cursor to the GE icon and press the right trackball key (= right-click).
3) Select Connect Clinical Lifeline.

This activates “Disruptive Mode” and “VCO” for the application OLC to quickly assist the customer. 

NOTE: To disable disruptive mode, select "CANCEL". 

Figure 5-21  Connect Clinical Lifeline (R1, R2, R2.5 only)

Figure 5-22  Connect Clinical Lifeline (R3 only)

Figure 5-23  Connect Clinical Lifeline (R4 and R4.5)

GE icon

Enables Disruptive
Mode and VCO

GE icon

Enables Disruptive
Mode and VCO
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Section 5-10
Common Service Desktop (CSD) (R1, R2, R2.5 only)

5-10-1 Internationalization
The user interface provided by the service platform is designed for GE personnel and as such is in 
English only. There is no multi-lingual capability built into the Service Interface.

There are different possibilities to access the Common Service Desktop and its available features:

1) Local Access via System Setup - Administration - SERVICE page
As soon as the Common Service Desktop (CSD) is started, the Service [Home] Page appears.

The navigation bar at the top of the screen allows to select from following tools:

• Error Logs on page 5-37
• Diagnostics on page 5-37
• Image Quality on page 5-38
• Configuration on page 5-39
• Configuration on page 5-39
• Utilities on page 5-40
• Replacement on page 5-42
• PM on page 5-42

Figure 5-24  Common Service Desktop - Home
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5-10-2 CSD Top Page

5-10-2-1 General Layout

Table 5-12    

1 System Information System ID, Serial, IP Address, InSite StatusÅc.etc

2 Connected Probes Connected and System recognized probe listed

3 Option Enabled Options and its expiration date

4 Peripheral Connected and system recognized peripheral listed

5 System Status System Date, Time...etc

6 Power On Hours System Power ON hours.  Health Limit link should not be referenced.

7 Temperature and Voltage Details on the following section
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5-10-2-2 Decoding System Temperature and Voltage

NOTE: These are reference only values and therefore, parameters are not constant.  Some parameters may 
be added/deleted depending on the system configuration, type, and variation.

In general, the first parameter defines data source (board).

"P" in the second parameter denotes "Plus" or "positive" in voltage.

"M" in the second parameter denotes "Minus" or "negative" in voltage.

"V" in the second parameter denotes "decimal point".  i.e. 1V5 is 1.5.

Some Example Shown below.

Table 5-13    

Parameter Description

BEP_CPU_TEMPERATURE Temperature at CPU core. This parameter used for system temperature monitoring

GFS_LM83 Additional temperature sensor at LM83 chip on GFS.

GFS_GFE Additional temperature sensor on GFS.

GFS_SDEM Additional temperature sensor on GFS.

GFS_BOT Additional temperature sensor on GFS.

GFS_M5V GFS Voltage. Minus 5.0Volt (-5V)

GFS_P3V3_VIDEO GFS Voltage. Positive 3.3Volt (+3.3V) for video signal

GFS_P1V5_PCIE GFS Voltage. Positive 1.5Volt (+1.5V) for PCI-E

GFS_P2V5 GFS Voltage. +2.5V

GFS_P3V3 GFS Voltage. +3.3V

   ~

BF_DVDD_1V8_1 BF Voltage. 1.8V for AFE Analog/Digital Conversion (group 1)

BF_DVDD_1V8_2 BF Voltage. 1.8V for AFE Analog/Digital Conversion (group 2)

BF_DVDD_1V8_3 BF Voltage. 1.8V for AFE Analog/Digital Conversion (group 3)

BF_AVDD_3V3_1 BF Voltage. 3.3V for AFE chip LNA/VCA (group 1)

   ~

BF_2V5_CLK BF Voltage. 2.5V for clock

BF_PHVA BF Voltage. Positive HVA

BF_MHVA BF Voltage. Negative HVA

   ~

PI_3V3_PRB Probe Interface, 3.3V powering Probe
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5-10-3 Error Logs
When the Error Logs page is selected, different log viewing options are available.
Log Viewer is displayed in a separate window.

5-10-4 Diagnostics

The Diagnostic page uses a web-controlled user interface to provide access to common service 
components and perform diagnostics.
The left frame shows the list of diagnostics items. The user can select diagnostics item as necessary 
and can perform the test with Execute button at the bottom.

The user can extend hierarchy menu and each folder contins several items. The user can select multiple 
items and execute selected items automatically.

Figure 5-25  Common Service Desktop - Error Logs

Figure 5-26  Common Service Desktop - Diagnostics
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5-10-5 Image Quality
In the Image Quality page, you can verify image quality.

NOTE: This page is not populated in this version.

Figure 5-27  Common Service Desktop - Image Quality
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5-10-6 Configuration
In the Configuration page, you can view and modify different device informations and configurations. 
in the “InsiteExC Agent Configuration” option field. 

Figure 5-28  Common Service Desktop - Configuration

NOTICE
!! NOTICE:

Remote access is ONLY possible if the service platform is properly configured (either by the user 
or a GE technician at site). Operation see: Section 7-5-6 "CSD: Configuration" on page 7-21. 
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5-10-7 Utilities
The Utilities page contains a variety of Windows utility tools to indicate the status of the system, 
in addition to various other tools.

Figure 5-29   

Note on Utilities:

One of the menu selections “Disk Defragmenter” invokes Windows® application executed in separate 
window.  Because CSD window is set to be "always on top", new window is forced to appear on behind 
CSD, and hence, not viewable.

In order to invoke this functionality, exit to desktop first, and select Windows® application for disk 
defragmentation.

5-10-7-1 Disk Defragmenter

1) Exit to Windows
2) Select Start -> Programs -> Administrative Tools -> Computer Management

Figure 5-30   
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3) Select “Disk Defragmenter” from left pane

Figure 5-31    

4) Select Disk Drive to defragment on right (upper) pane
5) Press “Defragment” to execute defragmentation of the selected disk

NOTE: Press “Analyze” button to see current status of the disk

6) Wait until process completes and report as such.

NOTE: Disk defragmentation - depending on status - may take hours to complete
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5-10-8 Replacement
There is no accessible parameters in Replacement page.

5-10-9 PM
In the PM page, information about planned, proactive and preventive maintenance is displayed, as 
described in Chapter 10 - Care & Maintenance, on page 10-1.

NOTE: This page is not populated in this version.

Figure 5-32  Common Service Desktop - PM
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Section 5-11
Common Service Desktop (R3, R4 and R4.5)

5-11-1 Purpose of this section
This section describes the features of the Service desktop. These are the different levels of access to 
the Service desktop:

• Service Basic access (Class A) – a user locally logged into the machine with Local Service Access 
privilege. This level provides limited access to Service desktop widgets and utilities.

• Service Advanced access (Class C) Local – Depending on the purchase level, includes an option 
string to control access.

• GE Service access (Class M) and an SSA key. For users with local Service Access privileges, this 
level provides unrestricted access to all Service desktop widgets and utilities.

• Remote access – a user remotely accessing the LOGIQ P7/P8/P9/P10. This level provides 
unrestricted access to all Service desktop widgets and utilities. Disruptive mode is limited to the 
user access privileges to Remote Service Access.

5-11-2 Disruptive mode
Disruptive mode is a way to control interruptions to operation of the LOGIQ P7/P8/P9/P10. Disruptive 
mode is required whenever service performs a function that may disrupt a normal scan. Activating 
Disruptive mode results in a red message displayed on the task bar. This message indicates that the 
LOGIQ P7/P8/P9/P10 needs to be restarted once the service activity is complete. The message 
remains until the LOGIQ P7/P8/P9/P10 is restarted. This prevents patient scanning while the LOGIQ 
P7/P8/P9/P10 is not operating at an optimal status.

For example, running a diagnostic may leave the LOGIQ P7/P8/P9/P10 in a state that is not good for 
imaging.

Specifically, Disruptive mode is required to run diagnostics, clean presets, and reset the patient 
database, and turn on Virtual Console Observation (VCO).

• When Disruptive mode is On, all service functionality on the Service desktop is allowed but user 
operation of the LOGIQ P7/P8/P9/P10 may be limited.

• When Disruptive mode is Off, some service functionality on the Service desktop is not available and 
user operation of the LOGIQ P7/P8/P9/P10 is normal. Additionally, the ability to enable Disruptive 
mode depends on the logged in user.

• Local user – a user locally logged into the machine will be able to set the LOGIQ P7/P8/P9/P10 to 
Disruptive mode or allow a Disruptive mode request from a remote user through the Service 
desktop. The local user must have Authorize Remote Service Access to allow Disruptive mode. If 
the local user does not have this right, the remote user’s request will be automatically denied.

• Remote user – a user remotely accessing the LOGIQ P7/P8/P9/P10 will not be able to automatically 
switch Disruptive mode to On. The logged in user (User actually logged on to the LOGIQ P7/P8/
P9/P10) needs to have the ability to grant remote access. The logged in user will be notified through 
a dialog box and asked to allow Disruptive mode

NOTE: Change Password and Disk Defragment are not available for the remote user whether Disruptive mode 
is On or Off.
For more information, see Section 5-11-2 "Disruptive mode" on page 5-43
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5-11-3 Color statuses
Throughout the Service desktop, colors indicate the following:

• Green – Status is normal
• Orange – Status is a warning
• Red – Status is an error

5-11-4 Licenses

With Service Basic Access (Class A), these are the available options:

• HOME
• Utilities
- Change Password

- Data Transfer

- Delete Files

- Gather Logs

- Network Capture

- SSA License

- Third Party Licenses

- Resolve Agent Quarantine

• Options
• Agent Configuration
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With Service Advanced (Class C), these are the available options:

• HOME
• Diags
- Run Diags

- Diags History

• DICOM
- DICOM Service Status

- DICOM Spooler

• Utilities
- Change Password

- Checkpoints

- Clean Userdefs

- Data Transfer

- Delete Files

- Disk Defragment

- Disruptive Mode Utility

- Gather Logs

- Network Capture

- Reset Patient Database

- Software Reload

- SSA License

- Third Party Licenses

- Resolve Agent Quarantine

• Options
• Agent Configuration



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

5-46 Section 5-11 - Common Service Desktop (R3, R4 and R4.5)

With GE Service access (Class M) and an SSA key, these are the available options:

• HOME
• Diags
- Run Diags

- Diags History

• DICOM
- DICOM Service Status

- DICOM Spooler

• Utilities
- Change Password

- Checkpoints

- Clean Userdefs

- Data Transfer

- Delete Files

- Disable Remote Connectivity 

- Disk Defragment

- Disruptive Mode Utility

- Gather Logs

- Network Capture

- Reset Patient Database

- Software Reload

- SSA License

- SSH

- System Shutdown

- Third Party Licenses

- Virtual Console Observation

- Resolve Agent Quarantine

• Options
• Agent Configuration
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With Remote access (Back office server), these are the available options:

• HOME
• Diags
- Run Diags

- Diags History

• DICOM
- DICOM Service Status

- DICOM Spooler

• Utilities
- Checkpoints

- Clean Userdefs

- Data Transfer

- Delete Files

- Disable Remote Connectivity

- Disruptive Mode Utility

- Gather Logs

- Network Capture

- Reset Patient Database

- Software Reload

- SSA License

- SSH

- System Shutdown

- Third Party Licenses

- Virtual Console Observation

- Resolve Agent Quarantine

• Options
• Agent Configuration
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5-11-5 Advanced Information - Service Desktop and SSA (Secure Service Access)

SSA Key

The SSA key provides secure access for GE service personnel to advanced tools to service the system

• Access to all service features
• Access to Windows Desktop
• Key must be renewed every 30 days
• Tied to SSO
• Password locked via key pad

Figure 5-33  SSA Key

Item Description

1. Blue LED

2. Key Pad

3. Lock Indicators
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5-11-6 Home
Home configurations vary depending upon the purchased service level.

Figure 5-34   Home with Class C and Class M Access (R3 only)

Figure 5-35   Home with Class C and Class M Access (R4 and R4.5 only)
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Figure 5-36   Home with Class A Access (R3 only)

Figure 5-37   Home with Class A Access (R4 and R4.5 only)

For more information, see: 

• System Information on page 5-51
• Software Status on page 5-53
• System Status on page 5-55
• Disk Drive Space on page 5-67
• Network Configuration on page 5-70
• Connected Probes on page 5-72
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System Information

System Information displays general information about the LOGIQ P7/P8/P9/P10. When the LOGIQ 
P7/P8/P9/P10 has been successfully configured with the back office, these elements will have the 
corresponding values: 

• Agent Registered will be Yes
• Agent Quarantine will be No
• Agent CRM Verified will be Yes
The information on System Information is available to all service class licenses. 

To access System Information, navigate to Utility > Service > Home. 

Figure 5-38   System Information (R3 only)

Figure 5-39   System Information (R4 and R4.5 only)



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

5-52 Section 5-11 - Common Service Desktop (R3, R4 and R4.5)

This table shows all the elements available on System Information with descriptions.

For more information, see: 

• Home on page 5-49

Table 5-14    System Information

Element DESCRIPTION

CRM Number Customer Relationship Management (CRM) number. System identifier assigned to 
the customer unit by the service region.

Agent Registered

Registered status of the agent. Valid values are:
•  Yes – The agent is registered in the back office.
•  No – The agent is not registered in the back office. 
•  Not Available – The agent is not running or has not been configured.

Agent Quarantine

Quarantine status of the agent. Valid values are:
•  Yes – The agent has more than one device registered with the same CRM Number 

in the back office.
•  No – The agent has one device registered with the listed CRM Number in the back 

office.
•  Not Available – The agent is not running or has not been configured.

Agent CRM Verified

CRM verified status of the agent. Valid values are:
•  Yes – The agent is verified in the back office.
•  No – The agent is not verified in the back office. 
•  Not Available – The agent is not running or has not been configured.

Model Number GE part number for the LOGIQ P7/P8/P9/P10. The same number as listed on the 
rating plate.

Serial Number Serial number of the LOGIQ P7/P8/P9/P10. The same number as listed on the rating 
plate.

System Type Product name of the LOGIQ P7/P8/P9/P10.

Facility Name of the hospital or facility where the LOGIQ P7/P8/P9/P10 is installed. 
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Software Status

Use Software Status to view general information about the software installed on the LOGIQ P7/P8/P9/
P10. 

The information on Software Status is available to all service class licenses. 

To access Software Status, navigate to Utility > Service > Home. 

Figure 5-40   Software Status (R3 only)

Figure 5-41   Software Status (R4 and R4.5 only)

This table shows all the elements available on Software Status with descriptions.

Table 5-15    Software Status

Element DESCRIPTION

System Date Current date in the format <day>, <month> <date> <year>.

System Time Local time based on the last time the system desktop was refreshed in the format 
<hh:mm:ss>.

Application Installation Date Date the application software was installed. The application software includes the 
LOGIQ P7/P8/P9/P10 product-specific software.
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For more information, see: 

• Home on page 5-49
• Software Reload on page 5-91

Base Image Installation Date Date the base image software was installed. The base image software includes the 
Windows operating system and other supporting software.

Base Image Version Version number of the base image software. 

Application Software Version Version number of the application software.

Application Status
Status of the application. Valid values are: 
•  Running
•  Stopped

Table 5-15    Software Status

Element DESCRIPTION
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System Status

Use System Status to view status information on the LOGIQ P7/P8/P9/P10. Specifically, do the 
following: 

• View the hardware configuration file
• View temperatures for FRUs, fans, and a graphical representation of the monitored temperatures
• View voltages for FRUs
• View issues with the boot process
• View alert logs
• View USB devices connected to the LOGIQ P7/P8/P9/P10
• View the amount of time the LOGIQ P7/P8/P9/P10 has been running
• View the amount of time since the LOGIQ P7/P8/P9/P10 has last been rebooted
The information on System Status is available to Class C and Class M licenses.

To access System Status, navigate to Utility > Service > Home. 

Figure 5-42   System Status (R3 only)

Figure 5-43   System Status (R4 and R4.5 only)
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This table shows all the elements available on System Status with descriptions.

For more information, see: 

• Hardware Configuration on page 5-57
• Temperature on page 5-58
• Voltage on page 5-61
• Bootup Issues on page 5-63
• Alert Logs on page 5-65
• USB Devices on page 5-66
• Home on page 5-49

Table 5-16    System Status

Element DESCRIPTION

Hardware Configuration Displays the contents of the hardware configuration file.

Temperature

Displays the temperature monitoring of the LOGIQ P7/P8/P9/P10 as normal, 
warning, or error using the standard colors and icons. Includes temperature out-of-
spec events including an overall count of event warnings and errors for the last 30 
days or the last status checkpoint whichever is sooner. Temperature displays 
temperature a graph for the configured monitoring points.

Voltage

Displays the voltage monitoring of the LOGIQ P7/P8/P9/P10 as normal, warning or 
error using the standard colors and icons. Includes voltage out-of-spec events 
including an overall count of the event warnings and errors for the last 30 days or 
last status checkpoint whichever is sooner.

Bootup Issues Based on the latest occurrence, displays all abnormal boots of the LOGIQ P7/P8/
P9/P10 for either the past 30 days or the latest check point.

Alert Logs Based on the latest occurrence, displays all alerts generated by the LOGIQ P7/P8/
P9/P10 for either the past 30 days or the latest check point.

USB Devices Displays the USB connected devices and their status.

System On Time Displays the time the LOGIQ P7/P8/P9/P10 was turned on.

Time Since Last Reboot Displays the time the LOGIQ P7/P8/P9/P10 was last rebooted. 
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Hardware Configuration

Hardware Configuration displays the contents of the hardware configuration file which includes all the 
vital product data (VPD). 

To access Hardware Configuration, navigate to Utility > Service > Home, and then under System 
Status, select Hardware Configuration.

Figure 5-44   Hardware Configuration

This table shows all the elements available on Hardware Configuration with descriptions.

For more information, see: 

• System Status on page 5-55
• Home on page 5-49

Table 5-17    Hardware Configuration

Element DESCRIPTION

Component Hardware component.

Item Parameter with the vital product data (VPD).

Value Actual value of the Item. 
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Temperature

Use Temperature to troubleshoot problems with monitored FRUs and the fans. Specifically, use these 
pages:

• FRU Status
• Graphs
To access Temperature, navigate to Utility > Service > Home, and then under System Status, select 
Temperature.

For more information, see:

• FRU Status on page 5-59
• Graphs on page 5-60
• System Status on page 5-55
• Home on page 5-49
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FRU Status

FRU Status displays a summary of the FRUs being monitored and the details for each FRU.

To access this page, under System Status, select Temperature and then select FRU Status.

Figure 5-45   FRU Status

This table shows all the elements available on FRU Status with descriptions.

For more information, see: 

• Temperature on page 5-58
• Home on page 5-49

Table 5-18    FRU Status

Element DESCRIPTION

FRU Status Summary Number of the FRUs being monitored.

FRU Status Details

Name
Name of the FRU.
•  ETX3 – Represents the ETX 64 transmitter board.
•  ETX4 – Represents the ETX 128 transmitter board.

Status 

Status of the FRU. Valid values are: 
•  Normal – Indicates that the FRU is operating within the allowable range. 
•  Warning – Indicates that the FRU is operating close to the limit of the allowable 

range. 
•  Error – Indicates that the FRU is operating outside the allowable range.

Low Level Warning Number of low temperature warnings. 

High Level Warning Number of high temperature warnings.

Low Level Errors Number of low temperature errors.

High Level Errors Number of high temperature errors.
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Graphs

Graphs displays trend graphs for selected elements which have been selected as key indicators of 
overall temperature status inside the card rack. 

To access this page, under System Status, select Temperature and then select Graphs.

Figure 5-46   Graphs

For more information, see: 

• Temperature on page 5-58
• Home on page 5-49
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Voltage

Use Voltage to troubleshoot problems with monitored FRUs of the LOGIQ P7/P8/P9/P10.

Specifically, use these pages:

• FRU Status
To access Voltage, navigate to Utility > Service > Home, and then under System Status, select 
Voltage.

For more information, see:

• FRU Status on page 5-61
• System Status on page 5-55
• Home on page 5-49
FRU Status

FRU Status displays a summary of the voltages for the FRUs being monitored and the details for each 
FRU. 

To access this page, under System Status, select Voltage and then select FRU Status.

Figure 5-47   FRU Status
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This table shows all the elements available on FRU Status with descriptions.

For more information, see:

• Voltage on page 5-61
• Home on page 5-49

Table 5-19    FRU Status

Element DESCRIPTION

Name Name of the FRU.

Status

Status of the voltage for the FRU. Valid values are: 
•  Normal – Indicates that the voltage is within the allowable range. 
•  Warning – Indicates that the voltage is close to the limit of the allowable range. 
•  Error – Indicates that the voltage is outside the allowable range.

Lower Limit Warnings Number of low limit voltage warnings.

Upper Limit Warnings Number of high limit voltage warnings.

Lower Limit Errors Number of low limit voltage errors.

Upper Limit Errors Number of high limit voltage errors.
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Bootup Issues

Bootup Issues displays a summary of bootup issues detected by the system that prevented normal 
scanning, shutdowns, or abnormal statuses.

To access this page, under System Status, select Bootup Issues.

Figure 5-48   Bootup Issues

Figure 5-49   Bootup Issues with Missing Devices
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This table shows all the elements available on Bootup Issues with descriptions.

For more information, see:

• System Status on page 5-55
• Home on page 5-49

Table 5-20    Bootup Issues

Element DESCRIPTION

ID Identifier for the system software boot. For example, 10 for the tenth boot and so on.

Timestamp Date and time that the associated issue for the boot occurred. 

Cycle Count
Number of times EchoLoader was restarted during the associated boot. 
•  0 - Normal. EchoLoader started without attempting a restart. 
•  1 or more - Indicates the number if times EchoLoader attempted to restart.

Missing Devices Displays the devices that were missing during the boot. 

Incompatible Board Displays whether an incompatible board exists. 

Battery State ID Type of battery detected. For example, EPS or PA. Invalid displays if no battery was 
detected.

Previous Boot Crash Dump
Displays whether a crash dump has occurred. Valid values are:
•  1 - Indicates a crash dump has occurred in the previous boot.
•  0 - Normal. No crash dump has occurred.

Warm Boot
Displays whether a warm boot has occurred. Valid values are: 
•  1 - The system was rebooted.
•  0 - The system was started after a shutdown.

AC Fail
Displays whether an AC failure occurred during the boot. Valid values are: 
•  1 - There was an AC failure in the boot. 
•  0 - Normal. No AC failure has occurred.

Abnormal Context

Displays whether the software has booted to a stable state (Interface manager 
successfully initiated). Valid values are:
•  1 - The system has not booted to a stable state. Only abnormal logs display.
•  0 - Normal. The system initialized to a stable state. 

Exit Requested Displays the type of exit that has been requested. For example, 4 displays the 
operating system was restarted. 

Echoloader Exit Code Displays the exit code generated by EchoLoader. 0 indicates that Echoloader exited 
without any issues. 

Echoloader Exit String Displays the type of exit requested by EchoLoader. For example, restart the 
operating system or exit the application software.
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Alert Logs

Alert Logs displays the details for each alert. Alerts are status logs typically reported as a result of an 
error. Alerts are sent to the back office to be managed and reported to service.

To access this page, under System Status, select Alert Logs.

Figure 5-50   Alert Logs

This table shows all the elements available on Alert Logs with descriptions.

For more information, see:

• System Status on page 5-55
• Home on page 5-49

Table 5-21    Alert Logs

Element DESCRIPTION

Alert ID Identifier for the alert log that has been sent to the back office.

Sub System Hardware component.

Rule Code for the alert. Alerts are filtered in the back office using rule codes.

Description Description of the alert log.

Value Current value read for the associated hardware component. 

Lower Limit Value for the lower limit for the associated hardware component. 

Upper Limit Value for the upper limit for the associated hardware component. 

Severity

Severity of the alert. These are the valid values:
•  1 - Error. Out of specification
•  2 - Warning
•  3 - Normal

First Alert Time Time the alert first occurred. 

Last Alert TIme Time the alert last occurred. 

Last Alert Local Time Time (local) the alert last occurred.

Last Alert Sent Time Time the alert was last sent to the back office. 

Count Number of times that the alert has occurred. 
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USB Devices

USB Devices displays the details for each USB device. 

To access this page, under System Status, select USB Devices.

Figure 5-51   USB Devices

This table shows all the elements available on USB Devices with descriptions.

For more information, see:

• System Status on page 5-55
• Home on page 5-49

Table 5-22    USB Devices

Element DESCRIPTION

Name Name of the USB device.

Serial Number Serial number of the USB device.

Speed Speed of the USB device. For example, USB 3.0. 

HW Version Hardware version of the USB device.

SW Version Software version of the USB device.

Status Status of the USB device.
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Disk Drive Space

Use Disk Drive Space to view the hard drive partitions including total size and available free space in 
GB. Includes the overall health of the drive in one of these colors: 

• Red – Available free space is less than 10% of the total size.
• Orange – Available free space is more than 10% and less than 20% of the total size.
• Green – Available free space is more than 20% of the total size.
Each partition displays these encryption statuses:

• Conversion status
• Percentage encrypted
• Encryption method
• Protection status
• Lock status
The information on Disk Drive Space is available to Class C and Class M licenses.

To access Disk Drive Space, navigate to Utility > Service > Home.

Figure 5-52   Disk Drive Space
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Figure 5-53   E: Drive Details
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This table shows all the elements available on Disk Drive Space with descriptions.

For more information, see: 

• Home on page 5-49

Table 5-23    Disk Drive Space

Element DESCRIPTION

C: Drive
C: partition shows the graphical representation of the following:
•  Used space in GB
•  Available free space in GB

D: Drive

D: partition shows the graphical representation of the following:
•  Service
•  Logs
•  Temp
•  Export
•  Service configuration
•  Misc
•  Available free space in GB

E: Drive

E: partition shows the graphical representation of the following:
•  Print spooler
•  Clipboard
•  Dicom spooler
•  Misc
•  Available free space in GB

V: Drive
V: partition shows the graphical representation of the following:
•  Misc
•  Available free space in GB

Z: Drive

Z: partition shows the graphical representation of the following:
•  Package repository
•  Misc
•  Available free space in GB
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Network Configuration

Use Network Configuration to view network (wired and wireless) information (the full ipconfig details) 
for the network configured with the LOGIQ P7/P8/P9/P10. 

The information on Network Configuration is available to Class C and Class M licenses.

To access Network Configuration, navigate to Utility > Service > Home. 

Figure 5-54   Network Configuration

Figure 5-55   Network Configuration with More Details



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 5 - Components and Functions (Theory) 5-71

This table shows all the elements available on Network Configuration with descriptions.

For more information, see: 

• Home on page 5-49

Table 5-24    Network Configuration

Element DESCRIPTION

Host Name Name of the local host for the LOGIQ P7/P8/P9/P10. 

More Details Displays the ipconfig details.

Wired Connection

lpV4 Address Local IP address for the wired network connection.

lpV6 Address Local IP address for the wired network connection.

Subnet Mask Local subnet mask for the wired network. 

Default Gateway Default gateway for the wired network. 

MAC Address Address for the MAC for the wired network.

Speed (Mbps) Speed of the wireless connection.

Wireless Connection

IP Address IP address for the wireless network connection.

Subnet Mask Subnet mask for the wireless connection.

Default Gateway Default gateway for the wireless connection. 

MAC Address Address for the MAC for the wireless connection.

Speed (Mbps) Speed of the wireless connection.

Status Current status of the wireless connection. 
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Connected Probes

Connected Probes shows probes connected to the LOGIQ P7/P8/P9/P10. The order on the user 
interface is top down matching the left-to-right order on the LOGIQ P7/P8/P9/P10. 

The information on Connected Probes is available to all service class licenses.

To access Connected Probes, navigate to Utility > Service > Home. 

Figure 5-56   Connected Probes

This table shows all the elements available on Connected Probes with descriptions.

For more information, see: 

• Home on page 5-49

Table 5-25    Connected Probes

Element DESCRIPTION

Active Probe Temperature 
(Celsius)

When available, temperature of the active probe. 
Not all probes report temperature. The most common probe to report temperature is 
the TEE probe.

Probe Name Name of the probe connected to the LOGIQ P7/P8/P9/P10.

Probe ID Identifier of the probe connected to the LOGIQ P7/P8/P9/P10.

Serial Number Serial number of the probe connected to the LOGIQ P7/P8/P9/P10. If the serial 
number of the probe is not available, then N/A displays.

Status
Statuses of the probe connected to the LOGIQ P7/P8/P9/P10. Valid values are: 
•  Active 
•  Non Active
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5-11-7 Diags
Use Diags to troubleshoot functionality with hardware components. With an active Service PRO 
license, probe diagnostics will be available. Specifically, use these pages: 

• Run Diags – Run diagnostics on hardware components.
• Diag History – View a history of the diagnostics you have run and the results. 

NOTE: Reboot the system after performing any diagnostics before returning the LOGIQ P7/P8/P9/P10 
to customer use.

For more information, see:

• Run Diags on page 5-73
• Diag History on page 5-77
Run Diags

With Disruptive mode set to On, use Run Diags to run diagnostics on hardware components with the 
LOGIQ P7/P8/P9/P10. For information on disruptive mode, see Disruptive Mode on page 5-105.

The information on Run Diags is available to Class C and Class M licenses.

To access Run Diags, navigate to Utility > Service > Diags > Run Diags. 

Figure 5-57   Run Diags
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This table shows all the elements available on Run Diags with descriptions.

Table 5-26    Run Diags

Element DESCRIPTION

Service Menu Available service diagnostics in a diagnostics tree.

Engineering Menu Available engineering diagnostics in a diagnostics tree.

Clear All Resets the selections within the diagnostics tree.

Selected Diagnostics Diagnostics that have been selected. 

Diagnostic Detail

Test Name Name of the diagnostic.

Last Execution Result Result of the diagnostic run.

Expected Execution Time Time expected to run the diagnostic.

Maximum Execution Time Maximum amount of time allowed to run the diagnostic. 

Instruction Special instructions needed in order to perform the diagnostic. 

Diagnostic Controls

Execution Mode

Way the diagnostic behaves when a failure occurs. Valid values are:
•  Continue on Failure
•  Finish Loop and Stop on Failure
•  Stop on Failure

Loop Count Number of times to run the selected diagnostic.

Start Starts the selected diagnostic.

Stop Stops the selected diagnostic.

Reset Clears the current diagnostic information.

Total Progress

Current Progress Progress the current diagnostic.

Total Progress Progress for all of the selected diagnostics. 

Diagnostic Results Summary

Diag Name Name of the diagnostic. 

Date/Time Date and time of the diagnostic run.

Diag Run Time Amount of time taken to run the diagnostic.

Overall Status Current status of the diagnostic.

Pass/Fail
Whether the selected diagnostic passed or failed.
•  Green - Diagnostic passed
•  Red - Diagnostic failed
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To run a diagnostic:

1.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set 
Disruptive mode to On.

2.) Navigate to Utility (second page) > Service > Diags > Run Diags.
3.) From the Service Menu tab, select the diagnostic (for example, GRLY with Probes). The Selected 

Diagnostics and Diagnostic Detail areas populate with information specific to the selected 
diagnostic.

4.) In Execution Mode, select the desired mode. 
5.) In Loop Count, select the number of times to run the diagnostic. 
6.) Click Start.

Figure 5-58   (R3)

Figure 5-59   (R4 and R4.5)
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7.) View progress in the Total Progress area.
8.) View the results (Passed or Failed) in the Diagnostic Results Summary area. 

Figure 5-60   (R3)

Figure 5-61   (R4 and R4.5)

9)
10.)To view details about the diagnostics run, see Diag History on page 5-77. 
For more information, see:

• Diags on page 5-73
• Diag History on page 5-77
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Diag History

Use Diag History to view a history of the diagnostics run on the LOGIQ P7/P8/P9/P10 and the results. 

The information on Diag History is available to Class C and Class M licenses.

To access Diag History, navigate to Utility > Service > Diags > Diag History.

Figure 5-62   Diag History

This table shows all the elements available on Diag History with descriptions.

Table 5-27    Diag History

Element DESCRIPTION

Checkpoints

Select All Selects all of the available checkpoints in the list. 

Controls

All Filters results to show all of the diagnostics. 

Failed Filters results to show failed diagnostics.

Get History Select to display a history of the run diagnostics.

Runs

List of diagnostics run on the LOGIQ P7/P8/P9/P10.

Diagnostic Results History

Details about the diagnostics run. 
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To view a history of diagnostics: 

1.) Navigate to Utility (second page) > Service > Diags > Diag History.
2.) Select the options that you want to view. 
3.) Click Get History. 
4.) View the results of your query.
5.) To view specific details, click Details

For more information, see:

• Diags on page 5-73
Run Diags on page 5-73
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5-11-8 DICOM
Use DICOM to troubleshoot DICOM components and connectivity. Specifically, use these pages: 

• DICOM Service Status
• DICOM Spooler
For more information, see:

• DICOM Service Status on page 5-79
• DICOM Spooler on page 5-81
DICOM Service Status

DICOM Service Status displays information on the DICOM components and connectivity. Use DICOM 
to test the connectivity of all the available DICOM devices or individual DICOM devices. In addition, you 
can: 

• View DICOM details
• View DICOM connectivity status
• Stop a service
• Ping a single service
• Ping all services
DICOM connectivity status displays as green or red.

• Green means that the DICOM ping passed
• Red means that the DICOM ping failed
The information on DICOM Service Status is available to Class C and Class M licenses.

To access DICOM Service Status, navigate to Utility > Service > DICOM > DICOM Service Status. 

Figure 5-63   DICOM Service Status
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This table shows all the elements available on DICOM Service Status with descriptions.

For more information, see:

• DICOM on page 5-79
• DICOM Spooler on page 5-81

Table 5-28    DICOM Service Status

Element DESCRIPTION

DICOM Details

AE Title of Console Application entity title of the LOGIQ P7/P8/P9/P10. 

Port No of Console Port number of the LOGIQ P7/P8/P9/P10.

DICOM Connectivity Status

Service Name Name of the DICOM services configured for the LOGIQ P7/P8/P9/P10.

Status

Status of the DICOM service. Valid values are:
•  OK
•  Not Ok
•  Not Ping
•  Ping in progress
•  Queued

Error Details Details for any errors associated DICOM services.

Type Type of error. 

Device Name Name of the device.

AE Title Application entity title for the device.

IP Address IP address for the device.

Port Port for the device.

Ping Device Select to confirm that a device is connected or not.
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DICOM Spooler

DICOM Spooler provides a summary of the current and recent outgoing jobs. 

The information on DICOM Spooler is available to Class C and Class M licenses.

To access DICOM Spooler, navigate to Utility > Service > DICOM > DICOM Spooler. 

Figure 5-64   DICOM Spooler
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This table shows all the elements available on DICOM Spooler with descriptions.

For more information, see:

• DICOM on page 5-79
• DICOM Service Status on page 5-79

Table 5-29    DICOM Spooler

Element DESCRIPTION

Job Status Displays the number of jobs for each type by status. For example, Pending.

Spooler Health

DICOM Spooler Space allotted to DICOM jobs on the E: drive. 

Free Space Available space on the E: drive.

Total Size of the E: Drive Total space on the E: drive.

Spooler Summary

Job ID Number for the job. 

Job Status

Current status of the job. These are the valid values: 
•  Pending
•  Active
•  Hold
•  Done
•  Success
•  Failed

Job Type

Type of job. These are the valid values: 
•  Storage – Images
•  Structured Reports
•  Key Image Notes
•  STC – Storage Commitment
•  MPPS – Modality Performed Procedure Step

Destination Name of service receiving the objects.

Age Amount if time the job has been in the spooler.

Spooler Entry time Time the job entered the spooler.

Transfer time Time the job was transferred from the spooler.

Job Size Size of the job.

Error details If applicable, details for the error. 
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5-11-9 Utilities
Utilities configurations vary depending upon the service class.

For more information, see:

• Change Password on page 5-89
• Checkpoints on page 5-103
• Clean Userdefs on page 5-96
• Data Transfer on page 5-106
• Delete Files on page 5-86
• Disable Remote Connectivity on page 5-87
• Disk Defragment on page 5-84
• Disruptive Mode on page 5-105
• Gather Logs on page 5-85
• Network Capture on page 5-111
• Reset Patient Database on page 5-95
• SSA License on page 5-99
• SSH on page 5-110
• Software Reload on page 5-91
• System Shutdown on page 5-101
• Third Party Software Licenses on page 5-98
• Virtual Console Observation on page 5-88
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Disk Defragment

Disk Defragment provides a way to launch the Windows Disk Defragmenter tool to use to defragment 
the disks. Disk fragmentation can reduce the amount of disk space available, and slow computing 
speed. Use the disk defragmenter to restore optimum disk space and speed performance. If LOGIQ P7/
P8/P9/P10 performance would be significantly reduced when the disk is being defragmented, a warning 
message displays. It is not possible to analyze the SSH drives. 

The information on Disk Defragment is available to Class C (Service Advanced) and Class M licenses. 
Disk Defragment is not available through a remote connection.

To access Disk Defragment, select Utility (second page) > Service > Utilities > Disk Defragment.

Figure 5-65   Disk Defragment

To analyze, optimize, or schedule optimization for a disk:

1.) Navigate to Utility (second page) > Service > Utilities > Disk Defragment.
2.) Click Launch Disk Defragmenter.
3.) In the Optimize Drives dialog box, select the drive.

4.) To analyze the selected drive, click Analyze.
5.) To optimize the selected drive, click Optimize.
6.) To set up a schedule, click Change settings and select the schedule.
For more information, see: 

• Utilities on page 5-83
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Gather Logs

Gather Logs provides a way to collect system logs and place the log files in the D:\Service directory for 
retrieval by the online center. These log files do not include protected data such as crash dumps and 
keyboard shadow logs. The customer can collect logs (including protected data) using Alt+D when 
Protected Data is checked. Log files are compressed into a .zip file and the file path and name display. 
If the application software is not running, use the Gather Logs shortcut on the Windows desktop.

The information on Gather Logs is available to all service class licenses. 

To access Gather Logs, select Utility (second page) > Service > Utilities > Gather Logs.

Figure 5-66   Gather Logs

This table shows all the elements available on Gather Logs with descriptions.

To gather log files: 

1.) Navigate to Utility (second page) > Service > Utilities > Gather Logs.
2.) Select one of the following: 

- 1 Day Logs
- 1 Week Logs
- All Logs

3.) Click Gather Logs. In the resulting dialog box, record the location of the log files and click OK. 
4.) When the gather log operation is complete, click the notification icon in the banner to view the 

location of the log files. 

For more information, see: 

• Utilities on page 5-83

Table 5-30    Gather Logs

Element DESCRIPTION

1 Day Logs When selected, gathers log files for one day.

1 Week Logs When selected, gathers log files for one week.

All Logs When selected, gathers all available log files. 

Gather Logs Select to gather the log files for the selected time period. 
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Delete Files

Delete Files displays all the files and folders present in the D:\Service folder and allows for their 
deletion. Deleting unneeded files improves performance and reduces the need to defragment the disk 
drive.

The information on Delete Files is available to all service class licenses.

To access Delete Files, select Utility (second page) > Service > Utilities > Delete Files.

Figure 5-67   Delete Files

This table shows all the elements available on Delete Files with descriptions.

To delete files:

1.) Navigate to select Utility (second page) > Service > Utilities > Delete Files.
2.) Under Delete Files, select the available folders and files that you want to delete. 
3.) Click Delete.
4.) In the resulting dialog box, click Delete and then click OK.
For more information, see:

• Utilities on page 5-83

Table 5-31    Delete Files

Element DESCRIPTION

Delete Files Displays the files that are available for deletion. 

Delete Deletes the selected files.



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 5 - Components and Functions (Theory) 5-87

Disable Remote Connectivity

This utility will uninstall remote connectivity items like Agent Configuration, SSH and Virtual Console 
Observation (VCO) from Service Desktop. If remote connectivity is disabled, then the Submit Changes 
button on Agent Configuration and the Start/Stop buttons for SSH and VCO will all be disabled. In 
addition, some scripts will execute to make the LOGIQ P7/P8/P9/P10 more secure.

NOTE: If you have disabled remote connectivity and then performed a software reload, you will have 
to disable remote connectivity again. 

To access Disable Remote Connectivity, navigate to Utility (second page) > Service > Utilities, and then 
select Disable Remote Connectivity.

Figure 5-68   Disable Remote Connectivity

To disable remote connectivity:

1.) Navigate to Utility (second page) > Service > Utilities, and then select Disable Remote Connectivity.
2.) Select Disable Remote Connectivity.
3.) To disable connectivity to the LOGIQ P7/P8/P9/P10 through Agent Configuration, SSH, and Virtual 

Console Observation, click OK.
4.) Once connectivity has been disabled, select OK again.
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Virtual Console Observation

Virtual Console Observation displays the status of the VNC server. Virtual console observation (VCO) 
is normally used to remotely access and modify settings and programs.

The information on Virtual Console Observation is available to Class M licenses. Virtual Console 
Observation is not available through a remote connection.

To access Virtual Console Observation, select Utility (second page) > Service > Utilities > Virtual 
Console Observation.

Figure 5-69   Virtual Console Observation

This table shows all the elements available on Virtual Console Observation with descriptions.

To start virtual console observation: 

1.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set 
Disruptive mode to On. 

2.) Navigate to Utility (second page) > Service > Utilities > Virtual Console Observation.
3.) Select Start. When VCO starts, the Windows task bar and Windows desktop display.
4.) Modify settings and programs as needed. 
5.) To stop virtual console observation, click Stop. When VCO is stopped, the Windows desktop is 

hidden.
6.) Restart the LOGIQ P7/P8/P9/P10.
For more information, see: 

• Utilities on page 5-83

Table 5-32    Virtual Console Observation

Element DESCRIPTION

Status
When Disruptive mode is on, displays the status of the VNC server. Valid values are: 
•  VCO is stopped
•  VCO is running

Start When Disruptive mode is ON, starts the VNC server.

Stop When Disruptive mode is ON and the VNC server is running, stops the VNC server.
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Change Password

Change Password allows you to change the password for a specified user type.

The information on Change Password is available to all service class licenses. Change Password is 
not available through a remote connection.

To access Change Password, select Utility (second page) > Service > Utilities > Change 
Password.

Figure 5-70   Change Password

This table shows all the elements available on Change Password with descriptions.

CAUTION RISK OF LOSING DATA.
IF THE PASSWORD IS LOST, GE WILL NOT BE ABLE TO RECOVER OR RESET IT. 
LOSS OF A PASSWORD MAY RESULT IN THE LOSS OF PATIENT DATA.

Table 5-33    Change Password

Element DESCRIPTION

User Type Type of user for the password reset.

New Password Password

Confirm Password Password

Update Password Select to update the password.

Reset Select to reset the information. 
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To change the password: 

1.) Navigate to Utility (second page) > Service > Utilities > Change Password.
2.) Under User Type, select the user. 

NOTE: Before changing the GEService password (the default is SvcForward123$), make sure the 
LOGIQ P7/P8/P9/P10 is connected to the network and the agent is configured. The GEService 
password is used to perform portions of remote service. If the password is changed and the 
system information is not updated, it may slow down remote service. Both file transfer and SSH 
depend on the GEService password.

3.) In New Password and Confirm Password, enter the new password. 

4.) Click Update Password.
5.) When a SVCService user password has been changed, reboot the LOGIQ P7/P8/P9/P10 to reflect 

the password change.
For more information, see: 

• Utilities on page 5-83

CAUTION RISK OF LOSING DATA.
GE WILL NOT BE ABLE TO RECOVER OR RESET CHANGED PASSWORDS. 
SECURELY RECORD THE NEW PASSWORD.
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Software Reload

Software Reload displays versions of the base image, application software, base patch, service 
platform, and documentation packages currently installed on the LOGIQ P7/P8/P9/P10. Software 
Reload reimages the C:\ drive and installs the base image. 

• If the drives are encrypted, Software Reload will have a catastrophic effect if the customer does 
not have the recovery key. All patient data will be lost.

• If the drives are not encrypted, software can be reloaded without a recovery key. 
With Disruptive mode set to On, reload these software versions from repository partition on the hard 
drive. The software reload is automatic without any loss of presets, patient data, or connectivity settings. 

The information on Software Reload is available to Class C (Service Advanced) and Class M licenses.
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To access Software Reload, select Utility > Service (second page) > Utilities > Software Reload.

Figure 5-71   Software Reload (R3 only)

Figure 5-72   Software Reload (R4 and R4.5)
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This table shows all the elements available on Software Reload with descriptions.

Table 5-34    Software Reload

Element DESCRIPTION

Base Image Version Displays the version number of the base image software.

Base Patch Version Displays the version number of the base patch.

Application Software Version Displays the version number of the application software.

Service Platform Version Displays the version number of the service platform.

Documentation Version Displays the version number for the documentation. 

Software Reload Reloads the versions listed.
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To reload software: 

1.) If the drives are encrypted, obtain the recovery key.
2.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set 

Disruptive mode to On.
3.) Navigate to Utility (second page) > Service > Utilities > Software Reload.
4.) View the current version numbers.
5.) Click Software Reload.

6.) If you have a recovery key, select I have a recovery key and then click Continue.

7.) If you have a recovery key, select I Agree and then click Continue Reload. 

For more information, see: 

• Utilities on page 5-83

CAUTION RELOADING SOFTWARE WITHOUT A RECOVERY KEY WILL RESULT IN THE LOSS OF 
PATIENT DATA. 
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Reset Patient Database

Reset Patient Database resets the LOGIQ P7/P8/P9/P10 patient database. This operation 
automatically shuts down the application before cleaning the patient database. Once the operation is 
complete, the LOGIQ P7/P8/P9/P10 reboots with an empty database. Disruptive mode must be On to 
reset the patient database. If Disruptive mode is Off, a warning message displays asking to turn on 
Disruptive mode.

Reset Patient Database deletes the contents of the following folders:

• E:\Scanner\GEMS_IMG
• E:\Scanner\GEMS_REP
The information on Reset Patient Database is available to Class C (Service Advanced) and Class M 
licenses.

To access Reset Patient Database, select Utility (second page) > Service > Utilities > Reset 
Patient Database.

Figure 5-73   Reset Patient Database

This table shows all the elements available on Reset Patient Database with descriptions.

To reset the patient database:

1.) Back up the patient database. 
2.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set 

Disruptive mode to On. 
3.) Navigate to Utility (second page) > Service > Utilities > Reset Patient Database.
4.) Click Reset Patient Database.
5.) Confirm the patient database has been emptied. 
For more information, see: 

• Utilities on page 5-83

Table 5-35    Reset Patient Database

Element DESCRIPTION

Instruction Information about the database reset.

Reset Patient Database When Disruptive mode is ON, resets the LOGIQ P7/P8/P9/P10 patient database.
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Clean Userdefs

Clean Userdefs provides a way to delete user-defined data when user presets may be inhibiting proper 
operation. User-defined data returns to the user-defined settings to the factory default values. Clean 
Userdefs provides information to backup the current settings if you want to use them later. Disruptive 
mode must be On to clean user-defined data. If Disruptive mode is Off, a warning message displays 
asking to turn on Disruptive mode.

Before cleaning user-defined data, the LOGIQ P7/P8/P9/P10 application software automatically shuts 
down. Once the operation is complete, the system reboots.

Clean Userdefs provides a way to selectively delete the following user-defined data:

• Connectivity – Deletes this file: %TEST_ROOT%\resources\userdefs\connectivity.res
• Imaging – Deletes this folder: %TEST_ROOT%\resources\userdefs\ImagingPresets\
• Measurement – Delete this folder: %TEST_ROOT%\resources\userdefs\EchoMeasure\
• Annotation/Bodymark – Deletes the folder: %TEST_ROOT%\resources\userdefs\EchoAnnotation\
• Scan Assistant – Deletes the folder: %TEST_ROOT%\resources\userdefs\EchoExamProtocol
The information on Clean Userdefs is available to Class C (Service Advanced) and Class M licenses.

To access Clean Userdefs, select Utility (second page) > Service > Utilities > Clean Userdefs.

Figure 5-74   Clean Userdefs

This table shows all the elements available on Clean Userdefs with descriptions.

Table 5-36    Clean Userdefs

Element DESCRIPTION

All When Disruptive mode is ON, deletes all of the user-defined data and returns the 
LOGIQ P7/P8/P9/P10 to factory default settings.

Selective Delete When Disruptive mode is ON, deletes the selected user-defined data.

Connectivity When Selective Delete is selected, deletes this file: 
%TEST_ROOT%\resources\userdefs\connectivity.res

Imaging When Selective Delete is selected, deletes this folder: 
%TEST_ROOT%\resources\userdefs\ImagingPresets\

Measurement When Selective Delete is selected, delete this folder: 
%TEST_ROOT%\resources\userdefs\EchoMeasure\

Annotation/Body Patterns When Selective Delete is selected, deletes this folder: 
%TEST_ROOT%\resources\userdefs\EchoAnnotation\

Scan Assistant When Selective Delete is selected, deletes this folder: 
%TEST_ROOT%\resources\userdefs\EchoExamProtocol 

Clean Userdefs Restarts the application software with a fresh database.
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To clean user-defined data: 

1.) If you want to use the current settings later, back them up now. 
2.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set 

Disruptive mode to On. 
3.) Navigate to Utility (second page) > Service > Utilities > Clean Userdefs.
4.) Select the data you want to set to the default settings.
5.) Click Clean Userdefs. 
For more information, see: 

• Utilities on page 5-83
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Third Party Software Licenses

Third Party Software Licenses displays the third-party software licenses used as part of the service 
platform.

The information on Third Party Software Licenses is available to all service class licenses.

To access Third Party Software Licenses, select Utility (second page) > Service > Utilities > Third 
Party Software Licenses.

Figure 5-75   Third Party Software Licenses

For more information, see: 

• Utilities on page 5-83
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SSA License

SSA License provides a way to do the following:

• When inserted, view the details of an SSA key.
• View the status of the service class options.
• Restore an SSA license when the SSA key is not validating or when a remote log in shows as a 

Class A user.
The information on SSA License is available to all service class licenses.

To access SSA License, select Utility (second page) > Service > Utilities > SSA License.

Figure 5-76   SSA License

This table shows all the elements available on SSA License with descriptions.

Table 5-37    SSA License

Element DESCRIPTION

Class M Key Details

Class M Key Status
Status of the SSA key. Valid values are:
•  Not Plugged In
•  Plugged In

Drive Letter Drive where the SSA key is plugged into the LOGIQ P7/P8/P9/P10. 

Expire Date Date the SSA key is set to expire. 

SSO ID Identifier for the user assigned to the SSA key.

Key Counter Value Number of times the SSA key has been used.

Max Key Counter Value Number of remaining times the SSA key can be used. 

Service Option Keys

Name Name of the service class option.

Status
Status of the access to the associated service class option. Valid values are: 
•  True
•  False

Restore SSA Restores the SSA license to the SSA key. 
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To view the Class M license information:

1.) Insert the SSA key.
2.) Navigate to Utility (second page) > Service > Utilities > SSA License.
3.) Under Class M key Details, view the values. For example, the SSO ID for the user assigned to the 

SSA key. 
If Not Available displays for all of these values, the SSA key is not validating.

To restore an SSA key that is not validating:

1.) Remove the SSA key from the LOGIQ P7/P8/P9/P10.
2.) If open, close the Service desktop. 
3.) Restart the LOGIQ P7/P8/P9/P10.
4.) Once the LOGIQ P7/P8/P9/P10 has restarted, plug in the SSA key.
5.) Navigate to Utility (second page) > Service > Utilities > SSA License.
6.) Click Restore SSA.
7.) Check to see if the SSA key validates.
For more information, see: 

• Utilities on page 5-83
• SSA key on page 7-32
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System Shutdown

With remote access, System Shutdown provides a way to shut down or restart the LOGIQ P7/P8/P9/
P10. Disruptive mode must be On to shut down or restart the LOGIQ P7/P8/P9/P10. If Disruptive mode 
is Off, a warning message displays.

The information on System Shutdown is available to Class M licenses.

To access System Shutdown, select Utility (second page) > Service > Utilities > System 
Shutdown.

Figure 5-77   System Shutdown

This table shows all the elements available on System Shutdown with descriptions.

Table 5-38    System Shutdown

Element DESCRIPTION

Select Operation

Shutdown System When Disruptive mode is On, shuts down the LOGIQ P7/P8/P9/P10 when Submit 
Request is pressed.

Restart System When Disruptive mode is On, restarts the LOGIQ P7/P8/P9/P10 when Submit 
Request is pressed.

Shutdown Application When Disruptive mode is On, shuts down the application software when Submit 
Request is pressed.

Disruptive Mode

Retain Disruptive Mode
Determines whether Disruptive mode is retained after an operation has been 
performed. Generally used by the remote engineer to regain access to disruptive 
functions after a reboot without having to request Disruptive mode be enabled again.

Submit Request Performs the operation selected under Select Operation. 
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To remotely start, restart, or shut down the LOGIQ P7/P8/P9/P10:

1.) Navigate to Utility (second page) > Service > Utilities > Disruptive Mode Utility and set 
Disruptive mode to On. 

2.) Navigate to Utility (second page) > Service > Utilities > System Shutdown and then select an 
operation: 
- To shut down the LOGIQ P7/P8/P9/P10, select Shutdown System. 
- To restart the LOGIQ P7/P8/P9/P10, select Restart System. 
- To shut down the application software, select Shutdown Application. 

3.) To retain the current setting for Disruptive mode, select Retain Disruptive Mode.
4.) Click Submit Request.
For more information, see: 

• Utilities on page 5-83
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Checkpoints

Checkpoints allows for the creation of checkpoints and displays the history of those checkpoints. 
Checkpoints are used to indicate when the LOGIQ P7/P8/P9/P10 has been serviced, status has been 
reset, and information related to the service performed has been added.

The information on Checkpoints is available to Class C (Service Advanced) and Class M licenses.

To access Checkpoints, select Utility (second page) > Service > Utilities > Checkpoints.

Figure 5-78   Checkpoints

This table shows all the elements available on Checkpoints with descriptions.

Table 5-39    Checkpoints

Element DESCRIPTION

Checkpoints History

Checkpoint Displays the name of the checkpoint. 

Service Personnel Displays the ID for the logged in user.

Action Displays the service action.

Comment Displays comment text entered when the checkpoint was created.

Service Checkpoint Displays whether the checkpoint is a service checkpoint or not.

Create Checkpoint

Action

Selects the service action. Value values are
•  Scheduled Maintenance
•  Unscheduled Maintenance
•  Upgrade
•  FMI

Service Personnel

ID for the logged in user. Value values are:
•  SSO ID: When a Class M key is plugged in, the SSO ID for the logged in user.
•  Remote user ID: If there is a remote connection, the remote user ID. 
•  User ID: If the SSO ID and remote user ID are not available, the user ID for the 

logged in user.
•  Unknown: The logged in user ID is not available.

Comment Enter comments for creating a checkpoint.

Service Checkpoint Select whether to mark a service checkpoint or not.

Save Saves the information.
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To create a check point:

1.) Navigate to Utility (second page) > Service > Utilities > Checkpoints. 
2.) Under Create Checkpoints, from Action, select the action.
3.) In Comment, enter notes for the checkpoint.
4.) If this is a checkpoint for service, select Service Checkpoint. 
5.) Click Save. 
For more information: 

• Utilities on page 5-83
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Disruptive Mode

Disruptive Mode provides a way to enable and disable Disruptive mode. When enabled, Disruptive 
mode allows a remote user to access the LOGIQ P7/P8/P9/P10 which can disrupt normal operation of 
the LOGIQ P7/P8/P9/P10. Disruptive mode can be remotely turned on when the logged-in user has 
Authorize Remote Service Access privilege. If the logged-in user does not have remote service 
privilege, displays this error message: “You do not have the required permission to perform this 
operation.”

When initiating Disruptive mode from a remote location, a message displays on the LOGIQ P7/P8/P9/
P10 asking whether the user will allow Disruptive mode and notifying them that normal operation might 
be disturbed.

• If Yes is selected, then Disruptive mode is turned on.
• If No is selected, then Disruptive mode is not turned on and an error message displays saying that 

permission to change the mode was denied.
When Disruptive mode is On, the GE icon in the status bar changes to red and displays this message: 
"Due to Service testing restart needed."

When Disruptive mode is changed to Off, the GE icon turns white and displays this message: "Due to 
Service testing restart needed." In addition, VCO and SSH stop if running.

The information on Disruptive Mode is available to Class C (Service Advanced) and Class M licenses.

To access Disruptive Mode, select Utility (second page) > Service > Utilities > Disruptive Mode 
Utility.

Figure 5-79   Disruptive Mode (R3 only)

Figure 5-80   Disruptive Mode (R4 and R4.5 only)

For more information: 

• Utilities on page 5-83

Enables Disruptive
Mode and VCO
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Data Transfer

Data Transfer provides a way to do the following:

• View information about past transfers of (APM) information.
• Set up automatic/scheduled transfer of allowed data files from the LOGIQ P7/P8/P9/P10 to the 

server. 
• Manually transfer data files allowed data files from the LOGIQ P7/P8/P9/P10 to the server.
The information on Data Transfer is available to all service class licenses.

To access Data Transfer, select Utility (second page) > Service > Utilities > Data Transfer.

Figure 5-81   Data Transfer (R3 only)

Figure 5-82   Data Transfer (R4 and R4.5 only)



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 5 - Components and Functions (Theory) 5-107

This table shows all the elements available on Data Transfer with descriptions.

Table 5-40    Data Transfer

Element DESCRIPTION

Type of Upload

Type of log file. For example, Incremental Logs or Full Logs. Monitoring Logs, 
System Logs, and Windows Logs are incrementally transferred when automatic 
transfer is enabled. To enable automatic transfer, navigate to System Admin and, 
under Service, check Enable Automatic Request for Service. 

Upload Permission Whether the permission to upload the log file is allowed or not. 

Last Upload Status Whether the last log file upload was successful or not.

Last Upload Attempt Date and time the last log file upload was attempted.

Last Successful Upload Date and time the last log file was successfully uploaded.

Scheduler When selected, enables the related day selections. For example, All Days, 
Monday, and Tuesday. 

Save Settings Saves the information.

Send All Manually send the selected log files to the server.
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To configure automatic data transfers:

1) On System Admin, configure these settings:
- Transfer Machine Logs to GE – Default is checked
- Transfer Operator Information to GE
- Transfer Images (captured without patient information) to GE – Default is checked.
- Enable Automatic Probe Diagnostics – Default is unchecked. (R4.5 only)

When Enable Automatic Probe Diagnostics, allows the Probe Check (VITA) Tool to gather 
information about probes used and put that information into a VITA folder.dump file. Once 
enabled, the Probe Check (VITA) routine will run once at system startup to generate this 
dump file. Only performed in the first supported probe found from left to right. Available in 
LOGIQ P7/P8/P9/P10 Version R4.5 (R4.5 .x.x) or later.

Figure 5-83  System Admin (R3-R4)

Figure 5-84  System Admin (R4.5)
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2.) Click Save. 
3.) Navigate to Utility (second page) > Service > Utilities > Data Transfer.
4.) On Data Transfer, select Scheduler, and then select the days to perform the data transfer. 
5.) Click Save Settings. 
6.) To manually perform a data transfer, click Send All.
For more information: 

• Utilities on page 5-83
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SSH

SSH displays the status of the Secure Shell (SSH) server. SSH is a cryptographic network protocol for 
operating network services securely over an unsecured network. This protocol is used for remote login 
to the operational system. SSH allows remote login to the LOGIQ P7/P8/P9/P10 and remote file transfer 
from the LOGIQ P7/P8/P9/P10. Remotely log into the LOGIQ P7/P8/P9/P10 using the username 
“GEService” and its password.

The information on SSH is available to Class M licenses.

To access SSH, select Utility > Service > Utilities > SSH.

Figure 5-85   SSH

This table shows all the elements available on SSH with descriptions.

To start the SSH server: 

1.) Navigate to Utility > Service > Utilities > Disruptive Mode Utility and set Disruptive mode to On. 
2.) Navigate to Utility > Service > Utilities > SSH.
3.) Click Start. 
4.) To stop the SSH server, select Stop.
For more information, see: 

• Utilities on page 5-83

Table 5-41    SSH

Element DESCRIPTION

Status
When Disruptive mode is on, displays the status of the SSH server. Valid values are: 
•  SSH is stopped
•  SSH is running

Start When Disruptive mode is ON, start the SSHD service.

Stop When Disruptive mode is ON and the SSHD service is running, stops the SSHD 
service.
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Network Capture

Network Capture displays network traffic between the LOGIQ P7/P8/P9/P10 and configured devices. 
A network capture outputs two log files: one for main logging with no protected information and another 
including protected information. These log files are useful when debugging connectivity issues. 
Because these log files can be large, they are only kept for one week.

The information on Network Capture is available to all service class licenses.

To access Network Capture, select Utility > Service > Utilities > Network Capture.

Figure 5-86   Network Capture

This table shows all the elements available on Network Capture with descriptions.

Table 5-42    Network Capture

Element DESCRIPTION

Network Capture Parameters

Maximum Size

Allowed size of the generated log file. Valid value are:
•  256MB
•  512MB
•  1024MB

Devices DICOM-configured devices for which you want to capture information. If no 
additional devices are configured, only All will be available.

Start Network Capture
Select to start the process. This causes the network capture to start, enables the 
Stop button, and updates the Network Capture Status pane and changes the 
Status to Running.

Stop Network Capture Select to stop the process.

Network Capture Status

Displays information about the status of the network capture. The language setting 
for this information is set in Windows and not through the Service desktop or LOGIQ 
P7/P8/P9/P10 application software.

Displays the current status of the network capture. Valid values are:
•  Not Running
•  Running
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To perform a network capture:

1.) Navigate to Utility > Service > Utilities > Network Capture.

2.) From Network Capture, do the following:
- Under Maximum Size, select the allowed size of the generated log file.
- Under Devices, select the DICOM-configured device for which you want to capture 

information. If no additional devices are configured, only All will be available. 
3.) Select Start Network Capture to start the process. This causes the network capture to start, 

enables the Stop button, and updates the Network Capture Status pane and changes the Status 
to Running.

4.) Click the Stop button to end data collection. Stopping is a two-step process:
- Stops the data collection and immediately closes the .etl file.
- Collects additional diagnostic data that may help diagnose network issues. When the file is 

closed, you see “There is no trace session currently in progress”. When the remaining data is 
collected and the .cab file is closed, you are notified in the banner.

NOTE: The network capture file, "NetworkCapture.etl" is saved in D:\Log\Protected\ folder. The .etl file 
shall be analyzed by using analysis tools like as Microsoft Message Analyzer, Wireshark and so 
on.

For more information, see: 

• Utilities on page 5-83
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5-11-10 Options
Use Options to:

• View software options.
• View software option details.
• Add (or delete) a valid option key, add a duplicate option key, not add an invalid option key, and ask 

for confirmation before deleting an option key.
• View software option key details. Key details are a list of options that are enabled by a particular 

key. Under Available Keys, highlight the option string, select Details and then view the options on 
the left side of the screen. Press Show All to view all of the activated options.

The information on Options is available to all service class licenses.

To access Options, navigate to Utility > Service > Options. 

Figure 5-87   Options

This table shows all the elements available on Options with descriptions.

Table 5-43    Options

Element DESCRIPTION

Software Options

Option Software options on the LOGIQ P7/P8/P9/P10.

Status Status of the options on the LOGIQ P7/P8/P9/P10.

Software Option Details

Product Name of the product.

Hardware Number Number for the hardware. The hardware number is the hash of the serial number 
that is used to generate the option key.

Serial Number Serial number of the LOGIQ P7/P8/P9/P10.
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Software Option Keys

Available Keys List of the option keys installed on the LOGIQ P7/P8/P9/P10.

Table 5-43    Options

Element DESCRIPTION
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5-11-11 Agent Configuration
Use Agent Configuration to:

• Edit and configure the following: 
- Enterprise host name in the agent
- Enterprise port number in the agent
- Proxy server in the agent
- Proxy port in the agent
- CRM number in the agent
- Display name in the agent

• Set the serial number in the agent
• Enter the username and password for the proxy
• Reset the edited unsaved value
• Update contact details
The information on Agent Configuration is available to all service class licenses.
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To access Agent Configuration, navigate to Utility > Service > Agent Configuration. 

Figure 5-88   Agent Configuration (R3 only)

Figure 5-89   Agent Configuration (R4 and R4.5 only)

This table shows all the elements available on Agent Configuration with descriptions.

Table 5-44    Agent Configuration

Element DESCRIPTION

Agent Configuration

Contact Details
Phone number for the person at the customer site a GE remote service engineer 
would contact. The phone number is entered during installation and reviewed at 
every service call to make sure the information is correct.
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Agent Status
Status for the agent. Valid values are: 
•  Running
•  Not Running

Agent Registered

Registered status of the agent. Valid values are:
•  Yes – The agent is registered in the back office.
•  No – The agent is not registered in the back office. 
•  Not Available – The agent is not configured or running.

Agent Quarantine

Quarantine status of the agent. Valid values are:
•  Yes – The agent has more than one device registered with the same CRM Number 

in the back office. This scanner cannot send data back to GE or be remotely 
accessed.

•  No – The agent has one device registered with the listed CRM Number in the back 
office.

•  Not Available – The agent is not configured or running.

Agent CRM Verified

CRM verified status of the agent. Valid values are:
•  Yes – The agent is verified in the back office.
•  No – The agent is not verified in the back office. 
•  Not Available – The agent is not configured or running.

Agent Model Number GE part number for the LOGIQ P7/P8/P9/P10. The same number as listed on the 
rating plate.

Serial Number

Serial number of the agent (read-only). If the agent is not registered with a serial 
number, this field is populated with the serial number of the LOGIQ P7/P8/P9/P10. 
The serial number of the agent is tied to the serial number of the LOGIQ P7/P8/P9/
P10.

CRM No

Customer Relationship Management (CRM) number. System identifier assigned to 
the customer unit by the service region. CRM is pre-populated by adding 
P9P7 to the CRM number. The CRM number of the LOGIQ P7/P8/P9/P10 is 
editable.

Display Name Displayed name of the agent.

Advanced Configuration

Enterprise Server Name of the enterprise server.

Enterprise Host Number of the enterprise host.

Enterprise Port Number of the enterprise port.

Proxy Configuration

Enable Proxy Enables the proxy server.

Proxy Server When Enable Proxy is selected, name of the proxy server IP.

Proxy Port When Enable Proxy is selected, number of the proxy server port.

Credentials

Enable Proxy Credentials Enables the proxy credentials.

Username When Enable Proxy Credentials is selected, name of the user.

Password When Enable Proxy Credentials is selected, password for the user.

Table 5-44    Agent Configuration

Element DESCRIPTION



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

5-118 Section 5-11 - Common Service Desktop (R3, R4 and R4.5)



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 6 - Service Adjustments 6-1

Chapter 6
Service Adjustments

Section 6-1
Overview

6-1-1 Purpose of Chapter 6
This chapter describes how to test and adjust the mechanical capabilities of a scanner that may be out 
of specification. Although some tests may be optional they should only be performed by qualified 
personnel.

Section 6-2
Regulatory

Verify, where applicable, that any regulatory information or tests required by national law are present 
and accounted for, and any regulatory tests required by national law are performed and documented.

Table 6-1    Chapter 6 Contents

Section Description Page Number

6-1 Overview 6-1

6-2 Regulatory 6-1

6-3 LCD Monitor Adjustment 6-2
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Section 6-3
LCD Monitor Adjustment

6-3-1 Brightness/Contrast (R1.x.x)

6-3-1-1 Brightness
Adjusting the monitor’s contrast and brightness is one of the most important factors for proper image 
quality. If these controls are set incorrectly, the Gain, TGC, Dynamic Range and even Acoustic Output 
may have to be changed more often than necessary to compensate.

The proper setup displays a complete gray scale. The lowest level of black should just disappear into 
the background and the highest white should be bright, but not saturated.

1) Go to Utility -> System -> General. 
2) Press the OSD Control button to adjust the BRIGHTNESS and Contrast by using scroll bar to 

decrease/increase value.

6-3-1-1-1 Gamma

1) Go to Utility -> System -> General.
2) Press the OSD Control button.
3) Press RGB tab.
4) Select 2.2 or 2.4 by using scroll bar to decrease/increase the value in Gamma Correction box.

Figure 6-1  Brightness/Contrast Adjust
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6-3-2 OSD Control on the Utility mode (R1.x.x)

Figure 6-2   Monitor

1) Go to Utility -> System -> General.
2) See Monitor category.
3) There are preset parameters below for monitor setting.

Table 6-2    

Preset Parameter Description

Dark Pre-defined monitor settings for Dark Room

Semi Dark Pre-defined monitor settings for Semi-Dark Room

Light Pre-defined monitor settings for Light Room

OSD Control

The monitor can also be adjusted in brightness and contrast. For detailed adjustment 
press the [ OSD controls] buttons on the screen. The OSD menu will appear on the 
screen. Brightness, Contrast, Backlight and Sharpness can be adjusted in General 
tab. Monitor colors can be adjusted in RGB tab.
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6-3-3 21.5 inch Wide Monitor Adjustment (R2.x.x and later)

All Monitor settings have been optimized at the factory, so normally, there should be no need for any 
further adjustments.

1) Go to Utility second touch panel
2) Adjust Room profile, Color Profile, Gamma, Brightness/Contrast (Roomprofile-User defined) as 

necessary.

Figure 6-3  Monitor Adjustment (R2.x.x)

Display Test patterns 
while the Utility is active

Select Color Profile

Select Gamma

Display scan screen 
while the Utility is ac-
tive

Select Room Profile

Adjust Brightness and Contrast for Room profile 
“User Defined”
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Table 6-3    Parameters for Wide Monitor

Figure 6-4  Monitor Adjustment (R3.x.x or R4.x.x)

Parameter Range Note

Room Profile Dark/Semi Dark/Light/User Defined

Color Profile 0 - 6

0: 6500K
1: 9000K

2: 11000K
3: 13000K
4: 7500K
5: 9500K
6: USER

Gamma 2.2 or 2.4

Brightness
(Room Profile - User Defined) 0 - 100

Contrast
(Room Profile - User Defined) 0 - 100

Display Test patterns 
while the Utility is active

Select Color Profile

Select Gamma

Display scan screen 
while the Utility is ac-
tive

Select Room Profile

Adjust Brightness and Contrast for Room profile 
“User Defined”
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6-3-3-1 Scan Screen

In order to view the monitor while adjusting the Contrast/Brightness and Color Profile, press the Scan 
Screen on the second Utility Page.

1) Press Scan Screen. The scan screen displays on the main display while the Utility touch panel is 
active.

2) Adjust Room Profile/Color Profile as necessary.

6-3-3-2 Room Profile
Room Profile changes Brightness/Contrast of main display.

If “User Defined” is selected the user can adjust Brightness/Contrast by Brightness/Contrast control at 
the bottom of the Touch Panel.

NOTE: Brightness/Contrast setting is displayed only when touch panel has Room profile button.

NOTE: Brightness/Contrast is changeable only when Room Profile setting is “User Defined”

6-3-3-3 Color Profile

Color Profile controls temperature.
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Section 6-4
Advanced monitor adjustment (R4 and R4.5)

6-4-1 Review Gamma Setting
Gamma settings can be adjusted in two ways, with or without DICOM Gray Scale Standard Display 
Function (GSDF) enabled. GSDF-compliant refers to all brightness settings, but not all contrast settings.

To enable the GSDF mode:

1) Navigate to Utilities > System > System Display.
2) Select Enable DICOM grayscale display mode (GSDF).
3) Set Use Wide Screen for Single Image to Off.
4) Navigate to Utility (second page) > Scan Screen. The scan screen displays on the main display 

while the Utility touch panel is active so you can see the affect your adjustments are making to the 
monitor.

5) With GSDF enabled, the Gamma button on the touch panel affects the image, emulating the 
appearance of that gamma, but does not affect the monitor.

If a site’s PACS workstations are calibrated to the GSDF, this setting may help to make the image 
appearance more uniform between the Ultrasound system and PACS.

• With GSDF disabled, the monitor still uses a gamma curve that may be selected on the touch panel 
(for backwards compatibility with sites that are happy with their PACS or may have a mix of older 
systems).

• With GSDF enabled, the gamma button on the touch panel affects the image, emulating the 
appearance of that gamma, but does not affect the monitor.

Figure 6-5  Check to enable GSDF Mode
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6-4-2 Test Patterns
Test patterns are available to aid in evaluating the display visually and quantitatively. 

Table 6-4    Test Patterns

Test Patterns Description Corresponding Graphic

Gray Bars
Confirm that you can clearly see all of the 
different gradations of the grayscale in each gray 
cell. 

Color Bars Confirm that you can clearly see all of the 
different colors in each colored cell.

Resolution Confirm that this image is clear and crisp and 
without edges or lines

Brightness contrast

Before making any adjustments, record the 
setting for contrast and brightness. In a dimly lit 
room, adjust the monitor to brightness 100 and 
contrast 10. Increase the contrast to 100. Most of 
the remaining blocks in the last 2 rows of the 
image should be more visible as the contrast 
value is increased. 
Reset the contrast and brightness to the 
recorded levels.
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LN1 to LN18

Luminance for different grayscale levels. 
Usually, the Facility’s Biomed Engineer tests 
each gray level map on the monitor from LN-1 to 
LN-18 with a light meter and then graphs these 
on a scale to ensure that the curve falls within the 
GSDF’s standard. 

QC Quality Control. Confirm that this image is clear 
and crisp and without jagged edges or lines.

Table 6-4    Test Patterns

Test Patterns Description Corresponding Graphic

LN1

LN18



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

6-10 Section 6-4 - Advanced monitor adjustment (R4 and R4.5)

NOTE: In QC, some characters of “QUALITY CONTROL” cannot be detected by eyes because this pattern is 
for 5 mega pixel high resolution monitor. 

NOTE: In CT, some circles cannot be detected by eyes because this pattern is for 5 mega pixel high resolution 
monitor. 

CT Used for Luminance response Contrast. Confirm that you can detect the circles 
within the square grayscale boxes. 

Table 6-4    Test Patterns

Test Patterns Description Corresponding Graphic
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Chapter 7
Diagnostics/Troubleshooting

Section 7-1
Overview

7-1-1 Purpose of Chapter 7
This section describes how to setup and run the tools and software that help maintain image quality and 
system operation. Basic host, system, and board level diagnostics are run whenever power is applied.

Some Service Tools may be run at the application level.

7-1-2 Overview
There may be a time when it would be advantageous to capture trouble images and system data (logs) 
for acquisition through remote diagnostics or to be sent back to the manufacturer for analysis. There 
are different options to acquire this data that would give different results.

Table 7-1    Contents in Chapter 7

Section Description Page Number

7-1 Overview 7-1

7-2 Collect Vital System Information 7-2

7-2-1  Collecting System Information 7-2

7-2-2  Request for Service (RFS) (R1, R2, R2.5 only) 7-5

7-2-3  Request for Service (RFS) (R3, R4 and R4.5) 7-7

7-3 Check Points Voltages 7-10

7-4 Screen Captures and Logs 7-11

7-5 Remote Access to Service Platform 7-18

7-5-1  General 7-18

7-5-2  How the Customer enables/disables Disruptive Mode and VCO 7-19

7-5-3  GE Icon and Remote Connection 7-19

7-5-4  Customer Granting Full Remote Access Permission to GE Service Technician 7-19

7-5-5  Common Service Desktop (CSD) 7-21

7-5-6  CSD: Configuration 7-21

7-6 Minimum Configuration to Boot/Scan 7-22

7-7 Troubleshooting Trees, Instructions and Tech Tips 7-23
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Section 7-2
Collect Vital System Information

7-2-1 Collecting System Information
The following information is necessary to properly analyze data or images being reported as a 
malfunction or being returned to the manufacturer:

NOTE: This information is normally collected with the Alt+D or Gather Logs utility.

- Product Name = LOGIQ P7/P8/P9/P10

1) From the touch panel, select Utility -> System-> About.

Figure 7-1   About (R1, R2, R2.5 only)
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Figure 7-2   About (R3 only)

Figure 7-3   About (R4 only)

Figure 7-4   About (R4.5 only)
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2) Record software version and System Image version

Applications Software

- Software Version
- Software Revision
- Software Part Number
- Build View
- Build Date

System Base Image Software

- Base Image Revision
- Image Part Number
- Image Date
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7-2-2 Request for Service (RFS) (R1, R2, R2.5 only)

There are two possibilities to contact GE:

• by means of the GE “Remote Status Icon” that is displayed on the bottom of the screen.

• via the System Setup - SERVICE page

1) Press the UTILITIES key on the control panel.
2) In the “Utilities” menu select SYSTEM SETUP to invoke the setup desktop on the screen.
3) On the left side of the screen select ADMINISTRATION and then click the SERVICE tab.
4) Enter the password SHE and click the ACCEPT button to display the Service Tools window.
5) Click the GFS button and fill out the displayed form. (Enter detailed Problem description.)

3) Click the SEND button to send the problem description to GE Service/Application representatives.

NOTICE
!! NOTICE:

Service Connectivity has to be checked out once before you can request for service.
i.e., Service platform has to be configured properly; see: CSD: Configuration on page 7-21.

Move the cursor to the GE icon and press the left trackball key (= left-click) to display the 
“Request For Service” form (see: Figure 7-5 below).

Figure 7-5  Contact GE - Request for Service

fill out the form

[Send] button

Connection must
be Checked out
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A request confirmation screen is displayed:

4) Write down and keep the Reference Number for follow up procedures, then click OK. 

NOTE: If the service platform is not configured an Error message is displayed. The request is NOT sent!

The request is saved in QUEUE for reviewing and/or resending.

Figure 7-6  Request submitted

Figure 7-7  Contact GE - Queue

write down and keep
the Reference Number
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7-2-3 Request for Service (RFS) (R3, R4 and R4.5)

7-2-3-1 Request for Service

1) Move the cursor to the GE icon and press the right-click, select “Contact GE”

Figure 7-8  Contact GE (R3 only)

Figure 7-9  Contact GE (R4 and R4.5)

NOTICE
!! NOTICE:

If Agent configuration is not configured correctly, "Contact GE" will not be indicated.
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2) The Request for Service (RFS) page is displayed

Figure 7-10  Contact GE – Request for Service
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3) Click the “Submit” button to send the problem description to GE Service/Application representatives

4) Click the “RFS History” button on Contact GE page
The Request for Service History page is displayed. RFS histories are displayed up to 10 recently 
requested

NOTICE
!! NOTICE:

If Agent configuration is not configured correctly, the "Submit" button is disabled. Refer to the below.

Figure 7-11  Contact GE – Not configured correctly of the Agent configuration

Figure 7-12  Contact GE – Request for Service History
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Section 7-3
Check Points Voltages

7-3-1 LED for Power Status
LEDs near the front cooling fan can provide information pertaining to the DC power distribution status.

1) Remove Front Cover (no tools required)
 

Figure 7-13  LED for Power Status

LED
Breaker OFF
System OFF

Breaker ON
System OFF

Breaker ON
System ON

Breaker ON
System Sleep

LIVE5V OFF ON ON ON

N5V OFF OFF ON OFF

12V OFF OFF ON OFF

P5V OFF OFF ON OFF

Voltage Status
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Section 7-4
Screen Captures and Logs

Sometimes, the customer or field engineer wants to capture a presentation on the screen to identify the 
issue may be recovered by the Online Center (OLC). This is accomplished by saving the log files.

A) To archive log files and current screen image put DVD-R/CD-R media to DVD drive tray or plug-in 
external USB drive.

B) Press ALT+D to archive log files and a screen capture to the target media
C) “System Problem Reporting” dialog will be popped up and please describe brief information about 

the issue.
D) Please select destination drive (CD/ DVD recordable/ HDD/ USB drive).
E) Press store button to save archive file to the destination drive.

7-4-1 Capturing a screen
The following is the generic process to capture any screen from the scanner.

1) Navigate and display the image/screen/volume to be captured.
2) Press the P1, P2, P3 or P4 key (depending on system configuration) on the control panel and store 

the image onto the clipboard (frame on left side of the screen).
3) Select the stored image(s) and export them to DVD-R/CD-R, an external USB drive (optional) or 

mapped Network drive (jpg, bmp, tiff).

7-4-2 Export Log’s and System Data
1) “ALT + D” key to save a snapshot and “Full Backup” of the System status.

See: Section 7-4-2-1 on page 7-8

7-4-2-1 Export System Data (by pressing the ALT + D key)
Pressing ALT + D make “Full Backup” archive of the system status. In addition, it creates one 
screenshot of the point in time when “ALT + D” is pressed. The main usage of the archived files is to 
identify system problem based on logs and captured screen. (e.g., when experiencing strange behavior 
or when the problem should be investigated by engineering team.)

Figure 7-14  System Problem Reporting

NOTE: For capturing logs limitation, please refer to LP9/P7 R3 user manual in chapter 10 under the "Groups" 
for the preset parameters. 
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7-4-3 System Warning/Errors and Logs

7-4-3-1 Temperature warning

7-4-3-1-1 Cause
CPU Temperature exceeded threshold (104°C).

7-4-3-1-2 What to do

1) Shut down the system and Clean the filter.

7-4-3-2 Temperature exceeded threshold

7-4-3-2-1 Cause
CPU Temperature exceeded threshold (100°C) and therefore, system must be shut down immediately.

7-4-3-2-2 What to do

1) Shut down the system and Clean the filter.

7-4-3-2-3 Log message of the high temperature
(Example)
Error   ; acqHouseKeeping(****); CPU Temperature Sensor BEP_CPU_TEMPERATURE = 105.00  
degrees C is outside tolerance limits. UpperLimit = 104.00 LowerLimit = -10.00



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 7 - Diagnostics/Troubleshooting 7-13

7-4-3-3 System voltage failure

7-4-3-3-1 Cause
System detected unexpected voltage level from voltage level monitoring circuits.

7-4-3-3-2 What to Do

1) Press OK and reboot the system.
2) If problem persists, then shut down the system, turn OFF breaker and reboot.

7-4-3-3-3 Log message of the Voltage error
(Example)
Error ; acqHouseKeeping(540); MCB_AFE_3V3_0= 2.5 outside tolerance limits. UpperBound =
3.6 LowerBound = 2.970, Soft Limits are usually narrower than upperBound and lower bound
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7-4-3-4 Hardware configuration error

7-4-3-4-1 Cause
Hardware(s) not detected as valid system. System will boot up but will not allow scanning.

7-4-3-4-2 What to do

1) Press OK, and shutdown the system and reboot.
2) If same issue persists, then shut down the system, system breaker.

7-4-3-4-3 Log message of the Invalid hardware error

Example

Error   ; acqHWCAP(1776); ********************************************

Error   ; acqHWCAP(1776); *** ***

Error   ; acqHWCap(1776); ***   HW RACK CONFIGURATION INVALID!!!   ***

Error   ; acqHWCAP(1776); *** ***

Error   ; acqHWCAP(1776); ********************************************

Error   ; acqHWCAP(1776); *** ***

Error   ; acqHWCAP(1776); *** Board FuncRevs Provided ***

Error   ; acqHWCAP(1776); *** ----------------------- ***

Error   ; acqHWCAP(1776); *** MCB_FuncRev1A (qty=1)

Error   ; acqHWCAP(1776); *** COMEXP_FuncRev1A (qty=1)

Error   ; acqHWCAP(1776); *** MDC_FuncRev1A (qty=1)

Error   ; acqHWCAP(1776); *** MPI_FuncRev1A (qty=1)

Error   ; acqHWCAP(1776); *** MIO_FuncRev1A (qty=1) 

Error   ; acqHWCAP(1776); *** ***

Error   ; acqHWCAP(1776); ********************************************

Info   ; DFEManager(1776); HandleRunFlag: setting RunDfe and RunBlock flags to true!

Error   ; EAErrorHandler(1776); Error from acqHWCAP: Invalid Hardware Rack Configuration - Check 
logs. Severity : FatalHW
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7-4-3-5 System Error

7-4-3-5-1 Cause
Unrecoverable error occurred and unable to continue scan. Error dialog does not indicate the root 
cause of system error. To identify the root cause clearly, it is necessary to investigate the log files. 

7-4-3-5-2 What to do

1) Press “OK”, turn off the console and reboot.
2) If same issue persists, then shut down the system, and turn off the system breaker.
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7-4-3-5-3 Log message of System error
Log message format

“Error ; EAErrorHandler(****); Error from” + ErrorModuleName + ErrorMessage

7-4-3-5-4 Types

7-4-3-5-4-1

Example1 Hardware Errors:

Please see the below tables for the details.

Exception Types:

Sub Type Codes:

GFI Hardware Exception

GFI Setup Exception

GFI Buffer Exception

GFI Processing Exception

Code Error Name Description

31 eSwHardwareException_ErrorHandler_GFIHardwareError Hardware Error (MCB/ MDC/MPI..)

167 eSwProcessingException_TsLevelOk_Timeout HV (High Voltage) is not available from MDC.

Hardware error

“Error ; EAErrorHandler(3276); Error from HouseKeeping   : GFI Hardware Exception:

SubType 31:  -GFE Ch0 empty-GFE Ch1 empty-CPS_ERROR(FAULT_HVLV). Severity :

FatalHW”

Error Module Name

Error descrition

Exception Type

Sub Type Code
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Error Descriptions:

7-4-3-5-4-2 Software Errors :

Message Description

GFE Ch0 empty-GFE Ch1 empty-CPS_ERROR(FAULT_HVLV). Severity :FatalHW MDC Error. 

GFE Ch0 empty-GFE Ch1 empty-CPS_ERROR(FAULT_POWER). Severity :FatalHW MDC Error. 

GFE Ch0 empty-GFE Ch1 empty-CPS_ERROR(FAULT_STOP). Severity :FatalHW MDC Error. 

GFE Ch0 empty-GFE Ch1 empty-BF_ERROR_A . Severity : FatalHW MCB Error (One of Callisto FPGA)

GFE Ch0 empty-GFE Ch1 empty-BF_ERROR_B . Severity : FatalHW MCB Error (One of Callisto FPGA)

scanctrl ScanControl::startScan: Tx Power Supply is not ready. HV setup timeout after 4127 
ms, ScanSequencer NOT started!. Severity : NonFatalSW MDC Error or MDC Error

Software error

“Error ; EAErrorHandler(2284); Error from DFEManager: DFEManager - RunDfe failed:!,

DFE ERROR: InPort is not connected (2); device "DelayValues_CW.ceDelay". Severity :

NonFatalSW” Error Module Name

Error Module Name
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Section 7-5
Remote Access to Service Platform 

7-5-1 General
If the console is setup to connect to InSite ExC server (refer to Chapter.3 for InSite ExC 
Configuration(R1, R2 and R2.5 only) or Agent Configuration(R3 only)), then remote access technology 
may provide GE technicians the possibility to view the entire customer’s desktop and operation system 
for diagnostics and trouble shooting.

Using VCO (Virtual Console Observation) a service technician or the OnLine Center can access and 
modify all PC settings and programs or run diagnostics on the customer’s ultrasound scanner. Remote 
access to the LOGIQ P7/P8/P9/P10 scanner requires permission and customer input before a GE 
service technician or OLC can access the customer’s ultrasound scanner remotely. “Disruptive Mode” 
can be selected by the customer directly on the LOGIQ P7/P8/P9/P10 ultrasound system (see: Section 
7-5-2 on page 7-16), or remotely by the service technician or OLC.
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7-5-2 How the Customer enables/disables Disruptive Mode and VCO
1) If not already in read mode, FREEZE the image.
2) Move the cursor to the GE icon and press the right trackball key (= right-click).
3) Select Connect Clinical Lifeline

This activates “Disruptive Mode” and “VCO” for the application OLC to quickly assist the customer.

NOTE: To disable disruptive mode, select “CANCEL”.

7-5-3 GE Icon and Remote Connection
Refer to Section 5-9 for Remote Access Icons.

Figure 7-15  Connect Clinical Lifeline (R1, R2, R2.5 only)

Figure 7-16  Connect Clinical Lifeline (R3 only)

Figure 7-17  Connect Clinical Lifeline (R4 and R4.5 only)

GE icon

Enables Disruptive
Mode and VCO

GE icon

Enables Disruptive
Mode and VCO

Enables Disruptive
Mode and VCO
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7-5-4 Customer Granting Full Remote Access Permission to GE Service Technician 

7-5-4-1 If GE Service Technician requests Remote Access Permission
If a GE Service technician requests remote access to your LOGIQ P7/P8/P9/P10 scanner, following 
“InSite Notification” appears on the systems screen.

1) Enable “Disruptive Mode” feature by confirming YES

NOTE: If the customer does not wish to have diagnostics running at the time of the request, they select NO. 
A message is sent back to the OLC or FE that “Disruptive Mode” is not enabled.

Figure 7-18  Insite Notification (R1, R2, R2.5 only)

Figure 7-19  Insite Notification (R3, R4 and R4.5)

select [Yes] to enable
“Disruptive Mode” feature

select [Yes] to enable
“Disruptive Mode” feature
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7-5-5 Common Service Desktop (CSD)
Refer to Section 3-13 for accessing Common Service Desktop remotely.

7-5-6 CSD: Configuration 
Refer to Section 3-13 for accessing Common Service Desktop remotely.



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

7-22 Section 7-6 - Minimum Configuration to Boot/Scan

Section 7-6
Minimum Configuration to Boot/Scan

LOGIQ P7/P8/P9/P10 will require at minimum MPI, MCB (with COMExpress),MDC, IO Box, 
HDD(Mounted on MBP) and OPIO to boot up.



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 7 - Diagnostics/Troubleshooting 7-23

Section 7-7
Troubleshooting Trees, Instructions and Tech Tips

Table 7-2 below outlines LOGIQ P7/P8/P9/P10 troubleshooting trees and instructions shown in the sub-
sections.

Table 7-2    Troubleshooting Trees and Instructions

Sub-section Description Page Number

7-7-1 System does not boot up 7-24

7-7-1 System does not boot up 7-24

7-7-2 Noise disturbs the image 7-25

7-7-4 Printer Malfunction 7-27

7-7-5 Monitor Troubleshooting 7-28
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7-7-1 System does not boot up

Figure 7-20   System does not Power On / Boot Up

System doesn’t boot

Is Standby Switch

illuminated ?

Verify that

- Power Cord is connected to Mains

- Power Switch is turned on

 (on the backside of the system)

Is Standby Switch

 ?

Press Standby Switch till it

changes to green

System starts booting

Press Standby Switch

 for approximately 5 sec.

until system is down.

Check cables between

Console and Monitor

Is there any picture on

the monitor ?

Is there any picture on

the touch screen ?

Shut off the power switch

Wait for 10 sec.

Shut on the power switch again

Is there any picture on

the monitor ?

Other error. Please

contact the service

engineer
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7-7-2 Noise disturbs the image

Figure 7-21   Noise disturbs the Image - Troubleshooting

Noise is shown in Image.

YES

NO

Is there any electrical 
devices that affect the 

Scanner?

Keep the Scanner away from those 
electrical devices.

use another wallsocket

Check probes.
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7-7-3 Trackball - Impaired Sensitivity 

Figure 7-22   Trackball - Impaired Sensitivity

The trackball has low sensitivity!

NO

YES

Is it difficult to roll the 
trackball?

Remove the fixing ring by turning it counterclockwise. 

Remove the trackball and clean it from dust.

Fixing
Ring

Return to normal scanning

Contact GE service representative 
to replace the trackball module.

Set up the appropriate trackball 
response time
(via [Trackball Speed] button in the 
System Setup - User Settings page).

Still low sensitive...
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7-7-4 Printer Malfunction

Figure 7-23  Printer Malfunction

Printer malfunction

Is printer

properly

connected?

Check all signal and power supply cable

connections between Printer and Scanner

Is printer

loaded with paper?

Load paper by using the correct format.

Check paper size (small, large, etc.)

Check paper tray to fit with the used paper format

Is printing media

(ink, cartridge, etc.)

empty?

Depending on the Printer Type

replace ink, cartridge etc. color

Are the P-keys

configured properly?

Check programmed P-keys and

re-configure them if not correct

Is printing also

impossible by manual

operation?

Check remote cable

Perform Printer Test

Print Test page

If unsuccessful replace printer

Return to normal scanning

yes

yes

yes

yes

yes

yes

no

no

no

no

no
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7-7-5 Monitor Troubleshooting

For further details refer to Section 6-3 "LCD Monitor Adjustment" on page 6-2.

7-7-6 How to import patient data base from older consoles
Customers should back up their dataset through DICOM Export from their older scanner to import back 
onto the LOGIQ P7/P8/P9/P10. The LOGIQ P7/P8/P9/P10 can only understand DICOM media and 
cannot understand GE-specific database or private xml.

7-7-7 EZbackup will not delete images to open disk space
Customers have to manually delete the patients after successful EZBackup operation to free up disk 
space. 

Fault symptom Check these items

No image

Check the power cord is properly connected.

Check the video cable is properly connected.

Check no pins of the video cable are bent.

Check if video is present on backplane.

Color is not uniform Turn ON the power to activate the Auto-Degauss function.

Colored streaks appear in image Check for presence of magnetic sources near the monitor.
Eliminate the sources and then degauss the monitor.

Screen image is not centered or sized 
properly

Adjust the picture location, picture size, picture rotation or pincushion distortion.

Some video modes do not fill the screen to the edge of the monitor. 
There is no single answer to solve the problem. 
This phenomenon may occur on higher refresh rates (vertical frequency).

Picture is fuzzy

Adjust the picture contrast and picture brightness.
Some SVGA cards having an excessive video output level will cause a fuzzy picture 
at the maximum contrast level.

Turn ON the power to activate the Auto-Degauss function.

Video test patterns are not clear, 
bright, parallel or square Replace the monitor.

NOTICE
!! NOTICE:

The monitor should automatically degauss itself each time power is applied if you wait at least 15 
seconds before you turn power back ON.
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7-7-8 Use ScLogWindow
The ScLogWindow application helps identify errors while the system is running. Access this application 
from the Windows desktop or through Task Manager. From ScLogWindow, you can:

• View the logs
• Save the log
• Filter the log 
To open ScLogWindow from the Windows desktop:

Figure 7-24   ScLogWindow from the Windows desktop

Insert and activate the SSA key.

• Exit to Windows.
• From the Windows desktop, 

click the ScLogWindow 
icon.
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To open ScLogWindow from Task Manager:

1.) Insert and activate the SSA key.
2.) Press Ctrl+Alt+Del and select Task Manager.
3.) In Task Manager, select File > Run New Task.

4.) In Open, enter SclogWindow, check Create this task with administrative privileges, and then 
press OK.
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To view logs in the ScLogWindow:

1.) With the ScLogWindow open, double-click the EchoLoader icon.
2.) Use Alt+Tab to put the ScLogWindow in front.
3.) While the application is booting up, observe logging in ScLogWindow.

To save logs in ScLogWindow:

• Select File > Save as

To filter logs in ScLogWindow:

1.) Select View and check the entries to filter. 
2.) Select Stop to stop the logging.
3.) View the filtered logs. 
4.) To clear the window and start a fresh log capture, select Clear.
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7-7-9 SSA key
Expiration of an SSA key

When you plug in an SSA key to the LOGIQ P7/P8/P9/P10 and enter the code to unlock it, a message 
should display on the screen acknowledging the connection. If the message does not appear, the SSA 
key may have expired. 

To check whether the SSA key has expired, navigate to Service > Utilities > SSA License and check 
the expiration status.

Figure 7-25   Example of an expired SSA key

Dual Class M SSA key support

The SSA service does not support two Class M SSA keys plugged into the LOGIQ P7/P8/P9/P10 at the 
same time. The first key will validate. If a second key is plugged in, the SSA service will not validate the 
second key. Apart from validation, plugging two SSA keys into the LOGIQ P7/P8/P9/P10 could cause 
additional problems.

Abnormal shutdown

If an abnormal shutdown occurs, there is a chance that the SSA service could corrupt and not validate 
the SSA key. In this occurs, see To restore an SSA key that is not validating: on page 5-100.

SSA key battery 

There is a battery inside the SSA key. If the SSA key is not periodically charged, the battery may die. 
The battery life is approximately six months.

For more information, see SSA License on page 5-99.
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7-7-10 Log analysis
Error logs and monitoring logs are kept in a database format. If needed for troubleshooting, collect them 
with Alt+D or gather logs. Either process extract information from the database in a collection of files 
that are readable for the field.

Crashes

Crash information is contained in /Log/CrashDump.

Use this log to troubleshoot issues with software crashes. Send these files to engineering for evaluation 
and determination of the root cause.

Auto transfer errors

When auto transfer is enabled, error information is contained in CSD_LogFile.log.

Auto transfer periodically logs data to the back office. For example:

13:27:49] ERROR data-transfer.js:764 DataTransfer Manual Data Transfer: Error in uploading full 
logs file D:\Scanner\upload\log_LogOther_E70034_171221_132748_DB.zip "error"

This example may indicate that network connectivity has been compromised on the LOGIQ P7/P8/P9/
P10 or there is an issue with the facility reaching out to the back office. Check with the network 
administrator.

Service alerts

Service alert information is contained in /Log/SvcAlert*.txt. 

Use this log to troubleshoot issues with alerts generated by the LOGIQ P7/P8/P9/P10. Alerts can also 
be viewed on the Service desktop. Review log file content to determine the errors the LOGIQ P7/P8/
P9/P10 has generated in the past.

USB issues

USB information is contained in /Log/ScLogsDatabase/UsbLog.txt. 

Use this log to troubleshoot issues with a USB device that may be working intermittently. This log 
indicates connection and disconnection of USB devices during operation.

Probe use

Probe use information is contained in /Log/ScLogsDatabase/MainLog.txt. 

Use this log to troubleshoot issues with probes. This log indicates probe selection and mode.

Monitoring logs

Monitoring log information is contained in /Log/ScLogsDatabase/MonitoringLog.txt. 

Use this log to troubleshoot issues with voltage and temperature. This log contains the monitoring 
parameters for voltage and temperature, same used to the status indicators on the Service desktop. 
Use this log to evaluate details of red indicators in the Service desktop.
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System configuration logs

Hardware configuration information is contained in /Log/SysCfg.csv. 

Use this file to troubleshoot issues with hardware configuration (also known as VPD). This log helps to 
determine the part numbers of boards installed along with versions and serial numbers.

Boot up issues

To troubleshoot issues at boot up, refer to Bootup Issues on page 5-63.
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7-7-11 Automatic probe diagnostics (Probe Check / VITA)
For R4.5.x and later, automatic probe diagnostics (PHT Probe Check /VITA) has been added.

NOTE: To enable automatic probe diagnostics (Probe Check/VITA), see Section  "To configure automatic 
data transfers:" on page 5-108.

The initial VITA version collects diagnostic data at boot up from the first supported probe found 

• Automatic Test Routine - Periodically between patient exams, an automatic routine pulses a single 
element and lens echoes are recorded by other elements in the array. This is repeated until all 
elements are pulsed.

• Advanced Data Analysis - The system compiles the lens echo data into a sensitivity matrix 
comprising the relative transmit and receive frequencies between each combination of elements. 
This matrix is then analyzed for patterns.

• On-Board Customer Features - The result of this analysis will assess the health of the customers 
probe, alert to specific failure types, and can even adjust image quality to compensate for probe 
wear and degradation. 

The diagnostic result will be logged in a file, stored under the d:\log\Diag/VITA folder and d:\log, 
with a.TXT extension.This file can be collected with the Alt+D logs.

Figure 7-26   Probe Acceptance Criteria
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7-7-11-1 Max. number of total defect elements

Increasing defect transducer elements result in a more and more dark image and might reduce the 
lateral resolution. If the overall limit of allowed defect element is reached, the algorithm rates the 
connected probe as failed. The position of the broken elements is not important for this test, bad 
elements can be randomly distributed all over the transducer surface.

7-7-11-2 Defects of nearby elements

This criterium looks for defect element groups with a defined maximum number of elements. These 
group might contain groups of good elements, where the section “Gap between defect nearby 
elements” defines the minimum number of good elements which separate the groups of defect 
elements. These limits are defined for each probe type individually. The image in the affected region is 
darker than the surrounding part and image details get lost which could result in clinical miss diagnoses. 
If the limit of too many elements in one group is reached, the element check is rated as failed.

7-7-11-3 Gap between defect nearby elements

Additionally, to the nearby element criterium a gap of good elements between the defects could appear. 
If the gap is very small, the image would appear like the image without gap and the automatic 
recognition would lead to a failed result. If the gap between group of defect elements is wide enough, 
the operator can recognize two separated areas of broken elements where each might have a negligible 
IQ effect. In combination with the nearby element criterium, gaps smaller than the limit are rated as 
failed. 

Figure 7-27   Example: 32 elements total. 8 defects (defect elements marked by X)

Figure 7-28   Example visualization: 6 out of 32 elements defect (defect elements marked by X)

Figure 7-29   Example: 6 of 32 elements are defect with a gap of 2 good elements between (defect elements 
marked by X)
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Chapter 8
Replacement Procedures

Section 8-1
Overview

8-1-1 Purpose of Chapter 8

This chapter contains replacement procedures for different modules and their subsystems. 

 

NOTICE
!! NOTICE:

The Manpower, time and Tools indicated in the Sub-sections include all requirements from 
Preparations to Installation Procedures.

WARNINGWARNING
!! WARNING:

No covers or panels should be removed from the system (high-voltage risk). 
Service and repairs must only be performed by authorized personal. 
Attempting do-it-yourself repairs invalidate warranty and are an infringement to 
regulations and are inadmissible acc. to IEC 60601-1.

NOTICE Energy Control and Power Lockout for LOGIQ P7/P8/P9/P10.
When servicing parts of the system where there is exposure to voltage greater than 30 Volts:
1. Turn off the scanner.
2. Unplug the system.
3. Maintain control of the system power plug.
4. Wait for at least 20 seconds for capacitors to discharge as there are no test points to verify isolation.
Beware that the Power Supply, Front End Processor and Back End Processor may be energized even 
if the power is turned off when the cord is still plugged into the AC Outlet.UT

The Waste of Electrical and Electronic Equipment (WEEE) must not be disposed as unsorted 
municipal waste and must be collected separately. 
Please contact the manufacturer or other authorized disposal company for information 
concerning the decommission of your equipment. 

Table 8-1    Chapter 8 Contents
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8-5 Settings - Backup and Restore 8-69

8-6 Replacement of Front Cover 8-74

8-7 Replacement of Cabinet 8-77

8-8 Replacement of Side Cover 8-79

8-9 Replacement of Rear Cover 8-83
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8-10 Replacement of Side Tray & Foot Rest Cover 8-84

8-11 Replacement of Monitor and LCD Arm Plastic Covers 8-86

8-12 Replacement of Monitor Covers 8-99

8-13 Replacement of Fixed Arm Cover and Fixed Arm Holder Grip 8-105

8-14 Replacement of OPIO and Related Parts 8-107

8-15 Replacement of the Caps for Hardkeys 8-129

8-16 Replacement of Key Caps (by special native language keys) 8-131
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8-24 Replacement of the HDD/SSD 8-188

8-25 Replacement of the M.2 SSD 8-190
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8-29 Replacement of the Harness Cable and OPIO Cable Assy 8-197
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8-36 Replacement of the BW printer 8-218

8-37 Replacement of the Speaker 8-220

8-38 Replacement of the Monitor Arm 8-224

8-39 Replacement of Front Fan Filter 8-225

8-40 Replacement of Bottom Fan Filter 8-226

8-41 Replacement of SW CD set (R1, R2, R2.5 only) and SW USB (R3, R4 and 
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8-227
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8-44 Replacement of DCWD ASSY 8-232

8-45 Replacement of MCWD ASSY 8-234

8-46 Replacement of battery pack for LP7-P9 R2 ext battery pack 8-234
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8-4 Section 8-1 - Overview

8-1-2 Returning/Shipping System, Probes and Repair Parts
When returning or shipping the LOGIQ P7/P8/P9/P10 system in the original packaging:

• system must be lowered to its minimum height with monitor flapped down 
• the Control Console has to be centered and locked in “unextended” position
Equipment being returned must be clean and free of blood and other infectious substances.

GEHC policy states that body fluids must be properly removed from any part or equipment prior to 
shipment. GEHC employees, as well as customers, are responsible for ensuring that parts/equipment 
have been properly decontaminated prior to shipment. Under no circumstance should a part or 
equipment with visible body fluids be taken or shipped from a clinic or site (for example, body coils or 
and ultrasound probe).

The purpose of the regulation is to protect employees in the transportation industry, as well as the 
people who will receive or open this package.

The US Department of Transportation (DOT) has ruled that “items what were saturated and/or dripping 
with human blood that are now caked with dried blood; or which were used or intended for use in patient 
care” are “regulated medical waste” for transportation purpose and must be transported as a hazardous 
material.



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 8 - Replacement Procedures 8-5

Section 8-2
Warnings and important information

8-2-1 Purpose of this section
This section includes important information. Please read it before doing any of the procedures in this 
chapter.

8-2-2 Warnings

WARNINGWARNING
!! WARNING:

NO COVERS OR PANELS SHOULD BE REMOVED FROM THE SYSTEM (HIGH-
VOLTAGE RISK). 
SERVICE AND REPAIRS MUST ONLY BE PERFORMED BY AUTHORIZED PERSONAL. 
ATTEMPTING DO-IT-YOURSELF REPAIRS INVALIDATE WARRANTY AND ARE AN 
INFRINGEMENT TO REGULATIONS AND ARE INADMISSIBLE ACC. TO IEC 60601-1.

WARNINGWARNING DO NOT TOUCH ANY BOARDS WITH INTEGRATED CIRCUITS PRIOR TO TAKING THE 
NECESSARY ESD PRECAUTIONS.
ALWAYS CONNECT YOURSELF, VIA AN ARM-WRIST STRAP, TO THE ADVISED ESD 
CONNECTION POINT LOCATED ON THE REAR OF THE SCANNER (NEAR THE POWER 
CONNECTOR). 
FOLLOW GENERAL GUIDELINES FOR HANDLING OF ELECTROSTATIC SENSITIVE 
EQUIPMENT.

WARNINGWARNING THE WASTE OF ELECTRICAL AND ELECTRONIC EQUIPMENT MUST NOT BE 
DISPOSED AS UNSORTED MUNICIPAL WASTE AND MUST BE COLLECTED 
SEPARATELY.
PLEASE CONTACT THE MANUFACTURER OR OTHER AUTHORIZED DISPOSAL 
COMPANY TO DECOMMISSION YOUR EQUIPMENT.

NOTICE Energy Control and Power Lockout for LOGIQ P7/P8/P9/P10.
When servicing parts of the system where there is exposure to voltage greater than 30 Volts:
1. Turn off the scanner.
2. Unplug the system.
3. Maintain control of the system power plug.
4. Wait for at least 20 seconds for capacitors to discharge as there are no test points to verify isolation.
Beware that the Power Supply, Front End Processor and Back End Processor may be energized even 
if the power is turned off when the cord is still plugged into the AC Outlet.UT
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8-2-3 Returning/Shipping Probes and Repair Parts

Equipment being returned must be clean and free of blood and other infectious substances.

GE Healthcare policy states that body fluids must be properly removed from any part or equipment prior 
to shipment. GE Healthcare employees, as well as customers, are responsible for ensuring that parts/
equipment have been properly decontaminated prior to shipment. Under no circumstance should a part 
or equipment with visible body fluids be taken or shipped from a clinic or site (for example, body coils 
or an ultrasound probe). The purpose of the regulation is to protect employees in the transportation 
industry, as well as the people who will receive or open this package.

Refer to Section 1-3-10 "Returning/Shipping System, Probes and Repair Parts" on page 1-19.

The US Department of Transportation (DOT) has ruled that “items that were saturated and/or dripping 
with human blood that are now caked with dried blood; or which were used or intended for use in patient 
care” are “regulated medical waste” for transportation purposes and must be transported as a 
hazardous material.
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Section 8-3
System Software - Installation/Upgrade Procedure

8-3-1 Introduction 
This section describes procedure to install/upgrade software to system.

8-3-2 Manpower
1 person, 1 hour

- Depends on contents of System DVD, peripherals, etc. (R1.x.x or R2.x.x)

- Depends on contents of USB media, peripherals, etc. (R3.x.x or later)

8-3-3 Tools
- System DVD (R1.x.x or R2.x.x)

- Software Flash Drive with Base Load Image and Application Software. (R3.x.x or later)

8-3-4 Preparations
Before performing the Software Upgrade:

• make sure that all system functions are working correct
• check the current Application Software version  and the installed Options

8-3-5 Preparation

8-3-5-1 General Notes on LOGIQ P7/P8/P9/P10 Software Loading
When preparing to load software, you must perform the following steps:

• Back up the entire Patient Archive and Reports (you can import the database from previous version 
into this version).

• Back up all presets, including Service.
• Record Connectivity settings (TCP/IP).
• Load Base System Software and install Application Software:

- Reload entire drive (all partitions) or 
- Reload only C partition
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• The Hard Disk Drive (HDD) on LOGIQ P7/P8/P9/P10 is divided into four visible (R1.x.x.) or 
five (R2.x.x or later) visible partitions.

NOTE: Before loading the Base System Software, you must perform the following steps:

• Contact the customer to allow enough lead time to back up the system.
• Be sure no images are in the clipboard or opened exams.
• Review troubleshooting section to collect information for future analysis if you are troubleshooting 

loss of image or patient data.
• Disconnect the system from the network and remove all transducers from the system.
• Be sure all USB devices (printers only) are connected and turned on (except for USB Flash 

devices). If a printer is plugged in at this time, it is automatically installed.
• Save all Service Presets if you are connected to InSite to restore remote connectivity after 

something is completed.
• Save all User Presets.

NOTE: After a full or partial system software load, be sure to check the system date, time and time zone are 
set correctly.

Table 8-2    Use of the Partitions (R1.x.x)

Drive Letter Label

C: SYSTEM

D: USER

E: ARCHIVE

Z: REPOSIT

Table 8-3    Use of the Partitions (R2.x.x or later)

Drive Letter Label

C: SYSTEM

D: USER

E: ARCHIVE

V: DVR

Z: REPOSIT
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8-3-5-2 Preparation for Software Loading

8-3-5-2-1 Recording important settings and parameters (optional)
If the system has not been deployed into a customer site yet (i.e. the system has been in the factory 
default and there has not been patient data), this step can be skipped.

8-3-5-2-1-1 Overview
See the following pages to record data.

These subsections include descriptions for recording/setting up data for the following screens.

With the system Powered On, follow the procedures below to document basic system information and 
back up Presets, and if required, Patient Archive and Patient Images prior to software load.

• Utility -> Connectivity
- TCP/IP (see: “Connectivity - Recording the TCP/IP settings”).
- Device (see: “Connectivity - Recording the AE Title and Port settings”).
- Miscellaneous (see: “Connectivity - Recording Miscellaneous settings”).

• Utility -> Admin
- System Admin (see: “Admin - Recording the Software Option Keys”).

These subsections include descriptions for recording/setting up data for the following screens.

Hardcopy forms are provided here for convenience, but content will be included if selected during 
Backup process. Backing up this information is only required if an upgrade specifies the information be 
backed up or as an extra precaution against loss due to a corrupt back-up disk.

• Utility -> Connectivity
- Device (see: “Connectivity - Recording Device Destination settings”).
- Service (see: “Connectivity - Recording Service settings”).
- Dataflow (see: “Connectivity - Recording Dataflow settings”).
- Buttons (see: “Connectivity - Recording the Print Key Assignments”).
- Removable Media (see: “Connectivity - Service settings”).

• Utility -> Admin
- Users (see: “Admin - Users”).

• Utility -> System
- Backup/Restore (see: “System - Data Store Management”).
- Peripherals (see: “System - Recording Peripheral settings”).
- About (see: “System - Recording software and hardware versions”).
- General, Record preset Region, Language and Regional Options. (See the latest revision of 

the LOGIQ P7/P9, LOGIQ P8/P9/P10 Basic User Manual))

8-3-5-2-1-2 Connectivity - Recording the TCP/IP settings

1) From the touch panel, select Utility -> Connectivity -> TCP/IP.
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Figure 8-1   Connectivity - Recording the TCP/IP settings (R1.x.x)

Figure 8-2   Connectivity - Recording the TCP/IP settings (R2.x.x or R3.x.x)

Figure 8-3   Connectivity - Recording the TCP/IP settings (R4.x.x or later)
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2) Record all settings in Table 8-4.

8-3-5-2-1-3 Connectivity — WLAN

1) Press Utility--> Connectivity--> TCP/IP--> Wireless Network Configuration--> Configuration. 
The Wireless Network Configuration tool appears. Available Wireless Networks appear. 

2) Select the Properties Tab. 

3) Record all settings in Table 8-5.
 

Table 8-4    Record settings from TCP/IP screen

Parameter Value

Computer Name

IP Settings

Enable DHCP ON  /  OFF

IP-Address

Subnet Mask

Default Gateway

Network Speed

MAC Address (R2.x.x or later)
Primary DNS Server (R4.x.x or later)
Secondary DNS Server (R4.x.x or later)

Table 8-5    Record settings from WLAN screen

PARAMETER VALUE

NETWORK NAME (SSID)

NETWORK AUTHENTICATION

DATA ENCRYPTION

NETWORK KEY

KEY INDEX

Specify Yes/No to “The Key is 
Provided Automatically”
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IEEE 802.1x AUTHENTICATION 
INFORMATION

EAP TYPE

Table 8-5    Record settings from WLAN screen

PARAMETER VALUE
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8-3-5-2-1-4 Connectivity - Recording the AE Title and Port settings

1) From the touch panel, select Utility -> Connectivity -> Device.
2) Select My Computer in the List of Devices, if not already selected.

Figure 8-4   Connectivity - Recording the AE Title and Port settings (R1.x.x)

Figure 8-5   Connectivity - Recording the AE Title and Port settings (R2.x.x and later)

3) Record all settings in Table 8-6.

Table 8-6    Record settings for My Computer from Device screen

Parameter Value

AE Title

Port Number

MAC Address (R1.x.x)
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4) Record all settings in Table 8-7.

8-3-5-2-1-5 Connectivity - Recording Device Destination settings

1) From the touch panel, select Utility -> Connectivity -> Service.

Figure 8-6   Connectivity - Recording Device Destination settings

2) Record all settings in Table 8-8 for each Destination Device and Service.

Table 8-7    Record settings for each device listed in Device table

Name IP Address

Table 8-8    Record settings from Service screen

Destination Device Properties
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8-3-5-2-1-6 Connectivity - Recording Dataflow settings

1) From the touch panel, select Utility -> Connectivity -> Dataflow.

Figure 8-7   Connectivity - Recording Dataflow settings

2) Record all settings in Table 8-9 for each Destination Device and Service.

Table 8-9    Record settings from Dataflow screen

Properties Name Direct Store Dataflow Verify Timeout (sec)

ON / OFF

ON / OFF

ON / OFF

ON / OFF

ON / OFF

ON / OFF

ON / OFF

ON / OFF

Table 8-10    Record settings from Dataflow screen 2

Default Dataflow
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8-3-5-2-1-7 Connectivity - Recording the Print Key Assignments

1) From the touch panel, select Utility -> Connectivity -> Buttons.

Figure 8-8   Connectivity - Recording the Print Key Assignments

2) Record all settings in Table 8-11.

Table 8-11    Record settings from Button screen

Parameter Format Image Frames Compression Compression 
Quality Printflow View

Print1

Print2

Print3

Print4

Print5

Print6

PrintScreen
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8-3-5-2-1-8 Connectivity - Recording other settings for Print

1) From the Touch Panel, select Utility -> Connectivity -> Buttons.

Figure 8-9   Button settings

2) Record all settings in Table 8-16

8-3-5-2-1-9 Connectivity - Service settings

1) From the touch panel, select Utility -> Connectivity -> Service.

Table 8-12    Record settings from Button screen

Still Images

Format Ultrasound Image / Secondary Capture - Image / Secondary Capture - Video / 
Secondary Capture - Screen

Compression None / RLE / JPEG / JPEG2000

Clip/Volumes

Clips Add Multiframe Data ON / OFF

Compression None / RLE / JPEG / JPEG2000

Quality

Volume File Format 1 - Standard DICOM / 2 - Standard DICOM with Raw / 3 - Enhanced DICOM / 2&3 (2 files)
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2) Record all settings in Table 8-13.

Figure 8-10   Connectivity - Service settings

Table 8-13    Record settings from Service screen

Destination 
Device Name

Services (Types) 
for each Destination Device Properties Name
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8-3-5-2-1-10 Connectivity - Recording Miscellaneous settings

1) From the touch panel, select Utility -> Connectivity -> Miscellaneous.

Figure 8-11   Connectivity - Recording Miscellaneous settings (R1.x.x or R2.x.x)

Figure 8-12   Connectivity - Recording Miscellaneous settings (R3.x.x or later)
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2) Record all settings in Table 8-14.

Table 8-14    Record settings from Miscellaneous screen

Patient/Exam Menu Options ON/OFF or Value

Use birthdate

Auto search for patient

Automatic generation of Patient ID

Auto Archiving patient data

After [End Current Patient], go to:

Keep Search String

Worklist Auto Query

Validate Incoming Worklist (R3.x.x or R4.x.x)

Show BBT

Double click on patient list to start:

Detail Mode

Export to USB HDD: Create DICOMDIR

Export to Network Storage: Create DICOMDIR

Automatic Disable Patient Data

Remember cursor position on Transfer Screen

Quick New Patient Entry (R3.x.x or R4.x.x)

Use Email to MMS (R3.x.x or R4.x.x)

Use Simple MPEGVue (R3.x.x or R4.x.x)

Use Pet Name (R3.x.x or R4.x.x)

Patient/Exam Message Options ON/OFF or Value

Request acknowledge of End Exam action

Warn Image store without patient

Warn register to No Archive

Warn Image store to Read Only dataflow

Warn video titles exist in the internal storage (R1.x.x or 
R2.x.x)

Columns in examination listings ON/OFF or Value

(Date | Category | Exam Description | Img. Size | M&A | Disk

Print and Store Options ON/OFF or Value

P[1-6] Key Sound

Store Dual as Dicom Only

Dual When Color Support is Mixed

Store Multiframe for Sec Capture Loops (R1.x.x. or R2.x.x)

Enable Smart Capture Area

Store 2D Loop with Timeline Data

Patient List Print - Font Size
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8-3-5-2-1-11 Admin - Recording the Software Option Keys

1) From the touch panel, select Utility -> Admin -> System Admin.

Add Titlebar Information to Multiframe Loops (R3.x.x or 
R4.x.x)

Add Scan Parameter Information to Multiframe Loops (R3.x.x 
or R4.x.x)

DICOM Multi-frame image resolution (R1.x.x or R2.x.x)

Show progress bar while storing image (R1.x.x or R2.x.x)

Image Order Scheme

Send Images via Wireless (R3.x.x or R4.x.x)

Allow press and hold print key to replace an image (R3.x.x or 
R4.x.x)

Other ID Options ON/OFF or Value

Enable Other ID

Validation Format

Cloud Reporting (R3.x.x or R4.x.x) ON/OFF or Value

Enable Cloud Reporting

Figure 8-13   Admin - Recording the Software Option Keys (R1.x.x or R2.x.x)

Table 8-14    Record settings from Miscellaneous screen
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2) Record the Software Option Key(s) - alphanumeric string(s) - from the Installed Option Keys field in 
Table 8-15.

Figure 8-14   Admin - Recording the Software Option Keys (R3.x.x or later)

WARNINGWARNING
!! WARNING:

Make sure that the Software Option Keys (alphanumeric passwords) have been 
recorded correctly. If the key is incorrect, you will not be able to log on after the 
software installation has been completed. The password is case sensitive. Hyphens 
must also be recorded. There may be more than one password.

Table 8-15    Software Option Keys

Item Value

HW Number

Installed Option Keys
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8-3-5-2-1-12 Admin - Users

1) From the touch panel, select Utility -> Admin -> Users.

2) Record all settings in Table 8-16.

Figure 8-15   Admin - Users (R1.x.x or R2.x.x)

Figure 8-16   Admin - Users (R3.x.x or later)

Table 8-16    Record settings from Users screen

User ID Prefix Last Name First Name Group 
Membership Op Rights
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8-3-5-2-1-13 System - Data Store Management

1) From the touch panel, select Utility -> System-> Backup/Restore.

Figure 8-17   System - Data Store Management (R1, R2, R2.5)

Table 8-16    Record settings from Users screen

User ID Prefix Last Name First Name Group 
Membership Op Rights
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2) Record all settings in Table 8-17.

Figure 8-18   System - Data Store Management (R4.x.x or later)

Table 8-17    Record settings from Backup/Restore screen

Move Files Older 
than in (Days)

Reminder Dialog 
Interval Days Media Capacity

EZMove

EZBackup
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8-3-5-2-1-14 System - Recording Peripheral settings

1) From the touch panel, select Utility -> System-> Peripherals.

Figure 8-19   System - Recording Peripheral settings (R1.x.x.)

Figure 8-20   System - Recording Peripheral settings (R2.x.x)

Figure 8-21   System - Recording Peripheral settings (R3.x.x or later)
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2) Record all settings in Table 8-18.

Table 8-18    Record settings from Peripherals screen (R1.x.x)

Parameter Value

Video Settings - Format

Standard Printer

Default Printer

Setup - Print Full Screen

Setup - Enable Video Invert

DVR Picture Quality
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Table 8-19    Standard printer and Default printer (R2.x.x. and later)

Table 8-20    DVR (R2.x.x. and later)

8-3-5-2-1-15 System - Recording software and hardware versions

1) From the touch panel, select Utility -> System-> About.

Figure 8-22   System - Recording software and hardware versions

2) Record software and hardware versions in Table 8-21.

Parameter Value

Standard Printer

Default Printer

Parameter Value

Media ____ DVR ____ USB

DVD Format ____ PAL ____ NTSC

Picture Quality ____ HQ ____ SP ____ LP ____ EP

DVD Chapter Record Interval ____ 15 ____ 30 ____ 60 ____ 120

USB Playback Skip Interval ____ 15 ____ 30 ____ 60 ____ 120

USB Video codec (R3.x.x or 
R4.x.x) ____ H264 ____ MPEG2

USB Video Size (R3.x.x or 
R4.x.x) ____Full ____Normal

Table 8-21    Record software and hardware versions

Description Record Versions

Application Software Version

Application Software Part Number

System Software Version (Image Rev)

System Software (Image) Part Number
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8-3-5-2-1-16 Location, Region and Language

1) From the touch panel, select Utility -> System-> General.

2) Record all settings in Table 8-22.

Figure 8-23   Location, Region and Language (R1.x.x)

Figure 8-24   Location, Region and Language (R2.x.x)

Figure 8-25   Location, Region and Language (R3.x.x or later)

Table 8-22    Record settings from Location

Parameter Value

Hospital

Department

Preset Region

Language
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Units

Machine Description1 (R2.x.x)

Machine Description2 (R2.x.x)

Dedicated Preset (R3.x.x or later)

Table 8-22    Record settings from Location

Parameter Value
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8-3-6 System Software - Installation Procedure
Two separate methods of software installation is offered in LOGIQ P7/P8/P9/P10.

A) Software Load from DVD(R1/R2) or USB media (R3/R4/R4.5)
B) Software Re-Load from Repository

Situation •  Harddrive is new
•  Reload from Repository fails
•  Wish to perform “Clean Install”

•  Re-installation for application or 
operating system issues

Perform Software Load from DVD or 
USB media
Refer to section 8-3-7

Perform Software Reload
Refer to section 8-3-8
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8-3-7 Software Installation from DVD

8-3-7-1 System Software - Installation Procedure (R1.x.x)

1) Prepare the Base System Software DVD.
2) Power ON the scanner and press “DEL”(If AN key is installed) or press left bottom key of trackball

(If there’s no AN Key) to enter BIOS

3) Type “maru” for password.

NOTICE
!! NOTICE:

If there’s no AN key, please use trackball to move menu in BIOS mode and click left bottom key of 
trackball to select menu in BIOS and double-click to set or change the value in BIOS. Right bottom key 
of trackball is ‘ESC’ in BIOS.

 Left bottom key of trackball to 
enter BIOS and select menu and set 
or change the value in BIOS

Right bottom key of trackball
for ‘ESC’ in BIOS
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4) Go to “Boot” in BIOS menu and change the setting value from “SATA 1 Drive” to “SATA 2 Drive” in 
‘1st Boot Device’, change the setting value from “SATA 2 Drive” to “SATA 1 Drive” in ‘2nd  Boot 
Device’

5) Go to “Save & Exit” in BIOS menu and select “Save Changes and Exit”. Then, the system will re-
boot.

6) Press DVD-Drive eject button.
7) Place the Base System Software DVD on the tray.
8) Wait few moments for DVD drive to read DVD contents.
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9) The notification screen appears, and then hit the Enter key.

NOTE: Use simulator A/N keyboard if customer’s system does not have external A/N keyboard

10) Select either
[1] “Load the complete disk”, or

[2] "Load the bootable C: and repository Z: partition only" and hit the Enter key.
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11) A confirmation window appears, and then hit the Enter key.

12) Approx. 40 minutes later, loading the software will be completed.
13) Remove Base System Software DVD, and type "exit" to reboot the system.
14) At the first system reboot after loading the software, the OS will reboot the system automatically.
15) After the reboot, the installation of system (Windows Embedded Standard

will be fully completed.
16) Go to BIOS mode (Refer to the procedure 2) 3) above.)
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17) Go to “Save & Exit” in BIOS menu and select “Restore Defaults”.

18) Go to “Boot” in BIOS menu and check that ‘1st Boot Device’ is set to “SATA 1” and ‘2nd Boot Device’ 
is set to “SATA 2”.
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19) Go to “Save & Exit” in BIOS menu and select “Save Changes and Exit”. Then, the system will re- 
boot.
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8-3-7-2 System Software - Installation Procedure (R2.x.x)

1) Prepare the Base System Software DVD.
2) Power ON the scanner and press “DEL”(If AN key is installed) or press left bottom key of trackball

(If there’s no AN Key) to enter BIOS

3) Type “maru” for password.

NOTICE
!! NOTICE:

If there’s no AN key, please use trackball to move menu in BIOS mode and click left bottom key of 
trackball to select menu in BIOS and double-click to set or change the value in BIOS. Right bottom key 
of trackball is ‘ESC’ in BIOS.

 Left bottom key of trackball to 
enter BIOS and select menu and set 
or change the value in BIOS

Right bottom key of trackball
for ‘ESC’ in BIOS
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4) Go to “Boot” in BIOS menu and change the setting value from “SATA 1 Drive” to “SATA 2 Drive” in 
‘1st Boot Device’, change the setting value from “SATA 2 Drive” to “SATA 1 Drive” in ‘2nd Boot 
Device’.

5) Go to “Save & Exit” in BIOS menu and select “Save Changes and Exit”. Then, the system will 
reboot.

6) Press DVD-Drive eject button.
7) Place the Base System Software DVD on the tray.
8) Wait few moments for DVD drive to read DVD contents.
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9) The notification screen appears, and then hit the Enter key.

NOTE: Use the trackball and left set key if the customer’s system does not have an external A/N keyboard.

10) Select either
[A] “Load the complete disk”, or
[B] “Load the 'C' partition only” and hit the Enter key.
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11) A confirmation window appears, and then hit the Enter key.

12) Approx. 30~40 minutes later, loading the software will be completed.
13) Remove Base System Software DVD, and hit the Enter key to reboot the system.
14) At the first system reboot after loading the software, the OS will reboot the system automatically.
15) After the reboot, the installation of system (Windows Embedded Standard 7) will be fully completed.
16) Go to BIOS mode (Refer to the procedure 2.) 3.) above.)
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17) Go to “Save & Exit” in BIOS menu and select “Restore Defaults”.

18) Go to “Boot” in BIOS menu and check that ‘1st Boot Device’ is set to “SATA 1” and ‘2nd Boot Device’ 
is set to “SATA 2”.
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19) Go to “Save & Exit” in BIOS menu and select “Save Changes and Exit”. Then, the system will re- 
boot.
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8-3-7-3 System Software - Installation Procedure (R3.x.x or later)

8-3-7-3-1 Set the system boot order (BIOS setting)

1.) Prepare the THUMB DRIVER R3.x.x, R4.x.x or R4.5.x.x (USB media) including Base Image Load 
Windows 10.

2.) Insert USB media to the system USB port.

3.) Power on the scanner 
4.) Press “DEL” (If AN key is installed) or press left bottom key of trackball (If there’s no AN Key) to 

enter BIOS
5.) Enter the “maru” in Enter Password

Figure 8-26   System USB port

Figure 8-27   Enter Password

Insert here
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6.) In “Boot” page, Change “Boot Option #1” to USB memory which is inserted (R3.x.x) or change “1st 
Boot Device” to USB Harddisk (R4.x.x or later). 

NOTE: The name of USB memory can be displayed different depend on the inserted USB memory 
(R3.x.x).

Figure 8-28   “Boot” page 1 (R3.x.x)

Figure 8-29   “Boot” page 1 (R4.x.x or later)
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7.) After changing the “Boot Option#1” (R3.x.x) or  "1st Boot Device" (R4.x.x), save the BIOS set and 
exit by pressing ‘F10’ key.

Figure 8-30   “Boot” page 2 (R3.x.x)

Figure 8-31   “Boot” page 2 (R4.x.x or later)
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8-3-7-3-2 Base and Application Software installation

• Base Image Software Load Procedure

1.) The system will reboot automatically.
2.) Wait few moments for USB drive to read USB contents.
3.) The notification screen appears like below.
4) Select [1] Load the complete disk (FULL), and Press [OK] button using the trackball key.

NOTE:  If there is no physical keyboard option, use the external keyboard or on-screen menu.

5.) A confirmation window appears, and then Press [Yes] button using the trackball key.

Figure 8-32   The notification screen 1

Figure 8-33   The notification screen 2
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6.) The Installation progress screen appears like below.

7.) Approximately 20~ 30 minutes (R3.x.x) or 10~ 15 minutes (R4.x.x or later) later, loading the 
software will be completed.

8.) After completing, remove USB media from the system USB port.
9.) Press [OK] button using the trackball key to reboot the system.
10) Enter BIOS mode with the password "maru" and change "1st Boot Device" to NVMe Storage. 

(R4.x.x)

Figure 8-34   The notification screen 3

WARNINGWARNING Do not interrupt the software loading at any time.

Figure 8-35   “Boot” page 3 (R4.x.x or later)
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11) After change the “1st Boot Device”, save the BIOS set and exit by pressing ‘F10’ key. (R4.x.x.)
12) At the system reboot after loading the software, the OS will reboot the system automatically.
13) After reboot, the installation will be fully completed.

NOTE: Do NOT touch the system during this process. Activating the keyboard, mouse or front panel 
could corrupt the installation. While the script is running, several window or dialog boxes appear 
on the screen. At times it may look like the system is unresponsive.
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8-3-7-3-3 Application Software Load Procedure

1.) After the reboot again, the application software installation will start automatically.
2.) About few minutes, the following options will appear. Select your product. Click “Start Installation” 

button.

3.) Don’t press any key and wait until the software installation is done.

4.) After the installation completes, the system will be rebooted automatically.
5.) SW License window may appear, then enter correct Option String and click “OK”.

NOTE: The HW Id shown in the picture is an example.

Figure 8-36   Click “Start Installation”

Figure 8-37   Installing application

Figure 8-38   SW License window
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8-3-7-3-4 Base and Application Software installation for LOGIQ P7/P9 R2.5 to R3 upgraded system

1.) If LOGIQ P7/P9 R3.0.11 System Software or above is being installed to the R2.5 to R3 upgrade 
R2.5 to R3 upgrade system, follow the below instructions.

2) Insert the SW thumb drive to the USB port.
3) Reboot the system.
4) Press “DEL” (If AN key is installed) or press left bottom key of trackball (If there’s no AN Key) to 

enter BIOS.
5) Enter the “maru” in Enter Password.
6.) Select the install USB in Boot Option #1 of Boot menu.

7.) Click “Restore User Defaults” and then click “Yes”.

Figure 8-39   

Figure 8-40   
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8.) Click “Save Changes” and then click “Yes”.

9) MUST force the shutdown by pushing the power button for 5 seconds.
10) After rebooting by forcing the shutdown, reinstall R3.0.11 or upgrade higher version by referring 

section System Software - Installation Procedure (R3.x.x or later) on page 8-44

Figure 8-41   
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8-3-7-4 Application Software Installation Preparation (R1.x.x or R2.x.x)

1) Verify the system boot up to Windows Screen
2) Prepare the Application Software DVD.
3) Press DVD-Drive eject button, and place the Application Software DVD on the tray.
4) Click Windows Explorer icon on the taskbar.

5) Select “G” drive in the tree view.

6) Double click “LoadSoftware.bat”. Software Installation will begin.
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8-3-7-5 Application Software Installation (R1.x.x or R2.x.x)

1) Application Software Installation process will take approximately 20 minutes

2) Select your product. Click “Start Installation” button.
3) After the installation completes, the system will be rebooted automatically.

NOTE: Do not remove Application Software DVD from drive. (R1.x.x or R2.x.x)

4) After rebooting the system, the “Start Application” window appears. Remove the DVD from the tray 
(R1.x.x or R2.x.x), then click “Start” button.
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5) If SW License window appears, then enter correct Option String and click “OK”.
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8-3-7-6 Software DVD / USB Storage (R1 to R3)
Remove the rear cover and store the software DVD / USB in the system.

1) Remove the rear cover.

2) Store the Software DVD in the pocket. (R1, R2, R2.5 only) 

Figure 8-42   Removing the rear cover

Figure 8-43   CD pocket
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3) Store the Software USB STICK in the pocket as below picture.(R3)

8-3-7-7 Software USB Storage (R4 and R4.5)

1) Simply pull out Front Cover.
2) Store the Software USB STICK in the pocket as below picture.

Figure 8-44   USB stick pocket

Figure 8-45   USB storage

 USB STICK POCKET
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8-3-8 Software Installation from Common Service Desktop  (R1.x.x or R2.x.x)

NOTE: This procedure requires PC with LAN connection capable of reaching to to GE Network

8-3-8-1 Involking Software Reload

1) Select [SERVICE] from [UTILITY] Menu (R1.x.x) or Select [SERVICE] from [UTILITY] Menu 
(R2.x.x)

Figure 8-46   Utility menu (R1.x.x)

Figure 8-47   Utility menu (R2.x.x)

2) Select “GE Service” and enter Password
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3) Verify entering to Common Service Desktop (CSD)

4) Select “Disruptive Mode” under Common Utility, in [Utilities] Tab
5) Acknowledge “Disruptive Mode” on Console Screen
6) Verify Disruptive Mode 

NOTE: This operation cannot continue without user acknowledge

7) Select [Invoke SW Reload] under Common Utilities.
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8) Click Setup software reload.

9) Select [SYSTEM SHUTDOWN] from Common Utility Menu in CSD
10) Select 

- Restart System
- Retain Disruptive Mode

11) Press [SUBMIT] 

12) On console side, wait until application software loading completes.
13) Rest of the processes are same as 8-3-7-4  Application Software Installation Preparation (R1.x.x or 

R2.x.x)
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8-3-9 Software Installation from Common Service Desktop (R3.x.x or R4.x.x)
For detail information, please refer to 8-3-9 Software Reload on page 5-91



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

8-62 Section 8-3 - System Software - Installation/Upgrade Procedure

8-3-10 System Setup Procedure to display the messages in Japanese/Chinese (Up to 
R3.0.8)

To setup the system to display the messages in Japanese/

Chinese:

NOTE: You cannot enter text in Japanese/Chinese.

1) Press Regional Options in Utility--> System--> General.
The "Region and Language pop-up" appears.

2) Select the "Administrative" tab. In the "Language for
non-Unicode programs" section. select the "Change system

locale..." button. The "Region and Language Settings"

pop-up menu appears.

Figure 8-48   Administrative tab
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3) Under "Current system locale:", select Japanese (Japan) or Chinese (Simplified PRC). Press OK.

4) The "Change System Locale" pop-up prompt appears. Select Cancel to not reboot the system yet.

5) Select Close on the Administrative tab. The "Change System Locale" pop-up prompt appears 
again. Select Cancel to not reboot the system yet.

6) Reboot the system using Power on/off button.

Figure 8-49   Set Language - example

Figure 8-50   Change system locale
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7) Open the Administrative tab and check Japanese or Chinese displays under Current language for 
non-Unicode programs.

Figure 8-51   Administrative tab - example
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8) Under "Format:", select "Japanese (Japan)"/"Chinese (Simplified PRC)". Press Apply, Press OK.

9) In Utility--> System--> General, set the Language as Japanese or Chinese. Press Save and reboot 
the system using Power on/off button.

Figure 8-52   Formats

Figure 8-53   Change the system language
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8-3-11 Setting the System’s Language and Keyboard (R3.0.9 or later)
1) Press Utility -> System -> General, then set the Language (restart needed) to the language 

required. Press Save.

2) Press the [Regional Options] button. The “Region” pop-up appears.

3) Select the language required from the [Current Format:] pull-down menu. 
4) Select the language required from the [Keyboard:] pull-down menu. Press [Ok].
5) When Question message box appears, press [Cancel] to not reboot the system yet.

Figure 8-54   

Figure 8-55   
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6) Insert SSA key into console USB port.
7) Enter the Windows maintenance mode.
8) Select Control Panel > Region. The Region pop-up menu appears.
9) On the Formats tab, Press Language preferences to open the Language pop-up.
10) Remove all other language keyboards, except for English and the required language keyboard by 

highlighting the language and pressing the Remove button.
11) Set English (United States) as the first keyboard. second, set the required language as the second 

keyboard; Press the X in the upper, right-hand corner of the Language pop-up to close the window.

12) Shut down and restart the system.

Figure 8-56   

Figure 8-57   



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

8-68 Section 8-4 - Software and Functional Checks after Installation Procedure

Section 8-4
Software and Functional Checks after Installation Procedure

8-4-1 Functional Check

Table 8-23    

Item Test Procedure Reference Note

Power ON 4-3-3  Power On/Off [___] Passed [___] Failed

System Info 4-3-4  System Information

Record software version and System Image version
Application Software
Part Number: ______________
Software Revision: _____________
Base Image Software
Part Number:. ____________
Software Revision: ________________

[___] Passed [___] Failed

Mode Transition 4-3-8  Mode Transition Checks [___] Passed [___] Failed

Functional Checks

4-3-2  Mechanical Parts Functional Check

CW Mode (Optional) [___] Passed [___] Failed [___] N/A

WLAN (Optional) [___] Passed [___] Failed [___] N/A

4D (Optional) [___] Passed [___] Failed [___] N/A

Power Assistant 
(Optional) [___] Passed [___] Failed [___] N/A

System Serial Number: 
Probe Used (Name and Serial Number written below):

Overall Results:   Passed   /   Failed
Date (MMM/DD/YYYY): ________________________
SSO ID and Name (Print): _______________________
Signature: ___________________________________
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Section 8-5
Settings - Backup and Restore

This section briefly describes Image Setting backup and restore function.

For detailed documentations and warnings, refer to Chapter.16, Section “System/Backup and Restore 
Preset Menu” in the Basic User Manual.
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8-5-1 General Information
The Backup/Restore function enables the user to:

• Copy/Restore the patient archive.
• Copy/Restore the system configuration. The Copy/Restore system configuration feature enables 

the user to configure several units with identical presets, providing that the units have the same 
software version.

8-5-1-1 Supported Media
Depending on the system, you can use either a CD-R, DVD-R, USB Flash Drive, or USB Hard Disk for 
system backup/restore. System does NOT support CD-RW/DVD+R/DVD+RW.

For the sake of simplicity, we have used the CD-R in the examples in this section.

8-5-1-2 General Notes

NOTE: When you restore backup data from the Utility menu, the LOGIQ P7/P8/P9/P10 application usually 
restarts automatically when the restoring is complete.

NOTE: To perform backup and restore procedures, you must login with administrator privileges.

8-5-2 Backup Procedures
Back up patient data AFTER you’ve archived (via EZBackup/EZMove) images so that the pointers to 
the patients images reflect that the images have been moved to removable media and are no longer on 
the hard drive.

LOGIQ P8/P9/P10 R4/R4.5 system does not support EZMove.

1) Insert a media into the drive or USB device into a USB port.

NOTE: About formatting media, See ‘Formatting removable media’ on Basic User Manual for more information.

2) In the patient screen, select the dataflow Local Archive - Int. HD.
3) On the touch panel, press Utility.
4) On the Utility touch panel, press System.
5) On the monitor display, select Backup/Restore.

The Backup/Restore screen is displayed.

6) In the Backup list,
- Select Patient Archive and Report Archive to backup the patient records.
- Select User Defined Configuration to copy system settings and user presets.

NOTE: The detailed section of this menu decouples the user defined configuration above. This allows you to 
selectively restore what you want to restore across multiple machines.

7) Specify where to save data in the media field.
8) Select Backup.

The system performs the backup. As it proceeds, status information is displayed on the Backup/
Restore screen.

9) At the end of the process, the Backup completed message is displayed on the monitor.
Press Eject (F3) for eject media/disconnect USB.

10) Make sure to physically label the media. An identification of the system should also be noted on the 
media and a backup log should be kept.
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File the media in a safe place.

8-5-3 Restore Procedures

1) On the touch panel, press Utility.
2) On the Utility touch panel, press System.
3) On the monitor display, select Backup/Restore.

The Backup/Restore screen is displayed.

4) In the Restore list,
- Select Patient Archive and Report Archive to restore the patient archive.
- Select User Defined Configuration to restore all system settings and user presets.

or

One or several system configuration items to restore parts of the Detailed Restore of User Defined.

5) In the Media field, select the appropriate Source device.
6) Select Restore.

The system performs the restore. As it proceeds, status information is displayed on the Backup/
Restore screen.

7) The LOGIQ P7/P8/P9/P10 restarts automatically when Restore is done.
 

8-5-4 EZBackup and EZMove

NOTE: R4/R4.5 System does not support EZMove.

EZBackup or EZMove allows you to manage hard disk space (move images off the hard drive) while 
maintaining the patient database on the scanner, as well as to back up the patient database and 
images.

• EZBackup: Copy the data from the local HDD to the removable media.
• EZMove: Copy the data from the local HDD to the removable media. After copying the image file to 

the media, EZMove deletes the image file from the Local HD.

8-5-4-1 EZBackup and EZMove
Basically, when you perform the EZBackup or EZMove procedure, you insert the media (or connect 
USB HDD if applicable), the system backs up/moves the images, and creates a reference between the 
patient database and the media’s volume.

CAUTION
!! CAUTION: 

The restore procedure overwrites the existing database on the local hard drive. Make sure to 
insert the correct media.
You cannot restore the data between systems with different software versions.

CAUTION
!! CAUTION: 

To avoid the risk of overwriting the local patient and report archives, DO NOT check Patient 
Archive when restoring userdefined configurations.

CAUTION
!! CAUTION: 

EZBackup or move do not backup patients without images, or reports. If the entire 
patient archive plus images plus reports need to be backed up, it is recommended to 
use the Export/import utility. (Export/Import Utility: go to Patient, and select Data 
Transfer menu.)
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8-72 Section 8-5 - Settings - Backup and Restore

EZBackup/EZMove can take up to 20 minutes (or longer, depending on the size of the backup). Make 
sure to schedule this at the same time daily, when no patients are scheduled.

1) Prepare unformatted media or the USB HDD before starting EZBackup/EZMove.
BEFORE starting the EZBackup, select Unlock All in Utility -> Admin -> Logon.

2) Specify the EZBackup/EZMove setup on the Utility -> System -> Backup/Restore page.
3) To start the EZBackup/EZMove procedure, go to the Patient menu and select EZBackup/EZMove. 

The EZBackup/EZMove Wizard starts.
4) Verify the information on the first page of the EZBackup/EZMove Wizard, then press Next.

Full backup options display on the first page of the EZBackup wizard. If you want to backup all of 
the exams in the range (even if the exam was previously backed up, check this option). If you 
uncheck this option, the system only backs up exams which have not yet been backed up.

EZBackup does not back up the exams which were previously backed up once by EZBackup or 
Export.

5) Verify the information on the EZBackup/EZMove Wizard, Page 2. The backup may span multiple 
media. This page tells you how many media you need to do this backup. After you have gathered 
the media (allow for one extra media, just in case), you are ready to begin the backup. Press Next.
Free Space/Total Size: tells you the size of the data you have selected to store/and the total size 
of the USB Hard Drive storage media. If the storage capacity of the USB HD is insufficient, you will 
see the message, Selected Location does not have enough free space.

6) A pop-up message appears that provides you with the media label. Label the media, then insert the 
media. Press OK.

8-5-4-2 To review EZBackup and EZMove
You can review backed up media via the Patient Menu, Import, and the DICOM Read dataflow.

To review EZMoved image,

1) Select the patient on the Patient Menu (on the same system where the EZMove was performed).
2) Insert the media volume indicated on the Patient Menu.
3) View the exam from the media.



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 8 - Replacement Procedures 8-73

8-5-5 Option Keys
1) From the touch panel, select Utility -> System-> Backup/Restore.
2) ADD or REMOVE new option key at “Enter New Option Key” field.

 

Figure 8-58   Option Keys

NOTE: This screen shot and options may slightly differ between product type and releases.

3) Record de settings in Table 12.
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8-74 Section 8-6 - Replacement of Front Cover

Section 8-6
Replacement of Front Cover

8-6-1 Manpower
1 person, 1 min.

8-6-2 Tools
None required.

8-6-3 Removal Procedure
1) Simply pull out Front Cover.

Figure 8-59   Front Cover

Front Cover

[R1, R2, R2.5 and R3]

[R4 and R4.5]
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2) Front cover is attached using four “latches” as shown below. 

Figure 8-60   latches

3) Pull out the Air filter from Front Cover.

Figure 8-61   Removal of Air filter

AIR FILTER FRONT
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8-76 Section 8-6 - Replacement of Front Cover

8-6-4 Installation Procedure
1) Front cover and Air filter to be installed in reverse order of removal.
2) Align the edges and simply push to make sure all four “latches” are engaged.

Figure 8-62   Installation of latches

8-6-5 Functional Check
Visual inspection only.
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Section 8-7
Replacement of Cabinet

8-7-1 Manpower
1 person, 5 min.

8-7-2 Tools
None required.

8-7-3 Removal Procedure
1) Cabinet shapes differ for each configuration, but removal/installation procedure are the same.

Figure 8-63   Low Cabinet and High cabinet

2) Slide out Cabinet toward front of the console. No tools required.

Figure 8-64   Slide out Cabinet

Low Cabinet High Cabinet
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8-78 Section 8-7 - Replacement of Cabinet

8-7-4 Installation Procedure
1) Cover to be installed in reverse order of removal.
2) Make sure “latches” on both sides are engaged.

NOTE: For Mid and High Cabinet type, there is “Guide Rail” for installation.

Figure 8-65   Guide Rail and latch

8-7-5 Functional Check
Visual inspection only.
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Section 8-8
Replacement of Side Cover

8-8-1 Manpower
1 person, 15 min.

8-8-2 Tools
Standard Phillips Screwdriver.

8-8-3 Removal Procedure 

8-8-3-1 Removal Procedure - Side Cover L

1) Remove Cabinet.

2) Remove 3 screws for Side Cover L.

Figure 8-67   Unscrew 3 screws

Figure 8-66   Removal of Cabinet
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8-80 Section 8-8 - Replacement of Side Cover

3) Pull out Side Cover (L). There is mechanical hook on bottom of the part.

Figure 8-68   Pull out Side Cover L
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8-8-3-2 Removal Procedure - Side Cover R

1) Remove Cabinet.

2) Unscrew 3 or 4 screws of RS Knobs and remove RS Knobs.

Figure 8-70   Removing RS probe knobs

Figure 8-69   Removal of Cabinet

[R4 and R4.5]

[R1, R2, R2.5 and R3]
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8-82 Section 8-8 - Replacement of Side Cover

3) Unscrew 3 screws for Side Cover R.

4) Pull out Side Cover R. There is mechanical hook on bottom of the part.

Figure 8-72   Pull out Side Cover R 

8-8-4 Installation Procedure
Cover to be installed in reverse order of removal.

8-8-5 Functional Check
Visual inspection only.

Figure 8-71   Unscrew 3 screws

[R1, R2, R2.5 and R3] [R4 and R4.5]
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Section 8-9
Replacement of Rear Cover

8-9-1 Manpower
1 person, 1 min.

8-9-2 Tools
No tool.

8-9-3 Removal Procedure
1) Pull the rear cover and remove it as following figure

Figure 8-73   Removal of Rear Cover.

8-9-4 Installation Procedure
1) Cover to be installed in reverse order of removal.

8-9-5 Functional Check
Visual inspection only.
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8-84 Section 8-10 - Replacement of Side Tray & Foot Rest Cover

Section 8-10
Replacement of Side Tray & Foot Rest Cover

8-10-1 Manpower
1 person, 15 min.

8-10-2 Tools
Standard Phillips Screwdriver.

NOTE: “Short” type driver preferable for Foot Rest Cover removal/installation.

8-10-3 Removal Procedure 

8-10-3-1 Removal Procedure - Side Tray.

Procedures are common for both the Left and Right Side Tray.

1) Remove 2 screws and carefully lift up the side tray.

Figure 8-74   Side Tray screw points

2) Remove 2 screws and carefully lift up the side tray.

Figure 8-75   SIDE TRAY FIX BRKT screw points

SIDE TRAY FIX BRKT
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8-10-3-2 Removal Procedure - Foot Rest Cover

1) Remove Front Cover (refer to section 8-6)
2) Remove Top Cover (refer to section 8-7)
3) Remove Side Cover (refer to section 8-8) 
4) Remove 3 screws.

Figure 8-76   Foot Rest Cover

8-10-4 Installation Procedure
Parts to be installed in reverse order of removal.
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8-86 Section 8-11 - Replacement of Monitor and LCD Arm Plastic Covers

Section 8-11
Replacement of Monitor and LCD Arm Plastic Covers

8-11-1 Replacement of Monitor and LCD Arm Plastic Covers (R1, R2, R2.5 and R3)

8-11-1-1 Manpower
2 person, 15 minutes.

8-11-1-2 Tools
Standard Phillips Screwdriver, 4 mm Hex Wrench.

8-11-1-3 Preparations

1) Lock the Monitor Arm to prevent hazard. Refer to the figure below.

8-11-1-4 Monitor Remove Procedure

1) Unscrew 2 screws, then remove the Monitor rear panel. Refer to the figure below.

WARNINGWARNING Be care that the monitor does not fall during the replacement process.

Figure 8-77   Locking the Monitor Arm

Figure 8-78   Removing the Monitor cover

Locked

2 screws
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2) Unscrew 5 screws, then remove cable clamp.

NOTE: There is cable position marker at red circle.

3) Disconnect three Monitor cables. Refer to the figure below.

Figure 8-80   Disconnecting Monitor cables

Figure 8-79   Unscrew cable clamp screws

Caution - This Clamp was only 
applied by opposite direction
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8-88 Section 8-11 - Replacement of Monitor and LCD Arm Plastic Covers

4) Unscrew 2 screws, then separate the Monitor from the Monitor Stand Arm. Refer to the figure 
below.

Figure 8-81   Unscrewing 2 screws & separating the Monitor

8-11-1-5 Monitor Installation Procedure
Parts to be installed in reverse order of removal. 

8-11-1-6 LCD Arm Plastic Covers Remove Procedure

1) Unscrew 1 screw, than remove 3rd Arm Cover. Refer to the figure below.

Figure 8-82   Removing the 3rd Arm Cover
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2) Remove 2nd Axis Cover. Refer to the figure below.

3) Remove 2nd Arm Cover. Refer to the figure below.

Figure 8-83   Removing 2nd Axis Cover

Figure 8-84   Removing 2nd Arm Cover
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8-90 Section 8-11 - Replacement of Monitor and LCD Arm Plastic Covers

4) Unscrew 1 screw and Remove the 1st Arm Cover. Refer to the figure below.

8-11-1-7 LCD Arm Plastic Covers Installation Procedure
Parts to be installed in reverse order of removal. 

Figure 8-85   Removing the 1st Arm Cover
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8-11-2 Replacement of Monitor and LCD Arm Plastic Cover (R4 and R4.5)

8-11-2-1 Manpower
2 person, 15 minutes

8-11-2-2 Tools
Standard Phillips Screwdriver, Hex Wrench set, Nipper

8-11-2-3 Preparations

1) Lock the Monitor Arm to prevent hazard.

8-11-2-4 Monitor Remove Procedure

1) Detach Monitor Cable Cover.

Figure 8-86   Locking the Monitor Arm

Figure 8-87   Removing the monitor cable cover



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

8-92 Section 8-11 - Replacement of Monitor and LCD Arm Plastic Covers

2) Unscrew 5 screws, then disconnect three monitor cables.

3) Unscrew 2 screws.

Figure 8-88   Unscrewing 5 screws and disconnecting monitor cables

Figure 8-89   Unscrewing 2 screws
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4) Unscrew 2 screws only halfway through and do not remove these screws.

5) Push the monitor so that screw holes meet the screw head as following figure and remove the 
monitor. 

Figure 8-90   Halfway unscrewing points

Figure 8-91   Pushing the monitor to remove the monitor
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8-94 Section 8-11 - Replacement of Monitor and LCD Arm Plastic Covers

8-11-2-5 Monitor Remove Procedure (R4 and R4.5 HD monitor)

1) Detach the Monitor Cable Cover.

2) Disconnect the USB cable.

Figure 8-92   Removing the monitor cable cover

Figure 8-93   Disconnecting USB cable



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 8 - Replacement Procedures 8-95

3) Unscrew 3 screws and unlock the cable clamp, then disconnect three monitor cables.

4) Unscrew 2 screws.

5) Unscrew 2 screws only halfway through and do not remove these screws.

6) Push the monitor so that screw holes meet the screw head as following figure and remove the 

Figure 8-94   Unscrewing 3 screws and disconnecting monitor cables

Figure 8-95   Unscrewing 2 screws

Figure 8-96   Half unscrewing points
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8-96 Section 8-11 - Replacement of Monitor and LCD Arm Plastic Covers

monitor. 

8-11-2-6 Monitor Installation Procedure
Parts to be installed in reverse order of removal.

Figure 8-97   Pushing the monitor to remove the monitor 
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8-11-2-7 LCD arm Plastic covers Remove procedure

1) Unscrew 2 screws, then detach Pan Arm Down Cover. 

2) Unscrew 2 screws, then detach Lift Arm Cover, L, R.

Figure 8-98   unscrewing 2 screws and separating the Pan Arm Down Cover 

Figure 8-99   unscrewing 2 screws and detaching the Lift Arm Cover L, R
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8-98 Section 8-11 - Replacement of Monitor and LCD Arm Plastic Covers

3) Detaching the Joint Cover.

4) Unscrew 1 screw, then detach Extension Arm Cover. 

8-11-2-8 LCD Arm Plastic Covers Installation Procedure
Parts to be installed in reverse order of removal. 

Figure 8-100   Detaching the Joint Cover

Figure 8-101   Unscrewing 1 screw and detaching the Extension Arm Cover
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Section 8-12
Replacement of Monitor Covers

8-12-1 Replacement of Monitor Covers (R1, R2, R2.5 and R3)

8-12-1-1 Manpower
2 persons, 10 minutes.

8-12-1-2 Tools
Standard Phillips Screwdriver, Hex Wrench

8-12-1-3 Pre-Work

1) LCD Monitor and Monitor Cable Cover removed (refer to section 8-11-1)

8-12-1-4 Removal Procedure

1) Remove 9 screws and remove the Monitor Rear Cover.

Figure 8-102   Monitor Rear Cover screw points

2) Remove 11 screws and remove the Monitor Front Cover and Glass Filter Assy.

Figure 8-103   Monitor Front Cover screw points
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8-100 Section 8-12 - Replacement of Monitor Covers

8-12-1-5 Installation Procedure

1) Parts to be installed in reverse order of removal.

8-12-1-6 Functional Check
Visual Check only.

CAUTION
!! CAUTION: 

Make sure not to remain any dust on Glass during Front Cover and Glass Filter Assy 
installation
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8-12-2 Replacement of Monitor Covers (R4 and R4.5)

8-12-2-1 Manpower
2 persons, 10 minutes.

8-12-2-2 Tools
Standard Phillips Screwdriver, Hex Wrench, Nipper, Hook Remover

8-12-2-3 Pre-Work

1) LCD Monitor and Monitor Cable Cover removed (refer to section 8-11-2-4)

8-12-2-4 Removal Procedure

1) Unscrew 4 screws and remove the Monitor Rear Cover by using Hook remover.

Figure 8-104   Unscrewing 4 screws and separating Monitor Rear Cover
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8-102 Section 8-12 - Replacement of Monitor Covers

2) Unscrew 8 screws and remove the Monitor front cover.

8-12-2-5 Monitor Covers Installation Procedure
Parts to be installed in reverse order of removal. 

Figure 8-105   Unscrewing 8 screws
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8-12-3 Replacement of Monitor Covers (R4 and R4.5 HD monitor)

8-12-3-1 Manpower
2 persons, 10 minutes.

8-12-3-2 Tools
Standard Phillips Screwdriver, Hex Wrench, Nipper, Hook Remover

8-12-3-3 Pre-Work

1) Monitor and Monitor Cable Cover removed (refer to section 8-11-2-5)

8-12-3-4 Removal Procedure

1) Unscrew 4 screws and remove the Monitor Rear Cover by using Hook remover.

Figure 8-106   Unscrewing 4 screws and separating Monitor Rear Cover
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8-104 Section 8-12 - Replacement of Monitor Covers

2) Unscrew 4 screws and remove the Monitor front cover by using Hook remover.

8-12-3-5 Monitor Covers Installation Procedure
Parts to be installed in reverse order of removal.

Figure 8-107   Unscrewing 4 screws and remove the Monitor Front Cover
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Section 8-13
Replacement of Fixed Arm Cover and Fixed Arm Holder Grip

8-13-1 Manpower
2 person, 5 minutes.

8-13-2 Tools
Standard Phillips Screwdriver, Hex Wrench.

8-13-3 Removal Procedure

8-13-3-1 Removal Procedure - Fixed Arm Cover

1) Remove 1 screw and lift up the Fixed Arm Cover.

Figure 8-108   Fixed Arm Cover screw point

8-13-3-2 Removal Procedure - Fixed Arm Holder Grip

1) Remove 2 screws and pull out the Fixed Arm Holder Grip.

Figure 8-109   Fixed Arm Holder Grip Cover screw points
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8-106 Section 8-13 - Replacement of Fixed Arm Cover and Fixed Arm Holder Grip

8-13-4 Installation Procedure
Parts to be installed in reverse order of removal.

8-13-5 Functional Check
Visual Check only.
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Section 8-14
Replacement of OPIO and Related Parts

NOTE: This section describes removal and installation of OPIO and related parts.
OPIO Assy itself, Main PWA Assy, LCD Touch module Assy, HUB Board, Encoder, Freeze key Assy, 
OPIO AN Key & Gel warmer board and Trackball Assy.

8-14-1 Replacement of OPIO and Related Parts (R1, R2, R2.5 and R3)

8-14-1-1 Manpower
1 person, 5 minutes.

8-14-1-2 Tools
Standard Phillips Screwdriver.

8-14-1-3 Removal Procedure 
Nesting of the parts are as follows.

For example, to access Encoder for repair, OP Panel must be removed and then OPIO Main PWA assy 
must be removed.

Figure 8-110   OP Panel Assy

External USB Board

OPIO AN Key & GEL 
Warmer board
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8-108 Section 8-14 - Replacement of OPIO and Related Parts

8-14-1-3-1 Removal Procedure - Trackball Ring

NOTE: Removal of Trackball Ring and Cleaning does not require tools.

1) Turn the ring counter clock-wise 
2) Lift trackball from OP Panel

Figure 8-111   Trackball Ring

8-14-1-3-2 Removal Procedure - OP Panel Assy

Figure 8-112   OP Panel Assy

1) Remove 7 screws from bottom of the OPIO Base.

Figure 8-113   Bottom of OPIO Base
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2) Remove 2 screws on OPIO covers. 

Figure 8-114   Rear of OPIO Base

3) Remove USB cables on Touch panel and unscrew 2 screws. Refer to following figure.

Figure 8-115   USB cable position and screw points.

USB connector

Screw points
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8-110 Section 8-14 - Replacement of OPIO and Related Parts

4) Lift OP Panel.

Figure 8-116   Lift OP Panel

5) Remove USB locking type Cable
6) Remove OPIO Power cable.
7) Remove USB locking type connector.

Figure 8-117   Removal of connectors

8) OP Panel can now be separated from the console.

USB locking type Cable

OPIO Power cable

GEL & AN KEY
Cable
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8-14-1-3-3 Removal Procedure - AN Keyboard (Option)

1) Remove 4 screws on AN keyboard Brkt. ( 2 screws on right side and 2 screws on left side)

Figure 8-118   Removal of screws

2) Unscrew 2 screws on AN keyboard Brkt only half . ( 1 screw on right side and 1 screw on left side). 
Do not remove these screws.(Red circle in following figure)

Figure 8-119   Half unscrewing points

3) Push the AN keyboard so that screw holes meet the screw head as following figure.

Figure 8-120   Half unscrewing points
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8-112 Section 8-14 - Replacement of OPIO and Related Parts

4) Disconnect USB cables as following figure.

Figure 8-121   Disconnecting USB cable

8-14-1-3-4 Removal Procedure - Trackball

1) Remove a connector from back of OP Panel Assy. 
2) Remove 2 screws.
3) Slowly lift up trackball from OP Panel.

Figure 8-122   Trackball removal
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8-14-1-3-5 Removal Procedure - LCD Touch Panel Assy

1) Disconnect connectors as following figure.

Figure 8-123   Disconnection of LCD Touch panel Assy

2) Remove 4 screws as following figure.

Figure 8-124   Removal of 4 screws of LCD Touch panel Assy
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8-114 Section 8-14 - Replacement of OPIO and Related Parts

8-14-1-3-6 Removal Procedure - Freeze key assy

1) Remove connector as following figure

Figure 8-125   Disconnection of freeze key Assy connector

2) Remove 3 screws from Freeze key Assy

Figure 8-126   Screw points of freeze key assy .

3) Slowly lift board from OP Panel.

8-14-1-3-7 Removal Procedure - OP Panel Main PWA Assy

1) Carefully lift up knobs as following figures
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2) Place the new knobs.

Figure 8-127   Position of knobs

Figure 8-128   Removal of knobs
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8-116 Section 8-14 - Replacement of OPIO and Related Parts

3) Disconnect freeze key assy connector, trackball connector and Touch panel connectors. Refer to 
following figure.

Figure 8-129   Removal of connectors on Main PWA assy

Trackball
connector

Freeze key 
connector

Touch panel
connector
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4) Remove 23 screws around PWA. Refer to following figure. 

Figure 8-130   Screw points on Main PWA Assy

8-14-1-3-8 Removal Procedure - Encoder on PWA

1) Remove OP Panel Main PWA Assy.
2) Loosen nut.
3) Remove part

Figure 8-131   Removal of Encoder 

8-14-1-3-9 Removal Procedure - Touch panel

1) Remove OP Panel Assy.
2) Separate LCD Touch Panel Assy from OP Panel Assy.
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3) Remove 12 screws on 3 BRKT and remove 3 BRKT Refer to following figure.

Figure 8-132   Screw points to remove 3 BRKT
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4) Remove 10 screws on BRKT and remove 1 BRKT Refer to following figure.

Figure 8-133   Screw points to remove 3 BRKT

5) Remove flexible connectors and carefully lift up Touch panel.

Figure 8-134   Disconnection of Touch panel connector

8-14-1-4 Installation Procedure

1) Parts to be installed in reverse order of removal.

NOTE: Make sure to assemble “Rubber Sheet” securely to PWA.

Figure 8-135   Installation of PWA
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NOTE: Make sure to connect Touch panel connector to hub board as blow figure.

Figure 8-136   Installation of Touch panel connector

NOTE: In some cases, when OPIO is replaced the Windows base system may recognize new OPIO as ‘new’ 
hardware device.
This could bring Touch Panel graphics to top of main screen resulting to have only the wall paper (ping, 
cherry blossom) without touch panel buttons.
When this occurs, go into Windows desktop, and double click “OPIO Position Reset” icon.
Alternatively, go to Windows graphics property manager, and bring SCREEN3 to below SCREEN1.

8-14-1-5 Functional Check

CAUTION
!! CAUTION: 

Make sure not to remain any dust on Glass during OPIO Upper Cover and Touch Screen Assy 
installation 

Test Refer to Note

System Exterior Visual Check section 4-3-1 Control panel visual check only

Power On/Off section 4-3-3

System Integration Checks section 4-3-5 section 4-3-5-1 OPIO Test only

OPIO Interface Check section 4-3-9
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8-14-2 Replacement of OPIO and Related Parts (R4 and R4.5)

8-14-2-1 Manpower
1 person, 5 minutes

8-14-2-2 Tools
Standard Phillips Screwdriver

8-14-2-3 Replacement Procedure
Nesting of the parts are as follows.

For example, to access Encoder for repair, OPIO Assy must be removed and then OPIO Main Board 
must be removed. 

Figure 8-137   OPIO Assy and GEL USB HUB Board

OPIO Assy GEL USB HUB Board
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8-14-2-3-1 Removal Procedure - Trackball Ring

NOTE: Removal of Trackball Ring and Cleaning does not require tools.

1) Turn the ring counter clock-wise 
2) Lift trackball from OP Panel

8-14-2-3-2 Removal Procedure - OPIO Assy

1) Unscrew 7 screws from bottom of the OPIO Base.

Figure 8-138   OPIO Assy

Figure 8-139   Unscrewing 7 screws
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2) Unscrew 2 screws on OPIO Top Covers

3) Disconnect USB cables on Touch panel and unscrew 2 screws.

4) Lift OPIO Assy up.

Figure 8-140   Unscrewing 2 screws on OPIO Top Covers

Figure 8-141   Disconnecting USB cables and unscrewing 2 screws

Figure 8-142   Lifting OPIO Assy up
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5) Disconnect 4 cables and separate the OPIO assy

6) Assembly Procedure - OPIO Assy
Parts to be installed in reverse order of removal.

8-14-2-3-3 Removal Procedure - AN Keyboard (Option)
Refer to section 8-14-1-3-3.

8-14-2-3-4 Removal Procedure - Trackball
Refer to section 8-14-1-3-4

8-14-2-3-5 Removal Procedure - OPIO Top assy

1) Disconnect 2 cables

Figure 8-143   Disconnecting cables

Figure 8-144   Disconnecting cables
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2) Unscrew 4 screws and separate OPIO Top assy.

3) Assemble Procedure - OPIO Top assy
Parts to be installed in reverse order of removal.

8-14-2-3-6 Removal Procedure - Freeze key assy

1) Disconnect cable and unscrew 3 screws

2) Detach the Freeze key assy
3) Assemble Procedure - Freeze key assy

Parts to be installed in reverse order of removal.

Figure 8-145   Unscrewing 4 screws and separating OPIO Top assy

Figure 8-146   
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8-14-2-3-7 Removal Procedure - OPIO Main board

1) Detach 11 knobs from the OPIO Bottom assy.

2) Disconnect freeze key assy connector, trackball connector and Touch panel connectors. 

Figure 8-147   Detaching 11 knobs

Figure 8-148   Disconnecting 4 cables
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3) Unscrew 20 screws on Main board and detach the board.

4) Assemble Procedure - OPIO main board
Parts to be installed in reverse order of removal.

8-14-2-3-8 Removal Procedure - Encoder on main board

1) Remove OPIO main board (Refer to the section 8-14-2-3-7)
2) Unfasten nut and detach the encoder.

3) Assemble Procedure - Encoder on main board
Parts to be installed in reverse order of removal.

Figure 8-149   unscrewing 20 screws

Figure 8-150   unfastening nut and detaching the encoder
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8-14-2-3-9 Removal Procedure - Joystick encoder on main board

1) Remove OPIO main board (Refer to the section 8-14-2-3-7)
2) Unfasten nut and detach the encoder.

3) Assemble Procedure - Joystick Encoder on main board
Parts to be installed in reverse order of removal.

Figure 8-151   Unfastening nut and detaching the Joystick encoder



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 8 - Replacement Procedures 8-129

Section 8-15
Replacement of the Caps for Hardkeys

8-15-1 Manpower
1 person, approx. 1 minute/cap.

8-15-2 Tools
Small-sized slotted screwdriver or tweezers.

8-15-3 Removal Procedure
1) By means of a small slotted screwdriver, carefully push against the hardkey cap.
2) Lift the cap, until it is completely loosened from its base.
3) Place the new hardkey cap down until it snaps into position.

Figure 8-152   Push against the circle cap and lift it

NOTE: Each of the key have “Slit” where flathead screwdriver can be inserted for easy removal.

Figure 8-153   Slit for removal

8-15-4 Installation Procedure
Parts to be installed in reverse order of removal.

Slit for removal
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8-15-5 Functional Check

Test Refer to Note

System Exterior Visual Check section 4-3-1 Control panel visual check only

Power On/Off section 4-3-3

System Integration Checks section 4-3-5 section 4-3-5-1 OPIO Test only

OPIO Interface Check section 4-3-9
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Section 8-16
Replacement of Key Caps (by special native language keys)

8-16-1 Manpower
1 person, 30 minutes.

8-16-2 Tools
• Regular Standard Phillips Screwdriver
• Screwdriver (Diameter : 3mm)

8-16-3 Preparations

1) Power Off/Shutdown the system.

8-16-4 Removal Procedure
1) Remove '1' Key, ‘Left Shift' Key, ‘F5’ Key, ‘6’ Key, ‘7’ Key, ‘H’ Key, ‘J’ Key, ‘N’ Key, ‘Back space’ 

Key, ‘Right Shift’ Key and ‘Pg Up’ Key by using fingertips. Refer to below Figure 8-75.

Figure 8-154   Remove key : ‘1’, ‘Left Shift’, ‘F5’, ‘6’, ‘7’, ‘H’, ‘J’, ‘N’, ‘Back space’, ‘Right Shift’, ‘Pg Up’

2) Remove the 6 screws using the plus(+) screwdriver. Refer to below Figure 8-76

Figure 8-155   Loosen the 6 screws

CAUTION
!! CAUTION: 

Before you replace the boards, please make sure you wear the Ground strap, which prevents 
ESD problems just in case. 
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3) Carefully pull out key caps. Refer to below Figure 8-77

Figure 8-156   Detaching key caps.

8-16-5 Installation Procedure 
1) Parts to be installed in reverse order of removal.

8-16-6 Replacement Checking Procedure
1) Insert service dongle key in the front USB port of OPIO. 
2) Push the power button and then click the exit.
3) Exit to windows mode by inputting the password.
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4) Run the OPIO Test tool (ScFpApiTest.exe) in the desktop screen and then click the “Op-panel 
Open” button of test tool. (Program path: C:\scanner\target\bin\ScFpApiTest.exe)

Figure 8-157   

5) Check on the “Keyboard Test on” check box.
6) Check that pressed key is displayed except for ‘Fn’ key, when AN Keyboard is pressed.
7) End ScFpApiTest by click the “Op-Panel Close” button.

Figure 8-158   

8-16-7 Functional Check

Test Refer to Note

System Exterior Visual Check section 4-3-1 Control panel visual check only

Power On/Off section 4-3-3

System Integration Checks section 4-3-5 section 4-3-5-1 OPIO Test only

OPIO Interface Check section 4-3-9
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Section 8-17
Replacement around Nest Box

NOTE: This section covers replacement of components related to Nest Box. 
: MPI,MCB,MDC,MIO,CWD,DCWD,EEPROM,DC4D,Battery,HDD and SOM

8-17-1 Manpower
1 person, 15 minutes for each part.

8-17-2 Tools
Standard Phillips Screwdriver.

8-17-3 Pre-Work
1) Front cover removed. (refer to section 8-6-3)
2) Rear cover removed. (refer to section 8-9-3)

8-17-4 Nest Box Access
1) Remove Rear Cover. (refer to section 8-9)
2) Remove 2 screws and Power Cord Fix Bracket.

Figure 8-159   Power Cord Fix Bracket.

Power cord Fix Bracket



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 8 - Replacement Procedures 8-135

3) Remove 5 screws and Cable Cover Bracket.

Figure 8-160   Cable Cover Bracket

4) Disconnect Cables.

Figure 8-161   Cable Disconnecting points

Cable Cover 
Bracket
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8-17-5 Removal Procedure - Nest Box 

NOTE: Before working with Nest box, be sure to remove probes.

1) Remove front cover. (refer to section 8-6)
2) Disconnect 1 fan connector of bottom fan.
3) Unlock cable clamp, then pull out connector and cable of bottom fan. Refer to following figures.

Figure 8-162   Fan Connector

4) Remove 2 screws on front side.

Figure 8-163   Front side screw points

5) Remove the rear cover. (refer to section 8-9)
6) Remove Power cord fix bracket and power cord. (refer to section 8-17)
7) Remove cable cover bracket and disconnect cables. (refer to section 8-17)
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8) Remove 2 screws on rear side.

Figure 8-164   Rear side screw points

9) Pull out Nest Box.

Figure 8-165   Nest Box

8-17-6 Installation Procedure - Nest Box.
Parts to be installed in reverse order of removal.
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8-17-7 Removal Procedure - Board Assy in Nest Box
1) Get Next Box access.
2) Remove 7 screws on EMI bracket.

3) Draw MPI, MCB and IO Box out of the Nest Frame

Figure 8-166   Screw points on Nest Box

Figure 8-167   Separating Board Assy
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Figure 8-168   Board assys in Nest Box
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8-17-8 Removal Procedure - Separating MPI and MCB
1) Unscrew 6 screws. Refer to following figure.

Figure 8-169   Screw points on MPI assy
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2) Carefully separate MPI assy from MCB assy. Refer to following figure.

Figure 8-170   Lifting up MPI and position of Stacking up connector on MPI assy

[R1, R2, R2.5 and R3]

[R4 and R4.5]
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8-17-9 Removal Procedure - Separating DCWD Board(Option) from MPI

8-17-9-1 R1, R2, R2.5 and R3
Philips screw-driver required to add this part. 

1) Remove 3 screws on MPI assy. 

Figure 8-171   DCWD Board screw points

2) Carefully separate DCWD board from MPI assy not to damage the DCWD connector. Refer to 
following figure.

Figure 8-172   Position of DCWD board connector
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8-17-9-2 R4 and R4.5

1) Separating MPI from MCB assy : refer to section 8-17-8

2) Remove 3 screw on bottom side of MPI assy

Figure 8-173   Separated MPI assy

Figure 8-174   DCWD board screw points
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3) Lift up DCWD board from MPI assy

Figure 8-175   Lift up DCWD board

Figure 8-176   Separated DCWD board
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8-17-10 Separating MDC assy from MCB assy

8-17-10-1 BIOS update

NOTE: In case of SOM GEPN “7324558-x” or “7324560-x”, it does not need to follow this procedure. Skip 
section 8-17-10-1 and go to section 8-17-10-2

1) Before replacing MDC assy (R1, R2), BIOS update is required if the current BIOS version is not the 
latest. The latest BIOS version is GEMARUR9. BIOS check and update procedure are described in 
the following procedure. 

1) Checking the current BIOS revision

1.) Turn the system on by pushing the power button.
2.) Enter the BIOS mode by pushing Delete button or Trackball left-side button.

(* This procedure needs the system BIOS password)
3.) Check the “OEM BIOS version”.

(* The BIOS information including OEM BIOS Version could be different than above 
figure. This is just for reference.)

4.) If the “OEM BIOS version” is not “GEMARUR9”, it needs to be updated to the latest 
version. The latest version of the BIOS is “GEMARUR9”.

2) Preparing BIOS update application and MARU BIOS binary file

1.) Need to download BIOS update application and MARU BIOS binary file. 
Access “SOM_BIOS_Revision_tool & MARU BIOS binary file” in the GE BOX.
https://ge.box.com/s/2yr0onbu7z8iq0fyd5wgs580vgi2tr5y

2.) Download two files
- BIOS update application : CGUTL_CGOS.zip
- Latest BIOS file : GEMARUR9.BIN

3.) Copy those files into an USB memory. The free capacity of the USB memory shall be at 
least 200MB.

3) Installing BIOS update tool

1.) Turn the system on and enter the maintenance mode.
(* This procedure needs a service dongle and maintenance access password.)

2.) Plug in the USB memory to the system.

Figure 8-177   

https://ge.box.com/s/2yr0onbu7z8iq0fyd5wgs580vgi2tr5y
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3.) Copy the BIOS update application and the latest BIOS file. 

4.) Extract BIOS update application file, and run “Setup.exe” file in the folder Cgos.
(\\...\CGUTL_CGOS\Cgos-x32-x64\Cgos\)

Figure 8-178   

Figure 8-179   
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5.) If the installation is complete, the program will be shown in the installed program list under 
“Program and Features”. 
The program name is 'congatec CGOS API”.

4) BIOS update

1.) Run “CGULGUI.exe” file in the folder win32.
(\\...\CGUTL_CGOS\Cgos-x32-x64\Cgos\)

Figure 8-180   

Figure 8-181   
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2.) Select “Board (CGOS)” and “BIOS Update”.

3.) Select “Select BIOS file”.

Figure 8-182   

Figure 8-183   
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4.) Find the latest BIOS file and select it and “Open”.

5.) Select “Update BIOS”.

Figure 8-184   

Figure 8-185   



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

8-150 Section 8-17 - Replacement around Nest Box

6.) After updating the BIOS, it will be shown like below. Check if the Current OEM BIOS 
version is “GEMARU 9”. Then, select “Close”.

7.) Select “Close”.

Figure 8-186   

Figure 8-187   
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5) Deleting BIOS update application and the BIOS file.

1.) Enter “Programs and Features” in Control Panel. Select “Congatec CGOS API” and 
“Uninstall/Change”.

2.) Delete copied files permanently. Select those files and push [Shift] + [Ctrl] + [Delete] keys 
all together at the same time. 

Figure 8-188   

Figure 8-189   
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3.) Turn the system off.

Select ‘Start’  and ‘Shut down’ .

6) Checking BIOS update completion

1.) Turn the system on by pushing the power button.
2.) Enter the BIOS mode by pushing Delete button or Trackball left-side button.

(* This procedure needs the system BIOS password)
3.) Check that “OEM BIOS version”.

It will be shown as below in main page.

Figure 8-190   
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8-17-10-2 Replacement Procedure

1) Remove 7 screws around MDC assy. Refer to following figure.

Figure 8-191   Screw points around MDC assy

2) Carefully separate MDC assy from MCB assy. Refer to following figure.

Figure 8-192   Removal of MDC assy
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8-17-11 Handling EEPROM on MCB Board
EEPROM on MCB board contains vital information.

A) System Serial Number that is matched against stored software option key.
B) ComExpress Functional REV that is monitored for sub-system compatibility.
Therefore, when MCB board is replaced, EEPROM must be moved from one board to the other to make 
sure vital information pertaining to the system is transferred to the new MCB board. 

EEPROM must be moved.

Figure 8-193   EEPROM

1) Locate EEPROM on MCB Board. 

Figure 8-194   Location of EEPROM (example)

2) Gently lift up EEPROM from its socket by using a chip-puller or a small straight blade screwdriver.

NOTE: Be sure not to bend “legs” of EEPROM. They are fragile.

MCB Board being replaced New MCB Board
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3) Remove EEPROM from replacement MCB board if present.
4) Verify direction of the EEPROM Slot by aligning EEPROM “notch” mark to that of MCB board. print 

mark.

Figure 8-195   Aligning EEPROM

NOTE: Inserting EEPROM in wrong direction will result in permanent damage to EEPROM or to MCB board. 
Proceed with caution.

5) Verify tips of all 8 pins are aligned with socket.
6) Gently push down EEPROM to its position.

Alignment marks

U44 Socket
(print mark)
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8-17-12 Separating MCB assy from Brackets and COM Express
1) Remove 8 screws around MCB assy. Refer to following figure.

Figure 8-196   Screw points around MCB assy
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2) Remove MCWD board from MCB assy. Refer to following figure.

NOTE: Be careful not to damage CWD connector.

Figure 8-197   Removal of MCWD board.

3) Remove Stud on MCB assy and carefully lift up the MCB assy. Refer to following figure.

Figure 8-198   Stud position on MCB board.

MCWD board assy
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8-17-13 Separating DC4D Unit from IO BOX
1) Unscrew 12 screws to remove the IO BOX Cover.

Figure 8-199   Screw points of IO BOX cover

2) Unscrew five screws to remove the DC4D from the MIO Assy. Refer to following figure.

Figure 8-200   Screw points of DC4D Assy

3) Carefully lift up the DC4D unit.
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8-17-14 Separating Battery Unit from IO BOX 
1) Unscrew 12 screws to remove the MIO Cover. (refer to section 8-17-13)
2) Unscrew 8 screws and 2 Battery connectors. Refer to following figure.

Figure 8-201   Screw points and Connectors on battery assy

3) Carefully lift up the battery unit
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8-17-15 Separating HDD (R1, R2, R2.5) or SSD (R3)
1) Open the front cover. (refer to section 8-6)
2) Remove 4 screws around HDD Bracket Refer to following figure.

Figure 8-202   Screw points around HDD Bracket.

3) Carefully pull down HDD assy. Refer to following figure.

NOTE: Be careful not to damage HDD connector

Figure 8-203   Removal of HDD assy and position of HDD connector
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8-17-16 Separating M.2 SSD (R4 and R4.5)
1) Take the board assy out of the nest box (Refer to section 8-17-7)
2) Remove eight screws (check red-designating circles out) and separate MCB from the assy.

3) Remove one screw and pull out M.2 SSD.

Figure 8-204   

Figure 8-205   
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8-162 Section 8-17 - Replacement around Nest Box

8-17-17 Separating COM Express

8-17-17-1 Separating COM Express (R1, R2, R2.5 and R3)

1) Unscrew 5 screws on bottom  side of MCB board assy. Refer to following figure.

Figure 8-206   Screw points for removal of COM Express

2) Disconnect fan cable and carefully detach COM Express module. Refer to following figure.

NOTE: Be careful not to damage COM Express connector

Figure 8-207   Detaching COM Express

3) Unscrew 4 screws in the side of COM Express to remove SOM bracket and carefully lift up the COM 
express from the bracket. Refer to following figure

Figure 8-208   Removal COM Express Bracket
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8-17-17-2 Separating COM Express (R4 and R4.5)

1) Disconnect fan cable.

2) Unscrew five male-type-screws.

Figure 8-209   Disconnecting fan cable

Figure 8-210   Unscrewing five male type screws
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8-164 Section 8-17 - Replacement around Nest Box

3) Detach COM-Express module.

4) Unscrew four male-type-screws in the side of COM-Express module. 
And remove SOM Bracket from the COM-Express module.

Figure 8-211   Detaching COM-Express

Figure 8-212   Unscrewing 4 male-type-screws
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8-17-18 Installation Procedure - MPI, MCB, MDC, DC4D, HDD, Battery and COM Express
1) Parts to be installed in reverse order of removal.

8-17-19 Functional Check - MPI, MCB, MDC, IO Box
Refer to section 4-4 for Functional Diag Test List

8-17-20 Removal Procedure - MBP assy

8-17-20-1 Removal Procedure - MBP assy (R1, R2, R2.5 and R3)

1) Remove Nest Box from system.
2) Remove MPI, MCB and IO Box out of Nest Frame
3) Remove 4 screws (Circle) and fan connector (Square). 

Figure 8-213   Screw points and connector point to remove MBP

4) Remove 6 screws.

Figure 8-214   Screw points to remove MBP
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8-17-20-2 Removal Procedure - MBP assy (R4 and R4.5)

1) Remove Nest Box from system
2) Remove MCB, MDC< MPI boards assy and IO BOX
3) Remove four screws and fan connector

(check red-designating circles)

4) Remove screw (red-designating circle) and pull CSI out of system

Figure 8-215   

Figure 8-216   
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5) Remove stud of CSI and six screws (red-designating circle)
6) Pull MBP4 out of system

8-17-21 Installation Procedure - MBP assy
Parts to be installed in reverse order of removal.

8-17-22 Functional Check
Refer to section 4-4 for Functional Diag Test List.

Figure 8-217   
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8-168 Section 8-18 - Replacement of Front fan

Section 8-18
Replacement of Front fan

8-18-1 Manpower
1 Person, 10 minutes.

8-18-2 Tools
Standard Phillips Screwdriver.

8-18-3 Removal Procedure
1) Remove the Front Cover from system. (refer to section 8-6)
2) Remove 4 screws and disconnect fan connector.
3) Unlock cable clamp (square), then pull out connector and cable. Refer to following figures.

Figure 8-218   Fan screw points and disconnecting fan connector

8-18-4 Installation Procedure
Parts to be installed in reverse order of removal.

8-18-5 Functional Check
Visual examination.

1) Verify that Fan is rotating when system is turned ON.
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Section 8-19
Replacement of Bottom fan

8-19-1 Manpower
1 Person, 10 minutes.

8-19-2 Tools
Hex Wrench.

8-19-3 Removal Procedure
1) Remove the Front Cover from system. (refer to section 8-6)
2) Remove the nest Box from system. (refer to section section 8-17-5)
3) Remove 4 Hex screws, front bottom and rear side.

Figure 8-219   Fan screw points of bottom fan assy
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8-170 Section 8-19 - Replacement of Bottom fan

4) Place bottom fan cable not to be entangled on system frame as following figure

Figure 8-220   Placing bottom fan connector

5) Pull out bottom fan assy as following figure

Figure 8-221   Removal of bottom fan Assy
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6) Remove 4 screws on the fan.

Figure 8-222   Screw points of bottom fan.

8-19-4 Installation Procedure
Parts to be installed in reverse order of removal.

8-19-5 Functional Check
1) After turn on the system, confirm the fan rotating by feeling wind at the bottom fan dust filter. 
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8-172 Section 8-20 - Replacement of Rear Handle

Section 8-20
Replacement of Rear Handle

8-20-1 Manpower
1 Person, 10 minutes.

8-20-2 Tools
Standard Phillips Screwdriver and 6mm Hex Wrench.

8-20-3 Removal Procedure
1) Remove 1 screw and remove the Link Arm Top Cover as following figure.

Figure 8-223   Removal of Link Arm Top Cover. 

2) Remove 2 Hex screws. Refer to following figure.

Figure 8-224   Hex screw points of Rear Handle

8-20-4 Installation Procedure
Parts to be installed in reverse order of removal.

NOTE: Hex screws should be tightened.

CAUTION
!! CAUTION: 

Rear Handle will not stay in position without screws. Make sure not to drop the part when 
removing/installing Rear Handle
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8-20-5 Functional Check
Visual Check only.
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8-174 Section 8-21 - Replacement of Link Arm Cable Hook

Section 8-21
Replacement of Link Arm Cable Hook

8-21-1 Manpower
1 Person, 10 minutes.

8-21-2 Tools
Standard Phillips Screwdriver.

8-21-3 Removal Procedure
1) Remove 1 screw and remove the Link Arm Top Cover as following figure.

Figure 8-225   Removal of Link Arm Top Cover. 

2) Remove 2 screws. Refer to following figure.

Figure 8-226   screw points of Link Arm Cable Hook

8-21-4 Installation Procedure
Parts to be installed in reverse order of removal.

8-21-5 Functional Check
Visual Check only.
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Section 8-22
Replacement of Caster

8-22-1 Manpower
2 persons, 15 minutes.

8-22-2 Tools
24mm Socket or adjustable Wrench, Standard Phillips Screwdriver

NOTE: “Short” type driver preferable for Foot Rest Cover removal/installation.

8-22-3 Removal Procedure

Figure 8-227   Caster 

NOTE: Press the caster wheel locks and ensure that they prevent the system from moving.

1) Remove Front Cover (refer to section 8-6)
2) Remove Top Cover (refer to section 8-7)
3) Remove Side Cover (refer to section 8-8)

Total Lock

Total Lock Total Lock

Swivel Lock
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8-176 Section 8-22 - Replacement of Caster

NOTE: This does not require any tools. Be careful not to damage Hand during pulling hook of the cap

Figure 8-228   Caster Cap and hook points 

4) Remove Caster Cap by slightly pulling hook of the cap to outside and then move upward.
Procedures are common for both the Left and Right Caster Cap.

5) Remove 3 screws. 

Figure 8-229   Foot Rest Cover 
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6) Remove Nut and replace Caster.

Figure 8-230   Removable Nut of Caster

8-22-4 Installation Procedure
Parts to be installed in reverse order of removal.

NOTE: Hex screws should be tightened.

8-22-5 Functional Check
Visual inspection Only.

CAUTION
!! CAUTION: 

Proceed with extreme caution and avoid system tipping over. The system weighs 
approximately 60kg.



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

8-178 Section 8-23 - Replacement of the COM Express

Section 8-23
Replacement of the COM Express

8-23-1 Manpower
1 Person, 5 minutes.

8-23-2 Tools
Standard Phillips Screwdriver.

8-23-3 Removal Procedure

8-23-3-1 Removal Procedure (R1, R2, R2.5 and R3)

1) Separate MCB Assy and MDC Assy. (Refer to section 8-17-10)
2) Remove 8 screws around MCB assy and carefully separate MCB assy from MPI assy. Refer to 

following figure.

Figure 8-231   Separating MPI and MCB

Carefully disconnect MCB from MPI
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3) Unscrew 5 screws on bottom side of MCB board assy. Refer to following figure.

Figure 8-232   Screw points for removal of COM Express.

4) Disconnect fan cable and carefully detach COM Express module. Refer to following figure.

NOTE: Be careful not to damage COM Express connector

Figure 8-233   Detaching COM Express.

5) Unscrew 4 screws in the side of COM Express to remove SOM bracket and carefully lift up the COM 
express from the bracket. Refer to following figure

Figure 8-234   Removal COM Express Bracket.
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8-180 Section 8-23 - Replacement of the COM Express

8-23-3-2 Removal Procedure (R4 and R4.5)

1) Disconnect fan cable.

2) Unscrew five male-type-screws.

Figure 8-235   Disconnecting fan cable

Figure 8-236   Unscrewing five male type screws
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3) Detach COM-Express module.

4) Unscrew four male-type-screws in the side of COM-Express module. 
And remove SOM Bracket from the COM-Express module.

Figure 8-237   Detaching COM-Express

Figure 8-238   Unscrewing 4 male-type-screws
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8-182 Section 8-23 - Replacement of the COM Express

8-23-4 Installation Procedure

Install components in reverse order of removal.

Figure 8-239   Push the SOM in both side of GFS Assy

8-23-5 Note on COM Express Replacement
COM Express retains its memory (date/time/BIOS setting) by receiving 3V from coin battery on MCB 
Board. Therefore, when COM Express and MCB boards are separated, COM Express is likely to loose 
its date/time setting. In such case, follow the procedure outlined below to update BIOS information.

8-23-5-1 Configuring BIOS

1) Power ON the scanner and press “DEL”(If AN key is installed) or press left bottom key of trackball 
(If there’s no AN Key) to enter BIOS. 

CAUTION
!! CAUTION: 

When replacing with new SOM, Push the SOM in both side of MCB Assy like as below Figure 
8-130.

NOTICE
!! NOTICE:

If there’s no AN key, please use trackball to move menu in BIOS mode and click left bottom key of 
trackball to select menu in BIOS and double-click to set or change the value in BIOS. Right bottom key 
of trackball is ‘ESC’ in BIOS.

Left bottom key of trackball to 
enter BIOS and select menu and set 
or change the value in BIOS

Right bottom key of trackball
for ‘ESC’ in BIOS
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2) Type “maru” for password.
3) After successfully entering BIOS, verify the following parameters

Table 8-24    Configuring BIOS.

4) Change date/time parameters as needed, and save the changes. 
5) Reboot the console.

8-23-6 Note on EEPROM Replacement

NOTE: EEPROM on MCB contains VPD (Vital Product Data) for SOM (ComExpress). This VPD contains 
information such as system serial number to be matched to Software License Key, or Board revision 
number that is cross referenced to system software for compatibility.
Service personnel may require to initialize EEPROM or to modify EEPROM contents for proper 
operation of the system.

Figure 8-240   EEPROM on MCB Board

NOTE: There are various types of VPD EEPROM integrated in the system.

TAB top menu

Main System Time

System Date

Board Name Main VPD Contents Replaceable Physical VPD location

MCB FuncRev No Integrated with MCB

MPI FuncRev No Integrated with MPI

MDC FuncRev No Integrated with MDC

COMEXP FuncRev, , SSN (System Serial Number Yes
On MCB board as replaceable 
EEPROM.

MIO FuncRev No Integrated with MIO

DC4D FuncRev No Integrated with DC4D

OPIOR FuncRev No Integrated with OPIO

EEPROM on MCB Board Memory
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8-184 Section 8-23 - Replacement of the COM Express

8-23-6-1 Accessing EEPROM

1) Exit to Desktop (Refer to section 5-10 for details)
2) Start VPD Editor by clicking icon on the desktop. (“Vpdedit”)

3) Select COMEXP from device grid.

4) Note: If the following windows pop up without changing any parameters (i.e. simply browsing 

Device Grid The list of devices in the system that support VPD. Click on a row in this grid to 
select a device and view the VPD fields.
For Maru, MCB, MPI, MDC, COMEXP, MIO, DC4D, and OPIOR supports VPD.

VPD Field Grid A list of data items that make up the selected VPD.

Device Grid

Data Grid
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through the VPD contents), then press “NO” before continuing.

8-23-6-2 Initializing EEPROM
When a new EEPROM is attached to a system, it will require initialization.

1) Select “COMEXP” from device grid. (right pane).

2) Select “Load Template” from right pane.
3) Select “Comexp4amaster.vpd”.

COMEXP

Load Template
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8-186 Section 8-23 - Replacement of the COM Express

The file can be found under c:\Scanner\target\resources\Acqusition\Housekeeping

4) Click “Open” to load the selected template.

NOTE: This procedure can be applied to other components with VPD, for example, for initializing MPI VPD. 
However, it is unlikely needed for such event arises, as these components are hardware-integrated into 
boards.

VPD templates to use EEPROM initialization of each board are stored in 
c:\Scanner\target\resources\acqusition\Housekeeping and please refer to the following table to 
template file names.

8-23-6-3 Modifying contents of EEPROM (ComExpress VPD)
System checks that the SSN (System serial number) is valid for the installed software option. If you 
need to update SSN to replace software option string for other SSN, please follow the below instruction.

1) Select COMEXP from device grid.
2) Double-click value for “System Serial Number (SSN)” .
3) Type in the console serial number (SSN)
4) Click “write dirty fileds” button on the right pane.

Board Name VPD Template File Name

MCB MCB.VPD(R1 to R2.5), MCB-R3_2C.VPD(R3), MCB-R4_3A.VPD(R4)

MPI MPI.VPD, MPI_R4.VPD(R4)

MDC MDC.VPD

COMEXP Comexp4AMater.VPD(R1 to R2.5), MARU_COMEXP.VPD(R3), 
MARU_COMEXP.VPD(R4)

MIO MIOMaster.VPD(R1 to R2.5), MIO-B.VPD

DC4D Dc4dMaster.VPD

OPIOR OpPanelMaruMaster.VPD, OpPanelMaruMaster_R4.VPD(R4)
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8-23-7 Functional Check

Test Refer to Note

Board Diagnostics section 4-4
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8-188 Section 8-24 - Replacement of the HDD/SSD

Section 8-24
Replacement of the HDD/SSD

8-24-1 Manpower
1 Person, 5 minutes.

8-24-2 Tools
Standard Phillips Screwdriver.

8-24-3 Removal Procedure
1) Open the front cover. (refer to section 8-6)
2) Remove 4 screws around HDD/SSD Bracket Refer to following figure.

Figure 8-241   Screw points around HDD/SSD Bracket.

3) Carefully pull down HDD/SSD assy. Refer to following figure.

NOTE: Be careful not to damage HDD/SSD connector

Figure 8-242   Removal of HDD/SSD assy and position of HDD/SSD connector
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4) Unscrew 4 screws to remove HDD/SSD bracket. Refer to following figure.

Figure 8-243   Removal of HDD/SSD bracket

8-24-4 Installation Procedure
Install components in reverse order of removal.

8-24-5 Functional Check

Test Refer to Note

Board Diagnostics section 4-4
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8-190 Section 8-25 - Replacement of the M.2 SSD

Section 8-25
Replacement of the M.2 SSD

8-25-1 Manpower
1 person, 20 minutes

8-25-2 Tools
Standard Phillips Screwdriver.

8-25-3 Removal Procedure
1) Take the board assy out of the nest box (Refer to section 8-17-7)
2) Remove eight screws (check red-designating circles out) and separate MCB from the assy.

Figure 8-244   Removal of eight screws

3) Remove one screw on bottom side of the board and pull out M.2 SSD.

Figure 8-245   Removal of one screw on bottom side of the board
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8-25-4 Installation Procedure
Install components in reverse order of removal.

8-25-5 Functional Check
Refer to section 4-3-3 for Power On/Off test.
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8-192 Section 8-26 - Replacement of Battery

Section 8-26
Replacement of Battery

8-26-1 Manpower
1 person, 1 hour

NOTE: LP9/P7 BUM 5504583 provides the information, "Refreshing the battery" in Chapter 3 Preparing to 
System for Use. The recommended procedure can be executed by user for maintaining battery life.

8-26-2 Tools
Standard Phillips Screwdriver.

8-26-3 Removal Procedure
1) Unscrew 12 screws to remove the IO BOX Cover.

Figure 8-246   Screw points of IO BOX cover
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2) Unscrew 4 screws and disconnect 2 connectors from Battery. Refer to following figure.

Figure 8-247   Screw points and Connectors on battery assy

3) Unscrew 4 screws to remove Battery bracket

Figure 8-248   Removal of Battery bracket

8-26-4 Installation Procedure
Install components in reverse order of removal.

8-26-5 Functional Check

Test Refer to Note

Power On/Off section 4-3-3
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8-194 Section 8-27 - Replacement of 4D

Section 8-27
Replacement of 4D

8-27-1 Manpower
1 Person, 1 hour.

8-27-2 Tools
Standard Phillips Screwdriver.

8-27-3 Removal Procedure
1) Unscrew 12 screws to remove the IO BOX Cover.

Figure 8-249   Screw points of IO BOX cover
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2) Unscrew five screws to remove the DC4D from the IO BOX. Refer to following figure.

Figure 8-250   Screw points of DC4D Assy 

3) Carefully lift up the DC4D unit.

8-27-4 Installation Procedure
Install components in reverse order of removal.

8-27-5 Functional Check
Refer to section 4-4 for Functional Diag Test List.
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8-196 Section 8-28 - Replacement of Wireless LAN

Section 8-28
Replacement of Wireless LAN

8-28-1 Manpower
1 Person, 5 minutes.

8-28-2 Tools
None Required.

8-28-3 Removal Procedure
1) Remove Top Cover (refer to section 8-7)
2) Attach loop sheet on Wireless LAN dongle. Refer to below figure.

Figure 8-251   Attachment of loop sheet.

3) Disconnect connector and carefully detach out Wireless LAN. Refer to following figure.

Figure 8-252   Removal of Wireless LAN

8-28-4 Installation Procedure
Parts to be installed in reverse order of removal.

8-28-5 Functional Check
Visual Check Only

Align edge
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Section 8-29
Replacement of the Harness Cable and OPIO Cable Assy

8-29-1 Replacement of the Harness Cable and OPIO Cable Assy (R1, R2, R2.5 and R3)

8-29-1-1 Manpower
1 person, 30 minutes

8-29-1-2 Tools
Standard Phillips Screwdriver, Nipper, 4mm Hex Wrench, 3 Cable ties (GEPN: 2160955).

8-29-1-3 Pre-Work

1) Rear Cover removed. (refer to section 8-9)
2) OPIO removed. (refer to section 8-14)
3) LCD Monitor removed and Covers from LCD Arm removed. (refer to section 8-11)
4) Main monitor cables disconnected. (refer to section 8-29)
5) All monitor and OPIO cables on rear connectors are disconnected. (refer to section 8-17)
6) Link arm top cover removed.  (refer to section 8-20)

8-29-1-4 Removal Procedure (Harness Cable Assy)

1) Loosen Cable through 3rd Arm (1).
2) Remove 2 Cable ties and loosen Cable from 2nd Arm.

NOTE: There is cable position marker at this location.

3) Remove 1 Cable tie and loosen Cable from 1st Arm.
4) Loosen cable around 2nd and 1st Axis as following figure.
5) Unscrew 1 screw and carefully lift up arms and loosen all cables.

NOTE: There is cable position marker at this location.

6) Release the cable holder and carefully pull down cables.
7) Unscrew 2 screws and remove Link arm cable fix brkt.
8) Carefully pull up cables and remove cables
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8-198 Section 8-29 - Replacement of the Harness Cable and OPIO Cable Assy

4
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Figure 8-253   Removal of Harness Cable Assy

8-29-1-5 Removal Procedure (OPIO Cable Assy)

1) Unscrew 1 screw, remove cable clamp, and then loosen cable through hole.

NOTE: There is cable position marker at this location.

2) Release the cable holder and carefully pull down cables.
3) Unscrew 2 screws and remove Link arm cable fix brkt.
4) Carefully pull up cables and remove cables

Figure 8-254   Removal of Harness Cable Assy

8-29-1-6 Installation Procedure
Install components in reverse order of removal. Replace the cut cable ties with new ones of the 
appropriate length.
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8-29-1-7 Functional Check

Visual check on LCD monitor to see if image displays without color distortion 

Check OSD Control function operates. Refer to section 6-3-1 Brightness/Contrast

8-29-2 Replacement of Monitor cable and OPIO cable (R4 and R4.5)

8-29-2-1 Manpower
2 persons, 30 minutes

8-29-2-2 Tools
Standard Phillips Screwdriver, Hex Wrench, Nipper, 6 Cable ties (GEPN: 2160955)

8-29-2-3 Pre-Work

1) Rear Cover removal (refer to Section 8-9)
2) OPIO Assy removal (refer to Section 8-14)
3) Monitor and arm cover removal (refer to Section 8-11)
4) Main monitor cables disconnected (refer to Section 8-11)
5) All monitor and OPIO cables on rear connectors disconnected (refer to Section 8-17)
6) Link arm top cover removal (refer to Section 8-20)

Test Refer to Note

System Exterior Visual Check section 4-3-1 Control panel visual check only

Power On/Off section 4-3-3
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8-29-2-4 Removal Procedure (Monitor cables)

1) Cut the 6 cable ties

2) Extract 3 monitor cables through the LCD Arm hole.

Figure 8-255    Cutting 6 cable ties

Figure 8-256   Extracting 3 monitor cables
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8-202 Section 8-29 - Replacement of the Harness Cable and OPIO Cable Assy

3) Unscrew 1 screw and detach the LCD arm.

Figure 8-257   Unscrewing 1 screw and detach the LCD arm
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4) Extract 3 monitor cables through the LCD Arm hole.

5) Extract 3 monitor cables as the picture below.

6) Assemble Procedure - Monitor Cables
Parts to be installed in reverse order of removal.

Figure 8-258   Extracting 3 monitor cables

Untying the cable clamp Unlocking cable clamp

Unscrewing 2 screws
Extracting 3 cables through the hole
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8-204 Section 8-29 - Replacement of the Harness Cable and OPIO Cable Assy

8-29-2-5 Removal Procedure (OPIO cables)

1) Unscrew 1 screw and extract the 2 cables.

2) Unscrew 2 screws and remove OPIO cables.

Figure 8-259   Unscrewing 1 screw and extract 2 cables through the hole

Figure 8-260   Unscrewing 2 screws and removing 2 cables



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 8 - Replacement Procedures 8-205

3) Assemble Procedure - OPIO Cables
Parts to be installed in reverse order of removal.

8-29-2-6 Functional Check

Visual check on LCD monitor to see if image displays without color distortion 

Check OSD Control function operates. Refer to section 6-3-1 Brightness/Contrast

Test Refer to Note

System Exterior Visual Check section 4-3-1 Control panel visual check only

Power On/Off section 4-3-3
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Section 8-30
Replacement of Peripheral Cable Assy

8-30-1 DVD Cables

8-30-1-1 Manpower
1 person, 5 minutes.

8-30-1-2 Tools
Nipper, 2 Cable ties (GEPN: 2160955).

8-30-1-3 Pre work

1) Remove Rear Cover. (refer to section 8-9)
2) Remove Top Cover. (refer to section 8-7)
3) Remove Cable Cover Bracket. (refer to section 8-17)

8-30-1-4 Removal Procedure

1) Remove the cable ties.

Figure 8-261   Cable tie points

2) Unlock cable clamp. Refer to following figure.

Figure 8-262   Cable clamps
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3) Disconnect 2 DVD cables from the rear panel. Refer to following figure.

Figure 8-263   DVD cable connectors

4) Disconnect 2 DVD cables from the DVD.

Figure 8-264   Removal of DVD cables from the DVD

5) Carefully pull out the cables.
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8-30-1-5 Installation Procedure
Parts to be installed in reverse order of removal. But, refer to below procedure for cable ties.

Figure 8-265   Tie cables with the ties through the holes

2 holes for fixing cable tie 2 holes for fixing cable tie

Align the head of cable tie as shown Align the head of cable tie as shown

Cable tie Cable tie
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8-30-2 B/W Printer Cables

8-30-2-1 Manpower
1 person, 5 minutes.

8-30-2-2 Tools
Standard Phillips Screwdriver.

8-30-2-3 Pre work

1) Remove Rear Cover. (refer to section 8-9)
2) Remove Top Cover (refer to section 8-7)
3) Remove Cable Cover Bracket. (refer to section 8-17)

8-30-2-4 Removal Procedure

1) Remove the cable tie.

Figure 8-266   Cable tie point

2) Remove 2 screws on left side of BW printer and remove BW printer Power fix Bracket

Figure 8-267   Screw points to remove BW power fix bracket.
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8-210 Section 8-30 - Replacement of Peripheral Cable Assy

3) Unlock cable clamp. Refer to following figure.

Figure 8-268   Cable clamp
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4) Disconnect 2 BW printer cables from the rear panel. Refer to following figure.

Figure 8-269   BW printer connectors

5) Disconnect 2 BW printer cables from printer and carefully pull out the cables.

Figure 8-270   Removal of printer cables from the printer
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8-30-2-5 Installation Procedure
Parts to be installed in reverse order of removal. But, refer to below procedure for cable ties.

Figure 8-271   Tie cables with the tie through the holes

8-30-2-6 Functional Check
Test 1: Print an image by pressing the button P1 on the operator panel. (P1 key should be configured 
correctly. Refer to section 3-8-4 Adding Printer to the system)

Verify1: - Verify that image can be printed.

Verify2: - Verify that printed image has no distortion as compared the image on screen.

2 holes for fixing cable tie Cable tie Align the head of cable tie as shown
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Section 8-31
Replacement of the Probe Holder

8-31-1 Manpower
1 Person, 5 minutes.

8-31-2 Tools
No tool is required.

8-31-3 Removal Procedure
1) Simply pull out Probe Holder from its location.

NOTE: This procedure applies to all locations of probe holder.

Figure 8-272   Removal of Probe Holder

Figure 8-273   Probe Holders

8-31-4 Installation Procedure
Parts to be installed in reverse order of removal.

8-31-5 Functional Check
Visual inspection Only.

Probe holder 4D Probe holder
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8-214 Section 8-32 - Replacement of the Cable Hook

Section 8-32
Replacement of the Cable Hook

8-32-1 Manpower
1 Person, 5 minutes.

8-32-2 Tools
Standard Phillips Screwdriver.

8-32-3 Removal Procedure
1) Remove screws as following figure and carefully remove cable hook.

NOTE: Make sure not to lose washers when removing hooks.

Figure 8-274   Removal of Cable hook

8-32-4 Installation Procedure
Parts to be installed in reverse order of removal.

8-32-5 Functional Check
Visual inspection Only.
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Section 8-33
Replacement of the OPIO Tray

8-33-1 Manpower
1 Person, 5 minutes.

8-33-2 Tools
Standard Phillips Screwdriver.

8-33-3 Removal Procedure
1) Remove screw as following figure and carefully remove OPIO Tray.

NOTE: Make sure not to lose tray fix brkt when removing OPIO Tray.

Figure 8-275   Removal of OPIO Tray

8-33-4 Installation Procedure
Parts to be installed in reverse order of removal.

8-33-5 Functional Check
Visual inspection Only.
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Section 8-34
Replacement of the Paper tray

8-34-1 Manpower
1 Person, 1 minutes.

8-34-2 Tools
None Required.

8-34-3 Removal Procedure
1) Remove Paper tray from Top Cover.

Figure 8-276   Removal of Paper tray

8-34-4 Installation Procedure
1) Align the assembly point and put the Paper Tray on Top Cover.

8-34-5 Functional Check
Visual inspection Only.
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Section 8-35
Replacement of AC Cable Holder

8-35-1 Manpower
1 Person, 5 minutes.

8-35-2 Tools
Standard Phillips Screwdriver.

8-35-3 Removal Procedure
1) Remove 2 Screws from AC Cable Holder

NOTE: This procedure applicable to all AC Power Cord replacement

Figure 8-277   AC Cable Holder

8-35-4 Installation Procedure
Parts to be installed in reverse order of removal.

8-35-5 Functional Check
Visual inspection Only.
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Section 8-36
Replacement of the BW printer

8-36-1 Manpower
1 person, 10 minutes

8-36-2 Tools
Standard Phillips Screwdriver.

8-36-3 Pre work
1) Remove Rear Cover. (refer to section 8-9)
2) Remove Top Cover (refer to section 8-7)
3) Remove Cable Cover Bracket. (refer to section 8-17)
4) Remove BW printer Power fix Bracket and Disconnect 2 BW printer cables from printer (refer to 

section section 8-29-2)

8-36-4 Removal Procedure
1) Remove 4 screws around BW printer. Refer to following figure.

Figure 8-278   4 screws points for removal of BW printer

Rear left Rear right

Front left Front right
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2) Pull out BW printer as following figure.

Figure 8-279   Pulling out the BW printer 

3) Remove 4 screws on BW printer bottom part. Refer to following figure.

Figure 8-280   4 screws points

8-36-5 Installation Procedure
1) Parts to be installed in reverse order on removal.

8-36-6 Functional Check
Test 1: Print an image by pressing the button P1 on the operator panel. (P1 key should be configured 
correctly. Refer to section 3-8-4 Adding Printer to the system)

Verify1: - Verify that image can be printed.

Verify2: - Verify that printed image has no distortion as compared the image on screen.



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

8-220 Section 8-37 - Replacement of the Speaker

Section 8-37
Replacement of the Speaker

8-37-1 Manpower
1 Person, 10 minutes.

8-37-2 Tools
Standard Phillips Screwdriver, Hex Wrench, Nipper, 1 Cable ties (GEPN: 2160955).

8-37-3 Pre work
1) Remove Rear Cover. (refer to section 8-9)
2) Remove Top Cover (refer to section 8-7) 
3) Remove Cable Cover Bracket. (refer to section 8-17)

8-37-4 Removal Procedure
1) Disconnect Speaker cable. Refer to following figure.

Figure 8-281   Speaker cable connector position
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2) Remove the cable tie.

Figure 8-282   Cable tie point

3) Unlock cable clamp. Refer to following figure.

Figure 8-283   Cable clamp

4) Remove 4 screws around speaker assy. Refer to following figure.

Figure 8-284   4 screws points to remove speaker assy
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5) Remove 4 screws, and then remove speaker brkt. Refer to following figure.

Figure 8-285   4 screw points to remove speaker brkt

6) Remove 8 screws and carefully pull out speaker assy. Refer to following figure.

Figure 8-286   8 screws points to remove speaker
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8-37-5 Installation
Parts to be installed in reverse order of removal. But, refer to below procedure for cable ties.

Figure 8-287   Tie cables with the tie through the holes

8-37-6 Functional Check
Perform Diagsnotics

1) Enter Common Service Desktop
2) Select Diagnostics -> Service Diag -> Doppler Audio -> Execute 
Make sure audible sound comes out of the speaker

NOTE: Make sure system volume is not set to zero.

2 holes for fixing cable tie Cable tie Align the head of cable tie as shown
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Section 8-38
Replacement of the Monitor Arm

8-38-1 Manpower
1 person, 15 minutes.

8-38-2 Tools
Standard Phillips Screwdriver, Nipper, 4 mm Hex Wrench, 3 Cable ties (GEPN: 2160955).

8-38-3 Removal Procedure
1) Remove LCD monitor and LCD Arm Plastic Covers.(refer to section 8-11)
2) Remove Harness Cable Assy and Monitor Arm. (refer to section 8-11-1-4 1)~4))

8-38-4 Installation Procedure
In reverse order of removal.

8-38-5 Functional Check
1) Visually check LCD monitor
2) LCD Arm Test. (Refer to section 4-3-2-2).
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Section 8-39
Replacement of Front Fan Filter

8-39-1 Manpower
1 Person, 2 minutes.

8-39-2 Tools
None Required.

8-39-3 Removal Procedure 
1) Remove Front Cover. (refer to section 8-6) 
2) Pull out Filter upward. Refer to following figure.

Figure 8-288   Pulling out the front fan filter.

8-39-4 Installation Procedure
In Reverse Order.

8-39-5 Functional Check
Visual inspection Only.
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Section 8-40
Replacement of Bottom Fan Filter 

8-40-1 Manpower
1 Person, 3 minutes.

8-40-2 Tools
None Required.

8-40-3 Removal Procedure
1) Pull out bottom fan filter as following figure.

Figure 8-289   Removal of bottom fan filter

8-40-4 Installation Procedure
In Reverse Order.

8-40-5 Functional Check
Visual inspection Only.
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Section 8-41
Replacement of SW CD set (R1, R2, R2.5 only) and SW USB (R3, R4 and R4.5 
only)

8-41-1 Manpower
1 Person, 3 minutes.

8-41-2 Tools
None Required.

8-41-3 Removal Procedure

8-41-3-1 Removal Procedure for R1/R2/R2.5/R3

1) Remove Rear Cover. (refer to section 8-9)
2) CD or USB is placed on Rear Cover.

8-41-3-2 Removal Procedure for R4/R4.5

1) Remove Front Cover. (refer to section 8-6)
2) USB is placed on Front Cover.

8-41-4 Installation Procedure
In Reverse Order.

8-41-5 Functional Check
Visual inspection Only.



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

8-228 Section 8-42 - Replacement of Drawer

Section 8-42
Replacement of Drawer

8-42-1 Manpower
1 Person, 5 minutes.

8-42-2 Tools
Standard Phillips screwdriver.

8-42-3 Removal Procedure
1) Pull out the Top cover.

Figure 8-290   Drawing out Top cover.

2) Remove 4 screws. Refer to following figure.

Figure 8-291   Screw point around drawer.

3) Carefully pull out the Drawer.

Rear left

Front rightFront left

Rear right
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8-42-4 Installation Procedure
Parts to be installed in reverse order on removal.

8-42-5 Functional Check
Visual Check Only



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

8-230 Section 8-43 - Replacement of ECG

Section 8-43
Replacement of ECG

8-43-1 Manpower
1 Person, 5 minutes.

8-43-2 Tools
Standard Phillips screwdriver.

8-43-3 Removal Procedure
1) Remove OPIO covers (refer to section 8-14)
2) Remove cables on ECG Assy (square) and unscrew 4 screws (circle). Refer to following figure.

Figure 8-292   Cables position and points.

3) Remove ECG Assy.
4) Unscrew 4 screws and remove ECG BRKT.

Figure 8-293   ECG BRKT screw points.
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5) Unscrew 4 screws and remove ECG BRKT

Figure 8-294   ECG screw points.

8-43-4 Installation Procedure
Parts to be installed in reverse order on removal.

8-43-5 Functional Check
Visual Check Only
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Section 8-44
Replacement of DCWD ASSY

8-44-1 Manpower
1 person, 15 minutes

8-44-2 Tools
Standard Phillips screwdriver.

8-44-3 Removal Procedure

8-44-3-1 Removal Procedure - R1 to R3

1) Separate MPI assy from MCB and MDC. Refer to the section 8-17-8 Removal Procedure - 
Separating MPI and MCB.

2) Remove 3 screws on MPI assy.

Figure 8-295   DCWD Board screw points

3) Carefully separate DCWD board from MPI assy not to damage the DCWD connector. Refer to 
following figure.

Figure 8-296   Position of DCWD board connector
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8-44-3-2 Removal Procedure - R4/R4.5

1) Separate MPI assy from MCB and MDC. Refer to the section 8-17-8 Removal Procedure - 
Separating MPI and MCB.

2) Remove 3 screws on MPI assy.

Figure 8-297   DCWD Board screw points

3) Carefully separate DCWD board from MPI assy not to damage the DCWD connector. Refer to 
following figure.

Figure 8-298   Position of DCWD board connector

8-44-4 Installation Procedure
Parts to be installed in reverse order on removal.

8-44-5 Functional Check
Refer to section 4-4 Functional Diag Test List
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Section 8-45
Replacement of MCWD ASSY

8-45-1 Manpower
1 person, 15 minutes

8-45-2 Tools
Standard Phillips Screwdriver.

8-45-3 Removal Procedure
1) Separate MCB Assy and MDC Assy. (Refer to section 8-17-7)
2) Unscrew 1 screw and remove MCWD assy

NOTE: Be careful not to damage MCWD connector.

Figure 8-299   Removal of MCWD board.

8-45-4 Installation Procedure
Parts to be installed in reverse order on removal.

8-45-5 Functional Check

NOTE: Refer to section 4-4 Functional Diag Test List
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Section 8-46
Replacement of battery pack for LP7-P9 R2 ext battery pack

8-46-1 Manpower
1 person, 30 minutes

8-46-2 Tools
Standard Phillips Screwdriver, Hex-Wrench

8-46-3 Removal Procedure
1) Unscrew 2 screws and then pull out the BATTERY PACK COVER BRKT LP7_P9 from 6 points of 

LATCH.

2) Unscrew 2 screws to remove CONNECTOR BRKT.

Figure 8-300   Removing the BATTERY PACK COVER BRKT LP7_P9

Figure 8-301   Unscrewing 2 screws to remove CONNECTOR BRKT
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8-236 Section 8-46 - Replacement of battery pack for LP7-P9 R2 ext battery pack

3) Disconnect BATTERY SIG Harness and PWR Harness.

4) Unscrew 4 screws.

Figure 8-302   Disconnecting BATTERY Harnesses

Figure 8-303   Unscrewing 4 screws

PWR Harness SIG Harness
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5) Disassemble LP7-P9 R2 EXT BATTERY PACK from extrude shape of BATTERY PACK FRAME 
BRKT.

6) Unscrew 8 screws to remove BATTERY PACK TOP BRKT.

Figure 8-304   Removing LP7-P9 R2 EXT BATTERY PACK

Figure 8-305   Unscrewing 8 screws to remove BATTERY PACK TOP BRKT



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL
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7) Lift up POLARIS BATTERY PACK and disconnect BATTERY Harness from PWA. Then remove 
POLARIS BATTERY PACK.

NOTE: Once replacing battery pack, all of battery packs (4 pcs) need to be replaced in same time.

8-46-4 Installation Procedure

NOTE: Once replacing battery pack, all of battery packs (4 pcs) need to be replaced in same time.

All components to be installed in reverse order of removal.

8-46-5 Functional Check
1) Turn on the circuit breaker.

Figure 8-306   Removing POLARIS BATTERY PACKS

Figure 8-307   Turning on circuit breaker
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2) Boot-up the console using power button on OPIO ASSY.

3) Check that battery icon is displayed on left bottom side.

4) Switch off the circuit breaker (Wall power mode -> Battery mode). Confirm that is operating with 
battery mode.

Figure 8-308   Booting-up using power button

Figure 8-309   Checking battery icon
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Section 8-47
Replacement of battery pack for LP7-P9 R2 Battery option

8-47-1 Manpower
1 person, 30 minutes

8-47-2 Tools
Standard Phillips Screwdriver, Hex-Wrench, Socket driver

8-47-3 Removal Procedure
1) Unscrew 2 screws to remove POWER CORD FIX BRKT. Then disconnect POWER CORD and 

remove REAR COVER.

2) Unscrew 5 screws to remove REAR CABLE COVER BRKT. Then disconnect all cables.

Figure 8-310   Removing POWER CORD FIX BRKT, POWER CORD and REAR COVER

Figure 8-311   Unscrewing 5 screws to remove REAR CABLE COVER BRKT and disconnect cables
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3) Unscrew 7 screws to remove the NEST EMI BRKT and pull out MIO ASSY from system.

4) Unscrew 12 screws to remove the MIO BOX BRKT.

Figure 8-312   Unscrewing 7 screws to remove NEST EMI BRKT and MIO ASSY

Figure 8-313   Unscrewing 12 screws to remove MIO BOX BRKT
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5) Disconnect 2 connectors of BATTERY and unscrew 4 screws to remove BATTERY ASSY.

6) Unscrew 4 screws to remove BATTERY TOP BRKT. Then remove POLARIS BATTERY PACK.

8-47-4 Installation Procedure
All components to be installed in reverse order of removal.

Figure 8-314   Removing BATTERY ASSY 

Figure 8-315   Removing BATTERY TOP BRKT to remove POLARIS BATTERY PACK
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8-47-5 Functional Check
1) Turn on the circuit breaker.

2) Boot-up the console using power button on OPIO ASSY.

3) Check that battery icon is displayed on left bottom side.

4) Switch off the circuit breaker (Wall power mode -> Battery mode). Confirm that is operating with 
battery mode.

Figure 8-316   Turning on circuit breaker

Figure 8-317   Booting-up using power button

Figure 8-318   Checking battery icon
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8-244 Section 8-48 - Replacement of MBOB

Section 8-48
Replacement of MBOB

8-48-1 Manpower
1 person, 20 minutes

8-48-2 Tools
Standard Phillips Screwdriver

8-48-3 Removal Procedure
1) Remove POWER CORD FIX BRKT and POWER CORD.

2) Remove REAR COVER ASSY.

Figure 8-319   Removing POWER CORD FIX BRKT and POWER CORD

Figure 8-320   Removing REAR COVER ASSY

REAR COVER ASSY
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3) Unscrew 5 screws and remove REAR CABLE COVER BRKT.

4) Remove CABLES (RED CIRCLE) and unscrew 7 screws, then remove NEST EMI BACK BKRT.

Figure 8-321   Unscrewing 5 screws

Figure 8-322   Removing CABLES (RED CIRCLE) and unscrewing 7 screws

REAR CABLE COVER BRKT

NEST EMI
BACK BRKT
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5) Draw IO BOX from NEST FRAME.

6) Unscrew 12 screws and remove MIO BOX BRKT.

Figure 8-323   Drawing IO BOX from NEST FRAME

Figure 8-324   Unscrewing 12 screws
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7) Disconnect PWR and SIG connectors.

8) Disassemble BATTERY ASSY.

9) Disassemble MBOB PWR HARNESS (5728317) and MBOB SIG HARNESS (5728318)

Figure 8-325   Disconnecting PWR and SIG connectors

Figure 8-326   Disassembling BATTERY ASSY

Figure 8-327   Disassembling MBOB PWR HARNESS (5728317) and MBOB SIG HARNESS (5728318)
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10) Disassemble MBOB PWA from MIO-B PWA 

8-48-4 Installation Procedure
All components to be installed in reverse order of removal.

8-48-5 Functional Check
Refer to section 4-4 for Functional Diag Test List.

Figure 8-328   Disassembling MBOB PWA
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Section 8-49
Replacement of MIO-B

8-49-1 Manpower
1 person, 20 minutes

8-49-2 Tools
Standard Phillips Screwdriver

8-49-3 Removal Procedure
1) Unscrew 12 screws and remove MIO BOX BRKT.

Figure 8-329   Unscrewing 12 screws
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8-250 Section 8-49 - Replacement of MIO-B

2) Disassemble ACFL BOARD FIX BRKT(5538682).

3) Disassemble Nut from the IOBOX-B Chassis Bracket

Figure 8-330   Disassembling ACFL BOARD FIX BRKT(5538682)

Figure 8-331   Disassembling Nut from the IOBOX-B Chassis Bracket
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4) Disassemble the following screws 

8-49-4 Installation Procedure
All components to be installed in reverse order of removal.

8-49-5 Functional Check
Refer to section 4-4 for Functional Diag Test List.

Figure 8-332   Disassembling the following screws 
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Section 8-50
Replacement of BBC

8-50-1 Manpower
1 person, 30 minutes

8-50-2 Tools
Standard Phillips Screwdriver, Hex-Wrench

8-50-3 Removal Procedure
1) Unscrew 2 screws to remove COVER BRKT.

2) Disassemble BATTERY PACK COVER BRKT.

Figure 8-333   Unscrewing 2 screws to remove COVER BRKT

Figure 8-334   Disassembling BATTERY PACK COVER BRKT
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3) Disassemble CONNECTOR BRKT using 2 screws. (2327596, SCREW WH M3X6)

4) Disconnect BATTERY SIG HARNESS and PWR HARNESS.

NOTE: Both connectors are locking type. Please pull out connectors pressing locking points.

Figure 8-335   Disassembling CONNECTOR BRKT using 2 screws

Figure 8-336   Disconnecting BATTERY SIG HARNESS and PWR HARNESS
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5) Unscrew LP7-P9 R2 EXT BATTERY PACK from BATTERY PACK FRAME BRKT LP7_9 using 4 
screws (5431313, SCREW HSH M5X10).

Figure 8-337   Unscrewing LP7-P9 R2 EXT BATTERY PACK from BATTERY PACK FRAME BRKT LP7_9 
using 4 screws
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6) Pull out LP7-P9 R2 EXT BATTERY PACK from BATTERY PACK FRAME BRKT

Figure 8-338   Pulling out LP7-P9 R2 EXT BATTERY PACK from BATTERY PACK FRAME BRKT

LP7-P9 R2 EXT BATTERY PACK
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7) Unscrew 8 screws to remove BATTERY PACK TOP BRKT.

8) Remove 4 BATTERY PACKS.

Figure 8-339   Unscrewing 8 screws to remove BATTERY PACK TOP BRKT

Figure 8-340   Removing 4 BATTERY PACKS

BATTERY PACK
TOP BRKT
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9) Disassemble BBC PWA

8-50-4 Installation Procedure
All components to be installed in reverse order of removal.

8-50-5 Functional Check
Refer to section 4-4 for Functional Diag Test List.

Figure 8-341   Disassembling BBC PWA
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Section 8-51
Replacement of ROTATION MODULE KIT

8-51-1 Replacement of LOGIQ P9 ROTATION MODULE KIT (R1 to R3)

8-51-1-1 Manpower
1 person, 30 minutes

8-51-1-2 Tools
Standard Phillips Screwdriver, Nipper, Torque wrench: Needed HEX wrench - 4mm HEX wrench (For 
M5 HEX Screw), Needed force - 60 Kgf·cm (For screw tighten force), Monkey Spanner (For NUT M4), 
Hot air blower or Electric hair dryer

8-51-1-3 Removal Procedure

1) Remove the Monitor, Monitor Arm and OPIO Assy.
2.) Unlock cable clamp and carefully pull down 3 cables. 

3.)  Unscrew 1 screw and remove the cable clamp, and then extract out the 5 cables through the hole 
of OPIO BASE. 

OPIO BASE

5 CABLES
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4.) Unscrew nut and unfix the cable wire from the UP DOWN LINK BRKT.
5.) Unscrew nut and unfix the cable wire from the CABLE WIRE FIX BRKT. 
6.) Unscrew 1 screw and remove the P CLAMP, and then extract out the cable through hole of the 

OPIO base. 

7.) Unlock CABLE CLAMP, and then extract out the all cables from the OPIO base and the UP DOWN 
LINK ARM. 

CABLE WIRE FIX 
BRKT

P CLAMP

Unscrew the one nut and extract 
out the cable

UP DOWN LINK BRKT
1

2

3

UP DOWN LINK ARM
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8.) Unscrew 3 screws and remove the TURN BUCKLE SET and SPRING from the ROTATION 
MODULE ASSY. 

9.) Unscrew 3 screws and remove the ROTATE LEVER BRKT from OPIO base. 
10.)Unscrew 2 screws and remove the ROTATION BUTTON from RATATE LEVER BRKT. 

11.)Unscrew 3 screws and remove the ROTATION MODULE ASSY from the OPIO base. 

TURN BUCKLE SET

ROTATION MODULE

SPRING

ROTATION BUTTON

ROTATE LEVER BRKT
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12.) Unscrew 6 screws and carefully remove the OPIO base. 

13.)Remove the IGUS THRUST BUSH. 

CAUTION When reassemble the ROTATION MODULE ASSY, HSH screw should be tightened proper 
torque (60kgf-cm)

CAUTION When reassemble the screws, please use  SCREW HSH M5X16 NYLOK(5729013).

CAUTION When reassemble the OPIO base, HSH screw should be tightened proper touque (60kgf-cm).

CAUTION When reassemble the screws, please use SCREW HSH M5X16 NYOK (5729013).

CAUTION DO NOT wipe out grease from part. 

IGUS THRUST BUSH
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8-262 Section 8-51 - Replacement of ROTATION MODULE KIT

14.) Each screws should be heated for 5 minutes by HOT AIR BLOWER or ELECTRIC HAIR DRYER  
to melt LOCTITE  on screw before unscrew the screw. ( Caution hot surfaces ) 

15.) Unscrew 7 screws and then remove the ROTATION PLATE. 

CAUTION When reassemble the ROTATION MODULE ASSY, HSH screw should be tightened proper 
torque (60kgf-cm). When reassemble the screws, please use SCREW FSH M5X16 
NYLOK(5729014).

CAUTION Carefully unscrew the each screw to prevent wear of screw head. 

ROTATION PLATE
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16.) Remove the THRUST NEEDLE BEARING WASHER 5578, THRUST NEEDLE BEARING 5578, 
OPIO SWIVEL SHAFT from the UP DOWN LINK ARM in order. 

8-51-1-4 Installation Procedure
Parts to be installed in reverse order on removal. But ROTATION PLATE, OPIO SWIVEL SHAFT, 
ROTATE LEVER BRKT and ROTATION MODULE ASSY should be reassembled using new parts.

8-51-1-5 Functional Check 

CAUTION
do 

Do not wipe out grease from part. 

Test Refer to Note

System Exterior Visual Check
section 4-3-1 of LOGIQ P8P9P10 PSM(GPN : 

5599028)

Mechanical Parts Functional Check
section 4-3-2 of LOGIQ P8P9P10 PSM(GPN : 

5599028)

Power On/Off
section 4-3-3 of LOGIQ P8P9P10 PSM(GPN : 

5599028)

System Integration Checks
section 4-3-5 of LOGIQ P8P9P10 PSM(GPN : 

5599028) OPIO Test only 

UP DOWN LINK THRUST NEEDLE BEARING

OPIO SWIVEL

THRUST NEEDLE BEARING 
WASHER 5578

1

2

3
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8-51-2 Replacement of LOGIQ P8/P9/P10 ROTATION MODULE KIT (R4 and R4.5)

8-51-2-1 Manpower
1 person, 30 minutes

8-51-2-2 Tools
Standard Phillips Screwdriver, Nipper, Torque wrench : needed HEX wrench – 4mm HEX 
wrench (For M5 HEX Screw), Needed force – 60Kgf·cm (For screw tighten force),
Hot air blower or Electric hair dryer, 6 Cable ties (GEPN : 2160955)

8-51-2-3 Pre-Work

1) Rear Cover removal (refer to section 8-9)
2) OPIO removal (refer to section 8-14)
3) Monitor and arm cover removal (refer to section 8-11)
4) Main monitor cables disconnected (refer to section 8-11)

8-51-2-4 Removal Procedure

1) Unscrew 1 screw and remove the cable clamp, and then extract our the 5 cables through the hole 
of OPIO BASE 

Figure 8-342   Unscrewing 1 screw and extract 5 cables through the OPIO BASE Hole
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2) Unscrew 1 screw and disassemble the cable wire from the bracket.

3) Unscrew nut and disassemble the cable wire from the bracket with the arrow direction.

Figure 8-343   Unscrewing 1 screw and disassemble the cable wire

Figure 8-344   Unscrewing nut and disassemble the cable wire
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4) Unlock cable clamp, and then extract 5 cables and cable wire from the Hole.

5) Unscrew 3 screws and remove the Turn Buckle Set and Spring.

Figure 8-345   

Figure 8-346   Unscrewing 3 screws and removing Turn Buckle Set and Spring



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 8 - Replacement Procedures 8-267

6) Unscrew 3 screws and remove the Rotation Module Assy.

7) Unscrew 6 screws and detach the OPIO Base.

Figure 8-347   Unscrewing 3 screws and removing Rotation Module Assy

CAUTION When reassemble the Rotation Module Assy, screw should be tightened with 60Kgf·cm torque 
and use the Screw HSH M5X16 Nylok (GE Part no.: 5729013) for reassembly.

Figure 8-348   Unscrewing 6 screws and detaching OPIO Base

CAUTION When reassemble the OPIO Base, screw should be tightened with 60Kgf·cm torque and use 
Screw HSH M5X16 Nylok (GE Part no. : 5729013) for reassembly.
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8) Detach the IGUS Thrust Bush.

9) Each screw should be heated for 5 minutes by Hot Air Blower or Electric Hair Dryer to melt 
LOCTITE on screw before unscrewing 6 screws.

Figure 8-349   Detaching IGUS Thrust Bush

CAUTION DO NOT wipe out grease from part. 

Figure 8-350   

CAUTION Be careful with hot surfaces.
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10) Unscrew 7 screws and then remove the ROTATION PLATE.

11) Remove the Thrust Needle Bearing Washer, Thrust Needle Bearing, OPIO Swivel Shaft.

Figure 8-351   Unscrewing 7 screws and removing Rotation Plate

CAUTION When reassemble the ROTATION PLATE, screw should be tightened with 60Kgf·cm torque and 
use SCREW FSH M5X16 NYLOK (GE Part no. : 5729014) for reassembly. 

CAUTION Carefully unscrew to prevent wear of screw head. 

Figure 8-352    Detaching Thrust Needle Bearing Washer, Thrust Needle Bearing, OPIO Swivel Shaft
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8-51-2-5 Installation Procedure
Parts to be installed in reverse order on removal. But Rotation Plate, OPIO Swivel Shaft.

Rotation Module Assy should be reassembled using new parts.

8-51-2-6 Functional Check 

Test Refer to Note

System Exterior Visual Check
section 4-3-1 of LOGIQ P8P9P10 PSM(GPN : 

5599028)

Mechanical Parts Functional Check
section 4-3-2 of LOGIQ P8P9P10 PSM(GPN : 

5599028)

Power On/Off
section 4-3-3 of LOGIQ P8P9P10 PSM(GPN : 

5599028)

System Integration Checks
section 4-3-5 of LOGIQ P8P9P10 PSM(GPN : 

5599028) OPIO Test only 



GEDRAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

Chapter 8 - Replacement Procedures 8-271

Section 8-52
Replacement of ODD Dummy Cover R3

8-52-1 Manpower
1 person, 5 minutes

8-52-2 Tools
Standard Phillips Screwdriver

8-52-3 Pre work
1) Remove Rear Cover (refer to section 8-9)
2) Remove Top Cover (refer to section 8-7)

8-52-4 Removal Procedure
1) Unscrew 2 screws and disassemble ODD Dummy cover.

8-52-5 Installation Procedure
All components to be installed in reverse order of removal.

8-52-6 Functional Check
Visual inspection only

Figure 8-353   Unscrewing 2 screws and disassembling ODD Dummy cover
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Section 8-53
Replacement of Probe Light assy

8-53-1 Replacement of Probe Light Assy (R3)

8-53-1-1 Manpower
1 person, 20minutes

8-53-1-2 Tools
Standard Phillips Screw driver 

8-53-1-3 Pre work

1) Remove OPIO Panel assy (refer to section 8-14)

8-53-1-4 Removal Procedure

1) Remove probe light cable.

Figure 8-354   Remove of probe light cable from LP7P9 OPIO MAIN BOARD PWA
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2) Untie clamp for release Probe light cable

8-53-2 Replacement of Probe Light Assy (R4 and R4.5)

8-53-2-1 Manpower
1 person, 20 minutes

8-53-2-2 Tools
Standard Phillips Screw driver

8-53-2-3 Pre-Work
1) Remove OPIO Assy (refer to section 8-14)

Figure 8-355   Un-tie of Probe light cable from OPIO base
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8-53-2-4 Removal Procedure

1) Disconnect the probe light cable.

2) Unscrew 1 screw for untying the probe light cable.

Figure 8-356   Disconnecting the probe light cable

Figure 8-357    Unscrewing 1 screw
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3) Unscrew 3 screws and detach the probe light assy

Figure 8-358   Unscrewing 3 screws and detaching the probe light assy
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Section 8-54
Replacement of ACDC

8-54-1 Manpower
1 person, 15 minutues

8-54-2 Tools
Standard Phillips screwdriver

8-54-3 Removal Procedure
1) Remove 2 screws and Power Cord Fix Bracket. 

2) Pull the rear cover and remove it as following figure.

Figure 8-359   Removing the power cord fix brkt and power cord

Figure 8-360   Removing the rear cover assy

POWER CORD FIX BRKT
POWER CORD

REAR COVER ASSY
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3) Remove 5 screws and Cable Cover Bracket. 

4) Disconnect Cables and unscrew 7 screws. Then remove NEST EMI Back Bracket.

5) Pull out the IOBOX-B Assy from the nest box. 

Figure 8-361   Unscrewing 5 screws and removing the rear cable cover brkt

Figure 8-362   Disconnecting cables and unscrewing 7 screws 

Drw

Figure 8-363   Drawing the IO Box from Nest Frame

REAR CABLE COVER BRKT

NEST EMI BACK BRKT
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8-278 Section 8-54 - Replacement of ACDC

6) Remove 12 screws:
- [LOGIQ P7/P9 R1 to R3]

1.) from IOBOSX or IOBOX-B.

2.) Install Artesyn ACDC-4 (5728320-4).
3.) Connect ‘Artesyn ACDC Input Harness (5728321)’ and ‘ACDC Output Harness 

(5728321)’

Figure 8-364   Removing 12 screws

Figure 8-365   
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4.) Assemble Artesyn ACDC Output Harness (5728321) with ACDC Assy.

5.) Tighten the harness using cable tie (2160954). 

6.) Assemble Artesyn ACDC heatsink. Red box is the ACDC heatsink position. Remove the 
adhesive tape from the heatsink.

7.) Attach Artesyn ACDC heatsink as below figure.

Figure 8-366   

Figure 8-367   Tightening the harness

Figure 8-368   Assembling Artesyn ACDC heatsink
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NOTE: Attach the heatsink exactly at the same position like red square. 

8.) Check the Internal harnesses.

Figure 8-369   Attaching Artesyn ACDC heatsink

Figure 8-370   Checking the Internal harness
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- [LOGIQ P8/P9/P10 R4 and R4.5]

1.) from IOBOX.

2.) Remove the TDK-L ACDC Input Harness (5856083), TDK-L ACDC Output Harness 
(5856084) then uninstall ACDC Module (5831552) with removing 4 screws on IOBOX.

Figure 8-371   

Figure 8-372   Removing Connected Harness and screws
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3.) Prepare ACDC Module (5831552). Then remove the 2screws on ACDC Module.

4.) Connect ‘TDK-L ACDC Input Harness (5856083)’ to ACFL and ‘TDK ACDC Module 
(5831552)’.

5.) Assemble TDK-L ACDC Output Harness (5856084) with ACDC Assy.

Figure 8-373   TDK ACDC Module

Figure 8-374   Connecting TDK ACDC Input harness

Figure 8-375   Connecting Artesyn ACDC Output harness
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6.) Check the Internal harnesses

8-54-4 Assemble procedure
All components to be installed/assembled in reverse order of removal. Please refer to step 1) ~ 6).

8-54-5 Verification after rework
• Power-On test: Follow the procedure in Section 4-3-3 "Power On/Off" 
• Power-Down test: Follow the procedure in Section 4-3-3-2 "Complete power down" 

8-54-6 Pass/Fail criterion for the reworks
• Pass: Both ‘A)’ and ‘B)’ are satisfied 

A.) After “Power-on” procedure regarding Section 4-3-3 "Power On/Off" , On/Off button color 
is changed to green. Then access the application. 

B.) After “Power-Down” procedure regarding Section 4-3-3-2 "Complete power down" , the 
system turns down and On/off button color is changed to blue.

• Fail: A) or B) is not satisfied. 

8-54-7 Check the IOBOX (or IOBOX-B) and replaced ACDC serial number

Figure 8-376   Checking the Internal harness

Figure 8-377   
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8-54-8 Check the IOBOX (or IOBOX-B) and replaced ACDC serial number

Figure 8-378   ACDC serial number
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Chapter 9
Renewal Parts

Section 9-1
Overview

9-1-1 Purpose of Chapter 9
This chapter gives an overview of replacement parts available for the LOGIQ P7/P8/P9/P10.

Mechanical Part

Plastics Covers (Front/Sides/Rear)

Figure 9-1  LOGIQ P7/P9 R1 to R2.5

Nest Box Parts

LCD Monitor

OPIO
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Mechanical Part

Plastics Covers (Front/Sides/Rear)

Figure 9-2  LOGIQ P7/P9 R3
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Mechanical Part

Plastics Covers (Front/Sides/Rear)

Figure 9-3  LOGIQ P8/P9/P10 R4 and R4.5
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Section 9-2
List of Abbreviations 

AC Alternating Current
ADC Analog to Digital Converter
A/N Key Alpha Numeric Keys
ASIC Application Specific Integrated Circuit
Assy Assembly
MCB MARU Core board(Merged Radio frequency module and Beaforming board) 
MBP Backplane interface module
CPU Central Processing Unit
MCWD Continuous wave doppler module
DAC Digital to Analog Converter
DC Direct Current
DSP Digital Signal Processing
DVD Digital Video Disc
DVI Digital Visual Interface
ECGP Electrocardiography module
EUM Electronic User Manual
FRU 1 Replacement part available in parts hub
FRU 2 Replacement part available from the manufacturer (lead time involved)
HDD Hard Disk Drive
Int Internal
I/O Input/Output
LCD Liquid Crystal Display
PCI Peripheral Component Interconnect
PWA Printed Wire Assembly
SOM System On Module
SSD Solid State Drive
USB Universal Serial Bus 
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Section 9-3
LOGIQ P7/P8/P9/P10 Software

Table 9-2    LOGIQ P9/P7 software (R1 to R2.5)

Item
SW 

Version Base SW Part Number
Application SW 

Part Number Qty FRU R1 R2 R2.5

1 R1.0.0 5507300 5507301 1 1 Y N N

2 R1.0.1

5507300-2

5507301-2 1 1 Y N N

3 R1.0.2 5507301-3 1 1 Y N N

4 R1.0.3 5507301-4 1 1 Y N N

5 R1.0.4 5507300-3 5507301-5 1 1 Y N N

6 R1.0.5 5507300-4 5507301-6 1 1 Y N N

7 R2.0.2 5724300 5724301 1 1 N Y N

8 R2.0.3
5724300-2

5724301-2 1 1 N Y N

9 R2.0.4 5724301-3 1 1 N Y N

10 R2.0.5 5724300-2(Ivybridge) 5724301-4 1 1 N Y N

11 R2.0.6 5724300-3(Skylake) 5724301-5 1 1 N Y N

12 R2.0.7
5724300-4(Ivybridge)

5724301-6
1 1 N Y N

5724300-5(Skylake) 1 1 N Y N

13 R2.5.3 5766409 5760487 1 1 N Y Y

14 R2.5.4 5781578 5760487-2 1 1 N N Y

15
R2.5.5

5781578-2(Skylake)
5760487-3

1 1 N N Y

16 5766409-2(Ivybridge) 1 1 N N Y

17
R2.5.6

5781578-3(Skylake)
5760487-4

1 1 N N Y

18 5766409-3(Ivybridge) 1 1 N N Y

19 R2.5.7
5781578-4(Skylake)

5760487-5
1 1 N N Y

5766409-4(Ivybridge) 1 1 N N Y

Table 9-3    LOGIQ P7/P8/P9/P10 software (R3 to R4.5)

Item SW Version SW FRU Number Qty FRU R3 R4 R4.5

1 R3.0.2 5795390 1 1 Y N N

2 R3.0.3 5795390-2 1 1 Y N N

3 R3.0.4 5795390-3 1 1 Y N N

4 R3.0.5 5795390-4 1 1 Y N N

5 R3.0.6 5795390-5 1 1 Y N N

6 R3.0.8 5795390-7 1 1 Y N N

7 R3.0.9 5795390-8 1 1 Y N N

8 R3.0.10 5795390-9 1 1 Y N N

9 R3.0.11 5795390-10 1 1 Y N N
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NOTE: How to check CPU code name, Ivybridge or Skylake

1.) Turn the system on and go to BIOS mode by pressing ‘Del’ key
2.) Go to ‘Main -> ‘Platform Information’
3.) Check ‘Codename’. There is ‘IvyBridge’ or ‘SkyLake’

NOTE: SOM 6324558 -x is only allowed for Ivybridge.
SOM 7324558 is only allowed for Skylake.

10 R3.0.12 5795390-11 1 1 Y N N

11 R4.0.3 5851137 1 1 N Y N

12 R4.0.4 5851137-2 1 1 N Y N

13 R4.0.5 5851137-3 1 1 N Y N

14 R4.0.7 5851137-5 1 1 N Y N

15 R4.0.6 5851137-4 1 1 N Y N

16 R4.5.1 5874238 1 1 N N Y

17 R4.5.2 5874238-2 1 1 N N Y

Table 9-3    LOGIQ P7/P8/P9/P10 software (R3 to R4.5)

Item SW Version SW FRU Number Qty FRU R3 R4 R4.5
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Section 9-4
Parts List Groups 

Figure 9-4  Console Views (R1 to R2.5)

Figure 9-5  Console Views(R3)
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Figure 9-6  Console Views (R4 and R4.5)

Table 9-4    Mechanical and user accessible parts

Item Part Group Name Table Number Description

101-
111 Plastics Covers (Front/Sides/Rear) Table 9-5 on page 9-10 Housing Covers

101-1-
113-1 Plastics Covers (Front/Sides/Rear) (R3 and R4) Table 9-6 on page 9-13 Housing Covers

201-
212 LCD Monitor Table 9-7 on page 9-16 Monitor and its covers

301-
343 OPIO Table 9-8 on page 9-19 User interface parts

401-
429 Nest Box Parts Table 9-10 on page 9-29

Main board modules
Including front/back end boards

501-
525 Mechanical Part Table 9-11 on page 9-37 Mechanical Parts and speaker

701-
748 Options Table 9-12 on page 9-42 Options

811 Optional Peripherals and Accessories Table 9-13 on page 9-51 B/W Printer, Color Printer, Line Printer 
Bluetooth

- Probes - Probes

930-
946 Power Cord Table 9-14 on page 9-53 Power Cord
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Section 9-5
Plastics Covers (Front/Sides/Rear)

9-5-1 Plastics Covers (Front/Sides/Rear) (R1,R2 and R2.5)
Table 9-5    Plastic Covers

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5

101 Side Cover R Assy 5499849

Assy Plastic

1 1 Y Y Y N N N

102 Side Cover L Assy R2 5499847-2

Assy Plastic

1 1 Y Y Y N N N

103 Front Cover Assy 5499845

Assy Plastic

1 1 Y Y Y N N N

104 Rear Cover Assy R2.5 S5499822

Assy Plastic(with e-IFU label)

1 1 N N Y N N N

104-1 Rear Cover Assy 5499846

Assy Plastic(without e-IFU 
label)

1 1 Y Y Y N N N
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105 Top Cover - High 
Cabinet

5499645

High Cabinet Cover

1 1 Y Y Y N N N

106 Top Cover - Low 
Cabinet

5499661

Low Cabinet Cover

1 1 Y Y Y N N N

107 High Cabinet Dummy 
Cover

5499660

Plastics, BW PRT Bezel, 
Dummy for High Cabinets

1 1 Y Y Y N N N

108 Dummy Cover Set 5582883

RS Dummy Cover, RS Lever 
Dummy Cover, CWD Dummy 

Cover

1 1 Y Y Y N N N

109 Foot Cover Set 5582885

Foot Cover Front, Foot Cover 
Rear L, Foot Cover Rear R

1 1 Y Y Y N N N

110 Link Arm Top Cover 5507028

Plastic

1 1 Y Y Y Y Y Y

Table 9-5    Plastic Covers

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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111 OPIO Top Cover Set 5582886

OPIO Top Cover L,  OPIO Top 
Cover R, OPIO USB COVER 

1 1 Y Y Y Y Y Y

Table 9-5    Plastic Covers

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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9-5-2 Plastics Covers (Front/Sides/Rear) (R3 and R4)
Table 9-6    Plastic Covers (R3 and R4)

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5

101-1 Side Cover R Assy R3 5794893

Assy Plastic

1 1 N N N Y N N

102-1 Side Cover L Assy R3 5794894

Assy Plastic

1 1 N N N Y Y Y

103-1 Front Cover Assy R3 5794912

Assy Plastic

1 1 N N N Y Y Y

104-1 Rear Cover Assy R3 5794891

Assy Plastic

1 1 N N N Y N N
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105-1 High Cabinet Assy R3 5794899

Assy Plastic

1 1 N N N Y Y Y

106-1 Low Cabinet Assy R3 5794892

Assy Plastic

1 1 N N N Y Y Y

107-1 High Cabinet Dummy 
Cover R3

5794085

Plastics, BW PRT Bezel, 
Dummy for High Cabinets

1 1 N N N Y Y Y

108-1 Dummy Cover Set R3 S5794033

RS Dummy Cover, RS Lever 
Dummy Cover, CWD Dummy 

Cover

1 1 N N N Y Y Y

109-1 Foot Cover Set R3 S5794020

Foot Cover Front, Foot Cover 
Rear L,Foot Cover Rear R

1 1 N N N Y Y Y

110-1 ODD Dummy Cover 
R3

5794027

Plastic

1 1 N N N Y Y Y

Table 9-6    Plastic Covers (R3 and R4)

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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111-1 Side Cover R Assy R4 5848755

Assy Plastic

1 1 N N N N Y Y

112-1 Rear Cover Assy R4 5857308

Assy Plastic

1 1 N N N N Y N

113-1 Rear Cover Assy R4.5 S5882294

Assy Plastic

1 1 N N N N N Y

Table 9-6    Plastic Covers (R3 and R4)

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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Section 9-6
LCD Monitor 

Table 9-7    User Interface

Item Part Name
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5

201 21.5" LCD 5501560-122

Full 21.5" LCD Monitor set with hinge

1 1 Y N N N N N

202
21.5 INCH LCD 
MONITOR with USB 
2.0 and without glass 
filter

5501560-141

Full 21.5" LCD Monitor set with hinge

1 1 Y Y Y N N N

203 MARU R3 21.5 monitor 7501560-2

MARU R3 21.5 monitor

1 1 N N N Y N N

204 21.5" LCD Cover SET 5582887

Plastics, Front, Rear and Cable cover, 
Monitor USB cap, Glass Filter for 21.5" 

LCD

1 1 Y N N N N N
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205 21.5 INCH LCD Cover 
SET w/o glass filter

5727721

Plastics, Front, Rear and Cable cover, 
Monitor USB cap 

1 1 N Y Y N N N

206 21.5inch LCD Cover 
SET R3

S5792901

Plastics, Front, Rear and Cable cover, 
Monitor USB cap

1 1 N N N Y N N

207 Bezelless 23.8 inch 
LCD Monitor

8501560

Bezelless 23.8 inch LCD monitor

1 1 N N N N Y N

208 Monitor Cover Set 23.8 
inch

S5848754

Plastics, Front, Rear, Cable Cover and 
Hook Remover

1 1 N N N N Y Y

209 HD Display 8501561

23.8 inch LCD monitor

1 1 N N N N Y N

Table 9-7    User Interface

Item Part Name
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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210 HD Monitor Cover Set 
23.8inch

S5862906

Plastics, Front, Rear, Cable Cover and 
Hook Remover

1 1 N N N N Y Y

211
Bezelless 23.8 inch 
LCD Monitor for 
external monitor audio 

9501560

Bezelless 23.8 inch LCD monitor

1 1 N N N N N Y

212 HD Display for external 
monitor audio

9501561

23.8 inch LCD monitor

1 1 N N N N N Y

Table 9-7    User Interface

Item Part Name
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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Section 9-7 OPIO

Table 9-8    OPIO

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5

301 OPIO ASSY LOGIQ P7 
SET

S5781418-2

OPIO ASSY LOGIQ P7 SET

1 1 Y Y Y N N N

302 OPIO ASSY LOGIQ P7 
R3

7503848

Full OPIO set, including Main and 
Sub OPIO sets for LOGIQ P7 

R3(Different Emblem)

1 1 N N N Y N N

303 OPIO ASSY LOGIQ P9 
SET

S5781419-2

OPIO ASSY LOGIQ P9 SET

1 1 Y Y Y N N N

304 OPIO ASSY LOGIQ P9 
R3

7603848

Full OPIO set, including Main and 
Sub OPIO sets for LOGIQ P9 R3 

(Different Emblem)

1 1 N N N Y N N
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305 OPIO Main PWA Assy 5503847

OPIO Main PWA Assembly

1 1 Y N N N N N

306
LOGIQ P7/P9 OPIO 
10.4 inch LCD module 
set

5561038

Maru OPIO 10.4 LCD Set

1 1 Y N N N N N

307 LP7 Upper ASSY SET S5788926

LP7 Upper ASSY SET

1 1 Y Y Y N N N

308 LP9 Upper ASSY SET 
R3

S5788927

LP9 Upper ASSY SET

1 1 Y Y Y N N N

309 LP7 Upper ASSY SET 
R3

S6788926

LP7 Upper ASSY SET R3

1 1 N N N Y N N

Table 9-8    OPIO

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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310 LP9 Upper ASSY SET 
R3

S6788927

LP9 Upper ASSY SET R3

1 1 N N N Y N N

311 Trackball Assy 5554918

Trackball Assy (In case it is not 
available, order 9554918 with 

5761351)

1 1 Y N N N N N

312 LOGIQ P7P8P9P10 
Laser trackball

9554918

LOGIQ P7P8P9P10 Laser 
trackball

1 1 N Y Y Y Y Y

313 OPIO Button and Knob 
Sets

S5582808-2

OP Button+Knob sets

1 1 Y Y Y N N N

314 OPIO Up/Down Button 
Sets

5582809

Up/Down Button, Rotation Button, 
OPIO Dummy Button Sets

1 1 Y Y Y N N N

Table 9-8    OPIO

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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315 OPIO AN Key Gel Board 5503844

OPIO AN Key Gel Board 

1 1 Y N N N N N

316 LP7P9 OPIO ANKEY 
GEL BOARD PWA - H

S5781421

LP7P9 OPIO ANKEY GEL 
BOARD PWA - H

1 1 N Y Y N N N

317 LP7P9 OPIO ANKEY 
GEL BOARD PWA

7503844

LP7P9 OPIO ANKEY GEL 
BOARD PWA

1 1 N N N Y Y Y

318 OPIO LOWER COVER 5507036

OPIO LOWER COVER

1 1 Y Y Y N N N

319 OPIO Main PWA Assy S5781422

OPIO Main PWA Assy

1 1 N Y Y Y N N

Table 9-8    OPIO

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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320 LP7P9 OPIO MAIN 
BOARD PWA  SET

S5781465

LP7P9 OPIO MAIN BOARD PWA  
SET

1 1 N N N Y N N

321 LP7P9 OPIO FREEZE 
AND P1 BOARD SET

S5781426-2

LP7P9 OPIO FREEZE AND P1 
BOARD SET

1 1 Y Y Y Y Y Y

322 LP7P9 OPIO 10.4 LCD 
Set - E

6561038

LP7P9 OPIO 10.4 LCD Set - E

1 1 N Y Y N N N

323 LP7P9 OPIO lower Assy 
- H

S5781425

LP7P9 OPIO lower Assy - H

1 1 N Y Y N N N

324 LP7P9 R3 OPIO lower 
assy

7554917

LP7P9 R3 OPIO lower assy

1 1 N N N Y N N

Table 9-8    OPIO

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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325
COMMON ROTARY 
ENCODER SET FOR 
LP9_LP7

S5718726-2

COMMON ROTARY ENCODER 
SET FOR LP9_LP7

1 1 Y Y Y N N N

326
LP7P9 R3 COMMON 
ROTARY ENCODER 
SET

S5794055

LP7P9 R3 COMMON ROTARY 
ENCODER SET

1 1 N N N Y N N

327
B MODE ROTARY 
ENCODER SET FOR 
LP9_LP7

S5718727-2

B MODE ROTARY ENCODER 
SET FOR LP9_LP7

1 1 Y Y Y N N N

328
LP7P9 R3 B MODE 
ROTARY ENCODER 
SET

S5794057

LP7P9 R3 B MODE ROTARY 
ENCODER SET

1 1 N N N Y N N

Table 9-8    OPIO

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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329 OPIO HUB BOARD 
PWA FOR LP9_LP7

5503846-3

OPIO HUB BOARD PWA FOR 
LP9_LP7

1 1 Y Y Y N N N

330 Probe Light Assy S7503830

Probe Light Assy

1 1 N N N Y Y Y

331 Op Button_Knob Sets 
R3

S5794044

OP Button+Knob sets

1 1 N N N Y N N

332 OPIO Up_Down Button 
Set R3

S5794070

Up/Down Button, Rotation Button, 
OPIO Dummy Button Sets

1 1 N N N Y Y Y

333 OPIO LOWER COVER 
R3

5794065

OPIO LOWER COVER

1 1 N N N Y N N

Table 9-8    OPIO

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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334 Operator Panel 10.4 R4 8603848

OPIO Assy LP8P9P10 R4

1 1 N N N N Y Y

335 LP8P9P10 R4 OPIO 
Upper Assy set

S7788926

LP8/P9/P10 OPIO Upper Assy

1 1 N N N N Y Y

336 LP8P9P10 R4 OPIO 
Lower Assy

S8554917

LP8/P9/P10 OPIO Lower Assy

1 1 N N N N Y Y

337 Main PWA for Operator 
Panel 10.4 R4

S7781465

LP8/P9/P10 OPIO Main PWA

1 1 N N N N Y Y

338 Rotary Encoder set for 
Operator Panel 10.4 R4

S6794055

Rotary Encoder set R4

1 1 N N N N Y Y

Table 9-8    OPIO

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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339 Joystick Encoder set for 
Operator Panel 10.4 R4

S5856454

Joystick Encoder set R4

1 1 N N N N Y Y

340 B Mode Rotary Encoder 
Set R4

S6794056

B Mode Rotary Encoder set R4

1 1 N N N N Y Y

341 OPIO Lower Cover R4 5841801

OPIO Lower Cover R4

1 1 N N N N Y Y

342 Key Rubber Set R4 S5857875

Key Rubber Set R4

1 1 N N N N Y Y

343 OPIO Button Knob set 
R4

S5848756

OPIO Button Set R4

1 1 N N N N Y Y

Table 9-8    OPIO

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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9-7-1 Software compatibility information
For the systems that are marked as ‘x’, both base and application software are required to be ordered 
as FRUs and installed as it is described in the table after the OPIO replacement. 

NOTE: In case LOGIQ P7/P9 OPIO 10.4 inch LCD module set (5561038) is not available: 

- For LP7 SW R1.0.5 or above systems, LP7 Upper ASSY SET(S5788926) can be used 
instead.

- For LP7 SW R1.0.4 or below systems, LP7 Upper ASSY SET(S5788926), Base 
SW(5507300-4) and Application SW(5507301-6) can be used instead. 

- For LP9 SW R1.0.5 or above systems, LP9 Upper ASSY SET(S5788927), can be used 
instead.

- For LP9 SW R1.0.4 or below systems, LP9 Upper ASSY SET(S5788927), Base 
SW(5507300-4) and Application SW(5507301-6) can be used instead. 

NOTE: In case LOGIQ P7/P9 OPIO 10.4 inch LCD module set(6561038) is not available: 

- For LP7 SW R2.0.5 or above systems, LP7 Upper ASSY SET(S5788926) can be used 
instead. 

- For LP7 SW R2.0.4 or below systems, LP7 Upper ASSY SET(S5788926), Base 
SW(5724300-2) and Application SW(5724301-4) can be used instead. 

- For LP9 SW R2.0.5 or above systems, LP9 Upper ASSY SET(S5788927) can be used 
instead. 

- For LP9 SW R2.0.4 or below systems, LP9 Upper ASSY SET(S5788927), Base 
SW(5724300-2) and Application SW(5724301-4) can be used instead.

Table 9-9    

# GPN Description

Base:5507300-4
Application: 5507301-6

Base:5724302-2
Application:5724301-4

R1.01 R1.0.2 R1.0.3 R1.0.4

R1.0.5 
or 

above R2.01 R2.0.2 R2.0.3 R2.0.4

R2.0.5 
or 

above

1 S5781418-2 OPIO ASSY 
LOGIQP7 SET x x x x x x x x

2 S5781419-2 OPIO ASSY 
LOGIQP9 SET x x x x x x x x

3 S5781422
LP7P9 OPIO 
MAIN BOARD 
PWA-H SET

x x x x x x x

4 S5788926 LP7 Upper 
ASSY SET x x x x x x x x

5 S5788927 LP9 Upper 
ASSY SET x x x x x x x x

6 S5781425
LP7P9 OPIO 

lower Assy - H 
SET

x x x x x x x
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Section 9-8
Nest Box Parts

Table 9-10    Nest Box Parts

Item Part Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5

401 MBP Assy 5503745

MBP Assy

1 1 Y Y Y Y N N

401-1 MBP R4 5822300

MBP R4 PWA

1 1 N N N N Y Y

401-2 CSI R4 5822433

CSI R4 PWA

1 1 N N N N Y Y

402 MCB PWA 5494666-4

MCB PWA

1 1 Y N N N N N

402-1 MCB-H 6494666-2

MCB-H Assy

1 1 N Y Y N N N

402-2 MCB-R3 7494666-2

MCB-R3 PWA - AudioCodec

1 1 N N N Y N N
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402-3 MCB-A 8494666-2

MCB-A PWA

1 1 N N N N Y Y

403 MDC Assy 5552220-2

MDC Assy

1 1 Y Y Y N N N

403-1 MDC-R3 Assy 5552220-3

MDC-R3 Assy

1 1 Y Y Y Y Y Y

404 3 port MPI 
Assy

5582646-6

LOGIQ_P7_P9_Three_ports_MPI_
H_Assy

1 1 Y Y Y Y N N

405 4 port MPI 
Assy

5504162-6

LOGIQ_P7_P9_Four_ports_MPI_H
_Assy

1 1 Y Y Y Y N N

Table 9-10    Nest Box Parts

Item Part Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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405-1 MPI-R4 5822930

MPI-R4-PWA

1 1 N N N N Y Y

406-1 IOBOX-B Assy 5554921-5

IOBOX Assy

1 1 Y N N N N N

406-2 IOBOX-B Assy 5991830-4

IOBOX-B Assy

1 1 N Y Y Y N N

406-3 IOBOX-BT 
Assy

5877267

IOBOX-BT Assy

1 1 N N N Y N N

406-4 IOBOX R4 5831932

IOBOX R4

1 1 N N N N Y Y

407 DC4D Assy 5372959

DC4D Assy

1 1 Y Y Y Y Y Y

408 HDD 5459671

HDD

1 1 Y Y Y N N N

Table 9-10    Nest Box Parts

Item Part Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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409 SSD 5839947

2.5inch SSD 500GB

1 1 N N N Y N N

409-1 M.2 SSD 5832283

M.2 SSD

1 1 N N N N Y Y

410 DVD Drive 
(ODD)

 5393433

Without Cables

1 1 Y Y Y Y Y Y

411
Nest front FAN 
with Cable 
Assy MARU

5549305

Nest front FAN with Cable Assy 
MARU

1 1 Y Y Y Y Y Y

412
ODD SATA 
PWR cable 
collector

S5581980

Maru Shielding SATA cable, Maru 
ODD PWR Cable

1 1 Y Y Y Y Y Y

Table 9-10    Nest Box Parts

Item Part Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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413
Nest Bot FAN 
with Cable 
Assy MARU

5549309

 Nest Bot FAN with Cable Assy 
MARU

1 1 Y Y Y Y Y Y

414 COM module 6324558-2

COM module

1 1 Y N N N N N

414-1 COM module 6324558-4*

COM module(IvyBridge) 

1 1 N Y Y N N N

414-2 COM module 7324558-2*

COM Express MODULE,Type6,i3-
6100E,DDR4 8G Memory, Heatsink 

with FAN for MARU(SkyLake)

1 1 N Y Y N N N

414-3 COM module 7324560-2

COM Express MODULE,Type6,i3-
6100E,DDR4 8G Memory, Heatsink 

with FAN for MARU R3

1 1 N N N Y N N

Table 9-10    Nest Box Parts

Item Part Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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414-4 COM module 8324560

COM Express MODULE,Type6,i3-
6100E, DDR4 8G Memory, 

Heatsink with FAN for MARU R4

1 1 N N N N Y Y

415
MBOB with 
Harness and 
screws

5758146

MBOB with Harness and screws

1 1 N Y Y Y Y Y

416

MIO-2 PWA 5551110-2

MIO-2 PWA Assy

1 1 Y N N N N N

MIOB2a 5551110-10

MIOB2a PWA Assy

1 1 N N N Y N N

MIOB2 6426420-4

MIOB2 PWA

1 1 N N N Y Y Y

417
BBC with 
Harness and 
Screws

5758147

BBC with Harness and Screws

1 1 N Y Y Y Y Y

Table 9-10    Nest Box Parts

Item Part Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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418
Artesyn 
LPS363 ACDC 
Assy for FRU

5737480-5

Artesyn LPS363 ACDC Assy for 
FRU

1 1 Y Y Y Y N N

418-1 ACDC with 
cable R4

S6737480-2

TDK ACDC with cable R4

1 1 N N N Y Y Y

419 OPIO Cable 
Assy MARU

5582888

OPIO Power Cable
OPIO USB Cable

1 1 Y Y Y Y Y Y

420
LCD Monitor 
Cable Assy  
MARU 

5582890

LCD POWER CABLE (R1/R2/R2.5/
R3)

LCD HDMI CABLE (R1/R2/R2.5/
R3)

LCD USB CABLE (R1/R2/R2.5)

1 1 Y Y Y Y N N

421 
Speaker with 
Cable 
Assembly 
MARU

5549296

Including Speaker Cable

1 1 Y Y Y Y Y Y

422
Peripheral 
Cable Assy 
MARU

5582891

Usb*2/Pwr -Bw Color USB Cable 
Assy

Usb*2/Pwr -Bw Color Power Cable 
Assy

1 1 Y Y Y Y N N

Table 9-10    Nest Box Parts

Item Part Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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422-1
Peripheral 
Cable Assy 
LP8P9P10 R4

S5857337

Peripheral Cable Assy LP8P9P10 
R4

1 1 N N N N Y Y

423 LP9P7 Cable 
Set R3

S7503831

LP9P7 Cable Set R3

1 1 N N N Y Y Y

424
LP9_LP7 
OPIO Cable 
Set

S5716942-2

LP9_LP7 OPIO Cable Set

1 1 Y N N N Y Y

425
LP9_LP7 
OPIO Cable 
Set - JH

5761351

LP9_LP7 OPIO Cable Set - JH

1 1 N Y N N Y Y

426
LP9_LP7 
OPIO Cable 
Set - H

6716942

LP9_LP7 OPIO Cable Set - H

1 1 N Y Y Y Y Y

427
LOGIQ P9P7 
External USB 
port ASSY

S5808601

LOGIQ P9P7 External USB port 
ASSY

1 1 Y Y Y N N N

Table 9-10    Nest Box Parts

Item Part Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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* Ivybridge and SkyLake COM module can be determined by checking the BIOS Codename.
Mechanical Parts

** Use the HDMI male to HDMI female adaptor cable to connect the external monitor as HCAT. 
After that, if there is a problem with the adaptor, please order FRU 5761422.

Section 9-9
Mechanical Part

428
HDMI male to 
HDMI female 
adaptor cable

H44942LW
(5761422)**

HDMI male to HDMI female adaptor 
cable

1 1 Y Y Y Y N N

429 Monitor Cable 
SET R4

S8503831

Monitor Cable SET R4

1 1 N N N N Y Y

Table 9-11    Mechanical Parts

Item Part Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5

501 Total Lock Caster 5400391-2

except Swivel Lock Caster (3 per 
console)

3 1 Y Y Y N N N

502 Swivel Lock Caster 5400392-2

Rear-Right Caster (1 per console)

1 1 Y Y Y N N N

503 Castor Total Lock 
N9

5746120

except Swivel Lock Caster (3 per 
console)

3 1 N N N Y Y Y

Table 9-10    Nest Box Parts

Item Part Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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504 Castor Dual Lock 
N9

5746121

Rear-Right Caster (1 per console)

1 1 N N N Y Y Y

505 Air Filter set 5582810

Front Air Filter, Bottom Air Filter

1 1 Y Y Y Y Y Y

506 Probe Holder set 5582811

Probe cup, Small Probe Cup, 4D 
Probe Holder, Hanger Cap Rubber

1 1 Y Y Y N N N

507 Probe Holder set 
R3

S5794066

Probe cup, Small Probe Cup, 4D 
Probe Holder, Hanger Cap Rubber

1 1 N N N Y Y Y

508 Front Cable Hook 5394432

OPIO Front Hook

1 1 Y Y Y N N N

509 OPIO Front Hook 
R3

5730659

OPIO Front Hook

1 1 N N N Y N N

Table 9-11    Mechanical Parts

Item Part Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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510 Fixed Arm set 5507554

Full Assy for LCD Monitor

1 1 Y Y Y N N N

511 Fixed Arm Assy R3 5794897

Full Assy for LCD Monitor

1 1 N N N Y N N

512 Fixed Arm Cover 
sets

5582893

Plastic Cover

1 1 Y Y Y N N N

513 Fixed Arm Cover 
Set R3

S5794075

Plastic Cover

1 1 N N N Y N N

514 AC Cable Holder 
set

5589119

Power Cord Fix BRKT 220V, Power 
Cord Fix

BRKT 110V

1 1 Y Y Y Y N N

Table 9-11    Mechanical Parts

Item Part Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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515 Gel Holder R2 5508055-2

Gel holder

1 1 Y Y Y N N N

516 Gel Holder R3 5794072

Gel holder

1 1 N N N Y Y Y

517 Link Arm Cable 
Hook

5507026

Link Arm Cable Hook

1 1 Y Y Y N N N

518 Link Arm Cable 
Hook R3

5794895

Link Arm Cable Hook

1 1 N N N Y Y Y

519 Option Tag Label 5573772

Option Tag Label

1 1 Y Y Y N N N

520 Option Tag Label 
R3

5794163

Option Tag Label

1 1 N N N Y N N

521 OPTION TAG 
LABEL R4 CHN

5857310

Option tag label R4 CHN

1 1 N N N N Y N

Table 9-11    Mechanical Parts

Item Part Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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522
LOGIQ P9 
ROTATION
MODULE KIT

5728965

LOGIQ P9 Rotation module kit

1 1 Y Y Y N Y Y

523 RS KNOB SET R3 S5794028

RS KNOB SET R3 

1 1 N N N Y Y Y

524 Option Tag Label 
R4 ENG

5857309

Option Tag Label R4 English

1 1 N N N N Y Y

525 Option Tag Label 
R4 CHN

5857310

Option Tag Label R4 
Chinese

1 1 N N N N Y Y

Table 9-11    Mechanical Parts

Item Part Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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Section 9-10
Options

Table 9-12    Options

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5

701 Multi Purpose 
Holder set

5582894

Multi Purpose Holder and Gel Cup

1 1 Y Y Y N N N

702 USB Footswitch, 3 
button

5380960-2

3 button switches operated by the 
feet

1 1 Y Y Y Y Y Y

703 LCD Arm 5538531

Full assy for LCD Monitor

1 1 Y Y Y N N N

704 LCD Arm R3 5794197

Full assy for LCD Monitor

1 1 N N N Y N N
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704-1 LCD Arm R4 5841783

LCD Arm Assy

1 1 N N N N Y Y

704-2 LCD Arm Cover Set 
R4

S5857259

LCD Arm Cover Set

1 1 N N N N Y Y

705 LCD Arm Plastic 
Covers

5548571

Plastics

1 1 Y Y Y N N N

706 LCD Arm Plastic 
Covers 3

S5794170

Plastics

1 1 N N N Y N N

707 OPIO Tray set 5603831

OPIO Tray, Tray Fix BRKT

1 1 Y Y Y Y Y Y

708 Paper Tray 5499671

Plastics

1 1 Y Y Y Y Y Y

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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709 Side Tray Assy 5582897

Side Tray L, R

1 1 Y Y Y Y Y Y

710 Drawer Assy 5537774

Drawer Assy

1 1 Y Y Y N N N

711 Drawer Assy R3 5794898

Drawer Assy

1 1 N N N Y Y Y

712 Rear Handle 5730809

Rear Handle

1 1 Y Y Y N N N

713 Rear Handle R3 5794081

Rear Handle

1 1 N N N Y Y Y

714 Probe cable hanger 5172249

Probe cable hanger

1 1 Y Y Y Y Y Y

715 Rear Cable Hook 5394433

Rear Cable Hook

1 1 Y Y Y N N N

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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716 OPIO Side Rear 
Hook R3

5730661

Rear Cable Hook

1 1 N N N Y Y Y

717 Card Reader BRKT 
set

5599965

Card Reader BRKT, Self adhesive 
hook

and loop

1 1 Y Y Y Y Y Y

718 MCWD assy 5717876

MCWD assy

1 1 Y Y Y Y Y Y

719 ECG 5570914

ECG

1 1 Y Y Y Y Y Y

720 Gel Warmer 5537501-2

Gel warmer 2 LP7P9

1 1 Y Y Y N N N

721 Gel Warmer Cap 5491354

Bottom of Gel Warmer

1 1 Y Y Y N N N

722 Gel Warmer 2 
LP7P9 R3

5794080

Gel Warmer

1 1 N N N Y Y Y

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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723 Gel Warmer Cap 
LS8 R3

5692045

Bottom of Gel Warmer

1 1 N N N Y Y Y

724 Multi Purpose 
Holder Set R3

S5794159

Multi Purpose Holder and Gel Cup

1 1 N N N Y Y Y

725 ECG Assy 5599525

LOGIQ P7_P9 ECG Module Assy

1 1 Y Y Y Y N N

725-1 ECG Assembly 5851293

LOGIQ P8P8P10 ECG Module 
Assy

1 1 N N N N Y Y

726

MARU WIRELESS 
LAN
ASSY for Japan
MARU WIRELESS 
LAN
ASSY except for 
Japan

5599724
5599725-2

MARU WIRELESS LAN ASSY for 
Japan

MARU WIRELESS LAN ASSY 
except for Japan

1 1 Y Y Y Y Y Y

727
BT820-02 Laird 
Bluetooth
dongle 

5799898

BT820-02 Laird Bluetooth dongle 

1 1 N N N Y Y Y

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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728 Battery 5450061-3

Battery

1 1 Y Y Y Y Y Y

730
Universal Video 
Converter
S300, UVC-S300

5750263

Universal Video Converter S300,
UVC-S300

1 1 Y Y Y Y Y Y

731 DCWD assy 5507749

DCWD assy

1 1 Y Y Y Y Y Y

731-1 DCWD Assy 5371008

DCWD Assy

1 1 N N N N Y Y

732 IEC Type ECG 
CABLE

5341188

ECG Patient cable only for EU, 
ASIA

1 1 Y Y Y Y N N

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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733 Norav ECG Patient 
cable AHA Type

5178978

Norav ECG Patient cable AHA 
Type

1 1 Y Y Y Y N N

734 Norav ECG Patient 
cable IEC Type

5192623

Norav ECG Patient Cable IEC 
Type

1 1 Y Y Y Y N N

735 ECG TRUNK 
CABLE AHA

2106305-
001

ECG TRUNK CABLE, 3/5-LEAD, 
AHA, 3.6 M/12 FT

1 1 N N N N Y Y

736 ECG TRUNK 
CABLE IEC

2106305-
003

ECG TRUNK CABLE, 3/5-LEAD, 
IEC, 3.6 M/12 FT

1 1 N N N N Y Y

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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737 ECG LEADWIRE 
SET AHA

2106390-
001

ECG LEADWIRE SET, 3-LD 
GROUPED, GRABBER, AHA, 74 

CM/ 29 IN

1 1 N N N N Y Y

738 ECG LEADWIRE 
SET IEC

2106390-
003

ECG LEADWIRE SET, 3-LD 
GROUPED, GRABBER, IEC, 74 

CM/ 29 IN

1 1 N N N N Y Y

739 AN KEYBOARD 
ASSY R3

5794155 AN KEYBOARD ASSY ENGLISH
AN KEYBOARD ASSY GREEK

AN KEYBOARD ASSY 
NORWEGIAN

AN KEYBOARD ASSY RUSSIAN
AN KEYBOARD ASSY FRENCH
AN KEYBOARD ASSY SWEDISH
AN KEYBOARD ASSY GERMAN

1 1 N N N Y Y Y

740 AN KEYBOARD 
ASSY GREEK R3

5794900 1 1 N N N Y Y Y

741
AN KEYBOARD 
ASSY
NORWEGIAN R3

5794902 1 1 N N N Y Y Y

742 AN KEYBOARD 
ASSY RUSSIAN R3

5794904 1 1 N N N Y Y Y

743 AN KEYBOARD 
ASSY FRENCH R3

5794906 1 1 N N N Y Y Y

744
AN KEYBOARD 
ASSY SWEDISH 
R3

5794908 1 1 N N N Y Y Y

745 AN KEYBOARD 
ASSY GERMAN R3

5794910 1 1 N N N Y Y Y

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

9-50 Section 9-10 - Options

746 AN KEYBOARD 
ASSY

5582898 AN KEYBOARD ASSY ENGLISH
AN KEYBOARD ASSY GREEK

AN KEYBOARD ASSY 
NORWEGIAN

AN KEYBOARD ASSY RUSSIAN
AN KEYBOARD ASSY FRENCH
AN KEYBOARD ASSY SWEDISH
AN KEYBOARD ASSY GERMAN

1 1 Y Y Y N N N

747 AN KEYBOARD 
ASSY GREEK 

5611226 1 1 Y Y Y N N N

748
AN KEYBOARD 
ASSY
NORWEGIAN 

5611228 1 1 Y Y Y N N N

749 AN KEYBOARD 
ASSY RUSSIAN 

5611234 1 1 Y Y Y N N N

750 AN KEYBOARD 
ASSY FRENCH

5611237 1 1 Y Y Y N N N

751 AN KEYBOARD 
ASSY SWEDISH

5611239 1 1 Y Y Y N N N

752 AN KEYBOARD 
ASSY GERMAN

5611241 1 1 Y Y Y N N N

Item Part Name 
Part 

Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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Section 9-11
Optional Peripherals and Accessories

NOTE: The illustrations may not correspond to the actual product!

Table 9-13    Optional Peripherals and Accessories - Printers

Item Part Name Part Number Description Qty FRU

811 Digital B/W Video Printer 
(Sony UP-D898)

H46992LS

Digital B/W Video Printer, USB-Port

- 1
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9-52 Section 9-12 - Probes

Section 9-12
Probes

Refer to the Table 3-24  Probe Description
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Section 9-13
Power Cord 

Table 9-14    Power Cord

Item
Part 

Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5

930 Power Cord 
for India 6736108-3

Power Cord for India

1 1 Y Y Y Y Y Y

931
Power Cord 

for 
Switzerland

6736113-3

Power Cord for Switzerland

1 1 Y Y Y Y Y Y

932 Power Cord  
for UK/HK 6736107-3

Power Cord for UK/HK

1 1 Y Y Y Y Y Y

933 Power Cord 
for ANZ 6736102-3

Power Cord for ANZ

1 1 Y Y Y Y Y Y

934
Power Cord 

for 
Denmark

6736115-3

Power Cord for Denmark

1 1 Y Y Y Y Y Y
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935 Power Cord 
for Italy 6736110-3

Power Cord for Italy

1 1 Y Y Y Y Y Y

936
Power Cord 

for 
Argentina

6736101-3

Power Cord for Argentina

1 1 Y Y Y Y Y Y

937 Power Cord 
for Israel 6736109-3

Power Cord for Israel

1 1 Y Y Y Y Y Y

938

Power Cord 
110V for 
Canada/

USA

6736114-3

Power Cord 110V for Canada/USA

1 1 Y Y Y Y Y Y

939
Power Cord 

220V fo r 
EU/Korea

6736105-3

Power Cord 220V for EU/Korea

1 1 Y Y Y Y Y Y

Table 9-14    Power Cord

Item
Part 

Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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940 Power Cord 
for China 6736104-3

Power Cord for China

1 1 Y Y Y Y Y Y

941 Power Cord 
for Brazil 6736103-3

Power Cord for Brazil

1 1 Y Y Y Y Y Y

942
Power Cord 

for South 
Africa

6736112-3

Power Cord for South Africa

1 1 Y Y Y Y Y Y

943
Power Cord 
for Japan/

Taiwan
6736111-3

Power Cord for Japan

1 1 Y Y Y Y Y Y

944

PWR SPLY 
CRD ST 

DENMARK 
NON-

HOSPITAL 
GRADE 

STD PLUG 
20A 250V

6736106-12

PWR SPLY CRD ST DENMARK NON-
HOSPITAL GRADE STD PLUG 20A 

250V

1 1 Y Y Y Y Y Y

Table 9-14    Power Cord

Item
Part 

Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5
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NOTE: In case of Feller power cable is being replaced with a Volex power cable, LP7P9 POWER CORD FIX 
BRKT (GPN:5802024) need to be ordered separately (R1 to R3)

945
LP7P9 

CORD FIX 
BRKT

5802024

LP7P9 POWER CORD FIX BRKT

1 1 Y Y Y Y N N

946 Power Cord 
Fix Brkt R4

5841823

Power Cord Fix Brkt R4

1 1 N N N N Y Y

Table 9-14    Power Cord

Item
Part 

Name Part Number Description Qty FRU R1 R2 R2.5 R3 R4 R4.5

FRONT BACK
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Chapter 10
Care & Maintenance

Section 10-1
Overview

10-1-1 Preventive Maintenance Inspections
It has been determined by engineering that your LOGIQ P7/P8/P9/P10 system does not have any high 
wear components that fail with use, therefore no Preventive Maintenance Inspections are mandatory. 
However, some Customers Quality Assurance Programs may require additional tasks and/or 
inspections at a different frequency than listed in this manual.

10-1-2 Purpose of Chapter 10
This chapter describes Care & Maintenance on the LOGIQ P7/P8/P9/P10 system and its peripherals. 
These procedures are intended to maintain the quality of the ultrasound systems performance. 
Read this chapter completely and familiarize yourself with the procedures before performing a task.     

Table 10-1    Contents in Chapter 10

Section Description Page Number

10-1 Overview 10-1

10-2 Why do Maintenance 10-2

10-3 Maintenance Task Schedule 10-2

10-4 Tools Required 10-5

10-5 System Maintenance 10-6

10-6 System Software Updates (Software Download) (R1, R2, R2.5 only) 10-13

10-7 Using a Phantom 10-22

10-8 Electrical Safety Tests 10-22

10-9 When There’s Too Much Leakage Current... 10-33

10-10 Ultrasound INSPECTION CERTIFICATE 10-36

CAUTION
!! CAUTION: 

Practice good ESD prevention. Wear an anti–static strap when handling electronic parts and 
even when disconnecting/connecting cables.

DANGER
!! DANGER:

THERE ARE SEVERAL PLACES ON THE BACKPLANE, THE AC DISTRIBUTION, 
AND DC DISTRIBUTION THAT ARE DANGEROUS. BE SURE TO DISCONNECT 
THE SYSTEM POWER PLUG AND SWITCH OFF THE MAIN CIRCUIT BREAKER 
BEFORE YOU REMOVE ANY PARTS. BE CAUTIOUS WHENEVER POWER IS 
STILL ON AND COVERS ARE REMOVED.

CAUTION
!! CAUTION: 

Do not pull out or insert circuit boards while power is ON.
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Section 10-2
Why do Maintenance

10-2-1 Quality Assurance
In order to gain accreditation from organizations such as the American College of Radiology (USA), it 
is the customer’s responsibility to have a quality assurance program in place for each scanner. 
The program must be directed by a medical physicists, the supervising radiologist/physician or 
appropriate designer.

Routine quality control testing must occur regularly. The same tests are performed during each period 
so that changes can be monitored over time and effective corrective action can be taken.

Testing results, corrective action and the effects of corrective action must be documented and 
maintained on the site.

Your GE service representative can help you with establishing, performing and maintaining records for 
a quality assurance program. Please contact us for coverage information and/or price for service.

Section 10-3
Maintenance Task Schedule

10-3-1 How often should care & maintenance tasks be performed?
The Customer Care Schedule (see: page 10-3) specifies how often your LOGIQ P7/P8/P9/P10 should 
be serviced and outlines items requiring special attention.

NOTE: It is the customer’s responsibility to ensure the LOGIQ P7/P8/P9/P10 care & maintenance is performed 
as scheduled in order to retain its high level of safety, dependability and performance.

Your GE Service Representative has an in-depth knowlegde of your LOGIQ P7/P8/P9/P10 ultrasound 
scanning system and can best provide competent, efficient service. 
Please contact us for coverage information and/or price for service.

The service procedures and recommended intervals shown in the Customer Care Schedule assumes 
that you use your LOGIQ P7/P8/P9/P10 for an average patient load (10-12 per day) and not use it as a 
primary mobile unit which is transported between diagnostic facilities.

NOTE: If conditions exist which exceed typical usage and patient load, then it is recommended to increase the 
maintenance frequencies.

Abbreviations used in the Customer Care Schedule Table 10-2:

D = Daily W = Weekly M = Monthly A = Annually

CAUTION
!! CAUTION: 

DO NOT operate this unit unless all board covers and frame panels are securely in place, to 
ensure optimal system performance and cooling. 
When covers are removed, EMI may be present.
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10-3-1 How often should care & maintenance tasks be performed? (cont?)
 

Table 10-2    Customer Care Schedule

Item Service at Indicated Time D W M A Notes

Air Filter Grid Remove the filter grid and clean the air filter. • Recommend to clean filter at 
least bi-weekly

AC Mains Cable Inspect AC Mains Cable • Mobile Unit Check weekly

Cables and Connectors
Check if all cables are fixed well seated at 
the correct position and if there is no 
mechanical damage visible.

• also after corrective 
maintenance

User Interface

Clean alphanumerical keyboard, Functional 
keys, Digital potentiometers, TGC-Shift 
potentiometers. (vacuum cleaner, lukewarm 
soap water on a soft, damp cloth) 

•
Be careful not to get the cloth 
too wet so that moisture does 
not enter the loudspeakers, 
TGC-Slider, or other keys!

LCD Monitor, Touch 
Panel and Probe holder

Clean LCD Monitor surface and Probe 
holder with a fluid detergent in warm water 
on a soft, damp cloth.

• Be careful not to get the cloth 
too wet so that moisture does 
not enter the entire system.

Mechanical parts

Clean and inspect the mechanical function 
of wheels, casters, brakes and swivel locks 
as well as side door, foot rest, front and rear 
handle, and monitor holder. 
Remove Dust and Coupling gel.

• Mobile Unit Check Daily

Control Console 
movement

Check Translation/Rotation and Height 
Adjustment (Elevation) • more frequently at Mobile Units

Trackball Check Check proper operation 
(Cursor movement X, Y direction) • If failure occurs go to trackball 

cleaning.

Trackball Cleaning
Remove trackball ring; open the trackball 
housing and take out the trackball to clean it 
with soft tissue and screwdriver shaft.

• Please record it in the systems 
setup maintenance report

Disk Drives
(Data Backup)

Test Image filing (Archive) Import and 
Export data capability (DVD/CD Drive) • •*

* save the image filing data 
weekly or at least monthly on 
DVD/CD depending on the 
number of examinations

Safe Probe Operation

Clean probes and probe cables and check 
acoustic lens housing (cracks) and probe 
cables. In case of mechanical damage, 
don’t use them! Danger: Safety risk for 
operator and patient.

•* * or before each use

Probe Air bubbles
To detect air bubbles in filling liquid, shake 
the probe carefully and check abnormal 
noise.

Probe connectors Remove dust/dirt of all probe connectors. 
Clean with vacuum cleaner if dust is visible. •

Console Leakage 
Current Checks • Also after corrective 

maintenance or as required by 
your facilities QA program.

Peripheral Leakage 
Current Checks • Also after corrective 

maintenance or as required by 
your facilities QA program.
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Surface Probe Leakage 
Current Checks • Also after corrective 

maintenance or as required by 
your facilities QA program.

Endocavity Probe 
Leakage 
Current Checks

• Also after corrective 
maintenance or as required by 
your facilities QA program.

Measurement Accuracy 
Checks • Also after corrective 

maintenance or as required by 
your facilities QA program.

Probe/Phantom Checks

Check axial and lateral resolution (see Basic 
User Manual Technical specifications). 
Check Gain and TGC changes, vary the 
focus and check reaction on screen. 

• Also after corrective 
maintenance or as required by 
your facilities QA program.

Functional Checks of all 
probes Section 10-5-2 
on page 10-7

• Also after corrective 
maintenance or as required by 
your facilities QA program.

Table 10-2    Customer Care Schedule

Item Service at Indicated Time D W M A Notes
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Section 10-4
Tools Required

10-4-1 Special Tools, Supplies and Equipment

10-4-1-1 Specific Requirements for Care & Maintenance

Table 10-3     Overview of Requirements for Care & Maintenance

Tool  Part Number Comments

Digital Volt Meter (DVM) minimum 5% accuracy, 3.5 digit and 200 Ohm range required

Anti Static Kit

46–194427P231
46–194427P279
46–194427P369
46–194427P373
46–194427P370

Kit includes anti–static mat, wrist strap and cables for 200 to 240 
V system
3M #2204 Large adjustable wrist strap
3M #2214 Small adjustable wrist strap
3M #3051 conductive ground cord

Anti Static Vacuum Cleaner
46–194427P278
46–194427P279

120V
230V

Safety Analyzer 46–285652G1 DALE 600 KIT (or equivalent) for electrical tests

QIQ Phantom E8370RB RMI Grayscale Target Model 403GS

CD-RW Media (minimum quad speed)

DVD+RW Disc Media blank H48641D blank 4,7GB DVD+RW disc

B/W Printer Cleaning Sheet see printer user manual for requirements

Color Printer Cleaning Sheet see printer user manual for requirements

Disposable Gloves Use to reach the exterior of the system

Cut resistant gloves Use to avoid scraping your hands when reaching into the Main 
Console or blind spaces

Screwdriver PH0

Screwdriver PH1

Screwdriver PH2
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Section 10-5
System Maintenance

10-5-1 Preliminary Checks
The preliminary checks take about 15 minutes to perform. Refer to the system user documentation 
whenever necessary.

 

Table 10-4    System Checks

Step Item Description

1 Ask & Listen Ask the customer if they have any problems or questions about the equipment.

2 Paperwork Fill in the top of the Ultrasound Inspection Certificate (see: page 10-36).
Note all probes and system options.

3 Power up Turn the system power on and verify that all fans and peripherals turn on. 
Watch the displays during power up to verify that no warning or error messages are displayed.

4 Probes Verify that the system properly recognizes all probes.

5 Displays Verify proper display on the LCD monitor and Touch Panel.

6 Presets “Full Backup” all customer presets on Hard disk and/or DVD (see: Settings - Backup and Restore on 
page 8-69).

7 Image Archive Backup the Image Archive on DVD, USB-Stick, etc. (see: see: "Settings - Backup and Restore" on 
page 8-69).
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10-5-2 Functional Checks
The functional checks take about 60 minutes to perform. 
Refer to the LOGIQ P7/P8/P9/P10 Basic User Manual whenever necessary.

10-5-2-1 System Checks 

NOTE: * Some software may be considered standard depending upon system configuration.

Table 10-5    System Functional Checks

Step Item Description

1 B Mode Verify basic B Mode (2D) operation. 
Check the basic system controls that affect this mode of operation.

2 M Mode Verify basic M Mode operation. 
Check the basic system controls that affect this mode of operation.

3 CFM Mode Verify basic CFM Mode (Color Flow Mode) operation. 
Check the basic system controls that affect this mode of operation.

4 PD Mode Verify basic PD Mode (Power Doppler Mode) operation. 
Check the basic system controls that affect this mode of operation.

5 Doppler Modes Verify basic Doppler Mode operation (PW ). 
Check the basic system controls that affect this mode of operation.

6 *Applicable Software 
Options

Verify the basic operation of all optional modes. 
Check the basic system controls that affect each options operation.

7 Keyboard Test Perform the Keyboard Test Procedure to verify that all keyboard controls are OK. 

8 LCD Monitor Verify basic LCD Monitor display functions.

9 Measurements
Scan a gray scale phantom and use the measurement controls to verify distance and area 
calculation accuracy.
Refer to the Basic User Manual, for measurement accuracy specifications.
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10-5-2-2 Peripheral/Option Checks

If any peripherals or options are not part of the system configuration, the check can be omitted. 

10-5-3 Input Power

10-5-3-1 Mains Cable Inspection 

10-5-4 Cleaning

10-5-4-1 General Cleaning
Frequent and diligent cleaning of the LOGIQ P7/P8/P9/P10 ultrasound system reduces the risk of 
spreading infection from person to person, and also helps to maintain a clean work environment. 

Table 10-6    Approved Peripheral/Hardware Option Functional Checks

Step Item Description

1 B/W Printer Verify hardcopy output of the B/W video page printer. Clean heads and covers if necessary.

2 Color Printer Verify hardcopy output of the Color video page printer. Clean heads and covers if necessary.

3 Color Deskjet 
(Bluetooth) Printer Verify hardcopy output of the Deskjet (Bluetooth) printer. Clean heads and covers if necessary.

4 DICOM Verify that DICOM is functioning properly. Send an image to a DICOM device.

5 Footswitch Verify that the footswitch is functioning as programed. Clean as necessary.

6 DVD-Drive Verify that the DVD-drive reads/writes properly
(export/recall image in Image Management System = Archive)

Table 10-7    Mains Cable Inspection

Step Item Description

1 Unplug Cord Disconnect the mains cable from the wall and system.

2 Inspect Inspect it and its connectors for damage of any kind.

3 Terminals Verify that the LINE, NEUTRAL and GROUND wires are properly attached to the terminals, and that 
no strands may cause a short circuit.

4 Inlet Connector Inlet connector retainer is functional.

Table 10-8    General Cleaning

Step Item Description

1 Console
Use a fluid detergent in warm water on a soft, damp cloth to carefully wipe the entire system. 
Be careful not to get the cloth too wet so that moisture does not enter the console.
Caution: DO NOT allow any liquid to drip or seep into the system.

2 LCD Monitor
Clean LCD Monitor surface with a fluid detergent in warm water on a soft, damp cloth. 
Caution: DO NOT spray any liquid directly onto the LOGIQ P7/P8/P9/P10 covers, LCD Monitor, 
keyboard, etc.
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10-5-4-2 Air filter cleaning
Clean the system's air filters to ensure that a clogged filter does not cause the system to overheat and 
reduce system performance and reliability. It is recommended the filters be cleaned every two weeks, 
but the requirements will vary with environment.

Plastic Air filter

1) Pull the front cover with hand and pull out the front air filter.

Figure 10-1   Front Air filter location

CAUTION Be sure to lock the wheels before cleaning the air filters to avoid injury by any unexpected 
movement of the system.
DO NOT operate the unit without the air filters in place.
Allow the air filters to dry thoroughly before re-installing them on the unit.
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2) Pull out the Bottom air filter.

Figure 10-2   Bottom Air filter location

3) Dust the filter with a vacuum cleaner and/or wash it with a mild soapy solution. If washed, rinse 
and dry the filter before re-installation.

4) Put back the air filters and the front cover.

NOTE: For your convenience or if the air filter is too dirty, replacement filters are available. Refer to 
Chapter 9 for the air filter replacement part number.
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10-5-5 Physical Inspection 

10-5-6 Optional Diagnostic Checks
Optionally you can access the diagnostic software as described in Chapters 5 or 7. 
View the error logs and run desired diagnostics.

10-5-6-1 View the logs

1) Review the system error log for any problems.
2) Check the temperature log to see if there are any trends that could cause problems in the future.
3) Check the Configuration Log; update if needed.

Table 10-9    Physical Checks

Step Item Description

1 Labeling Verify that all system labeling is present and in readable condition.

2 Scratches & Dents Inspect the console for dents, scratches or cracks.

3 LCD Monitor Display Inspect the LCD Monitor Display for scratches and raster burns. 
Verify proper operation of Contrast and Brightness controls.

4 Control Panel and 
Keyboard

Inspect the Control Panel and Keyboard. Note any damaged or missing items. 
(Replace faulty components, as required).

Verify proper operation of Control Panel backlighting and TGC sliders.

5 DVD Drive
Clean the drive head and media with the vendor-supplied cleaning kit.Advise the user to repeat 
this often, to prevent future problems. DVDs/CDs must be stored away from dust and cigarette 
smoke. Do not use alcohol or benzene to clean the drive

6 Wheels & Brakes Check all wheels and casters for wear and verify operation of foot brake, to stop the unit from 
moving, and release mechanism. Check all wheel locks and swivel locks for proper operation.

7 Cables & Connectors Check all internal cable harnesses and connectors for wear and secure connector seating. 
Pay special attention to footswitch assembly and probe strain or bend reliefs.

8 Power Cord
Check the power cord for cuts, loose hardware, tire marks, exposed insulation or other 
deterioration, and verify continuity. Tighten the clamps that secure the power cord to the unit and 
the outlet plug to the cord. 

9 Shielding & Covers Check to ensure that all EMI shielding, internal covers, air flow panels and screws are in place. 
Missing covers and hardware could cause EMI/RFI problems during scanning.

10 Peripherals Check and clean the peripherals according to the manufacturer’s directions. 
To prevent EMI or system overheating, dress the peripheral cables inside the peripheral cover.

11 External I/O Check all connectors for damage and verify that the labeling is good.

12 Op Panel Lights Check proper operation of all control panel key illuminations (flash once during system start-up).
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10-5-7 Probe Maintenance

10-5-7-1 Probe Related Checks 

10-5-7-2 Basic Probe Care
The Basic User Manual and/or care card provides a complete description of probe care, maintenance, 
cleaning and disinfection. Ensure that you are completely familiar with the proper care of GE probes.

Ultrasound probes can be easily damaged by improper handling. Review the Basic User Manual of 
LOGIQ P7/P8/P9/P10 for more details. Failure to follow these precautions can result in serious injury 
and equipment damage. Failure to properly handle or maintain a probe may also void its warranty.

Any evidence of wear indicates the probe cannot be used.

Do a visual check of the probe pins and system sockets before plugging in a probe.

10-5-7-3 Basic Probe Cleaning and/or Disinfection
Refer to the Basic User Manual of LOGIQ P7/P8/P9/P10 for details on cleaning.    

Table 10-10   Probe Related Checks

Step Item Description

1 Probes Thoroughly check the system probe connectors and remove dust from inside the connector 
sockets if necessary. Visually check for bent, damaged or missing pins.

2 Probe Holder Clean probe holders (they may need to be soaked to remove excess gel).

CAUTION
!! CAUTION: 

Failure to follow the prescribed cleaning or disinfection procedures will void the probe’s 
warranty. DO NOT soak or wipe the lens with any product not listed in the LOGIQ P7/P8/P9/P10 
Basic User Manual and/or care card. Doing so could result in irreparable damage to the probe 
and/or LOGIQ P7/P8/P9/P10 system. 

CAUTION
!! CAUTION: 

Follow the Care Card instructions supplied with each probe (inside the transducer boxes)
for disinfectants and gels that are compatible with the surface material of the probes.

CAUTION
!! CAUTION: 

To help protect yourself from blood borne diseases, when cleaning and handling probes, 
wear approved, non-allergenic disposable gloves.

NOTICE
!! NOTICE:

Disinfect a defective probe before you return it. Be sure to tag the probe as being disinfected.

OK OKOK

CAUTION
!! CAUTION: 

Please be aware of the 
sensitive probe head.
TAKE EXTREME CARE!

NEVER place or store a 
probe on its scan head!

When 
disinfecting a probe, ensure 
that there is sufficient space 
between the probe and the 
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Section 10-6
System Software Updates (Software Download) (R1, R2, R2.5 only)

Software Updates for the unit may be available for download and installation. When a Software Update 
is available, a message icon is displayed on the system exit window.

Only users with administrator rights are allowed to download Software Upgdates. You first download 
the software, then install the software. It is a two-step process.

Once the software installation has begun, the system is not useable until the software installation is 
done. The installation can take up to 45 minutes to complete. While installing, DO NOT turn off system 
power or the system can be left in a unusable mode. For this reason, you may want to perform the 
software download one evening and then install the software the next evening.

After the software installation is complete, you will be asked to perform a few system functional checks 
to determine normal system operation.

NOTE: A software download may take more than 1 hour (and may take several hours), depending on local 
network conditions. During this time, you cannot perform any other function. Please allow sufficient time 
to complete the software download and installation.

NOTE: A wired network connection is recommended for faster software download.

NOTE: After you press a software download button, it may take up to three (3) seconds for the system to 
respond.

NOTE: Software Updates through the GE service platform may not be available in all countries.
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10-6-1 Software download and installation
You receive notification of available software updates via the envelope icon that appears in the status 
bar on the bottom of the monitor.

NOTE: To update the software, you must login with administrator privileges.

1) Press the on/off button on the control panel. The Exit dialog window with software download 
displays. 

Figure 10-3   System - Exit Dialog Window

• Automatically install after download: The software installation starts automatically after the 
software has been downloaded if this box is checked.

• More Info: Displays a window with information about the software to download.

Figure 10-4   More Info

• Decline: You decline the software download; the software is not downloaded, no update will be 
performed. The software download will not occur and you will not be informed about this package 
again.

• Download: Starts the software download.
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NOTE: If you are not logged in as an Administrator and there is a software package to download, you will see 
the following dialog when shutting down the system:

Figure 10-5   Software Download Dialog If Not an Administrator

If you get a dialog with “Unknown status,” this may mean that your system has lost connection with the 
network. In this case, ensure that your system is connected to the network. Then restart your system.

Figure 10-6   Check the Network Connection

However, if the network appears to be connected, then the problem may have resolved itself and no 
further action on your part is required.
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2) Press Download.

Figure 10-7   System - Exit Dialog Window

The download process starts. The progression of the download process is displayed.

NOTE: The download step can be paused. While paused, you can return to normal operation. However, once 
the software installation has begun, the system is not useable until the software installation is done. The 
installation can take up to 45 minutes to complete. While installing, DO NOT turn off system power or 
the system can be left in a unusable mode. For this reason, you may want to perform the software 
download one evening and then install the software the next evening.

NOTE: A typical software update of about 600 Mb may take up to 60 minutes to download, but times may vary 
depending on your location and network connection. If you are downloading both the Operating System 
and software update, the total size is about 9 GB and will take much longer to download.
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Press Download.

Figure 10-8   Download in Progress Options

• Stop: Stops the download process; no software upgrade is performed. If you select Stop, you WILL 
NOT be given an opportunity to download this package again.
The following dialog appears (it is the same dialog as the Decline option): 

Figure 10-9   Stop (or Decline) the Software Download Dialog

• Pause: Pauses the software download process. If you select Pause, you can cancel out of this 
dialog and return to normal scanning or you can power off the scanner. A paused download can be 
resumed by logging in as Administrator, pressing the power switch, and selecting Resume.
When you press Pause, the following dialog displays:
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Figure 10-10   Paused Software Download

• Resume: Press Resume to continue the software download.
3) If auto-install was not checked, you will see the following dialog when the software download has 

finished (the message, “SW is ready to be installed,” and the “Install” button appear.

Figure 10-11   Software Ready To Be Installed

Press Install.
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The system reboots automatically and the installation process is started. Do not interrupt the 
installation. The system may reboot automatically during installation or you may be prompted to restart 
the system.

NOTE: At this time, you can also select to stop, or decline, the software installation process.

• Decline: DO NOT install the downloaded software; no software upgrade will be performed. If you 
decline this installation, you WILL NOT be offered the chance to install this software package again. 
You can select Cancel to return to normal scanning. You can perform the install at a later time.

NOTE: If auto-install was checked, the system will reboot automatically and start the software installation as 
soon as the download has finished.

Multiple screens appear during the software installation process. DO NOT interrupt this process AND 
follow instructions as they appear on the display.

NOTE: A typical installation may take up to 15 minutes. When the installation is complete, the New Software 
Verification Checklist window is displayed.

4) When the system starts up after the software installation has finished, the following dialog displays: 
the “New Software Verification” Checklist.

This dialog is critical. You MUST perform software verification after downloading and installing a 
software update.

Figure 10-12   New Software Verification Checklist

These verification results are tracked for regulatory purposes, sent back to GE for tracking, and 
approved with your signature.

CAUTION
!! CAUTION: 

Perform a check for all the features listed. You MUST ensure that the entire system functions 
normally, as expected, in each of the categories listed on the New Software Verification 
checklist.
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NOTE: Press the Question mark to get information on how to check each feature.

Figure 10-13   New Software Verification Checklist

NOTE: You can move this dialog, but DO NOT close it. You can also minimize this dialog by clicking on the “<<“ 
button at the top, right-hand corner of the dialog.

A minimized window looks like this. To maximize the Checklist again, click on the “>>” button at the 
lower, right-hand corner of the dialog.

Figure 10-14   Minimized New Software Verification Checklist

5) As you verify that each feature works correctly, select “Passed.” If all features work correctly and 
“Passed” is filled in for all features, then the signature field is enabled at the bottom of the New 
Software Verification Checklist.
Type your signature (minimum of three characters) and press OK. The system is now ready for use.

WARNINGWARNING
!! WARNING:

However, if any of the features DID NOT function as expected, you need to select 
“Failed” next to the feature that failed. Type your signature (minimum of three 
characters) and press Reload.
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When there is a failed feature noted on the New Software Verification Checklist, the following Warning 
dialog displays:

Figure 10-15   Re-Install Previous Software Version Dialog

When the New Software Verification Checklist contains a ‘Failed’ feature, you have two options 
available: 1) Re-Install the previous version of software (“OK”), or 2) Revert to the Checklist (“Cancel”) 
and continue with the software version you just downloaded and installed.

If you press “OK,” the system re-images the hard drive and reloads the previous version of software. 
This takes approximately 30 minutes. Select Cancel to return to the dialog window. Here you can either 
1) change the New Software Verification Checklist items to Pass and then use the just-installed version 
of the software; or 2) select OK and to reload your original software.

Multiple screens appear during the software re-imaging installation process. DO NOT interrupt this 
process AND follow instructions as they appear on the display.
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Section 10-7
Using a Phantom

Refer to the User Manual of the Phantom for information on using a phantom and quality assurance 
tests. For measurement accuracy of the system review chapter 13.5 of the Basic User Manual of LOGIQ 
P7/P8/P9/P10. To get comparable results, use Multi-purpose phantom, Model 539-05 from ATS 
Laboratories Inc.

Section 10-8
Electrical Safety Tests

10-8-1 Safety Test Overview
The electrical safety tests in this section are based on and conform to ANSI/AAMI ES60601-1(For USA) 
and IEC60601-1 Medical Equipment Safety Standards. They are intended for the electrical safety 
evaluation of cord-connected, electrically operated, patient care equipment. If additional information is 
needed, refer to the ANSI/AAMI ES60601-1(For USA) and IEC 60601-1 documents.

 

To minimize the risk of a probe causing electrical shock, the customer should observe the following 
recommendations: 

• DO NOT use a probe that is cracked or damaged in any way
• Check probe leakage current:

* once a year on surface probes 
* once a year on endocavitary probes 
* whenever probe damage is suspected

WARNINGWARNING
!! WARNING:

THE USER MUST ENSURE THAT THE SAFETY INSPECTIONS ARE PERFORMED AT 
LEAST EVERY 12 MONTHS ACCORDING TO THE REQUIREMENTS OF THE PATIENT 
SAFETY STANDARD AAMI/ANSI ES 60601-1 AND IEC60601-1. ONLY TRAINED 
PERSONS ARE ALLOWED TO PERFORM THE SAFETY INSPECTIONS MENTIONED 
ABOVE.

CAUTION
!! CAUTION: 

To avoid electrical shock, the unit under test must not be connected to other electrical 
equipment. Remove all interconnecting cables and wires. The unit under test must not be 
contacted by users or patients while performing these tests.

CAUTION
!! CAUTION: 

Possible risk of infection. Do not handle soiled or contaminated probes and other components 
that have been in patient contact. Follow appropriate cleaning and disinfecting procedures 
before handling the equipment.

WARNINGWARNING
!! WARNING:

Test the system, peripherals and probes for leakage current. Excessive leakage current 
can cause FATAL INJURY OR DEATH. High leakage current can also indicate 
degradation of insulation and a potential for electrical failure. DO NOT use probes or 
equipment having excessive leakage current.
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10-8-2 GEHC Leakage Current Limits
The following limits are summarized for ANSI/AAMI ES60601-1(For USA), IEC 60601-1 Medical 
Equipment Safety Standards and IEC 62353 Medical Electrical Equipment - Recurrent test and test 
after repair of medical electrical equipment. 
Measurement limits per ANSI/AAMI ES60601-1(For USA) and IEC 60601-1 Medical Equipment Safety 
Standards.

 

Table 10-11   Enclosure Leakage Current Limits - Accessible Surfaces not protectively earthed

Conditions
Country

USA Others

Close Protective earth and close neutral with normal polarity 0.1mA* 0.1mA***

Close Protective earth and close neutral with reverse polarity 0.1mA* 0.1mA***

Open Protective earth and close neutral with normal polarity 0.3mA** 0.5mA***

Open Protective earth and close neutral with reverse polarity 0.3mA** 0.5mA***

Open neutral and close Protective earth with normal polarity 0.5mA* 0.5mA***

Open neutral and close Protective earth with reverse polarity 0.5mA* 0.5mA***

Table 10-12   Earth Leakage Current Limits 

Conditions
Country

USA Others

Close Protective earth and close neutral with normal polarity 0.3mA** 0.5mA***

Close Protective earth and close neutral with reverse polarity 0.3mA** 0.5mA***

Open neutral and close Protective earth with normal polarity 1mA* 1mA***

Open neutral and close Protective earth with reverse polarity 1mA* 1mA***

Table 10-13   Type BF Patient Leakage Limits - Non-Conductive Surface

Conditions
Country

USA Others

Close Protective earth and close neutral with normal polarity 0.1mA* 0.1mA***

Close Protective earth and close neutral with reverse polarity 0.1mA* 0.1mA***

Open Protective earth and close neutral with normal polarity 0.5mA* 0.5mA***

Open Protective earth and close neutral with reverse polarity 0.5mA* 0.5mA***

Open neutral and close Protective earth with normal polarity 0.5mA* 0.5mA*

Open neutral and close Protective earth with reverse polarity 0.5mA* 0.5mA***
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NOTE: * Measurement limits per ANSI/AAMI ES60601-1 Medical Electrical Equipment Safety Standards 
Table IV
** Measurement limits per ANSI/AAMI ES60601-1 Medical Electrical Equipment Safety Standards, 

Table 19.5DV.1
*** Measurement limits per IEC 60601-1 Medical Electrical Equipment Safety Standards, Table IV
**** Isolation between Mains and Applied Limits refers to the measurement of leakage current flow 

which would flow from mains to patient if the patient were to come into contact with mains voltage.

The following tests are performed at the factory and should be performed at the customer site as well.

- Grounding Continuity
- Earth Leakage Current.
- Enclosure Leakage Current
- Patient Leakage Current

All measurements should be made with an electrical safety analyzer.

Table 10-14   Type BF Patient Auxiliary Limits

Conditions
Country

USA Others

Close Protective earth and close neutral with normal polarity 0.1mA* 0.1mA***

Close Protective earth and close neutral with reverse polarity 0.1mA* 0.1mA***

Open Protective earth and close neutral with normal polarity 0.5mA* 0.5mA***

Open Protective earth and close neutral with reverse polarity 0.5mA* 0.5mA***

Open neutral and close Protective earth with normal polarity 0.5mA* 0.5mA***

Open neutral and close Protective earth with reverse polarity 0.5mA* 0.5mA***

Table 10-15   Isolation between Mains and Applied Limits
**** Patient Leakage Main to Type BF Applied part

Conditions
Country

USA Others

Close Protective earth and close neutral with normal polarity 5mA* 5mA***

Close Protective earth and close neutral with reverse polarity 5mA* 5mA***
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10-8-3 Outlet Test - Wiring Arrangement - USA & Canada
Test all outlets in the area for proper grounding and wiring arrangement by plugging in the neon outlet 
tester and noting the combination of lights that are illuminated. Any problems found should be reported 
to the hospital immediately and the receptacle should not be used.

NOTE: No outlet tester can detect the condition where the Neutral (grounded supply) conductor and the 
Grounding (protective earth) conductor are reversed. If later tests indicate high leakage currents, this 
should be suspected as a possible cause and the outlet wiring should be visually inspected.

Figure 10-16   Typical Outlet Tester
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10-8-4 Grounding Continuity  

Measure the resistance from the third pin of the attachment plug to the exposed protectively - earthed 
metal parts of the case. The ground wire resistance should be less than 0.2 ohms.
Reference the procedure in the IEC60601-1. 

10-8-4-1 Meter Procedure
Follow these steps to test the Ground wire resistance.

1) Turn the system unit OFF.
2) Plug the unit into the meter, and the meter into the tested AC wall outlet.
3) Plug the black chassis cable into the meter’s “CHASSIS” connector and attach the black chassis 

cable clamp to an exposed protectively earthed metal part of the system, such as Potential 
equilibrium connector.

4) Set the meter’s “FUNCTION” switch to the RESISTANCE position.
5) Set the meter’s “POLARITY” switch to the OFF (center) position.
6) Measure and record the Ground wire resistance. This should be less than 0.2 Ohms.

CAUTION
!! CAUTION: 

Electric Shock Hazard!
The patient or operator MUST NOT come into contact with the equipment during this test

Figure 10-17   Ground Continuity Test

CAUTION
!! CAUTION: 

Lacquer is an isolation barrier! Resistor may be high-impedance!
Measure only on blank parts, stated in Figure 10-17 above.

ACCESSIBLE METAL PARTS

GROUND PIN

OHMMETER

Potential equilibrium connector
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10-8-5 Enclosure Leakage Current Test

10-8-5-1 Definition
This test measures the current that would flow in a grounded person who touched accessible non-
protectively-earthed parts of equipment if the ground wire were to break. The test verifies the isolation 
of the power line from the chassis.

The meter is connected from accessible non-protectively-earthed parts of the case to ground. 
Measurements should be made with the ground open and closed, with power line polarity normal and 
reversed, and with the neutral open and closed. Record the highest reading.

10-8-5-2 Generic Procedure
The test verifies the isolation of the power line from the enclosure. The testing meter is connected from 
accessible non-protectively-earthed parts of the case to ground. Measurements should be made with 
the ground open and closed, with power line polarity normal and reversed, and with the neutral open 
and closed. Record the highest reading of current.

NOTE: Color of Power outlet cable

i) USA and Canada
Hot: Black
Neutral: White
Ground: Green or Green-yellow

ii) Others
Hot: Brown
Neutral: Blue
Ground: Green-yellow

DANGER
!! DANGER:

Electric Shock Hazard. 
When the meter’s ground switch is OPEN, DO NOT touch the unit!

CAUTION
!! CAUTION: 

Equipment damage possibility. Never switch the Polarity and the status of Neutral when the unit 
is powered ON. Be sure to turn the unit power OFF before switching them using the POLARITY 
switch and/or the NEUTRAL switch. Otherwise, the unit may be damaged.

Figure 10-18   Set Up for Test of Enclosure Leakage Current, AAMI/ANSI ES 60601-1/IEC 60601-1 Clause 19
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When using Dale 600/601 or a similar test instrument, its power plug may be inserted into the wall outlet 
and the equipment under test is plugged into the receptacle on the panel of the meter. This places the 
meter in the grounding conductor and the current flowing from the case to ground will be indicated in 
any of the current ranges. The maximum allowable limit for enclosure leakage current is shown in 
Table 10-11 on page 10-23

10-8-5-3 Data Sheet for Enclosure Leakage Current
The test passes when all readings measure less than the value shown in Table 10-11. 
Record all data on the Ultrasound Inspection Certificate.

10-8-6 Earth Leakage Current Test 

10-8-6-1 Definition
This test measures the current that would flow to a grounded person who touched accessible 
protectively-earthed parts of equipment if the ground wire should break. 

The meter is connected from accessible protectively-earthed parts of the equipment to ground. 
Measurements should be made with power line polarity normal and reversed, and with the neutral open 
and closed Record the highest reading.

Table 10-16   Typical Data Sheet for Enclosure Leakage Current 

Tester 
Neutral 

Tester Polarity 
Switch 

Protective Earth 
Switch 

Test 1 
Wheel 

Test 2
LCD

Optional 
Test 3

Optional 
Test 4

Enter Name of tested peripheral here:   

Closed Normal  Closed     

Closed Normal Open     

Closed Reversed  Closed     

Closed Reversed  Open     

Open Normal  Closed     

Open Reversed  Closed     

CAUTION
!! CAUTION: 

Equipment damage possibility. Never switch the Polarity and the status of Neutral when the unit 
is powered ON. Be sure to turn the unit power OFF before switching them using the POLARITY 
switch and/or the NEUTRAL switch. Otherwise, the unit may be damaged.
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10-8-6-2 Generic Procedure

The testing meter is connected from accessible protectively-earthed parts of the equipment to ground. 
Measurements should be made with power line polarity normal and reversed, and with the neutral open 
and closed. Record the highest reading of current. 

NOTE: Color of Power outlet cable

i) USA and Canada
Hot: Black
Neutral: White
Ground: Green or Green-yellow

ii) Others
Hot: Brown
Neutral: Blue
Ground: Green-yellow

When using Dale 600/601 or a similar test instrument, its power plug may be inserted into the wall outlet 
and the equipment under test is plugged into the receptacle on the panel of the meter. This places the 
meter in the grounding conductor and the current flowing through protective earth will be indicated in 
any of the current ranges. The maximum allowable limit for earth leakage current is shown in Table 10-
12.

Figure 10-19   Set Up for Test of Earth Leakage Current, AAMI/ANSI ES 60601-1/IEC 60601-1 Clause 19

Table 10-17   Typical Data Sheet for Earth Leakage Current

Tester Neutral Tester Polarity Switch Measured Earth leakage current

Enter Name of tested peripheral here:

Closed Normal  

Closed Reversed  

Open Normal  

Open Reversed  
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10-8-7 Type BF Patient Leakage Current Test - Probe

10-8-7-1 Definition
This test measures the current that would flow to ground from any of the probes through a patient who 
is being scanned and becomes grounded by touching some other grounded surface.

NOTE: Some leakage current is expected on each probe, depending on its design. Small variations in probe 
leakage currents are normal from probe to probe. Other variations will result from differences in line 
voltage and test lead placement. It is abnormal if no leakage current is measured. If no leakage current 
is detected, check the configuration of the test equipment.

10-8-7-2 Generic Procedure on Leakage Current
Measurements should be made with the ground open and closed, with power line polarity normal and 
reversed, and with neutral open and closed. For each combination, the probe must be active to find the 
worst case condition.

Figure 10-20   Set Up for Probe Leakage Current

NOTE: Saline water pod should be insulated from floor and earth ground

CAUTION
!! CAUTION: 

Equipment damage possibility. Never switch the Polarity and the status of Neutral when the unit 
is powered ON. Be sure to turn the unit power OFF before switching them using the POLARITY 
switch and/or the NEUTRAL switch. Otherwise, the unit may be damaged.

Table 10-18   Typical Data Sheet for Type BF Patient Leakage Current Test

Tester Neutral Tester Polarity Switch Ground Switch Measured leakage current

Closed Normal  Closed  

Closed Normal  Open  

Closed Reversed  Closed  

Closed Reversed  Open  

Open Normal  Closed  
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Open Reversed  Closed  

Table 10-18   Typical Data Sheet for Type BF Patient Leakage Current Test

Tester Neutral Tester Polarity Switch Ground Switch Measured leakage current
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10-8-8 Type BF Patient Leakage current - Mains to Probe

Reference the procedure in the IEC 60601-1. Measure leakage current flow from mains to Probe.

NOTE: It is not necessary to test each lead individually or power condition combinations as required in 
previous tests.

DANGER
!! DANGER:

Electric Shock Hazard. 
Line voltage is applied to Probe during this test. To avoid possible electric shock hazard, the 
system being tested must not be touched by patients, users or anyone during testing.

CAUTION
!! CAUTION: 

Equipment damage possibility. Never switch the Polarity and the status of Neutral when the unit 
is powered ON. Be sure to turn the unit power OFF before switching them using the POLARITY 
switch and/or the NEUTRAL switch. Otherwise, the unit may be damaged.

Table 10-19   Typical Data Sheet for Type BF Patient Leakage Current - Mains to Probe

Tester Neutral Tester Polarity Switch Ground Switch Measured leakage current

Closed Normal  Closed  

Closed Reversed Closed  
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Section 10-9
When There’s Too Much Leakage Current...

10-9-1 Earth and/or Enclosure Fails
Check the ground on the power cord and plug for continuity. Ensure the ground is not broken, frayed, 
or intermittent. Replace any defective part. Tighten all grounds. Ensure star washers are under all 
ground studs. Inspect wiring for bad crimps, poor connections, or damage. Test the wall outlet; verify it 
is grounded and is free of other wiring abnormalities. Notify the user or owner to correct any deviations. 
As a workaround, check the other outlets to see if they could be used instead.

NOTE: No outlet tester can detect the condition where the neutral wire and the grounding wire are reversed. If 
later tests indicate high leakage currents, this should be suspected as a possible cause and the outlet 
wiring should be visually inspected.

10-9-2 Probe Fails
• Test another probe to isolate if the fault lies with the probe or the scanner.

NOTE: Each probe will have some amount of leakage, dependent on its design. Small variations in probe 
leakage currents are normal from probe to probe. Other variations will result from differences in line 
voltage and test lead placement. The maximum allowable leakage current for body surface contact 
probe differs from an inter-cavity probe. Be sure to enter the correct probe type in the appropriate space 
on the check list.

• Test the probe in another connector to isolate if the fault lies with the probe or the scanner. If 
excessive leakage current is slot dependent, inspect the system connector for bent pins, poor 
connections, and ground continuity.

If the problem remains with the probe, replace the probe.

10-9-3 Peripheral Fails
Tighten all grounds. Ensure star washers are under all ground studs.

Inspect wiring for bad crimps, poor connections, or damage.

10-9-4 Still Fails
If all else fails, begin isolation by removing the probes, external peripherals, and then the on-board 
peripherals one at a time while monitoring the leakage current measurement.
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10-9-5 New Unit
If the leakage current measurement tests fail on a new unit and if situation cannot be corrected, submit 
a Safety Failure Report to document the system problem. Remove unit from operation. 

ELECTRICAL SAFETY

Outlet and Ground Continuity test

Earth leakage current test

Enclosure leakage current test

Table 10-20   

Outlet/Ground Continuity Max Value 
Allowed 

Value 
Measured OK? Comments

Outlet (correct ground & wiring config.) N/A N/A   

System Ground Continuity 0.2 Ohm    

Table 10-21   

Tester Neutral Tester Polarity 
Switch Max Value Allowed Value 

Measured OK? Comments

Enter Name of tested peripheral here:

Closed Normal 0.3mA(USA)/0.5mA(Others)    

Closed Reversed 0.3mA(USA)/0.5mA(Others)    

Open Normal 1mA    

Open Reversed 1mA    

Table 10-22   

Tester 
Neutral 

Tester 
Polarity 
Switch 

Protective 
Earth 

Switch 

Max Value 
Allowed 

Test 1 
Wheel 

Test 2 
LCD

Optional 
Test 3

Optional 
Test 4 OK? Comments

Enter Name of tested peripheral here:

Closed Normal Closed 0.1mA(USA)/
0.1mA(Others)       

Closed Normal Open 0.3mA(USA)/
0.5mA(Others)       

Closed Reversed Closed 0.1mA(USA)/
0.1mA(Others)       

Closed Reversed Open 0.3mA(USA)/
0.5mA(Others)       

Open Normal Closed 0.5mA(USA)/
0.5mA(Others)       

Open Reversed Closed 0.5mA(USA)/
0.5mA(Others)       
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Type BF Patient Leakage Current Test - Probes (This test should be done for all probe)

Type BF Patient Leakage Current Test - Mains to Probe (This test should be done for all probes)

Final Check. All system covers are in place. System scans with all probes as expected.

Accepted by: ______________________________________________________________________

10-9-6 Ultrasound Equipment Quality Check (EAC and IQC)
Download and use the latest version of these forms. They can be retrieved from MyWorkshop.

• EQC -- Refer to DOC0929340 in MyWorkshop.

Table 10-23   

Tester 
Neutral 

Tester Polarity 
Switch 

Ground 
Switch 

Max Value 
Allowed 

Value 
Measured OK? Comments

Closed Normal Closed 0.1mA    

Closed Normal Open 0.5mA    

Closed Reversed Closed 0.1mA    

Closed Reversed Open 0.5mA    

Open Normal  Closed 0.5mA    

Open Reversed Closed 0.5mA    

Table 10-24   

Tester 
Neutral 

Tester Polarity 
Switch 

Ground 
Switch 

Max Value 
Allowed 

Value 
Measured OK? Comments

Closed Normal Closed 5mA    

Closed Reversed Closed 5mA    



GERAFT LOGIQ P7/P8/P9/P10
DIRECTION 5604324, REVISION 18 DRAFT (MAY 24, 2022)  SERVICE MANUAL

10-36 Section 10-10 - Ultrasound INSPECTION CERTIFICATE

Section 10-10
Ultrasound INSPECTION CERTIFICATE

* Scan Format: Phased Array, Linear Array, Curved Array, Mechanical Array or Other

FUNCTIONAL CHECKS_______________PHYSICAL INSPECTION AND CLEANING

COMMENTS:
_____________________________________________________________________________________________
_____________________________________________________________________________________________
_____________________________________________________________________________________________
_____________________________________________________________________________________________

Customer Name: System ID: Dispatch Number/Date Performed: Warranty/Contract/HBS

System Type Model Number: Serial Number: Manufacture Date:

Probe 1: Frequency: Scan Format*: Model Number: Serial Number:

Probe 2: Frequency: Scan Format*: Model Number: Serial Number:

Probe 3: Frequency: Scan Format*: Model Number: Serial Number:

Probe 4: Frequency: Scan Format*: Model Number: Serial Number:

Probe 5: Frequency: Scan Format*: Model Number: Serial Number:

Probe 6: Frequency: Scan Format*: Model Number: Serial Number:

Probe 7: Frequency: Scan Format*: Model Number: Serial Number:

Probe 8: Frequency: Scan Format*: Model Number: Serial Number:

Probe 9: Frequency: Scan Format*: Model Number: Serial Number:

Functional Check (if applicable)
OK? or 

N/A
Physical Inspection and Cleaning

(if applicable) Inspect Clean

B-Mode Function Console

M-Mode Function Monitor

Doppler Modes Functions

Color Modes Functions Air Filter

3D/4D-Mode Function Probe Holders

Applicable Software Options External I/O

Applicable Hardware Options Wheels, Brakes & Swivel Locks

Control Panel Cables and Connectors

Monitor Approved Peripherals (VCR, DVD Drive, Printers, etc.)

Measurement Accuracy
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ELECTRICAL SAFETY

Final Check. All system covers are in place. System scans with all probes as expected.

Accepted by: ______________________________________________________________________

Electrical Test Performed
Max Value 
Allowed

Value 
Measured OK? Comments

Outlet (correct ground & wiring conflg.)

System Ground Continuity

Chassis Source Leakage Current - Probe

Chassis Source Leakage Current - Wheel

Chassis Source Leakage Current - CRT

Patient Lead Source Leakage 
(Lead to Ground)

Patient Lead Source Leakage
(Lead to Lead)

Patient Lead Source Leakage
(Isolation)

Peripheral 1 Leakage Current

Peripheral 1 Ground Continuity

Peripheral 2 Leakage Current

Peripheral 2 Ground Continuity

Peripheral 3 Leakage Current

Peripheral 3 Ground Continuity

PROBES

Probe Number
(from previous page)

Mas Value 
Allowed

Max Value 
Measured OK? Comments

Probe 1:

Probe 2:

Probe 3:

Probe 4:

Probe 5:

Probe 6:

Probe 7:

Probe 8:

Probe 9:
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